How can we help you?
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
questions about Sage ERP Accpac.
I'm setting up Sage ERP Accpac and need information or assistance
I'm looking for instructions to complete a task within Sage ERP Accpac
I think something is broken, or I'm getting error messages
I'm looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage ERP Accpac
I want to share knowledge with other Sage ERP Accpac users
I want to contact a Sage ERP Accpac representative

What's New in Purchase Orders 6.0
Purchase Orders version 6.0 supports changes to Common Services'
Fiscal Calendar.
Fiscal periods are now locked separately for each Sage ERP Accpac
program, including Purchase Orders. Although this change does not
affect the way you enter transactions, you should note the following
points:
The program checks the status of a fiscal period when you enter
certain dates in Purchase Orders documents.
Day End Processing is not affected by locked fiscal periods.
Day End Processing creates transactions for General Ledger,
Accounts Payable, and Project and Job Costing (depending on your
system and settings) and updates costs, as usual. However, if a fiscal
period is locked for a ledger receiving the resulting transactions, the
transactions can fail to post in the other ledger.

Upgrading from an Earlier Version?
If you are upgrading from version 5.5, see Features Added in Purchase Orders 5.6.
If you are upgrading from version 5.4, also see Features Added in Purchase Orders
5.5.
If you are upgrading from version 5.3, also see Features Added in Purchase Orders
5.4.

Steps for Setting Up Purchase Orders
Before you can set up Purchase Orders, you must install the following
Sage ERP Accpac programs: System Manager (with Bank Services and
Tax Services), Accounts Payable, and (if you use them) General Ledger
and Inventory Control. Then install and activate Purchase Orders.
You must also create a company database and choose company-wide
options in Common Services, and activate Tax Services, then add
information about the taxes used in your Purchase Orders system.
If needed, add information about the currencies used in your Purchase
Orders system.
Step 1: Activate Purchase Orders, select options, and add background information and optional fields
Step 2: Design the formats for your printed and e-mailed forms
Step 3: Add current transactions
Step 4: Add historical transactions and statistics (optional)

See also
Choosing Purchase Orders options
Choosing G/L Integration options
Creating E-Mail Messages
Creating formats for printed forms
Entering current requisitions and purchase orders transactions
Entering Purchase Orders setup information
Setting up optional fields
Setting up Purchase Orders without Inventory Control (stand-alone)
Using multicurrency accounting in Purchase Orders

Setting Up Purchase Orders without Inventory
Control
Purchase Orders is designed to be used with or without Inventory
Control.
To set up the program for use as a stand-alone program, without
Inventory Control, follow the procedures for setting up Purchase Orders with
Inventory Control. Then you must take the following additional steps to
set up Purchase Orders for use as a stand-alone program:
Select the Allow Fractional Quantities option, if needed, and add the Weight Unit Of
Measure on the Processing tab of the Options form.
Define and add records for account sets, items, vendor details, and weight units of measure.

Using Multicurrency Accounting in Purchase
Orders
Purchase Orders lets you process transactions in any currencies your
vendors use. This section summarizes the steps you take to set up a
multicurrency Purchase Orders system.
To create a multicurrency Purchase Orders system
1.Turn on the Multicurrency option for the company and select a default
rate type in the Company Profile form in Common Services.
2.Use the Common Services Currency forms to add any currency codes
you need for Purchase Orders, and enter rates for the currencies you
use.
Sage ERP Accpac comes with a comprehensive set of currency
codes that use standard international abbreviations and the format
and number of decimal places that are normally used with each
currency. You probably will not need to define new codes unless you
do not use the international codes.
3.Turn on the Multicurrency option in your Accounts Payable Options
form. This step automatically turns on the Multicurrency option for
Purchase Orders as well.
4.Create an account set in Accounts Payable for each currency you
want to use for Accounts Payable vendors in Purchase Orders.
5.If you post transactions to add current or year-to-date requisitions or
purchase orders, enter the amounts in the vendors' currencies.
6.If you enter statistics for previous years and periods, enter the
amounts in both the functional and vendor currencies. Purchase
Orders cannot calculate equivalent amounts from statistics you enter
yourself.
For more information, see Processing multicurrency transactions.
See also
Steps for setting up Purchase Orders

Creating Formats for Printed Forms
The Sage ERP Accpac Purchase Orders package includes sample
formats you may be able to use with your laser or ink-jet printer "as is" or
adapt to print on the forms you use for purchase orders, requisitions,
receiving slips, returns, and mailing labels.
The files containing the formats include:
Form

Printing On Plain Paper

Printing On Preprinted Forms

Requisition

PORQN01

PORQN02

Purchase order

POPOR01
POPOR04

POPOR02 POPOR05

Receiving slip

PORCP01
PORCP03

PORCP02
PORCP04

Returns

PORET01

PORET02

Mailing labels

POLABEL

n/a

If possible, you should design the formats you want to use and test them
with the sample data before you begin entering transactions in your new
Purchase Orders system.
For more information on custom formats, see the online document
"Customizing Printed Forms with Crystal Reports."
E-mailing purchase orders and returns. The Purchase Orders program
also lets you email purchase orders and purchase order returns to
vendors.&#45;
If you want to email purchase orders and returns to vendors, you use the
Email Messages form in the P/O Setup folder to create the email
messages that you want to send to vendors.&#45;&#45;&#45;
For each vendor that you want to email, you must set the Delivery
Method to Email or to Contact's Email on the Processing tab of the
vendor record in Accounts Payable.&#45;&#45;&#45;

Purchase Orders Security: Overview
If security is turned on for your Sage ERP Accpac ERP system, users without Purchase Orders
security assignments have no access to Purchase Orders.
To view records and to print reports in Purchase Orders, users must
belong to a security group with Common Inquiry permission.
Common Inquiry permission by itself does not let users edit any
Purchase Orders records. To allow users in a security group to edit
records or perform processing tasks, you must grant the group access to
additional tasks from the following list:
Setup Maintenance
Item Maintenance (Service)
Cost Inquiry (in stand alone P/O systems)
Requisition Entry
Requisition Printing
Purchase Order Entry
Edit Blanket PO Amount (requires rights to PO Entry)
Create POs Automatically
Day End Processing (Service)
Purchase Order Printing
Receipt Entry
Receiving Slip Printing
Return Entry
Return Printing
Invoice Entry
Edit Invoiced Quantity (requires rights to Invoice Entry)
Edit Invoiced Cost (requires rights to Invoice Entry)
Credit/Debit Note Entry

Edit Credit Note Quantity (requires rights to Credit/ Debit Note Entry)
Edit Credit Note Cost (requires rights to Credit/ Debit Note Entry)
Mailing Label Printing
Transaction Inquiry
History Clearing
Import Processing (requires rights to the form to import into)
Export Processing (requires rights to the form to export from)
Transaction Optional Fields
Show Requisition/ Receipt Costing Information
Requisitions Manual Approval
Dashboard

Account Sets Form
If you use Purchase Orders as a stand-alone system (without Inventory
Control) this form lets you:
Define a set of general ledger accounts to which you post Purchase
Orders transactions.
You must add at least one account set to Purchase Orders before you
can add item records. If you add more than one account set, you can
group items by the account set to which they belong.
Click the following buttons or the links for help on using these buttons:

Finder

Navigation buttons

New

Click a topic for more information:
Adding Account Set records
Editing Account Set records
Deleting Account Set records
Printing reports of Account Set records

See also
Account Sets report
Options form
Setting up Account Sets
Setting up Purchase Orders without Inventory Control
Steps for setting up Purchase Orders

Additional Costs Form
This form lets you:
Define codes to identify the extra costs you are charged by your
vendors (such as shipping or handling charges).
Click these buttons for help about using the buttons:
Finder

Navigation buttons

New

Click a topic for more information:
Adding additional cost records
Editing additional cost records
Deleting additional cost records
Printing reports of additional cost records

See also
Additional Costs report
Options form
Setting up additional costs
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure

Drop-Down Lists

Create E-mail Messages
Purchase Orders lets you e-mail purchase orders and purchase returns
directly to vendors using the forms for printing purchase orders and
returns.

To e-mail purchase orders and returns
1.Use the Email Messages form in the P/O Setup folder to create the
email message that you want to send to vendors.&#45;&#45;
Each message is identified with a unique 16-character message ID
code. When you select vendor as the Delivery Method on the print
purchase orders or returns forms, you can also select the Message ID
for the type of form you are sending.
To create e-mail messages:
a.

Double-click the E-mail Messages icon in the P/O Setup folder.

b.

Select Purchase Order or Return from the drop-down list in the
Message Type field.

c.

Click the New button.

d.

In the Message ID field, enter an ID, using up to 16 characters.

e.

Enter a description in the Description field.

f.

Enter a subject in the E-mail Subject field. Note that you can use
e-mail information codes in this field. They will be replaced by the
company or document information when the message is sent.

g.

Type your message, using company or document information
codes to specify PO or return details.

h.

Click Add or Save when you are satisfied with your message.

2.In Accounts Payable, set the Delivery Method to Email or to Contact's
Email for each vendor that you want to email. You set the delivery
method on the Processing tab of the vendor record in Accounts
Payable.&#45;&#45;&#45;
3.Choose Vendor as the Delivery Method on the Print Purchase Orders
or Print Returns form when you print purchase orders or returns.

See also
E-mail Message Information Codes
Printing the E-mail Messages Report

Using the G/L Integration Form
Use this form to choose various options for integrating Purchase Orders
with the General Ledger program.
On the Integration tab:
Specify whether to add general ledger transactions to the G/L batch
during posting or each time you run Day End Processing, or to create
the transactions at a later date.
Note: This choice can have a large impact on the speed of
processing transactions in Purchase Orders, especially if you are
costing inventory during posting (in which case, you may want to
create transactions at a later date).
Choose whether to create a separate G/L batch each time you create
the G/L batch (and optionally automatically post the batch) or add new
transactions to the existing batch. (This option applies only if you use
Sage Accpac General Ledger with Purchase Orders at the same
location.)
Choose whether to consolidate the G/L batch when you post, or
always enter full transaction details in the batch.
Decide when Sage ERP Accpac ERP generates entries for noninventory expenses and for expensed additional costs:
Choose whether to generate G/L entries in the Purchase Orders
program for expenses from receipts and returns for non-inventory
items, or have the G/L entries for expenses created in the
Accounts Payable program.
Choose whether to generate G/L entries in the Purchase Orders
program for additional cost expenses on receipts, or have the G/L
entries for expenses created in the Accounts Payable program.
(This is similar to the previous option.)
Specify several General Ledger accounts used by the Purchase
Orders program:
The G/L account number of the default inventory expense account,
default cost expense account, and non-inventory payables clearing

account.
The G/L account that you want to update with expensed additional
costs if you create general ledger transactions from Purchase
Orders. (See Create G/L Entries for Expensed Additional Costs.)
Look up the last Day End Number for which you have created general
ledger batches.
On the Transactions tab:
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in G/L
transactions arising from invoices and shipments. (This information
appears for transactions in the G/L Transactions report.)
Click the field list button or on of the links shown below for more
information on selecting G/L integration options.
Transactions tab

Changing Settings
You can change any of your choices on the G/L Integration page at any
time. However, you should be aware that any changes you make will
apply only to general ledger transactions created after the change, and
will not affect existing general ledger batches.
If you want to change from using the Create Batch form to produce your
general ledger transactions to creating them during day-end processing,
be sure to run Create Batch to process any outstanding transactions first,
to avoid accidentally omitting transactions from your general ledger
batches.

Before using the G/L Integration form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact the options have
on processing within Purchase Orders.
Note: You cannot change settings on the Integration tab of the G/L
Integration form if other Purchase Orders forms are open, or other users
are working with the Inventory Control database.

Make sure that no one else is using the Purchase Orders data and that
no other Purchase Orders forms are open for the company before you
save changes to the G/L Integration form.

A/P integration option is set in the P/O Options
form
Purchase Orders also lets you choose when to post Accounts Payable
batches arising from invoices posted in Purchase Orders.
To specify when to post A/P batches generated from Purchase Orders
Invoices, credit notes and debit notes, use the option Post A/P Batches During Posting
or Day End Processing/On Request Using Create Batch Icon.
See also
Additional Costs
Choosing Purchase Orders options
G/L Integration
Optional Fields
Options report
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure
Changing settings

Items Form — Overview
The Items Form lets you:
Add a record for each item in your inventory list.
An item record includes the item code, account set, tax authority, and
tax classes that the item uses. It also includes units of measure and a
unit of weight for the item, as well as up to 300 characters of
additional descriptive information.
Before adding item records
Add the account sets you require for posting transactions to general
ledger accounts.
Add the taxing authorities and tax classes you require (using the Tax
Services icon in the Common Services folder).
Click these buttons for help about using the buttons:
Finder

Navigation buttons

New

Click the links below for help on using the corresponding tabs:
Items

Units

Taxes

Optional Fields

Click a topic for more information:
Adding Item records
Editing Item records
Deleting Item records
Printing reports of Item records

See also
Account Sets
Additional Costs
Items report
Options form
Setting up items
Setting up Purchase Orders without Inventory Control
Ship Via codes
Steps for setting up Purchase Orders
Vendor Contract Costs
Vendor Details
Weight Units of Measure

Optional Fields Form
This form appears in the P/O Setup folder if you use Sage ERP Accpac's
Transaction Analysis and Optional Field Creator, a separately licensed
package that you can purchase and use with Purchase Orders.

To set up optional fields for your Purchase
Orders system
1.Choose the Optional Fields form from the P/O Setup folder.
2.Select the form to which you are adding the optional fields.
3.Select the optional fields that you are adding.
You must use the same optional fields for transactions in Purchase
Orders, Accounts Payable, and General Ledger if you want to pass
optional field information from Purchase Orders transactions to
Accounts Payable when you create A/P invoice batches and to
General Ledger when you create batches for G/L transactions.
Similarly, you must define the same fields for transaction details as
you define for additional costs and item records if you want
information from costs and items to appear by default in transactions.
(Items are used only if you do not have Sage ERP Accpac Inventory
Control.)
4.If you want to set a default value for the optional field, double-click in
the Value Set column to change it to Yes.
5.Type or select the value that the program will display as the default for
each optional field.
If the optional field you selected requires validation (in other words,
the user is restricted to choosing from a list of entries), you must
select a value that is defined for the optional field in Common
Services.
If the optional field allows blanks, you can leave the default value
field blank.
If the optional field does not use validation, you can do one of the
following:
Select a value that is defined for the optional field in Common
Services.
Leave the field blank.
Enter the default value that you want. The entry must be

consistent with the type of field (text, number, date, amount,
and so on) and must not exceed the number of characters
specified for the optional field. In a Yes/No field, you can enter
only Yes or No.
When you specify a value that is defined in Common Services, the
program displays the description for the value.
6.To make the optional field
column.

mandatory

, double-click in the Required

If you make an optional field a required field, the Auto Insert field
changes to Yes.
7.Select Yes in the Auto Insert field if you want the program to display
the optional field and its default value on the form for the type of
optional field when you set up new records or enter transactions.
Select No if you do not want the optional field to appear automatically.
8.If the Settings button is active, choose the Settings button to specify
which optional fields will be sent through to other Sage ERP Accpac
subledgers and which will be included in transactions that will be
passed to General Ledger for posting to G/L accounts.
By default, all optional fields in Purchase Orders that match fields in
Accounts Payable and in General Ledger accounts will be passed to
A/P and G/L unless you restrict the fields using the Settings form. See
Optional Field Settings.
9.Click Save to save your changes.
See also
Selecting Processing options
Selecting Document Numbering options
Selecting G/L Integration options
Setting up Optional Fields
Steps for setting up Purchase Orders

Options Form — Overview
You select options when you create your Purchase Orders ledger. Once
you have set up your ledger, use this Form when you need to change
your selections.
This form lets you:
Change the contact name, telephone number, and fax number for
your ledger. (Choose the Company tab.)
Check the choice for the Multicurrency option (set in Accounts
Payable) and, if you use multicurrency accounting, specify a default
rate type for the Purchase Orders ledger. (Choose the Processing
tab.)
Select options to determine whether your Purchase Orders ledger
allows non-inventory items, keeps transaction and purchasing history,
and accumulates statistics, and specify a default template code and a
default cost type. (Choose the Processing tab.)
Specify the number of days in each of three aging periods. (Choose
the Documents tab.)
Enter the length, prefix, and next number to assign as document
numbers to purchase orders, requisitions, receipts, and returns.
(Choose the Documents tab.)
If you do not use Inventory Control, choose when to cost items
maintained by the Purchase Orders module.
Note: You cannot save most changes to the Options form if any other
Purchase Orders forms are open for the company on your computer or
on other workstations on a network.
For information about another tab on the Options form, choose the
corresponding link:
Company

Processing

Documents

See also
Additional Costs
Choosing Purchase Orders options
G/L Integration
Optional Fields
Options report

Costing

Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure
Changing settings

Ship-Via Codes Form
This form lets you:
Set up a record for each carrier you use to deliver your orders from
vendors.
Ship-via records are optional. Add them for the carriers you regularly use,
so that you have a record of each carrier's address, phone numbers, and
contact people. You can then specify ship-via codes on purchase orders,
requisitions, receipts, and returns. If you do not use ship-via records, you
can still type the name of a carrier on transactions (but not the address or
any other information), or not specify a shipping method at all.
Click the following links for help on using the corresponding buttons:
Finder

Navigation buttons

New

Click a topic for more information about ship-via codes:
Adding ship-via records
Editing ship-via records
Deleting ship-via records
Printing reports of ship-via records
Setting up ship-via codes

See also
Additional Costs
Options form
Ship Via Codes report
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure

Templates Form — Overview
Use this form to:
Create, edit, or delete sets of default information for transaction
header and vendor information.
You use the templates to automatically fill in fields in the transaction-entry
forms with the information and selections you use most often, so you do
not have to type the information every time you add a transaction.
Click these buttons for help on using them:
Finder

Navigation buttons

New

For information about a tab, choose its tab:
Order

Vendor

Click a topic for more information:
Adding templates
Editing templates
Deleting templates
Printing reports of templates
Using templates

See also
Additional Costs
Options form
Setting up templates
Ship Via codes
Steps for setting up Purchase Orders
Templates report
Vendor Contract Costs
Weight Units of Measure

Vendor Contract Costs Form
This form lets you:
Assign vendors’ prices to your inventory items, specifying:
Base unit costs for single or multiple units of measure.
Sale unit costs for single or multiple units of measure.
Volume discount amounts or percentages.
Tax authorities and tax statuses for the contract cost.
Vendor Contract costs appear by default when you add purchase orders,
receipts, invoices, returns, and credit/debit notes. If no contract cost
exists for an item and vendor, Purchase Orders displays the Default Item
Cost specified in the P/O Options form.
You can also view all vendors’ contract costs in the item Finder for the
Unit Cost field in the Purchase Order, Receipt, Invoice, Return, and
Credit/Debit Note Entries forms.
Note: Vendor Contract Costs are not available in Sage ERP Accpac 100.
Click the following links for help on using the corresponding buttons:
Finder

Navigation buttons

New

For information about other tabs in the Item Pricing form, click the
following links:
Costs

Discounts

Taxes

For information about fields in the Item Pricing form, select the Field List
button beside the title of this help topic.

Click a topic for more information about vendor
contract costs:
Adding Vendor Contract Costs
Editing Vendor Contract Costs
Deleting Vendor Contract Costs
Printing Vendor Contract Costs
Setting up Vendor Contract Costs

See also
Additional Costs

Options form
Ship-Via Codes
Steps for setting up Purchase Orders
Templates

Vendor Details Form
This form lets you:
Record the vendors for each item you purchase, and the cost.
Establish the order of priority of your suppliers, if you buy the same
item from more than one vendor.
Click these buttons for help about using the buttons:
Finder

Navigation buttons

New

Click a topic for more information:
Adding vendor detail records
Editing vendor detail records
Deleting vendor detail records
Printing reports of vendor detail records

See also
Options form
Setting up Purchase Orders without Inventory Control
Setting up vendor details
Steps for setting up Purchase Orders
Vendor details report

Weight Units of Measure Form
This form lets you:
Add the different units that you use for measuring the weight of items
— such as pounds, tons, kilograms, and metric tons.
The default weight unit of measure (specified on the P/O Options form) is
the unit for expressing the weight of orders in the Purchase Orders
module if you do not use the Inventory Control module.
The default weight unit of measure has a conversion factor of 1, and all
other weight UOMs are defined in terms of a default weight UOM.
To add a weight unit of measure, you specify
The weight unit of measure.
A description of the weight.
The weight conversion factor between the default weight unit of
measure and the unit you are adding (as a multiple of the default
weight unit of measure).
The conversion factor for a default weight unit of measure is
always 1.
You can use fractions in weight conversion factors even if you do
not use fractional inventory quantities.
Before adding weight units of measure
Decide on the default weight unit of measure that you want to use on
orders.
Calculate the conversion factors between the default weight unit of
measure and all other weight units of measure.
You set the default weight unit of measure on the P/O Options form
after adding it to the Weight Units of Measure form.
Choose what to call each of the weight units of measure. The names
you use appear on data entry screens.
See also

Additional Costs
Choosing Purchase Orders options
G/L Integration
Optional Fields
Options report
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Changing settings

Purchase Orders Forms
The following list includes the name of each Purchase Orders icon that
you can select from the Sage ERP Accpac company desktop. Select one
of the keywords below for information on the purpose and operation of
the forms these icons open.

Create Purchase Orders
Create POs from Requisitions
Create POs from I/C
Create POs from O/E

P/O Forms
Requisitions
Purchase Orders
Receiving Slips
Returns
Mailing Labels

Periodic Processing
Clear History
Create Batch
Day End Processing (standalone PO only)
Delete Inactive Record (standalone PO only)

P/O Setup
Account Sets (stand-alone only)
Additional Costs
E-Mail Messages
G/L Integration
Items (stand-alone only)
Optional Fields
Options
Ship-Via Codes
Templates
Vendor Contract Costs
Vendor Details (stand-alone only)
Weight Units of Measure (stand-alone only)

Statistics and Inquiries
Pending Receipts Inquiry

Purchase History
Purchase Statistics

Transactions
Copy Purchase Orders
Credit/Debit Note Entry
Invoice Entry
Purchase Order Entry
Receipt Entry
Requisition Entry
Return Entry

Reports
Analytical reports
Aged Purchase Orders
G/L Transactions
Item Transaction History (stand-alone only)
Payables Clearing Audit list
Posting Journals
Purchase History
Purchase Order Action
Purchase Statistics
Shippable Backorders
Transaction List

Setup Reports
Account Sets (stand-alone only)
Additional Costs
E-mail Messages
G/L Integration
Items (stand-alone only)
Optional Fields
Options
Ship-Via Codes
Templates
Vendor Contract Costs
Vendor Details (stand-alone only)
Weight Units of Measure (stand-alone only)

See also
Purchase Orders menu commands
Using Help

Data Entry Tools and Shortcuts
Accounts Payable data entry forms contain many aids to data entry which
you can activate by pressing a function key or clicking an icon.
Select the icon or command listed below for which you want information:
or
Find

or
Go

or
Navigation
buttons

Zoom

See also
Changing column order in data entry forms
Changing column width in data entry forms
Drop-down lists
Using forms
Using Help

New

Working with Detail Entry Grids
The first tab of each transaction entry form in Purchase Orders contains a
detail entry grid that shows the document details in tabular format.
If there are more columns than can be displayed at one time, you can
use the horizontal scroll bar at the bottom of a list to view the additional
columns. You can also rearrange the order of columns, or change column
widths, consistent with how you enter data.
If you need to view or edit tax options for a single detail, you can select a
detail on the grid, then open a separate form that lets you see all the
fields, including tax fields, for the selected detail.
To add details using the detail grid, do one of the following
If a blank line is highlighted, tab to the Item Number field, then either
type the item number or select it from the Finder. Enter the remaining
information for the detail.
To start a new line, press Insert or tab through the end of the last line
on the grid. If you want to insert a new line in a particular location,
highlight the line above the location, then press Insert.
A detail line is saved as you enter it on the detail entry grid.
To edit details using the detail grid
Highlight the line you want to edit, then enter your changes on that
line.

To delete details using the detail grid
1.Highlight the line you want to delete.
2.Press the Delete key on your keyboard.
3.If you see a message asking you to confirm the deletion, click Yes.

To open the Detail Items/Taxes form or the Detail
Costs/Taxes form
In most cases, you can enter all the necessary details for a document

right on the grid.
You can also view and edit all the fields for a single detail on a separate
Detail Items/Taxes form. The Detail Items/Taxes form also contains tax
information fields that let you change certain tax options for the detail.
These tax fields do not appear in the detail grid.
To open the Detail Items/Taxes form to edit item information or to change
the Tax Class or Tax Included options, highlight the detail on the grid,
then either click the Item/Tax button or press the F9 key on your
keyboard.
If you are entering additional costs, you highlight an additional cost detail,
then click the Cost/Tax button or press the F9 key to open the Detail
Costs/Taxes form. The Detail Costs/Taxes form contains all the fields,
including tax fields, for the selected additional cost detail.
See also
Changing column order in data-entry forms
Changing column widths

File Menu
The File menu appears in most Purchase Orders forms. The File menu in
each form contains some or all of the following commands.
Print

Prints the current report, list, or form.

Printer Setup

Selects a printer and sets printing options.

Customize

Lets you hide or display fields on a form, depending on
the user.

Import

Imports the data records you specify from non-Sage
ERP Accpac programs to Purchase Orders.

Export

Exports the data records you specify from Purchase
Orders to non-Sage ERP Accpac programs.

Close

Closes the current form.

Help Menu
The Help menu contains the following commands.
Contents
Starts Help and displays the topics in Purchase Orders Help.
Using Help
Describes how to use Help.
About...
Displays information about Purchase Orders, including:
Product version number.
Copyright information.

Settings Menu
A Settings menu appears in the menu bar for transaction entry forms and
on some report forms — such as the screens for printing requisitions,
purchase orders, receiving slips, returns, and mailing labels.
The Settings menu provides the following options:
Auto Clear (on transaction entry forms)
The Auto Clear option helps you to streamline data entry in transaction
entry forms.
Select the Auto Clear option to start a new entry automatically when you
add a transaction (as if you clicked the Add button, then the New button).
Save Settings As Defaults (on print forms)
In some print forms, the Settings menu also contains options that let you
save the current settings as personal defaults or restore the program's
original settings.
To save the current settings as your personal defaults for the form, select
the Save Settings As Defaults option.
Clear Saved Settings (on print forms)
To revert to the program's original settings, select the Clear Saved
Settings option.

Creating Purchase Orders
Before you begin
If you require requisitions for purchase orders, add the requisitions
first using the Requisition Entry form.
Make sure you have full information for each purchase order,
including vendor number, purchase order number (if you enter your
own document numbers), requisition number (if required), your
company's shipping and billing locations or addresses for the
purchase order, arrival date and type of purchase order, and the
vendor's address, contact, phone numbers, tax group, and terms
code.
For each item on the order, find out the item number, unit of measure,
quantity to order, and location (if you use Inventory Control). For items
for which no record exists in your system, you also must have turned
on the Allow Non-inventory Items option and know the general ledger
expense account for each detail.
For each drop-shipment, find out the address and customer number
or inventory location (if applicable, and you have Inventory Control)
for the shipment.
If you use multicurrency accounting, find out the rate type, rate date,
and exchange rate to use for each purchase order.
If the purchase order is job-related, get (for each item detail) the
contract, project, category, resource (if applicable), billing type and
rate, and A/R item number.
To add a purchase order
1.Choose Purchase Order Entry from the P/O Transactions folder to
add purchase orders.
2.Use the PO Order Number field to add a new purchase order. Press
the Tab key or click the New button.
If you do not want Purchase Orders to assign the order number, type
the new number yourself.

3.Type the vendor number or select it from the Finder. You can also
type a new vendor number, not yet added in Accounts Payable.
4.Complete the Purchase Order Information and Vendor Information tabs with the
information you need for the purchase order.
5.Add the details, optional field entries (if used) and other information for the
purchase order.
6.In multicurrency ledgers, edit the exchange rate information, if necessary.
7.Click the Post button to post the purchase order.

See also
Processing purchase orders

Processing Requisitions
Use Purchase Orders' Requisition Entry form to enter requisitions for
purchases you plan to make and for which you need approval before you
can issue purchase orders. Requisitions are optional in Purchase Orders.
You can enter purchase orders with or without requisition numbers.
Use requisitions to:
Keep current records of present and expected purchasing needs by
entering and updating requisitions as you run low or out of stock in
inventory items and supplies.
Specify the vendor for the items you need to purchase, either by
selecting a single vendor number for an entire requisition or by
assigning a vendor number to each detail line.
Create purchase orders from requisitions, either by selecting details
and vendors from requisitions when adding a single purchase order,
or by automatically creating a series of purchase orders from existing
requisitions.
When you enter a requisition, you specify the date on which you need to
issue the purchase order. You can also specify an expiration date that
lets you delete an unused requisition automatically during Day End
Processing, so that you do not have to keep track of and manually clear
unwanted requisitions.
When you specify a requisition number on a purchase order, the
requisition details that specify the vendor number are automatically
included (as are details with no vendor number if you choose to include
them). You can change the displayed information and insert and delete
detail lines to create exactly the purchase order you need.
Job-related requisitions. If the requisition is for a contract that you
manage using Sage ERP Accpac Project and Job Costing, you must also
specify a contract and a project for each requisition detail, and,
depending on the project type, specify the project category, cost class
and resource for the job.
You can print requisitions from Purchase Orders and design the requisition
forms you want to use.

See also
Adding requisitions
Completing requisitions
Creating purchase orders from requisitions
Deleting requisitions
Editing requisitions
Using security with requisitions

Processing Purchase Orders
Use the Purchase Order Entry form to issue new purchase orders and to
edit existing purchase orders.
When you post a purchase order, quantities on hand for the ordered
items are immediately placed on purchase order in Inventory Control
unless the purchase order is job-related.
If the purchase order is job-related, posting updates committed quantities
and amounts in Project and Job Costing for the contract, project and
category that you specify (and does not change the quantity on purchase
order for the inventory location).
You can enter four types of purchase orders:
Active orders you plan to use right away.
Future

purchase orders you plan to activate on a future date.

purchase orders for a specified total amount to which you can
post details until the amount is used up.
Blanket

purchase orders for standard items from which you can issue
other types of purchase orders.
Standing

For more information about the four types of purchase orders, see Purchase
order type

Specifying requisition numbers on purchase orders
You do not have to create requisitions before entering purchase orders. If
you do not use requisitions, you enter all the information and details on
the purchase order.
If you create requisitions first, the details and most of the other
information entered on the requisition appear automatically on the
purchase order. You can also choose to include requisition details with no
vendor number (when the purchase order vendor is assigned as the
item's vendor type) in the purchase order. You can edit all the information
from the requisition, and add or delete lines.
Selecting from more than one requisition
You can select details from more than one requisition to create a single

purchase order.
When you post a purchase order that references a requisition, the
requisition details you include are marked as completed on the
requisition, whether you ordered the full quantity or a greater or lesser
amount. When you post a purchase order for all the outstanding details
on a requisition, the requisition is marked as completed and will be
deleted the next time you run Day End Processing, if you do not keep
transaction history.
The information you enter to add purchase orders includes:
Header information and vendor information.

for inventory items, non-stock items (if permitted) and noninventory items (if your Purchase Orders system allows non-inventory
items).
Detail information

(if you use Sage ERP Accpac's Transaction Analysis
and Optional Field Creator and you have added optional fields).
Optional field information

The exchange rate for converting amounts from the vendor's currency to
the functional currency (in multicurrency ledgers only).

Job-related purchase orders
Job-related purchase orders update Project and Job Costing committed
quantities and costs.
See also
Checking purchase order totals
Creating purchase orders automatically
Day-end processing of purchase orders
Deleting purchase orders
Editing purchase orders
Posting purchase orders
Printing purchase orders
Using security with purchase orders
Using templates

Processing Receipts
Use the Receipt Entry form to receive items into inventory.
You can enter receipts with or without purchase order numbers. If you
use a purchase order number on a receipt, the purchase order
information is displayed.
If you need to edit a receipt you created from a purchase order, you can
change the vendor and header information (except for the template and
tax group codes), delete item details, and add additional cost details, but
you cannot add item details. When editing a posted receipt, you cannot
delete any detail lines but you can add additional cost details.
Note: You cannot view or edit costs unless you are assigned the security
right to "Show Receipt Costing Information."
Effects on Inventory Control. When you post a receipt in Purchase
Orders, item quantities on hand are increased in Inventory Control for the
received items.
If you post the receipt with a purchase order number, quantities on
purchase order are reduced in Inventory Control, and the purchase
order's received quantities and outstanding quantities are updated on the
purchase order.
You can process receipts either in Purchase Orders or Inventory Control.
However, we recommend that you enter all receipts in Purchase Orders
because Purchase Orders' Receipt Entry form allows you to fully track
and prorate additional costs, and record more information for each
receipt than you can record in Inventory Control.
When you enter receipts with existing purchase order numbers in
Purchase Orders, the purchase orders are updated. They are not
updated by receipts you enter in Inventory Control.
If you enter or change additional costs on invoices in Purchase Orders,
you can also prorate the new costs to the corresponding receipts.
Effects on Accounts Payable. When you enter receipts in Purchase
Orders, you can also create and post invoices, credit notes, and debit
notes, and transfer the transactions to Sage ERP Accpac Accounts

Payable.

Job-related receipts
Job-related receipts update Project and Job Costing committed and
actual quantities and costs.
For more information, choose from the following topics:
Calculating prorated additional costs
Entering receipts
Entering header information and vendor information
Entering receipt details
Entering additional costs
Expensing job-related additional costs
Importing receipts
Prorating additional costs
Checking receipt totals
Editing receipts
Posting receipts
Printing receiving slips
Day end processing of receipts
Using security with receipts

You can also process receipts in Inventory Control. For more information,
see Using Purchase Orders with other Sage ERP Accpac programs.
Use the Return Entry form to return items to suppliers, as described
under Processing returns.

Processing Invoices
Use the Invoice Entry form to enter invoices for goods received and
additional costs billed, to complete receipts and provide information for
invoices that are transferred to Accounts Payable from Purchase Orders.
You can also look up posted invoices until you clear them from Purchase
Orders.

Valid receipt numbers are required
You can enter invoices only for existing receipts. When you post the
invoice, the receipt details are completed for the vendor.
When you select a receipt for an invoice, the information entered with the
receipt is displayed. You can make any changes you need to the vendor
and header information.
You can add new additional costs and prorate them for the receipts used
in the invoice. You can delete item and cost details that were posted on a
receipt, and you can change the amounts and quantities (if you have
rights to change quantities and costs).

Posting invoices to cleared receipts
If you wish to post an invoice for a secondary vendor on a receipt you
have cleared from Purchase Orders, post it as a credit note or debit note,
using the Credit/Debit Note Entry form, to ensure that all costs are
correctly updated.

Job-related invoices
Job-related invoices update Project and Job Costing quantities and costs
only if the invoices differ from the posted receipts (which have already
updated the committed and actual quantities and costs for the job).
See also
Entering invoices
Posting invoices
Day End Processing of invoices
Using security with invoices
Exporting invoices

Processing Returns
You can post returns of items to inventory against existing receipts or
against receipts you have already cleared from Purchase Orders. You
can also post returns without entering any receipt number.
If you enter a receipt number, the return is to the primary vendor on the
receipt. (You cannot post returns to secondary vendors specified on
receipts.)
When you post a return, inventory quantities are immediately updated for
the returned items in Inventory Control. You can edit posted returns until
they are completed (when credit notes are posted).

Job-related returns
Job-related returns update Project and Job Costing actual quantities and
costs, reducing the WIP account for the job.
See also
Entering header and vendor information on returns
Entering returns for existing receipts
Entering returns for non-existing receipts

Processing Credit Notes and Debit Notes
You can post credit notes that apply to existing and non-existing (cleared)
returns and invoices, as well as credit notes that do not reference returns
or invoices. You can post debit notes that apply to existing and nonexisting invoices, or just to the vendor.
Credit notes and debit notes are completed when you post them. You
cannot recall them after posting to make changes. When you create
credit notes from returns, the credit notes complete the returns.
If you use the Keep Transaction History option, you can display posted
credit notes and debit notes in the Credit/Debit Note Entry form until you
use the Clear History form to clear them from Purchase Orders. If you do
not keep transaction history, posted credit notes and debit notes are
deleted during Day End Processing (run in Inventory Control).

Effects on Inventory Control
Credit notes that apply to returns affect quantities and costs in Inventory
Control only when the credit note adjusts returned quantities and costs.
If you adjust returned quantities on credit notes, posting them adjusts the
quantity on hand for the location in Inventory Control for the difference
between the quantity returned on the return and the quantity on the credit
note.
If you adjust the return costs on the credit note, posting or Day End
Processing adjusts the item costs in Inventory Control and creates the
appropriate general ledger journal entries.
When credit notes and debit notes are applied to invoices, the
transactions affect item costs in Inventory Control, but they do not
change item quantities.
Job-related credit notes. Job-related credit notes generally arise from
returns. They update Project and Job Costing quantities and costs only if
the credit note differs from the posted return (which has already reduced
the actual quantities and costs in WIP).
See also
Entering credit notes and debit notes
Entering additional costs on credit notes and debit notes
Checking credit note and debit note totals
Posting credit notes and debit notes
Day End Processing of credit notes and debit notes
Using security with credit notes and debit notes

Journal Entries Generated by Purchase Orders
This topic describes the general ledger journal entries that are created for
Purchase Orders transactions. Purchase Orders journal entries are
created in two stages: posting or Day End processing creates inventory
entries (or general ledger entries, if you do not use Inventory Control)
from receipts and returns, and Accounts Payable posting creates entries
from invoices, returns, credit notes, and debit notes. (No general ledger
transactions are created from requisitions or purchase orders.)
If you use the Create Batch form to produce the general ledger
transaction batches for Purchase Orders, you can print the G/L
Transactions report and check the entries before creating G/L
batches.
If you do not use the option, the transactions are created and the
report information deleted by posting or Day End Processing
(depending on when you cost inventory), and you must use the G/L
Listing in General Ledger to see the information.
Taxes. Allocated taxes are posted to the same general ledger accounts
as their corresponding item or additional cost details. Recoverable and
expensed taxes are posted to the accounts specified for the tax
authorities in Tax Services.
For information about the general ledger transactions created for a
particular Purchase Orders transaction type, choose from the following:
Receipts
Invoices
Returns
Credit notes
Debit notes

See also
Creating general ledger batches

Importing and Exporting Purchase Orders
Transactions
You can import requisitions, purchase orders, and receipts that you
previously exported for reuse. You cannot import documents with
numbers that you have already assigned in Purchase Orders, unless you
have cleared the transactions with those numbers.
The original file from which you imported the information is retained until
you delete it.
Purchase orders can include requisition numbers, and receipts can
include purchase order numbers. You can import additional cost details
for the primary vendor on a receipt, but you cannot import additional
costs for secondary vendors.
You cannot import multicurrency requisitions, purchase orders, or
receipts into a single-currency Purchase Orders system. Edit a
multicurrency import file to remove the multicurrency fields before
importing.

You can export all Purchase Orders transaction types, including
requisitions, purchase orders, receipts, invoices, returns, credit notes,
and debit notes.
Note that Purchase Orders uses more than one database table to store
transaction records. If you are exporting any of these records (including
additional costs), the Export dialog box shows a list of the tables that you
can export for the record once you select the export file type and the file
to which to export the data.

For step-by-step instructions on importing or
exporting transactions
Click Import or Export on the File menu of a transaction-entry form, then
press the F1 key to display System Manager help that will guide you
through the import or export process.
See also
Import Processing security access
Export Processing security access

About Serialized Inventory Items
Serialized items are goods with serial numbers assigned to them for
tracking purposes. For example, an electronics retailer can use serial
numbers to record sales of inventory items that have warranty periods.
You may be prompted to assign serial numbers to items when performing the
following Purchase Order transactions:
Receiving inventory
Returning stock

purchased from a vendor and entering an invoice

back to a vendor and entering debit or credit notes

When assigning serial numbers in Purchase Orders, you are either
generating new serial numbers or selecting from a pool of previously
created numbers. The actual management and maintenance of serial
numbers is performed using the Sage ERP Accpac Inventory Control
application.

Assigning Serial Numbers to P/O Receipts
and Invoices
When you receive serialized items from vendors in Purchase Orders, the
program prompts you to assign serial numbers.
You use the same procedure when entering a vendor invoice, except you
start with the Invoice Entry form instead of the Receipt Entry form.
To assign serial numbers when receiving serialized items:
1.Open the Receipt Entry form, if you haven't already done so.
2.Process the receipt as usual.
3.Enter a value in the Quantity Received field, and then press either the
Enter key or the Tab key to display the Serial Numbers Generation/
Allocation form.
If the correct number already appears in the Quantity Received field,
and you just want to change a serial number already assigned, click
the Zoom button in the Quantity column.
Note: You cannot partially invoice receipts of serialized items.
4.Either accept or edit the default value that appears in the Next Serial
Number field. The value in this field is the starting point for the serial
numbers you will assign.
5.Assign serial numbers either automatically or manually:
Click the Auto Gen button to generate serial numbers
automatically for the quantities you require, starting with the value
in the Next Serial Number field.
Or
Click the Add button for each serial number you need to create.
Edit the Next Serial Number value if you don't want to assign the
next sequential number.
In both cases, assigned serial numbers appear in the details grid. You
can select entries in the grid to change serial numbers as required.
6.Click Close.

If the Remaining value is not zero, there are still serial numbers to
assign. You cannot close the form until the Remaining value is zero.
After closing the Serial Numbers Generation/ Allocation form, you can
complete and post the transaction.

Assigning Serial Numbers During Receipt Entry
or Invoice Entry
You can assign serial numbers when you receive serialized items, or
when you create the invoice for the items, provided the item does not use
the serial costing method and the Allow Serial Quantity To Be Different
From The Quantity In The Entries option is selected in the I/C Items form.
Generally, there are not big differences in assigning numbers during
receipt or invoicing. However, there can be an impact when using the
Inventory Control Serial Inquiry report.
Note that if you chose not to assign numbers in the P/O Receipt Entry
form, but did so using the P/O Invoice Entry form, the cost that appears in
the Inventory Control Serial Inquiry report will be zero, as this inquiry
reports only the net change from the time of receipt to invoice, not the
original receipt cost. For instance, say you enter the cost of a serialized
item as two dollars during receipt entry, but you don't assign the serial
number. Then, you use the P/O Invoice Entry form to enter the serial
number, and you change the cost of the item to three dollars. The value
that appears on the I/C Serial Number Inquiry for that transaction is one
dollar.
See also
Assigning Serial Numbers to P/O Returns
About Serialized Inventory
P/O Receipt Entry

Assigning Serial Numbers to P/O Returns
and Credit/Debit Notes
Purchase Orders prompts you to allocate serial numbers when you return
serialized items to vendors.
The following procedure also applies when creating a debit or credit note
for a vendor, except you are starting from the Credit/Debit Note Entry
form instead of the Return Entry form.
To assign serial numbers to returned serialized items:
1.Open the Return Entry form, if you haven't already done so.
2.Process the return as usual.
3.Enter a value in the Quantity Returned field for the serialized items
you want to return, and press either the Enter or Tab key to display
the Serial Numbers Allocation form. If the correct number already
appears in the Quantity Returned field, and you just want to change a
serial number already allocated, click the Zoom button in the Quantity
column.
If you selected a Receipt Number in the Return Entry form, only serial
numbers from that receipt appear in the Serial Numbers Allocation
form.
4.If you did not select a Receipt Number in the Return Entry form, enter
the lot number manually , or select it using the Finder.
5.To return all the serial numbers that appear in the details grid, click
Return All. Note that the Return All button in the Return Entry form
returns all items on the entire invoice, while the Return All button on
the Serial Numbers Allocation form returns all items for the specific
detail line previously selected in the Return Entry form.
To allocate serial numbers automatically, select the Auto-Allocate
From checkbox, enter or select a value in the field that appears, and
then click the Auto-Alloc button. Available serial numbers appear in
the grid.
6.Allocate serial numbers individually by selecting them from the Finder

or by entering the numbers manually.
7.Click Close.
If the Remaining value is not zero, there are still serial numbers to
assign. You cannot close the form until the remaining count is zero.
After closing the Serial Numbers Allocation form, you can complete and
post the transaction.
See also
Assigning Serial Numbers to P/O Receipts
About Serialized Inventory
P/O Return Entry

About Lotted Inventory Items
Lotted items are goods you sell that have lot numbers assigned to them
for tracking purposes. For example, a food distribution company can use
lot numbers to record purchases and sales of unique lots. Other
industries such as pharmaceuticals and meat-packing are legally
required to have traceability for the items that they purchase,
manufacture and ship.
Unlike serial numbers, many different items can share the same lot
number.
You may be prompted to assign lot numbers to items when performing the
following transactions:
Receiving inventory
Returning stock

purchased from a vendor and entering an invoice

back to a vendor and entering debit or credit notes

When assigning lot numbers in Purchase Orders, you are either
generating new lot numbers or selecting from a pool of previously created
numbers. The actual management and maintenance of lot numbers is
performed using the Sage ERP Accpac Inventory Control application.

Assigning Lot Numbers to P/O Receipts and
Invoices
When you receive lotted items from vendors in Purchase Orders, the
program prompts you to assign lot numbers.
You use the same procedure when entering a vendor invoice, except you
start with the Invoice Entry form instead of the Receipt Entry form.
To assign lot numbers when receiving lotted items:
1.Open the Receipt Entry form, if you haven't already done so.
2.Process the receipt as usual.
Lot numbers are stored and displayed by location. Therefore, you
must specify a location before entering the quantity.
3.Enter a value in the Quantity Received field, and then press either the
Enter key or the Tab key to display the Lot Numbers Generation/
Allocation form.
If the correct number already appears in the Quantity Received field,
and you just want to change a lot number already assigned, click the
Zoom button in the Quantity column.
Note: You cannot partially invoice receipts of lotted items.
4.Specify the number of lots and quantities in each lot using the Make X
Lots OR Each Lot Has fields.
5.If desired, edit the default value that appears in the Next Lot Number
field. The value in this field is the starting point for the lot numbers you
will assign.
6.Assign lot numbers either automatically or manually:
Click the Auto Gen button and the lot numbers are automatically
generated for the quantities you require. The lot numbers will be
sequential to the starting value that appears in the Next Lot
Number field.
Or
Click the Add button for each lot number you need to create. Edit

the Next Lot Number value if you don't want the assigned numbers
to be sequential.
7.Click Close to exit the form. If the Remaining value is not zero, there
are still lot numbers to assign and you may not be able to exit the
form until the remaining count is zero.
After closing the Lot Numbers Generation/ Allocation form, you can
complete and post the transaction.

Assigning Lot Numbers During Receipt Entry or
Invoice Entry
You can assign lot numbers when you receive lotted items or when you
create the invoice for the items, provided the item does not use the lot
costing method and the Allow Lot Quantity To Be Different From The
Quantity In The Entries option is selected in the I/C Items form.
Generally, there are not big differences in assigning numbers during
receipt or invoicing. However, there can be an impact when using the
Inventory Control Lot Inquiry report.
Note that if you chose not to assign numbers in the PO receipt form, but
did so using the PO Invoice form, the cost that appears in the Inventory
Control Lot Inquiry report will be zero, as this inquiry reports only the net
change from the time of receipt to invoice, not the original receipt cost.
For instance, say you enter the cost of a lotted item as two dollars during
receipt entry, but you do not assign the lot number. Then, you use the
Invoice Entry form to enter the lot number, and you change the cost of
the item to three dollars. The value that appears on the I/C Lot Number
Inquiry for that transaction is one dollar.
See also
Assigning Lot Numbers to P/O Returns and Credit/Debit Notes
About Lot Tracking
P/O Receipt Entry

Assigning Lot Numbers to P/O Returns and
Debit/Credit Notes
Purchase Orders prompts you to allocate lot numbers when you return lotted
items to vendors.
You also use the following procedure when entering a debit note or a
credit note for a vendor, except that you start from the Credit/Debit Note
Entry form instead of the Return Entry form.
To assign lot numbers to returned lotted items:
1.Open the Return Entry form, if you haven't already done so.
2.Process the return as usual.
3.Enter a value in the Quantity Returned field for the lotted items you
want to return, and press either the Enter or Tab key to display the Lot
Numbers Allocation form. If the correct number already appears in the
Quantity Returned field, and you just want to change a lot number
already allocated, click the Zoom button in the Quantity column.
If you selected a Receipt Number in the Return Entry form, only
the applicable lot numbers from that receipt are listed in the Lot
Numbers Allocation form.
If you did not select a Receipt Number in the Return Entry form,
then enter the lot number manually or select it using the Finder.
5.If you want to return all the lot numbers that appear in the details grid
back to the vendor, click Return All and Yes appears in the Returned
column for all items in the grid. Note that the Return All button in the
Return Entry form returns all items on the entire invoice, while the
Return All button on the Lot Numbers Allocation form returns all items
for the specific detail line selected previously in the Return Entry form.
6.To allocate lot numbers automatically, select the Auto-Allocate From
checkbox and a field appears for you to enter or select a value. Click
the Auto-Alloc button and available lot numbers appear in the grid
sequential to the starting value entered.
7.Allocate lot numbers individually by selecting them from the Finder or

by entering the numbers manually.
8.Click Close to exit the form. If the Remaining value is not zero, there
are still lot numbers to assign and you may not be able to exit the
form until the remaining count is zero.
After closing the Lot Numbers Allocation form, you can complete and
post the transaction.
See also
Assigning Lot Numbers in P/O as Stock is Received
About Lot Tracking
P/O Return Entry

Copy Purchase Orders
The Copy Purchase Orders form lets you select an existing purchase
order, or a range of POs, on which to base a new purchase order. The
details from the existing POs, including item numbers, quantities ordered,
costs, and other information, appear as defaults for the new purchase
order.
You can select the details that you want to copy to the new purchase
order, and you can change the location, expected arrival date, whether
items are drop-shipped, the quantity ordered, cost, unit of measure, unit
weight, optional fields for any detail lines, and contract information for
job-related orders.
Note:
You cannot add new detail lines to a purchase order.
You cannot select different item codes for the detail lines and, if you
are copying job-related POs, you cannot change the contract, project,
or category.
You can:
Decide whether to copy or not copy the detail line.
Change the location, quantity, and costs for the item.
To create a purchase order from one or more existing POs:
1.Choose the Copy Purchase Orders form from the P/O Transactions
folder.
2.In the From Vendor Number field, type the code for the vendor whose
purchase order details you want to copy for the new PO.
3.In the To Vendor Number field, type the code for the vendor for whom
you are creating the new purchase order, or use the Finder or the
navigation buttons to select it.
4.In the From PO Number and To PO Number fields, enter the range of
existing From Vendor orders to use as the basis for the new purchase
order.
5.If the vendors are different and have different tax groups, enter or

select the tax group for the To vendor.
6.Choose the type of PO that you want to copy (Active, Standing,
Future, or Blanket).
7.Choose whether you are copying job-related purchase orders.
8.Select the Use PO Cost checkbox if you want to copy costs from the
original POs to the new PO that you are creating.
9.Click the Go button ( ) to add the details from the existing purchase
orders to the new order.
10.In the PO Number field, type a purchase order number if you wish to
assign a number manually, or accept the ***New*** entry to let the
program assign the next number in the purchase order number
sequence.
11. In the PO Date field, enter or choose the date for the purchase order.
The program automatically displays the session date as the PO date.
12.If you need to put the purchase order on hold for some reason, select
the On Hold option.
13.Enter a description and a reference for the PO.
14.Use the detail grid on the Copy Purchase Orders form to edit the
details as you require.
To delete a detail line, you simply click the detail line, and then press
the Delete key on your keyboard.
15.When you have finished editing information for the purchase order,
click the Create button to generate the PO.
You can then view, edit, and post the order using the Purchase Order
Entry form.

Credit/Debit Note Entry — Overview
Use this form to:
Enter credit notes and debit notes from your vendors.
Review existing credit notes and debit notes.
Enter new additional costs on credit notes and debit notes.
Export credit notes and debit notes.
Assign serial/lot numbers to items if you have the Serialized Inventory
and Lot Tracking license installed.
For help on particular tasks, choose one of the following topics:
Day End Processing of credit notes and debit notes
Editing currency exchange rates
Editing tax information
Entering additional costs on credit notes and debit notes
Entering credit notes and debit notes
Exporting credit notes and debit notes
Posting credit notes and debit notes
Processing credit notes and debit notes
Using security with credit notes and debit notes
Assigning Serial Numbers to Credit/Debit Notes
Assigning Lot Numbers to Credit/Debit Notes

Before you start
Before entering credit notes and debit notes:
Post any invoices or returns for which you are being credited or
debited.
Make sure you have complete information for each transaction. Once
you post a credit note or debit note, it is completed, and you cannot
edit it.
Find out the credit note or debit note number to use.
Click one of the links below for help on using the corresponding tab:
Credit/Debit

Taxes

Retainage

Optional Fields

Rates

Totals

Additional Costs

Use the Post button to post the credit note or debit note. Note that you
cannot edit credit notes or debit notes after posting them.

Use the History button to open the Purchase History form and check information
about the items you have purchased from your vendors.
Use the Close button to close the Credit/Debit Note Entry form.
See also
Invoice Entry Form — overview
Purchase Order Entry Form — overview
Purchase Orders processing overview
Receipt Entry Form — overview
Requisition Entry Form — overview
Return Entry Form — overview

Invoice Entry Form — Overview
Use this Form to:
Enter invoices for receipts of goods into Purchase Orders.
Review existing invoices.
Enter additional costs for invoices, and allocate additional costs for
multiple receipts.
Export invoices.
Assign serial numbers to serialized items (if you have the Serialized
Inventory and Lot Tracking license installed as part of Sage ERP
Accpac Inventory Control).
Assign lot numbers to lotted items (if you have the Serialized
Inventory and Lot Tracking license installed as part of Sage ERP
Accpac Inventory Control).
For help on particular tasks, choose one of the following topics:
Day End Processing of invoices
Editing currency exchange rates
Editing tax information
Entering additional costs
Entering invoices
Exporting invoices
Posting invoices
Processing invoices
Using security with invoices
Assigning Serial Numbers to Receipts and Invoices
Assigning Lot Numbers to Receipts and Invoices

Before entering invoices
Post the receipts to which the invoices apply.
Find out the invoice number and the receipt number for which you
have been invoiced.
Use the Post button to post the invoice. Note that you cannot edit
invoices after posting them.
Use the History button to open the Purchase History form and check information
about the items you have purchased from your vendors.
Use the Close button to close the Invoice Entry form.

To find out about additional forms that you can open from the Invoice
Entry form, click the following links:
Additional Cost Tax Distribution form
Bill-To Location
Comments
Create Invoice From Receipts form
Remit-To Location

For information about using tabs on the Invoice Entry form, click a link
below for help on using the corresponding tab:
Invoice
Additional Costs

Taxes
Optional Fields

See also
Credit/Debit Note Entry — overview
Purchase Order Entry — overview
Purchase Orders processing — overview
Receipt Entry — overview
Requisition Entry — overview
Return Entry — overview

Terms
Rates

Retainage
Totals

Purchase Order Entry - Overview
Use the Purchase Order Entry form to:
Enter, edit, and post purchase orders, including active, blanket, future,
and standing purchase orders.
Enter purchase order details.
Specify drop-ship addresses for purchase order details.
Check and edit tax distributions by detail line and for the purchase
order.
Import and export purchase orders.
To get help on any field in the Purchase Order Entry form, click the Field
List button (above).
For help on particular tasks, choose one of the following topics:
Creating purchase orders
Changing a purchase order
Changing tax information
Consolidating requisition details on purchase orders
Day-end processing of purchase orders
Day End Processing of Job-Related Transactions
Deleting purchase orders
Editing currency exchange rates
Entering blanket purchase orders
Entering future purchase orders
Entering standing purchase orders
Importing purchase orders
Printing purchase orders
Processing purchase orders
Using security with purchase orders

Click one of the links below for help on using the corresponding tab:
Order

Taxes

Rates

Totals

Optional Fields

Use the Post button to post the purchase order or to post changes you
have made to existing purchase orders.
Use the History button to open the Purchase History form and check information
about the items you have purchased from your vendors.
Use the Close button to close the Purchase Order Entry form.

To find out about additional forms that you can open from the Purchase
Order form, choose from the following:
Bill-To Location
Comments/Instructions
Item Tax Distribution
Drop-Ship Address
Create PO From Requisition
Ship-To Location

Click these icons for information about using the corresponding buttons:

Finder

Navigation
buttons

or
Zoom

New

Before you start
Before you enter new purchase orders, you should define the following
Purchase Orders information:
Ship-via codes
Templates
In Accounts Payable:
Define the terms codes you want to use for the purchase orders you
will enter.
Add records for the vendors for whom you will enter purchase orders
(you can also enter purchase orders with vendor numbers you have
not yet added to Accounts Payable, then add the vendors to Accounts
Payable later).
You should also use the Options form to:
Edit or verify the lengths, prefixes, and numbers you want the
program to assign to purchase orders, if you want the numbers
assigned automatically.
Select the options to use when processing purchase orders.
Select a default template code (optional).
Define any optional fields you want to add to the Purchase Order
Entry form.

You must also set up the following information:
Tax records in Common Services.
Currency records (multicurrency ledgers) in Common Services.
Non-existent vendor records. You can enter a purchase order for a
vendor who is not in Accounts Payable, but you must add the vendor
before you post an invoice, credit note, or debit note for that vendor in
Accounts Payable.
One-time vendors. If you frequently make one-time cash purchases,
create a record for one-time vendors in Accounts Payable.
Item, price list, location, account set, and category records in
Inventory Control.
See also
Credit/Debit Note Entry Form - Overview
Invoice Entry Form - Overview
Processing purchase orders
Purchase Orders processing overview
Receipt Entry Form - Overview
Requisition Entry Form - Overview
Return Entry Form - Overview

Receipt Entry — Overview
Use this Form to:
Enter receipts of goods into Purchase Orders—for inventory or noninventory items.
Edit existing receipts.
Enter or change the vendor address information.
Enter additional costs for receipts (from primary or secondary
vendors).
Invoice receipts and additional costs.
Identify items as fixed assets for management by the Sage Fixed
Assets (FAS) module.
Specify drop-ship addresses for receipt details.
Check and edit tax distributions by detail line and for the primary and
secondary vendors.
Import and export receipts.
Assign serial numbers to serialized items (if you have the Serialized
Inventory and Lot Tracking license installed as part of Sage ERP
Accpac Inventory Control).
Assign lot numbers to lotted items (if you have the Serialized
Inventory and Lot Tracking license installed as part of Sage ERP
Accpac Inventory Control).
Note: If users do not have the "Show Receipt Costing Information"
security right, they will not be able to view item unit cost information on
receipts.
All cost amounts will be hidden — including totals, taxes, discounts, and
additional cost amounts. (In other words, the Taxes tab, Additional Costs
tab, and Totals tab will not appear on the Receipt Entry form for users
who do not have this right.)
Integration with Sage Fixed Assets (FAS)

If you use Sage Fixed Assets system (FAS) to manage the fixed assets in
your company, you can also mark received goods as fixed assets, and
choose the FAS template that you want to use for the new asset. Sage
Accpac ERP will transfer the asset information to FAS when you run
Create Assets in the FAS Integration module.
Before you enter receipts you need to:
1.Set up the following Purchase Orders records:
Additional cost codes
Optional fields

(if you use them)

Ship-via codes
Templates

2.

Set up related records in other Sage Accpac programs.

3.

Choose options for receipts on the Options form

.

For more information about the Receipt Entry form, click the links below
for help on using the corresponding tabs:
Receipt

Taxes

Retainage

Optional Fields

Rates

Totals

Additional Costs

To find out about additional forms you can open from Receipt Entry,
choose from the following:
Additional Cost Vendor Taxes
Bill-To Location
Comments
Create Receipt from PO
Detail Item/Taxes form
Detail Costs/Taxes form
Drop-Ship Address
Invoice form
Purchase History form
Optional Fields in receipt details
Ship-To Location
Serialized Inventory Pop-ups
Lot Tracking Pop-ups

Use the Post button to post the receipt. Note that you cannot edit
receipts after posting them.
Use the Calculate Taxes button to recalculate tax amounts after you
change the Tax Class or Tax Included field. (Tax amounts are not
automatically calculated until you choose Post for the invoice or select

the Totals tab.)
Use the Receive All button to add to the Receipt Entry form all the
detail lines from the specified purchase orders. If working with
serialized/lotted items, however, you cannot use the receive all button
as you will need to assign serial/lot numbers manually.
Use the Close button to close the Receipt Entry form.
For help on particular tasks, choose from the following topics:
Day End Processing of receipts
Editing currency exchange rates
Editing receipts
Editing tax information
Editing vendor address information
Entering additional costs
Entering a purchase order number
Entering receipts
Importing receipts
Posting receipts
Printing receiving slips
Processing receipts
Using security with receipts
Assigning serial numbers
Assigning lot numbers

Click these icons or links for information about using the following
buttons:
or
Finder

Navigation buttons

Zoom

New

Click the Fields List button at the top of this help page for information
about fields and tabs.
See also
Credit/Debit Note Entry — overview
Invoice Entry — overview
Processing receipts
Purchase Order — overview
Purchase Orders processing overview
Requisition Entry — overview
Return Entry — overview
Using P/O with Sage Fixed Assets (FAS)

Requisition Entry Form — Overview
This form lets you:
Enter requisitions for purchases you plan to make and for which you
may need approval before you can create purchase orders.
Edit or delete requisitions you posted previously.
Print requisitions.
Import requisitions from other Sage ERP Accpac databases or from
non-Sage ERP Accpac programs.
Export requisitions to other Sage ERP Accpac databases or non-Sage
ERP Accpac programs.
Requisitions are optional in Purchase Orders. You can enter purchase
orders with or without requisition numbers.
If you use requisitions, Purchase Orders provides you with a requisition
approval system to enforce purchase approvals. For more information,
see requiring approval for requisitions.
You can make changes to requisitions and individual requisition detail
lines until they are completed. When you post a purchase order that uses
a requisition detail, the detail is completed, regardless of the quantity that
was ordered.
Click these icons for information about using the buttons:
Finder

Navigation
buttons

or
Zoom

New

Use the Post button to post the requisition or the changes you have
made to an existing requisition.
Use the History button to open the Purchase History form and check information
about the items you have purchased from your vendors.
Click one of the links below for help on using the corresponding tab:
Requisition

Optional Fields

Totals

For help on particular tasks, choose one of the following topics:

Adding requisitions
Editing requisitions
Deleting requisitions
Importing requisitions
Printing requisitions
Using requisition approvals

Before you start
Assign or verify the length, prefix, and number for Purchase Orders to
assign to the next new requisition you create, if you want to assign
numbers automatically.
If you use Transaction Analysis and Optional Field Creator (a
separate package), define any optional fields you want to add to the
Requisition Entry Form (and the other transaction-entry forms).
Find out the numbers of requisitions you wish to edit or delete.

After using
Print copies of the requisitions you posted (if you did not print them
individually after posting them).
Enter purchase orders for the requisitions.
See also
Purchase Orders processing overview
Processing requisitions
Using Detail Entry Grids

Return Entry Form — Overview
Use this form to:
Enter, edit, and post returns of merchandise to vendors.
Export returns to non-Sage Accpac programs and other Sage ERP
Accpac Purchase Orders databases.
Assign serial/lot numbers to returned items if you have the Serialized
Inventory and Lot Tracking license installed.
For help on particular tasks, choose one of the following topics:
Day End Processing of returns
Editing currency exchange rates
Editing tax information
Editing returns
Entering returns
Exporting returns
Posting returns
Processing returns
Using security with returns

Before you start
Use the Options form to assign or verify the length, prefix, and next
number for Purchase Orders to assign to returns, if you want to
assign numbers automatically.
Post any receipts from which you are returning items.

Preparing to enter returns
Before entering returns, make sure you have complete information for
each return, including:
Vendor number.
Return number (if you assign your document numbers).
Receipt number, if any.
All returned item numbers and corresponding locations, units of
measure, and quantities to return.

After using
Run Day End Processing in Inventory Control to:

Update inventory records.
Create general ledger entries from returns.
Create the Returns Posting Journal of the transactions you posted in
Purchase Orders since the last time you ran Day End Processing.
Print the Returns Posting Journal to check the returns you posted.
Click the links below for help on using the corresponding tabs:
Return

Taxes

Retainage

Optional Fields

Rates

Totals

Click the Post button to post the return or to post changes you have
made to existing returns.
Click the History button to open the Purchase History form and check
information about the items you have purchased from your vendors.
For help on fields and buttons in this form, click the Field List button at
the top of this help page.
See also:
Credit/Debit Note Form — overview
Invoice Entry Form — overview
Purchase Order Entry Form —- overview
Receipt Entry Form — overview
Requisition Entry Form — overview
Assigning Lot Numbers to P/O Returns
Assigning Serial Numbers to P/O Returns

Creating Purchase Orders Automatically
You can create purchase orders automatically, from current requisitions, from
reorder quantities in Inventory Control, and from active sales orders in Order Entry.
Assigning purchase order numbers. When creating purchase orders
automatically, the program assigns the purchase order numbers, using
the length, prefix, and next number specified in the Options form. The
program also selects Active as the purchase order type, posts the
purchase orders, and increases quantities on purchase order in Inventory
Control.
You can automatically create purchase orders only for active items,
locations (if you use Inventory Control), and vendors. Inventory Control
must also allow the items at all locations for which they are ordered, if
you use that program.
After posting, the program displays the number of purchase orders that
were created. You use the Purchase Orders choice in the Forms folder to
print the new purchase orders. Use the Purchase Order Entry form to
review and edit new purchase orders you create automatically.
Assigning entries for optional fields. You can specify entries for any
optional fields that you use. All the new purchase orders will then have
these entries in their optional fields, but you can change them if
necessary.
See also
Creating purchase orders from requisitions
Consolidating requisition details on purchase orders

Create Purchase Orders from Inventory Control
verview

O

To create purchase orders:
1.Open Purchase Orders > P/O Create Purchase Orders > Create POs
from I/C.
Click here for help on Create POs from I/C fields.

2.Enter the run date.
You enter a run date to identify the reorder period used to determine
order quantities, and set the purchase order date.
3.Specify the vendor number and the ranges of item numbers and
locations for which to create purchase orders.
4.Choose to create POs for a specific location or for all locations.
5.Select the vendor types to include.
Items in the range you specified are selected if the vendor number for
which you are creating a purchase order is specified as one of the
selected vendor types in the vendor details record.
This allows you to create POs only if a vendor is listed as Vendor 1 or
Vendor 2 for an inventory item.
6.Select the method for determining which item numbers to order.
All Items.
Items Below Minimum.
Items Below Projected Sales for [ ] Days.

7.Select the method for determining item quantities.
Up to Maximum.
Above Maximum.
Up to Projected Sales for [ ] Days.
Above Projected Sales for [ ] Days.

8.Click the Optional Fields tab (if you use optional fields on the
purchase orders form), and specify entries for the optional fields that
appear on the purchase orders.

9.Click the Detail Optional Fields tab (if you use optional fields with
purchase order details), and specify entries for the optional fields that
appear on detail lines.
10.Click the Process button to create the purchase orders.
The program creates a purchase order for each vendor in the ranges
you specified.
When the purchase orders have been posted, you see a message
that lists the range of purchase order numbers that were assigned.
Note: If vendor accounts are on hold, the purchase orders will be
created, but the POs will be On Hold.
Related topics

Creating Purchase Orders from Order Entry
Sales Orders
verview

O

To create purchase orders:
1.Open Purchase Orders > P/O Create Purchase Orders > Create POs
from O/E.
Click here for help on Create POs from O/E fields.

2.Specify the ranges of customers, orders, order dates, and expected
ship dates by which to select the purchase orders to create.
3.Select the vendor type.
4.Choose whether to create purchase orders by vendor number
(producing only one purchase order for each vendor), or create a
separate purchase order for each order number and each vendor
listed on the order (choose Order).
5.Choose whether to order all items on the selected orders, or only
items for which you have insufficient quantities on hand, or only for
items that are on backorder.
6.Choose whether to include drop-ship addresses entered for items and
customers on the Order Entry orders. If you choose this option, you
cannot consolidate details.
If you use the Drop-Ship Items option, every purchase order detail is
assigned either the address entered on the sales order or the
customer's address in Accounts Receivable.
7.Choose whether to consolidate details on the purchase orders with
the same item number, location, and unit of measure into single
details on purchase orders.
Note: The Consolidate Items checkbox is disabled if any optional
fields or detail optional fields are assigned to this form.
8.Choose whether to include non-stock items on the purchase order.
If you do not choose the option, non-stock items will be omitted from

the Finder and treated as non-inventory items. (This option appears
only if you allow receipt of non-stock items in Inventory Control.)
9.Click the Optional Fields tab (if you use optional fields on the
purchase orders form), and specify entries for the optional fields that
appear on the purchase orders.
10.Click the Detail Optional Fields tab (if you use optional fields with
purchase order details), and specify entries for the optional fields that
appear on detail lines.
11. Click the Process button to create the purchase orders.
If you create purchase orders by vendor number, all orders for the
same item, location, and vendor are consolidated into a single detail
on the purchase order for the vendor.
If you create purchase orders by sales order, you produce a
separate purchase order for each vendor specified on the selected
orders, resulting in more than one purchase order for vendors
specified on more than one order. This option retains order numbers
and lets you print the Shippable Backorders report for the transactions
you post for Order Entry orders.
Related topics

Creating Purchase Orders from Requisitions
You can create purchase orders from requisitions as follows:
Using the Purchase Order Entry form, you can:
Specify a requisition number on a purchase order. The program
then displays the information entered for the requisition, including
detail lines that specify the vendor number and, optionally, detail
lines that have no vendor number.
Select more than one requisition number for a single purchase
order, to add details from different requisitions posted for the
vendor (and for blank vendors, if desired) to a single purchase
order.
Select item details with no vendor number when the purchase
order vendor is specified as the vendor type in the item records.
Consolidate like detail lines into single lines.
For information about the Purchase Order Entry form, see Processing
purchase orders.
Using the Create POs From Requisitions form, you can create
purchase orders automatically from requisitions, specifying a range of
requisitions, requisition dates, and vendors from which to create
purchase orders and, optionally, consolidating item details from more
than one requisition into single details on purchase orders.
You can also create purchase orders from requisitions that contain
detail lines without vendor numbers and you can specify entries for
any optional fields you use.
For more information, see Automatically creating purchase orders from requisitions.

Create Purchase Orders Automatically Security
Access
The Purchase Orders security choice "Create Purchase Orders
Automatically" (in the Security Groups form in Administrative Services)
allows you to:
Automatically create purchase orders using the Create POs From
Requisitions, Create POs From I/C, and Create POs From O/E (if you
have Transaction Inquiry security rights in Order Entry) icons in the
Create Purchase Orders folder.

Create POs From IC Form
Use this form to automatically create purchase orders from the reorder
quantities you have defined for items in Inventory Control.
Note that the vendors must exist and be valid before you can create
Purchase Orders.
For background information, see Creating purchase orders from Inventory Control reorder
quantities.
Click these icons for information about using the buttons:
Finder

Drop-Down Lists

Use the Process button to create and post the purchase orders you
specified.
Use the Close button to close the Create POs from IC form.
Before you begin
Set up or update reorder information in Inventory Control's Reorder
Quantities form.
Assign vendor types to item records using the Vendor Details form in
Inventory Control.
Determine the vendors, items, and locations for which you want to
create purchase orders.
Determine the run date to use to select reorder periods from Inventory
Control and to assign to the purchase orders you create.
Determine the methods by which to select items and quantities to
order.
Decide what information you need for purchase order optional fields
and purchase order detail optional fields.
Choose Reorder Report from the Stock Control Reports form in
Inventory Control to print a report of the quantities you need to order.
For more information, select from the following topics:
Creating purchase orders from I/C reorder quantities

Assigning dates and purchase order numbers
After creating purchase orders

See also
Create POs From Requisitions form
Create POs From O/E form
Printing / e-mailing purchase orders

Create POs From O/E Form
Use this form to automatically create purchase orders from Order Entry
sales orders if you use Sage ERP Accpac Order Entry with Purchase
Orders.
For background information, see Creating purchase orders from Order Entry sales orders.
Click these icons for information about using the buttons:
Finder

Drop-Down Lists

Use the Process button to create and post the purchase orders you
specified.
Use the Close button to close the Create POs from O/E form.
Note: The Consolidate Items checkbox is disabled if any optional fields
or detail optional fields are assigned to this form.

Before you begin
Assign vendor types to item records in Inventory Control.
Determine the customers, orders, dates, and vendor types for which
you want to create purchase orders.
For more information, select from the following topics:
Creating purchase orders from Order Entry orders
Assigning dates and purchase order numbers
After creating purchase orders

See also
Create POs From I/C
Create POs From Requisitions
Printing purchase orders

Create POs From Requisitions Form
Use this form to automatically create purchase orders from the
requisitions you have added in Purchase Orders.
For background information, see Creating purchase orders from requisitions
Click these icons for information about using the buttons:
Finder

Drop-Down Lists

Use the Process button to create and post the purchase orders you
specified.
Use the Close button to close the Create POs from Requisitions form.
Note:
The Consolidate Items checkbox is disabled if any optional fields or
detail optional fields are assigned to this form.
You cannot mix job-related and non-job-related requisitions when
creating purchase orders. If you are creating POs from both types of
requisitions, you must run this function twice.

Before you begin
Use the Requisition Entry form to create or import requisitions.
Determine the requisitions, vendors, and dates for which you want to
create purchase orders.
If you are using Project and Job Costing, choose ether job-related or
non-job-related requisitions.
In Accounts Payable:
Add any new vendor numbers used in requisitions for which you
want to create purchase orders. (The program cannot create
purchase orders for vendor numbers that are not defined in
Accounts Payable.)
Make sure the vendor numbers you want to use are all active. You
cannot create purchase orders for inactive vendors.
In Inventory Control, make sure that:
All items you are ordering for a location are allowed at the location.
You specified only active items and locations on the requisitions for
which to create purchase orders.
Choose Transaction List from the Analytical Reports folder, then print a
detailed list of the requisitions from which you are ready to create
purchase orders. Make any changes you need to the requisitions,
using the Requisition Entry form.
For more information, select from the following topics:
Creating purchase orders from requisitions
Assigning dates and purchase order numbers
Purchase orders for on-hold requisitions or vendors
After creating purchase orders

See also
Create POs From I/C form
Create POs From O/E form
Printing purchase orders

Entering Statistics for the Current and Previous
Periods
To add statistical information during setup or edit it later, you must first
select the Accumulate (purchase) Statistics and Allow Edit Of Statistics
options in the Options form.
If you set up Inventory Control and Purchase Orders together, partway
through a fiscal year, you may also want to add statistical data for the
year to date and previous years. You should add any of the data that you
wish to view online or print on reports.
Transactions and statistics
Depending on the history and statistical options you select, Purchase
Orders automatically updates statistical information with every
transaction that you post. The program keeps this data until you choose
to clear it using the Clear History form.
Entering Statistics from Your Previous Purchase Orders System
If you use the Accumulate Statistics option, Purchase Orders creates
statistics from each transaction you post. If you also use the Allow Edit Of
Statistics option, you can manually enter statistics from prior periods in
your old purchase order system when you are setting up your new
Purchase Orders system.
You use the Purchase Statistics form to add the data to your Purchase Orders
system, and to look at the data online or print the data on the Purchase
Statistics report.
For each period, you can enter:
Number of purchase orders, receipts, invoices, and credit notes and
debit notes.
Net quantity purchased and net purchase amount.
Net invoice amount.
Average invoice, credit note, and debit note amounts.
Largest and smallest invoice, credit note, and debit note amounts,

and the vendors who issued them.
Do not add the same statistics twice. If you post opening and year-todate transactions to set up your new Purchase Orders system, Purchase
Orders will also create statistics for these transactions and periods (if you
use the Accumulate Statistics option). If you are also adding statistical
data you want to keep in Purchase Orders, be careful not to duplicate
statistics that the program has already created for you.
For more information about the historical information you can keep in
Purchase Orders, see Accumulating purchasing history and statistics for reporting.
See also
Purchase Statistics report
Steps for setting up Purchase Orders

Purchase History Form
The Purchase History form appears when you select Statistics and
Inquires > Purchase History. Use this form to:
Review purchasing data that is kept by Purchase Orders when you
use the Keep Purchase History option.
Select the Details button to see details of a select transaction.
You can also open this form using the History button in the Requisition
Entry, Purchase Order Entry, Receipt Entry, Invoice Entry, Return Entry,
and Credit/Debit Note Entry forms to check the purchase history for an
item or vendor while entering a transaction.
The form displays all purchases and returns of items for the fiscal or
calendar years and periods for which you keep history.
Click these icons for information about using the buttons:
Finder

Drop-Down Lists

Before using
Select the Accumulate Purchase History option in the P/O Options
form.
Specify the type of year and period by which you want to accumulate
purchase history.
To review purchase history
1.Select Statistics and Inquiries > Purchase History, or click the History
button in a Purchase Order transaction-entry form.
2.Select whether to sort by Item Number or Vendor Number.
3.If you use multicurrency accounting, choose Functional Currency or
Vendor Currency.
4.Type the item number or vendor number, or select it from the Finder.
5.Click the Go button ( ) or press the F7 key.
6.To view the transaction details for an item or vendor entry, doubleclick on the line for which you want more information, or select the line

and click the Details button. The Purchase History Detail form
appears.
7.For applicable transactions that appear in the Purchase History Detail
form, you can select the entry in the grid and click the Serial/Lot
Numbers button to display the serial and/or lot numbers in the
specified transaction.
To view purchase history for a range of item numbers, vendor
numbers, and reporting periods
1.Choose the Purchase History icon from the P/O Analytical Reports
folder, or click Print on the File menu on the Purchase History form.
2.Print the Purchase History report.

To view the details of a transaction
Click the Details button while reviewing history to see the details of the
transactions posted for a particular vendor or item number.
Click the Close button in the detail form to return to the main Purchase
History form.
See also
Accumulate Purchase History option
Clear History form
Purchase Statistics form

Purchase Statistics Form
Use this form to:
Enter purchase statistics from your previous purchase order system
when setting up Sage ERP Accpac Purchase Orders, or edit existing
statistics.
Review, add, or edit the number of purchase orders, receipts,
invoices, credit notes, and debit notes posted in your Purchase
Orders system for the year and period you specify.
Review, add, or edit the net quantity purchased, and net purchase
and net invoice amounts that were posted in your Purchase Orders
system during the year and period you specify.
Purchase Orders can keep purchase statistics from your posted
purchase orders, invoices, receipts, credit notes, and debit notes. You
can review the statistics as far back as the oldest year and period for
which you keep this information by printing the Purchase Statistics report.
Click these icons for information about the buttons in the Purchase
Statistics form:
or
Finder

Go

or
Navigation buttons

Zoom

New

Before adding or editing purchase statistics
Select the options to Accumulate Statistics and Allow Edit Of
Statistics in the Options form.
Select the type of year and period to accumulate statistics by in the
Options form.
Click the Add button to add a set of statistics you have just entered.
Click the Save button to save the changes you made to the selected
statistics.
Click the Delete button to delete the set of statistics that are displayed.
For help on particular tasks, choose one of the following topics:
Adding or editing statistics
Deleting statistics

See also
Accumulate Statistics option
Accumulating purchasing history and statistics for reporting
Purchase History form

Pending Receipts Inquiry
This form lets you review items that are expected to arrive at particular
locations within a given time period (for example, in the next 7 days) and
whether there will be sufficient stock to cover sales orders.
Purchase Orders lets you search pending receipts by item number or by
vendor, and also lets you view completed purchase orders to see if items
were delivered within the expected arrival times.
The inquiry finds active, standing, future, blanket, or all purchase orders
that are not on hold and that fit the selection criteria. You can limit the
inquiry to specific locations.
To inquire on pending receipts:
1.Choose Pending Receipts Inquiry from the P/O Statistics and
Inquiries folder.
2.Choose whether you want to inquire by item or by vendor, and then
select the item number or vendor number for which you want to view
details.
3.Select a range of locations, or skip the Location fields to display all
locations.
4.In the PO Date fields, leave the From and To fields with the defaults to
include all purchase orders, or specify a range of PO dates.
5.In the Expected Arrival Date fields, leave the From field blank to
include all purchase orders with outstanding items, and enter the end
date for the inquiry in the To field.
6.In the PO Type field, select from All, Active, Standing, Future, or
Blanket purchase orders.
7.Choose Include Completed Detail Lines to see if items were delivered
within the expected arrival times.
8.Choose Show Late POs Only to see incomplete detail lines that are
past their expected arrival dates.
9.Click the Go button ( ).

The program fills in the detail grid with PO line information that
matches the select criteria that you specified:
Purchase Order Number
Item Number or Vendor Number
Item Description or Vendor Name
PO Type
Location
PO Date
Quantity Ordered
Unit of Measure
Expected Arrival Date
Date Received
Days Late
Completed
10.To view more information for any PO line item — such as receipt
quantities and days late — double-click the PO line on the detail grid,
or select the line and click the Details button.
The program displays the following additional information for each
receipt associated with the PO line:
Receipt Number
Location
Contract, Project, Category (if job-related)
Quantity Ordered
Order Unit of Measure
Quantity Received
Receipt Unit of Measure
Date Received
Expected Arrival Date
Days Late

Day End Processing — Overview
When you post Purchase Orders transactions that affect item quantities,
the program will immediately update item records and quantities on
purchase order in Inventory Control, if you are using it.
However, unless you cost inventory during posting, you must run Day
End Processing to completely update your Purchase Orders, Inventory
Control, Accounts Payable, and Project and Job Costing data.
Each time you run Day End Processing, the program:
Processes all the transactions you have posted since the last time
you ran Day End Processing.
Creates a batch of Accounts Payable invoices, credit notes, and debit
notes from posted Purchase Orders transactions, using the next
available Accounts Payable batch number.
Creates general ledger transactions from posted receipts, returns,
invoices, credit notes, and debit notes.
Optionally posts Accounts Payable and General Ledger batches in
the A/P and G/L modules.
Updates costs in Inventory Control for non-job-related invoices, if you
use Inventory Control (unless you chose the Inventory Control option
to do costing during posting).
Updates quantities and costs in Project and Job Costing for jobrelated invoices.
Activates and posts future purchase orders that have reached their
purchase order date. When Day End Processing is complete, you can
print the new POs.
Clears requisitions that have reached their expiration dates.
Deletes completed transactions if you do not keep transaction history.
Updates statistics and history in both Purchase Orders and Inventory
Control (if you keep history and statistics).
Creates the receipt, invoice, return, and credit/debit note posting
journals in Purchase Orders for the new day-end sequence number.

Note: Most Day End Processing tasks will be performed during posting if
you choose the Inventory Control option to cost inventory items during
posting and to create subledger transactions and audit information during
posting.
Note also that if you use Inventory Control, you run Day End Processing
from the Inventory Control folder. If you do not use Inventory Control, you
run Day End Processing from the Purchase Orders folder. (For more
information about running Day End Processing in a stand-alone system,
see Day End Processing in a Stand-Alone Purchase Orders System.)
You should run Day End Processing as part of your daily routine, to keep
your audit trail and reports up to date. You can run Day End Processing
as many times a day as you want.
Warning! The time it takes to complete day-end processing varies
according to your computer and the number of transactions you entered
since the last time you ran Day End Processing. We recommend that you
run Day End Processing when you do not need to use your computer for
other tasks. You might find it best to run it overnight.
Assign the default cost expense account first. Before running Day
End Processing, you must assign the general ledger account code for the
default cost expense account in Purchase Orders' Options form. Day End
Processing will display an error message and stop processing if the
account is not designated.
Locked fiscal periods
Note that if a fiscal period is locked for General Ledger but not for
Purchase Orders, you can create batches for General Ledger during
posting, during Day End Processing, or using the Create G/L Batch icon
(depending on your system and settings). When you try to post
transactions to a locked period in General Ledger, however, the
transactions will be placed in an error batch. You can avoid this situation
if you create and post General Ledger batches for outstanding Purchase
Orders transactions before locking the period for General Ledger.
Similarly, you can create transactions for Accounts Payable from
Purchase Orders transactions, but you cannot post them to a period that
is locked for Accounts Payable.

For more information, select from the following:
Before Running Day End Processing
Day End Processing in a Stand-Alone Program
Tasks performed by Day End Processing
After running Day End Processing
Day End Processing of Credit Notes and Debit Notes
Day End Processing of Invoices
Day End Processing of Job-Related Transactions
Day End Processing of Purchase Orders
Day End Processing of Receipts
Day End Processing of Returns

Periodic Processing � Overview
This topic outlines tasks you might follow as part of your weekly, biweekly, or monthly procedures, and tells you how to use Purchase
Orders to accomplish these tasks.
Use the Create Batch form (unless you create transactions during posting
or day end processing) and Clear History form to complete processing
and to clear out obsolete data and records at the end of your accounting
periods.
At each period end, you should:
1.Create any new purchase orders you wish to process in the period.
Use the Purchase Order Entry form and the Create Purchase Orders
From Requisitions, Create Purchase Orders From I/C, and Create
Purchase Orders From O/E forms.
2.Post other transactions that apply to the period.
Use the Requisition Entry, Purchase Order Entry, Receipt Entry,
Invoice Entry, Return Entry, and Credit/Debit Note Entry forms.
3.Print the Purchase Order Action and Aged Purchase Orders reports to
identify purchase orders that require action.
Use the Purchase Order Action and Aged Purchase Orders forms
from the Analytical Reports folder to print the reports.
4.Print the G/L Transactions report, then create general ledger
transactions (if you do not use the option to create general ledger
transactions during posting or Day End Processing). Process the
batches in Sage ERP Accpac General Ledger, if you use it, or post
them manually to another general ledger.
Choose the G/L Transactions icon from the Processing Reports form
to print the report. Choose the Create Batch form from the Periodic
Processing folder to create the general ledger transactions.
5.Clear the paid transactions, posting journals, and statistics that you no
longer need.
Choose the Clear History form from the Periodic Processing folder to

clear this information.
Sage Accpac will mark reports as printed no matter which print
destination you use when you print posting journals.
6.If you use Purchase Orders as a stand-alone program (without
Inventory Control), use the Delete Inactive Records form to delete
inactive item and account set records from your Purchase orders
system.
Choose the Delete Inactive Records icon from the Periodic
Processing folder and specify the types and ranges of records you
want to clear.

Reporting Purchase Orders Data
Purchase Orders prints a variety of reports to help you manage your
requisitions, purchase orders, invoices, receipts, returns, credit notes,
and debit notes. Printed reports also serve as a source of backup
information in case the data is damaged.
This section contains an overview of the Purchase Orders reports. For
printing instructions and information about report contents, see Purchase Orders
reports. For information about how to change, export, and e-mail reports,
see Crystal reports.

Printing reports
There are five ways you can print reports in Purchase Orders:
Print directly from the program to the printer, to obtain permanent copies
of the information.
Print the information on your screen, for quick review.
Print to a file for printing later, importing into another program, or
transferring to a diskette.
Print to an e-mail message that you will send to someone else.
Schedule the report for printing later on a network.
You can print all Purchase Orders reports on 8½-inch x 11-inch paper or
A4 paper.

Setup reports
Using the Setup Reports folder, you can print reports of the records you
created when setting up or updating your Purchase Orders system,
including:
Additional cost codes
Account Sets (stand-alone program)
E-mail Messages
Items (stand-alone program)
Optional fields
Options
Ship-via codes
Templates
Vendor details (stand-alone program)

Any time you add, delete, or change any of these records, you should
print and file the corresponding reports, to keep your printed records up
to date.

Analytical reports
Purchase Orders provides reports you can use to analyze purchases.
There are also reports about the Purchase Orders transactions you post
(receipts, invoices, returns, debit notes, and credit notes), and the journal
entries created for the general ledger from these transactions.
Use the icons in the Analytical Reports folder to print the following
Purchase Orders transaction and analysis reports:
Aged Purchase Orders
G/L Transactions
Item Transaction History (stand-alone program)
Payables Clearing Audit
Posting Journals
Purchase History
Purchase Order Action
Purchase Statistics
Shippable Backorders
Transaction List

General ledger transactions. If you use the option to create general
ledger transactions using the Create G/L Batch form, rather than creating
them during posting or Day End Processing, you can print the G/L
Transactions report in Purchase Orders.

Printing and E-mailing Forms
Purchase Orders provides standard forms and e-mail messages for
producing copies of the following transactions to send to vendors or use
internally:
Mailing Labels
Purchase Orders
Receiving Slips
Requisitions
Returns

— print or e-mail

— print or e-mail

If you want to email purchase orders and returns to vendors, you use the
Email Messages form in the P/O Setup folder to create the email
messages that you want to send to vendors.&#45;&#45;&#45;
For each vendor that you want to email, you must set the Delivery
Method to Email or to Contact's Email on the Processing tab of the
vendor record in Accounts Payable.&#45;&#45;&#45;
You use the same icons in the Forms folder to print forms or send e-mail
messages to vendors.
For information about adapting the sample forms to match your
requirements or creating your own, choose the System Manager online
documentation "Customizing Printed Forms with Crystal Reports" (from
the Help menu). The file opens in Acrobat Reader.

Clear History Form — Overview
Use the Clear History form to selectively clear (delete) data you no longer
want to keep in your Purchase Orders system. This form lets you clear:
Transaction history.
Purchasing history.
Purchase statistics.
Printed posting journals.
Payables Clearing Audit list.
If you do not use Inventory Control, item transaction history.
You can clear one or more types of data at the same time.

Before you start
Run Day End Processing to update Purchase Orders transactions and
statistics that could affect records you want to clear.
Determine the date through which to clear transaction history.
Determine the fiscal year and period through which to clear purchase
statistics and purchasing history.
Determine the day-end number through which to clear printed posting
journals and the types of journals to clear.
Print reports of the data you want to clear. For example:
Before clearing transaction history, print the Transaction List for the
transaction history you plan to clear. Also, make sure you have
printed copies of any completed requisitions, purchase orders,
receiving slips, and returns you require.
Before clearing purchase history, print the Purchase History report for
the historical data you plan to clear.
Before clearing sales statistics, print the Purchase Statistics report for
the statistics you plan to clear.
Before clearing posting journals, print a copy of each posting
journal you want to clear. (Make sure you have printed the posting
journals to a printer or a file.)
If you use the Create Batch icon to create the general ledger
batch, print the G/L Transactions report for the journals. Note that
you must print the G/L Transactions report before you use the
Create Batch icon.
Before clearing the Payables Clearing Audit list, print the Payables
Clearing Auditlist for the year, period, and account sets you want to
clear.
Before clearing item transaction history (in stand-alone
systems only), print the Item Transaction History report for the period you
plan to clear.
To use the Clear History form

1.Choose Clear History from the Periodic Processing folder.
2.To clear transaction history, select the Transaction History option, then
type the date up to which to clear history.
3.To clear purchase history, select the Purchasing History option, then
select the year and period up to which to clear history, and the range
and type of records to clear.
4.To clear purchase statistics, select the Purchase Statistics option,
then select the year and period up to which to clear statistics.
5.To clear printed posting journals, select the Printed Posting Journals
option, then select the type of posting journal to clear and the day-end
number up to which to clear.
6.To clear the Payables Clearing Audit list, select the list and the year,
period, and the account sets to clear.
7.To clear item transaction history, select the Item Transaction History
option, then select the year and period through which to clear data.
(This option is available only a stand-alone Purchase Orders system.)
8.Select Process to clear the specified data.
You use the following buttons in the Clear History form:
Process — to clear the selected data.
Close — to close the Clear History form.
See also
Create G/L batch
Periodic processing

Create Batch Form — Overview
Use this form to:
Produce a batch of general ledger transactions (or append to an
existing general ledger batch) from the receipt, invoice, return, credit
note, and debit note transactions you posted in Purchase Orders.
You can use this form to produce G/L batches only if you selected On
Request Using Create Batch Icon for the Create G/L Transactions option in the
G/L Integration form.
Post a batch of invoices in Accounts Payable from invoices or
credit/debit notes posted in Purchase Orders.
You can use this form to post A/P invoices only if you selected On
Request Using Create Batch Icon for the Post A/P Batches option in the P/O
Options form.
If you do not use Sage ERP Accpac General Ledger, or if your Sage
ERP Accpac General Ledger system is at another location, Purchase
Orders appends its general ledger transactions to a file called
pogltran.csv, which can be imported by an Sage ERP Accpac General
Ledger at another site, or transferred to another general ledger that you
use. The file is in a Comma Separated Values (CSV) format, and is
created in the same directory as your company database.
Note that if you do not use Sage ERP Accpac General Ledger in the
same database as Purchase Orders, all general ledger transactions are
placed in the same CSV file, and that each time Purchase Orders creates
transactions it asks whether to add to the file, or replace it.
Before you begin
Select the On Request Using Create Batch Icon and other general
ledger options on the Integration tab of the G/L Integration form.
Select the On Request Using Create Batch Icon for the Post A/P
Batches option in the P/O Options form.
Run Day End Processing in to update the company’s Purchase Orders data.
Print the G/L Transactions report, then file it with your audit trail reports. (You

must print the report before using the Create Batch form. When you
create general ledger transactions, the data for the G/L Transactions
report is deleted from Purchase Orders.)
Locked fiscal periods
Note that if a fiscal period is locked for General Ledger but not for
Purchase Orders, you can create batches for General Ledger during
posting, during Day End Processing, or using the Create G/L Batch icon
(depending on your system and settings). When you try to post
transactions to a locked period in General Ledger, however, the
transactions will be placed in an error batch. You can avoid this situation
if you create and post General Ledger batches for outstanding Purchase
Orders transactions before locking the period for General Ledger.
Similarly, you can create transactions for Accounts Payable from
Purchase Orders transactions, but you cannot post them to a period that
is locked for Accounts Payable.
To create the general ledger batch (and optionally post it in G/L)
1.Choose the Create Batch icon from the Periodic Processing folder.
2.Select the Create G/L Batch option.
3.Specify the day-end number up to which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
4.Click Process.
Depending on the options you chose in the G/L Integration form,
Purchase Orders will create and optionally post the G/L batch in the
General Ledger module.
To post the A/P Invoice batch in Accounts Payable
1.Choose the Create Batch icon from the Periodic Processing folder.
2.Select the Post A/P option.
3.Click Process.
After using
Post the batches in Sage ERP Accpac General Ledger, if you use it.

If you use a different general ledger, import the CSV batch file into
your general ledger, then delete the file.
Or
Using the G/L Transactions report, transfer the entries to your general
ledger manually, then delete the CSV batch file.
You use the following buttons in the Create Batch form:
Click the Process button to create the general ledger batch.
Click the Close button to close the Create Batch form.
See also
Clear history
Periodic processing

Day End Processing in a Stand-Alone Purchase
Orders System
If you use Purchase Orders as a stand-alone program (without Inventory
Control), you choose Day End Processing from the Periodic Processing
folder in Purchase Orders, rather than from Inventory Control.
Unless you cost inventory during transaction posting, you must run Day
End Processing to update your audit trail and item statistics, to create
general ledger inventory/expense transactions, and to update your
Accounts Payable data.
Note: Most Day End Processing tasks will be performed during posting if
you choose the Purchase Orders option to cost inventory items during
posting.
Warning! The time it takes to complete day-end processing varies
according to your computer and the number of transactions you entered
since the last time you ran Day End Processing. We recommend that you
run Day End Processing when you do not need to use your computer for
other tasks. You might find it best to run it overnight.
Assign the default cost expense account first. Before running Day
End Processing, you must assign a default cost expense account in the
Purchase Orders G/L Integration form. Day End Processing will display
an error message and stop processing if the account is not designated.

To run Day End Processing from Purchase
Orders
1.Choose the Day End Processing icon from the Periodic Processing
folder in Purchase Orders.
2.Click the Process button.
A message appears informing you when day-end processing is
complete.
3.Click the OK button or press Enter to close the information form.
For more information, select from the following:
Before Running Day End Processing

Tasks performed by Day End Processing
After running Day End Processing

Delete Inactive Records Form (stand-alone
program)
If you use Purchase Orders as a stand-alone program (without Inventory
Control), you can use the Delete Inactive Records form in the P/O
Periodic Processing folder to remove obsolete item and account set
records. The form removes records only if they currently have an inactive
status and were set to inactive within the range of dates you specify.
Before you begin
Print reports.
Update records.
Assign Inactive status to all records you want to delete.
Assign to another account set item records that are currently assigned
to the account set you want to delete.
Run day-end processing if you have posted, since the last day-end
processing, any transactions for items you will be deleting.
To delete inactive records
1.Choose the Delete Inactive Records icon from the Periodic
Processing folder.
2.Select the types of inactive records to delete.
3.Enter the range of codes or numbers to delete for each record type
you selected, or use the Finder to select the ranges.
4.Enter a range of dates to indicate when a record must have been
made inactive to delete it. Purchase Orders selects records that have
a status of Inactive and a corresponding "inactive" date within the
range of dates you specify.
5.Choose Process.
6.When you have finished deleting records, choose Close.
After using
Print new copies of the reports of the types of records you deleted to

update your files with current information. For information about printing
reports, see Reporting Purchase Orders data.
See also
Clear history
Periodic processing

Choosing E-mail as the Print Destination
To send the report as an attachment to e-mail, click Print Destination from
the File menu on the company desktop, and then click E-mail. The report
will be send as an attachment in PDF or RTF format to the e-mail
address you specify.
See also
Purchase Orders reports

Choosing File as the Print Destination
To print to a file, click Print Destination on the File menu on the company
desktop. Click File, then enter the drive, directory, and filename, or use
the Browse button to scroll through the list of directories and files to
select the file you want to use.
You can enter the name of a non-existent file or directory to be created
by the system when you print.
See also
Purchase Orders reports

Choosing Printer as the Print Destination
To print to a printer, click Print Destination from the File menu on the
company desktop. Click Printer, then click OK.
See also
Purchase Orders reports

Choosing Screen as the Print Destination
To print to the screen (display the report on your monitor), click Print
Destination on the File menu on the company desktop. Click Preview.
See also
Purchase Orders reports

Delivery Method for Vendors
Purchase Orders and Returns can be sent to the delivery addresses of
Accounts Payable vendors or can be printed to the current print
destination.
The delivery methods for vendors include:
Mail
E-Mail
Contact's E-Mail
Use the Processing tab on the Vendors form to specify the delivery
method.
When you print a Purchase Order or a Return (when posting, you have
the option to print), you can choose to print using the vendor's delivery
method or to the current print destination. If you choose Vendor, the
program uses the delivery method from the Vendor record.

Account Sets Report (stand-alone program) —
Printing
If you use Purchase Orders without Inventory Control, you can print the
Account Sets report from Purchase Orders to list descriptions and
numbers of the general ledger accounts in your Purchase Orders account
sets.
When to print
Print the report when you change information for the account set codes
you have defined.
How to print
1.Choose Account Sets from the Setup Reports folder, or choose File,
Print from the Account Sets form.
2.Select a range of account sets.
3.Choose Print.
For more information on the contents of this report, see Account Sets report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Additional Cost Codes Report — Printing
Print the Additional Cost Codes report to list the information entered to
define each of the additional cost codes used in your Purchase Orders
system. (Additional costs are extra charges, such as for shipping and
handling, that are entered separately from the costs of the items you
purchase, then prorated to item costs, if you wish.)
When to print
Print the report when you change information for the additional cost
codes you have defined.
How to print
1.Choose Additional Costs in the Setup Reports folder, or choose File,
Print from the Additional Costs form.
2.Specify whether to list data first by additional cost code or vendor
number.
3.Enter the range of additional cost codes and vendor numbers to list.
4.In multicurrency ledgers, enter the range of currencies to include.
5.Choose whether you want to print optional fields on the report.
6.Choose Print.
For more information on the contents of this report, see Additional Cost Codes report
— features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Printing the E-mail Messages Report
Print the E-mail Messages report to see a list of all the e-mail messages
defined for purchase orders and returns.
When to print
Print the report when you add new e-mail messages or change
information for existing e-mail messages.
How to print
Double-click the E-mail Messages icon in the Setup Reports folder, or
choose File, Print from the E-mail Messages form, and then choose the
Print button.

Information printed on the report
The report includes, for each e-mail message:
The message type.
The message ID and description.
The subject.
The body of the message.
The last maintained date.
The Inactive date, if applicable.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

G/L Integration Report — Printing
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Purchase Orders system sends transactions to General
Ledger.
For more information on the contents of this report, see G/L Intregration — Features.
When to print
Print the report before and after changing options.
To print the G/L Integration report
1.Double-click the G/L Integration icon in the Setup Reports folder, or
choose File, Print from the G/L Integration form.
2.To begin printing, click the Print button.
If you are printing to a printer, Purchase Orders displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Purchase Orders displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Purchase Orders displays
the report. You can then export it to a file or send it to the printer.
See also
Purchase Orders Reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Items Report (stand-alone program) — Printing
If you do not use Inventory Control, you can print the Items report from
Purchase Orders to obtain a report of information entered for each item in
the Items form.
When to print
Print the Items Report when you need a quick reference list of item
information. You should also print a new copy for your files after adding,
deleting, or changing item records.
How to print
1.Choose Items from the Setup Reports folder, or choose File, Print
from the Items form.
2.Type the range of account sets for the report, or select a range using
the Finder.
3.Specify the range of item numbers to include in the report.
4.Specify the type of items to include on the report. You can choose all
items, only active items, or only inactive items.
5.For each item included in the report, print all or a combination of the
information entered in the item record (Profile, Units Of Measure,
Comments, Optional Fields, Vendors, Taxes).
6.Choose Print.
For more information on the contents of this report, see Items report — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Optional Fields Report — Printing
This report lists the optional fields you have defined for Purchase Orders.
For information on the contents of this report, see Optional Fields Report — Features.
When to print
Print the report when you add, change, or delete optional field records.
To print the report
1.Choose the Optional Fields icon from the P/O Setup Reports folder.
2.Choose

Print.

See also
Optional Fields
Setting Up Optional Fields
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Options Report — Printing
Print the Options report to list the information and options you entered
when you set up your Purchase Orders system, or when you changed
the information using the Options form.
When to print
Print and file the report when you change company options for the
Purchase Orders system.
How to print
Choose the Options icon in the Reports form, or choose File, Print from
the Options form, then choose the Print button.
For more information on the contents of this report, see Options report — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Ship-Via Codes Report -- Printing
Print the Ship-Via Codes report to list the information entered to define
the shipping methods used in your Purchase Orders system (for
example, courier, air mail, parcel post).
When to print
Print the report when you change ship-via information.
How to print
1.Choose the Ship-Via Codes icon in the Setup Reports folder, or
choose File, Print from the Ship-Via Codes form.
2.Specify the range of ship-via codes.
3.Choose Print.
Choose the following icon for information about using the Finder button:
Finder

For more information on the contents of this report, see Ship-Via Codes report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Templates Report — Printing
The Templates report lists the information entered to define the templates
that are used in your Purchase Orders system. You can speed up and
simplify Purchase Orders by setting up templates. Templates provide
default information and settings when you add a new transaction.
When to print
Print the report when you add or change templates.
How to print
1.Choose the Templates icon in the Setup Reports folder, or choose
File, Print from the Templates form.
2.Specify the range of template codes.
3.Choose Print.
Choose the following icon for information about using the Finder button:
Finder

For more information on the contents of this report, see Templates report — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Vendor Contract Costs Report — Printing
The Vendor Contract Costs report lists the vendors from whom you
purchase items and the costs of the items that each supplies.
Note: The report includes only the item costs that you have entered
using the Vendor Contract Costs form.
When to print
Print the report to check the costs of inventory items from your standard
vendors.
How to print
1.Choose Vendor Contract Costs from the Setup Reports folder, or
choose File, Print from the Vendor Contract Costs form.
2.Choose the type of report that you want to print:
Summary — lists one line for each base vendor cost in P/O.
Detail — lists all of the information entered for each item contract
cost in P/O.
Vendor Contract Cost — lists each unit cost for items and vendors,
providing one line for each unique cost arising from unit, quantity,
and sale discounts.
3.Specify the order in which to list vendor details. You can sort them by
item number or vendor number.
4.Specify the range of items or vendors to include in the report.
5.If you have a multicurrency system, choose whether to print amounts
in the vendor currency or in your functional currency.
Note: The Vendor Contract Costs reports use the rate type from the
vendor, along with the session date, to determine the exchange rate.
6.Choose Print.
For more information on the contents of this report, see Vendor Contract Costs report
— features.
See also
Purchase Orders reports

Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Vendor Details Report (stand-alone program) —
Printing
If you do not use Inventory Control, you can print the Vendor Details
report from Purchase Orders.
The Vendor Details report lists vendors from whom you purchase items
and the items each supplies. The report includes only the vendors you
have assigned to item numbers on the Item Vendors tab of the Items
form.
When to print
Print the report when you need to review the vendors from whom you buy
items, or when you change the vendor information in item records.
How to print
1.Choose Vendor Details from the Setup Reports folder, or choose File,
Print from the Vendor Details form.
2.Specify the order in which to list vendor details. You can sort them by
vendor number or item number.
3.Specify the range of vendors to include in the report.
4.Choose Print.
For more information on the contents of this report, see Vendor Details report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Weight Units of Measure Report — Printing
The Weight Units of Measure report lists the information entered to define
the weight units of measure for your inventory items (if you do not use the
Inventory Control module).
For more information on the contents of this report, see Weight Units of Measure
Report — Features .

When to print
Print the report when you add, change, or delete weight units of measure,
or to provide people setting up items with a list of the weight UOMs that
have already been added.

To print the Weight Units of Measure report
1.Double-click the Weight Units of Measure icon in the Setup Reports
folder, or choose File, Print from the Weight Units of Measure form.
2.To begin printing, click the Print button.
If you are printing to a printer, Purchase Orders displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Purchase Orders displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Purchase Orders displays
the report. You can then export it to a file or send it to the printer.
See also
Purchase Orders reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Requisitions — Printing
You can print copies of requisitions until they are completed. Once they
are completed, you can no longer print them and they will be deleted
when you run Day End processing if you do not keep transaction history.
When to print
Print a requisition immediately after posting it in the Requisition Entry
form, or use the Requisitions form when you want to print several
requisitions together.
How to print
Choose Requisitions in the Forms folder, or print the requisition from the
Requisition Entry Form immediately after posting. (Purchase Orders asks
whether you want to print the requisition when it displays the "Posting
completed" message.)
To print requisitions using the Requisitions form
1.Select the Requisitions icon from the Forms folder.
2.Select the report format you want to use to print requisitions.
Choose the Browse button to search for the report file to use. You can
also select the default file that appears.
3.Choose the range of requisitions for which to print the forms.
4.Choose whether to print new copies of requisitions you printed before.
5.Choose Print.
You can also choose the Align button when printing to a printer. This
button lets you print a sample copy of the requisition to check that
preprinted forms are correctly inserted in the printer so that information
will be printed in the right places.
Choose the following icon for information about using the Finder button:
or

Find

For more information on the contents of this report, see Requisitions —
See also

.

features

Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Purchase Orders — Printing
You can print copies of purchase orders until they are completed. Once
they are completed, you can no longer print them and they will be deleted
when you run Day End processing if you do not keep transaction history.
E-mailing purchase orders. The Purchase Orders print program also
lets you email purchase orders to vendors.&#45;
If you want to email purchase orders to vendors, you must:&#45;
1.Use the Email Messages form in the P/O Setup folder to create the
email message that you want to send to vendors.&#45;&#45;
2.Set the Delivery Method to Email or to Contact's Email for each
vendor that you want to email. You set the delivery method on the
Processing tab of the vendor record in Accounts
Payable.&#45;&#45;&#45;
3.Choose Vendor as the Delivery Method on the Print Purchase Orders
form when you print purchase orders.
If you choose Vendor as the Delivery Method, the program will
print to the destination specified in the Vendor record (that is, the
current print destination, the vendor e-mail, or the contact e-mail).
If you choose Print Destination, the program will print all POs to
the currently selected print destination.
When to print
Print each purchase order immediately after posting it in the Purchase
Order Entry form, or use the Purchase Orders form to print several
purchase orders together when you need copies to send to vendors or for
other reasons.
How to print
Choose Purchase Orders in the Forms folder, or choose Yes from the
posting message in the Purchase Order Entry Form immediately after
posting.
To print purchase orders using the Purchase Orders form

1.Select the Purchase Orders icon from the Forms folder.
2.Select the report format you want to use to print purchase orders.
Choose the Browse button to search for the report file to use. You can
also select the default file that appears.
If you are e-mailing purchase orders, choose Vendor as the Delivery
Method, and specify the e-mail message that you want to use.
3.Choose the range of purchase orders to print.
4.Choose the types of purchase orders to print (Active, Future, Blanket,
Standing).
5.Choose whether to print new copies of purchase orders you printed
before and whether to include the details you printed before or only
details added later.
6.Select the Custom Form option only if you know that you are using a
customized return form that requires it. (This option is for custom
forms that do not use the report selection criteria sent by this print
window.)
7.Choose Print.
You can also choose the Align button when printing to a printer. This
button lets you print a sample copy of the purchase order to check that
preprinted forms are correctly inserted in the printer so that the purchase
order information will be printed in the right places.
Choose the following icon for information about using the Finder button:
or

Find

For more information on the contents of this report, see Purchase orders — features
and Creating formats for printed forms.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Receiving Slips � Printing
You can print copies of receiving slips until they are completed. Once
they are completed, you can no longer print them and they will be deleted
when you run Day End processing if you do not keep transaction history.
Note: Forms PORCP03.RPT and PORCP04.RPT will print cost
information. If you want to hide costs on these forms, you will need to
customize them.
When to print
Print a single receiving slip immediately after posting it in the Receipt
Entry form, or use the Receiving Slips form to print a range of receiving
slips when you want to print several slips together.
How to print
You can use the Receiving Slips icon to print a range of receiving slips, or
you can print a receiving slip from the Receipt Entry Form immediately
after posting. (Purchase Orders asks whether you want to print the
receiving slip when it displays the "Posting completed" message.)
To print receiving slips using the Receiving Slips form
1.To print a range of receiving slips using your browser, click the
Purchase Orders Receiving Slips button in the panel on the left of the
browser, or click the icon that appears on the right-hand side.
To print a range of receiving slips from your Sage Accpac desktop,
choose the version 5.0 Receiving Slips icon from the P/O Forms
folder.
2.Select the report format you want to use to print receiving slips.
Choose the Browse button to search for the report file to use. You can
also select the default file that appears.
3.Choose the range of receipts for which to print receiving slips.
4.Choose whether to print new copies of receiving slips you printed
before.
5.Choose whether to include serial and lot numbers on the receiving

slip.
6.Choose Print.
You can also choose the Align button when printing to a printer. This
button lets you print a sample copy of the receiving slip to check that
preprinted forms are correctly inserted in the printer so that the receipt
information will be printed in the right places.
Choose the following icons for information about using the Finder:
or
Finder

For more information on the contents of this report, see Receiving slips � features
and Creating formats for printed forms.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Returns — Printing
You can print copies of returns until they are completed. Once they are
complete, you can no longer print them and they will be deleted when
you run Day End processing if you do not keep transaction history.
E-mailing purchase returns. The print program also lets you email
purchase returns to vendors.&#45;
If you want to email returns to vendors, you must:&#45;
1.Use the Email Messages form in the P/O Setup folder to create the
email message that you want to send to vendors.&#45;&#45;
2.Set the Delivery Method to Email or to Contact's Email for each
vendor that you want to email. You set the delivery method on the
Processing tab of the vendor record in Accounts
Payable.&#45;&#45;&#45;
3.When you print returns, choose Vendor as the Delivery Method on the
Print Purchase Orders form.
If you choose Vendor as the Delivery Method, the program will
print to the destination specified in the Vendor record (that is, the
current print destination, the vendor e-mail, or the contact e-mail).
If you choose Print Destination, the program will print all returns to
the currently selected print destination.
When to print
Print each return immediately after posting it in the Return Entry form, or
use the Returns form when you want to print several returns together.
How to print
Choose Returns in the Forms folder, or print the return from the Return
Entry Form immediately after posting. (Purchase Orders asks whether
you want to print the return when it displays the "Posting completed"
message.)
To print returns using the Returns form:
1.Select Forms > Returns.

2.Select the report format you want to use to print returns.
Click the Browse button to search for the report file to use. You can
also select the default file that appears.
If you are e-mailing returns, choose Vendor as the Delivery Method,
and specify the e-mail message that you want to use.
3.Choose the range of returns for which to print the forms.
4.Choose whether to print new copies of returns you printed before.
5.Choose whether to print serial and/or lot numbers on the return slip.
6.Specify whether to print the number of labels on the Return Totals tab
for each return (select the Require Mailing Labels option) or only one
label per return (do not select the option).
7.Select the Custom Form option only if you know that you are using a
customized return form that requires it. (This option is for custom
forms that do not use the report selection criteria sent by this print
window.)
8.Click Print.
Choose the following icon for information about using the Finder button:
or

Find

For more information on the contents of this report, see Returns — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Mailing Labels — Printing
Print mailing labels to attach to envelopes in which you are mailing
documents to vendors and to packages in which you are returning items
to vendors.
When to print
Print labels when sending purchase orders to vendors or returning goods.
How to print
1.Choose the Mailing Labels icon from the Forms folder.
2.Select the report format you want to use to print labels.
The program displays the name of the last report file used by default.
Click the Browse button to select a different report file.
3.Choose whether to print labels for purchase orders or returns, then
specify the range of document numbers.
4.Choose whether to print labels you printed before and whether to print
labels for returns for which you selected the Require Mailing Labels
option when you printed return forms.
5.Click the Print button.
When printing to a printer, you can click the Align button to print sample
labels and check that the labels print properly on preprinted forms. (If the
mailing information does not appear in the right places, ensure that the
forms are correctly inserted in the printer.)
Choose from the following icons for information about the buttons in the
Purchase Statistics form:
Finder

Drop-Down
Lists

For more information on the contents of this report, see Mailing labels — features
and Creating formats for printed forms.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination

Choosing Printer as the print destination
Choosing Screen as the print destination

Aged Purchase Orders Report — Printing
Print the Aged Purchase Orders report to list all incomplete purchase
orders and their relative ages in the system.
You can list all or a range of purchase orders by purchase order number,
vendor number, or currency (in multicurrency systems). You specify the
number of days in each of three aging periods. There is also a current
period and a fifth period which includes purchase orders that have been
outstanding for more than the number of days in the last period you
specified. (You set default report periods in the Options form.)
In multicurrency systems, you can list purchase orders on the report by
their currencies and you can print amounts in either the functional
currency or the vendors' currencies.
When to print
Print the report periodically to identify purchase orders which have not
been completed.
How to print
Choose the Aged Purchase Orders icon in the Analytical Reports folder,
then specify the following information:
The date as of which you want purchase orders aged.
All purchase orders older than the Aged As Of date fall into one of the
aging periods. Purchase orders which are more recent than the Aged
As Of date (and up to the Cutoff Date) appear in the Current column.
The Cutoff Date (the date of the most recent purchase order you want
listed). The report does not list orders with a document date later than
this date. If you do not want to list any current purchase orders, enter
the same date in the Aged As Of and Cutoff Date fields.
The sorting order for the report: by purchase order number, vendor
number, or currency code.
Ranges of purchase order numbers and vendor numbers to include
on the report.
In multicurrency ledgers, the range of currency codes to use to select the

transactions for the report (only the transactions entered in the selected
currencies are printed).
Number of days in each report aging period. The default aging
periods are defined in the Options form.
Whether to print amounts in the vendor currency or in the functional
currency (multicurrency ledgers).
Extra information to include: contact name and phone number, and
space for comments.
Click these icons for information about the buttons in the Aged
Purchase Orders form:

Finder

Drop-Down
Lists

For more information on the contents of this report, see Aged Purchase Orders report
— features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

G/L Transactions Report — Printing
Print the G/L Transactions report to obtain a list of the general ledger
journal entries created from all transactions posted in Purchase Orders
since the last time you created the general ledger batch.
To print this report, you must select On Request Using G/L Batch Icon for
the Create G/L Transactions option in the Options form. If you create
transactions during posting or during day-end processing, you cannot
print the G/L Transactions report.
You can print detailed or summary versions of the report.
In multicurrency systems, you can print amounts either in the functional
currency or in the source (vendor) currencies in which you posted the
transactions in Purchase Orders.
When to print
Print the report before you use the Create Batch form to produce general
ledger transactions. When you create the general ledger batch, the
program erases the data for the G/L Transactions report.
Remember to run Day End Processing before you create the general ledger
batch if you want to include the latest costing information in the report.
How to print
Choose the G/L Transactions icon in the Analytical Reports folder, then
specify the following information:
The posting sequence for which to list transactions.
Whether to print a detail or summary report. On detail reports, you
also select whether to list transactions by account number or year and
period.
Whether to print amounts in functional or source (vendor) currency
(multicurrency ledgers).
Click this icon for information about the button in the G/L Transactions
form:
Drop-Down Lists

For more information on the contents of this report, see G/L Transactions report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Item Transaction History Report (stand-alone
program) — Printing
If you do not use Sage ERP Accpac Inventory Control, you can print the
Item Transaction History report from Purchase Orders.
The Item Transaction History report lists all transactions posted for the
items assigned to the account sets and period that you select for the
report. The report also shows the net change to the Inventory/Expense
account for the account set and period.
Item transaction history is accumulated and reported according to the
fiscal year you defined in Common Services. Transactions are
accumulated for this report only if you use the Keep Transaction History
option in the Options form.
Transactions cleared by the Clear History form will not be included in the
report.
When to print
Print the report when you want to review transaction history by item, or
list transactions from all posting journals.
How to print
1.Choose Item Transaction History from the Analytical Reports folder.
2.Select the ending period for the range of transactions you want to
print. Purchase Orders lists all transactions occurring before and
during the specified period, excluding those you cleared using the
Clear History form.
3.Specify the method of sorting transactions. Choose either Account
Set Code or Item Number in the By field.
4.Select a range of account sets to include in the report.
5.If you chose to sort by item number, select a range of item numbers to
include in the report.
6.Choose Print.
For more information on the contents of this report, see Item Transaction History

report — features

.

See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Payables Clearing Audit List — Printing
The Payables Clearing Audit list reports the debit and credit entries to the
Payables Clearing account for receipts, invoices, returns, credit notes,
and debit notes. Use the list to reconcile the Payables Clearing account.
When to print
When you want to reconcile your Payables Clearing account. The report
is updated during Day End Processing and, if you keep history, lists
transactions that occurred during and since the last year and fiscal period
for which you keep history.
How to print
1.Choose Payables Clearing Audit from the Analytical Reports folder.
2.Choose the account sets for which to include transactions on the
report.
3.Choose the fiscal years and periods for the report.
4.If you have a multicurrency ledger, choose whether to print amounts
in source currency or in source and functional currency.
5.Click Print.
Click these icons for information about the buttons in the Payables
Clearing Audit (list) form:

Finder

Previous/
Next

Drop-Down
Lists

For more information on the contents of this report, see Payables Clearing Audit list
— features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Posting Journals — Printing
Print the posting journals at the end of each day, as part of your day-end
procedure and audit trail documentation.
When to print
Print posting journals regularly (daily or weekly) after running Day End
processing.
How to print
1.Select Analytical Reports > Posting Journals.
2.Select the type of transaction for which to print a posting journal
(Receipt, Return, Invoice, Credit/Debit Note).
3.Select the method by which to group transactions on the journal:
Day End Number — lists transactions by the Day End Processing
run when they were posted, beginning with transactions posted
during the earliest selected day-end.
Transaction Date — lists transactions in order of their transaction
date (such as the receipt date for receipt transactions). The
transaction with the earliest date is listed first.
Vendor Number — lists transactions by vendor number so that
you can easily see all transactions posted for each vendor.
(Transaction) Number — lists transactions by their document
numbers (Receipt Number, Return Number, Invoice Number,
Credit/Debit Note Number), beginning with the lowest number.
4.Specify the range of day-end numbers for which you are printing the
report.
5.Specify whether to include additional costs on receipt journals.
6.Specify whether to add a summary of taxes.
7.If you are printing Invoices or Credit/Debit Notes, you can select
Accounts Payable audit information to help you match postings in
Purchase Orders to Accounts Payable transactions.
8.If you have Project and Job Costing, select Include Job Details to print

job-related information.
9.Select Optional Fields to include optional field information on posting
journals (if you use Optional Fields).
10.Choose whether you want to reprint journals you have printed before.
11. Choose to include serial and or lot numbers for applicable items on
the report.
12.Choose the size of the paper in your printer (either legal size, or
letter/A4).
13.Click Print.
For more information on the contents of this report, see Posting journals — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Purchase History Report — Printing
Print this report to obtain summary or detailed purchase information by
vendor or inventory item. Since Summary reports provide less
information than Detail reports, some fields will be hidden if you select
Summary in the Report Type list. For instance, summary reports retrieve
purchase orders from a range using specific years and periods, while
detail reports can also select by Document Date and filter by Item
Number.
When to print
After running Day End Processing, at the end of an accounting cycle, or
any time you want to check your purchasing history.
How to print
Select Analytical Reports > Purchase History to display the Purchase
History Report form. Or open the Purchase History form and select File >
Print from the menu bar.
1.Select either Detail or Summary from the Report Type list.
2.If you selected a Detail report, you choose to select purchase orders
from Document date or Year/Period, and include Serial/Lot numbers
for applicable items on the report. For Summary reports, purchase
orders can only be selected by Year/Period and the Include Serial/Lot
Numbers checkbox is not available for selection.
3.Specify the report range (either by Year/Period or by Document Date).
4.Use the Sort By list to select how the purchase history information is
reported (either by vendor number or item number).
5.Choose the vendors and/or items to include on the report. A Detail
report allows you to select ranges for both Vendor and Item Numbers,
while Summary report only gives you one of the two options
6.If you are printing a Detail report and selected the Include Serial/Lot
Numbers checkbox, enter ranges for both the serial and lot numbers
you want to appear on the report.
7.If you use multicurrency accounting, choose the range of currency

codes for which to print transactions (only transactions posted with
the selected currency codes are listed), and specify whether to print
amounts in the vendor's currency or functional currency.
8.If you selected a Detail report and use the Accpac Project and Job
Costing application, select the Include Job Details checkbox to print
job information for all job-related transactions.
9.Choose Print.
Click these icons for information about the buttons in the Purchase
History (report) form:

Finder

Previous/Next

Drop-Down
Lists

For more information on the contents of this report, see Purchase History report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Purchase Order Action Report — Printing
Print the Purchase Order Action report to obtain a summary or detail list
of your current purchase orders. Detail reports can be sorted by purchase
order number, vendor number, or item number. Summary reports can not
be sorted by Item Number, nor can they be filtered by Item Status.
When to print
When you need to review purchase orders to see what has been or
needs to be done.
How to print
Choose Purchase Order Action from the Analytical Reports folder, then
specify the following information:
Choose to print in detail or summary. If you selected Detail as the
report type, you can sort by purchase order number, vendor number,
or item number. Summary reports can only be sorted by purchase
order number or vendor number. Choose the start and end range of
numbers for the selection you made in the Sort By field.
Specify the start and end range for the secondary sort option, which is
automatically determined for you and displayed in the Then By field. If
you are printing a Detail report, select the range for the third sort
option.
Make a selection from the Select By list to report by either Expected
Arrival Date or Purchase Order Date. Then enter a start and end date
range for selection made.
Select a Purchase Order source, then the Purchase Order type. You
can choose all purchase orders, those that have yet to be received,
partially received or are on hold.
Use the Print Status list to specify whether to print all purchase orders
in the range, or only those that are posted or printed.
Use the Item Status list to specify whether to select purchase orders
with all items defined in the range, or only items that are or partly
completed, completed or incomplete.

In multicurrency ledgers, choose whether to print amounts in the
functional or vendor currency.
If you are printing a Detail report and have the Accpac Project and
Job Costing application installed, select the Job Details checkbox to
include job-related information with purchase orders.
Select Optional Fields to include optional field information with
purchase orders (if you use Optional Fields).
Click these icons for information about the buttons in the Purchase Order
Action (report) form:
Finder

Drop-Down
Lists

For more information on the contents of this report, see Purchase Order Action report
— features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Purchase Statistics Report — Printing
Print the report to obtain a list of the statistics accumulated from
Purchase Orders transactions since you last cleared the purchase
statistics data for the period you specify. Statistics are reported for the
type of year (fiscal or calendar) and period you specified for the
Accumulate Statistics option in the Options form.
When to print
When you want to check on the volume of purchase orders, receipts,
invoices, credit notes, and debit notes you processed during a period.
You can print the report after running Day End processing, only if you use
the Accumulate Statistics option.
How to print
Choose the Purchase Statistics icon in the Analytical Reports folder, or
choose File, Print from the Purchase Statistics form, then:
1.Specify the range of years and periods for which to print the report.
2.If you use multicurrency accounting, specify whether to print amounts
in vendor currency or functional currency, choose the range of
currency codes (to list only the purchase orders entered in the
selected currencies), and select whether to consolidate statistics for
the range of currencies you specify.
3.Choose Print.
Choose from the following icons for information about the buttons in
the Purchase Statistics form:

Finder

Previous/Next

Drop-Down
Lists

For more information on the contents of this report, see Purchase Statistics report —
features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination

Choosing Printer as the print destination
Choosing Screen as the print destination

Shippable Backorders Report — Printing
The Shippable Backorders report lists the sales orders that you may be
able to fill as a result of receipts you have posted in Purchase Orders.
The report contains meaningful data only if you enter sales order
numbers with detail lines on receipts. If you use Sage ERP Accpac Order
Entry with Purchase Orders, you can select order numbers from Order
Entry and include them on the report.
When to print
Print the report after posting receipts to find out which sales orders you
may now be able to fill.
How to print
1.Choose Shippable Backorders in the Analytical Reports folder.
2.Specify the ranges of sales order numbers and item numbers for
which to print the report.
3.Specify the range of receipt dates from which to select data for the
report.
4.Choose Print.
Choose the following icon for information about using the Finder button:
or

Find

For more information on the contents of this report, see Shippable Backorders report
— features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Transaction List — Printing
Use the Transaction Lists to print detailed or summary listings of all
current Purchase Orders transactions. You can sort transaction reports
by transaction number or vendor number, and you can specify a range of
transaction numbers, vendor numbers, and currency codes (if you have a
multicurrency system) by which to select the transactions to report.
When to print
Print these reports for information about current transactions and, if you
keep transaction history, about past transactions you have not yet
cleared.
Keep Transaction History option. If you do not keep transaction history,
Purchase Orders deletes transaction information when you run Day End
processing. If you keep transaction history, you choose when to delete
the data for the reports using the Clear History form.
How to print
Choose the Transaction List icon in the Analytical Reports folder, then:
1.Select the type of transaction you want to print (requisitions, purchase
orders, receipts, returns, invoices, credit notes, or debit notes).
2.Select the type of report (detail or summary).
3.Select the sort order (by transaction number or vendor number).
4.Select the range of transaction numbers, vendor numbers, and
currencies (if you have a multicurrency system).
5.Select the additional information you want to include in the report
such as the entries from the "Information" tab for the transaction type,
transaction details, addresses, requisition numbers (for purchase
orders) and additional costs (for receipts). You can also choose job
details (for job-related transactions), optional field information (if you
use Optional Fields) and serial/lot numbers (if working with
transactions involving serialized/lotted items).
6.When printing the Purchase Order List, choose the types of purchase
orders to list (active, standing, future, blanket).

7.When printing the Purchase Order or Requisition List, choose the
statuses to include (Entered, Purchase Order Printed, Never
Received, Partially Received, Completed, On Hold).
8.Click the Print button.
Choose from the following icons for information about the buttons in
the Transaction List form:

Finder

Drop-Down
Lists

For more information on the contents of this report, see Transaction List — features.
See also
Purchase Orders reports
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination

Sage ERP Accpac Training
Become a Sage ERP Accpac expert with online or classroom training
through Sage University.
If you want to get beyond the basics and tap into the full power of your
Sage ERP Accpac system, nothing beats targeted training and
education.
Our training resources include a nationwide network of authorized
classroom training centers, online courses, partners who can conduct onsite training, manuals and guides for your self-study, and an annual
customer conference.
For more information on Sage ERP Accpac training, choose one of the
following links:
Find a Course

Search training courses on the Sage University Web site by product,
type, location, track, schedule—or try our advanced search.
Anytime Interactive

Anytime Interactive training offers a full range of recorded instructor-led
sessions that are easy to use, always accessible, and ready when you
are. All you need is a computer, speakers and a high-speed Internet
connection.
Anytime Interactive sessions are ideal for review material, acquainting
new-hires with basic processing skills, and cross-training staff. Interactive
sessions include product specific instruction and online review quizzes.
Classroom

Instructor-led classroom training provides you with personal interaction in
a professional atmosphere you will enjoy. Classroom training also allows
you the opportunity to become Sage certified.
Classroom training is ideal if you prefer one-on-one assistance,
interaction with other students and a classroom atmosphere.
Lunch & Learn

Lunch & Learns are one-hour Realtime (Online) sessions that cover a

particular topic or process. Each Lunch & Learn is designed to increase
productivity by simply providing you with a stronger understanding of a
specific feature or functionality within the software.
Choose one of our 40+ information packed Lunch & Learn sessions and
become more proficient in just one hour.
Realtime

Realtime training sessions are online, instructor led and scheduled for a
specific date and time. All you need is a computer, phone, and an
Internet connection. Everything happens live, so you can ask questions
and interact with other participants and the instructor.
Realtime combines the interaction of a classroom with the convenience
of staying right where you are.
Realtime sessions include live product specific instruction, electronic or
printed course materials, hands-on exercises, and online review quizzes.

Create a New Purchase Requisition
Overview
About requisition approval

To create a new requisition:
1.Open Purchase Orders > P/O Transactions > Requisition Entry.
Click here for help on Requisition Entry fields.

2.Press the Tab key to accept *** NEW *** as the number in the
Requisition Number field.
Purchase Orders will assign a requisition number when you post the
requisition.
If you do not want Purchase Orders to assign the number
automatically, you can type the new number yourself, and then press
the Tab key.
3.Type the Vendor number or select it from the Finder.
You can skip the vendor number and enter a vendor name—such
as for a new vendor—or you can skip the vendor fields entirely.
You can also click the New button to add a new vendor record in
Accounts Payable.
4.Enter a requisition date, a date required, and an expiration date.
If it has not been completed, this requisition will be deleted when you
run Day End Processing on the expiration date.
5.Choose whether this requisition is on hold.
Note: You cannot create purchase orders from on-hold requisitions.
If you are approving a requisition that was previously entered:

6.Choose the Job Related option if you use the Project and Job Costing
module and this requisition is for a job.
If the purchase requisition is job-related, all items must be for
particular contracts, projects and categories in Project and Job
Costing.
Also, you cannot add serialized items or items assigned to lots to job-

related transactions. Instead, you must order them as non-job-related
items, receive them into inventory, and then use the Material Usage
form in Project and Job Costing to move them from inventory to jobs.
7.Type the name of the person requesting the order. If you use Sage
ERP Accpac Payroll, you can choose the requester from the Finder.
8.Enter or type the location where you want the goods delivered, and
enter a requisition description and reference.
9.Tab into the detail entry grid (or click the grid) to start entering
requisition details. You may have to press the Insert key to start a new
line.
10.If this is a job-related requisition, double-click the Contract field and
enter the contract number, or click the Contract column heading to
look up contract numbers.
You must also enter or choose the project and category to which you
are allocating items.
11. Double-click the Item Number field and enter an item number.
You can also click the Item Number column heading to look up item
numbers. (Using the Finder.)
Note: You can leave the vendor fields blank, and you can specify
different vendors on each line. You can create more than one PO from
a single requisition.
12.Use the tab key to move through the columns on the form. Or, you
can click the Item/Tax... button or press F9 to display an entry form for
adding items.
Some columns may not be displayed. Purchase Orders lets you
hide columns and change the column order.
The Location for each line defaults from the Location field in the
header fields.
You must enter a Quantity Ordered.
For information on other detail fields, see Requistion Entry fields.
13.To add optional field information for the requisition, click the Optional
Fields tab.

14.To change currency exchange rates in a multicurrency system, click
the Detail button at the bottom to use the Detail Items popup form.
15.To check the totals for the requisition, click the Totals tab.
16.Click Post to post the purchase requisition.
Purchase Order Entry lets you print the purchase requisition after
posting.
You can also print the purchase requisition separately, from the P/O
Forms folder.
Note: If you do not have the security right to approve requisitions, the
requisition will be on hold after you post it, and the Approval Status
field will display "Entered."
Related topics

Approve a Purchase Requisition
About requisition approval

Note the following points concerning requisition approval:
You must have requisition approval security rights assigned to you in
Sage ERP Accpac.
You must log on using the Sage ERP Accpac User ID that is assigned
approval rights.
You must remove the On Hold status from the requisition, and then
post it.
To approve a requisition:
1.Open Purchase Orders > P/O Transactions > Requisition Entry.
Click here for help on Requisition Entry fields.

2.Use the Finder ( ) or the navigation keys (
requisition that you want to approve.

) to look up the

To check the requisition details and totals:
a.

Click in the detail grid and use the scroll bars to review requisition
details. You can expand the size of the Requisition Entry form to
view more information.
Note: Some columns may not be displayed. Purchase Orders lets
you hide columns and change the column order.
You can also click the Detail button to easily review all the fields for
a single detail.

b.

Click the Totals tab to see the requisition comment and item totals.

c.

Click the Optional Fields tab to see additional information for this
requisition.

3.Uncheck the On Hold checkbox on the first tab to approve the
requisition.
You cannot create purchase orders from on-hold requisitions.
4.Click Post to post the purchase requisition.

Purchase Order Entry lets you print the purchase requisition after
posting.
You can also print the purchase requisition separately, from the P/O
Forms folder.
Note:
If you have approval rights, the Approval Status field will say
"Approved," and the description for your User ID will appear in the
Approver Name field.
If you do not have the security right to approve requisitions, the
requisition will still be on hold after you post it, and the Approval
Status field will display "Entered."
Related topics

Create a New Purchase Order
Overview
Before entering purchase orders

To create a new purchase order:
1.Open Purchase Orders > P/O Transactions > Purchase Order Entry.
Click here for help on Purchase Order Entry fields.

2.Press the Tab key to accept *** NEW *** as the purchase order
number (in the PO Number field).
Purchase Orders will assign a purchase order number when you post
the PO.
If you do not want Purchase Orders to assign the number
automatically, you can type the new number yourself, and then press
the Tab key.
3.Type the Vendor number or select it from the Finder.
You can also click:
The New button to add a new vendor record in Accounts Payable.
The Zoom button to check address and contact information.
To change the tax code, click the Taxes tab, and then return to the
Order tab.
4.Choose a template if your company uses templates to fill in default
field entries.
5.Click the Zoom button ( ) to choose one or more requisitions from
which you are issuing the purchase order.
Skip this field if you are creating a purchase order without referencing
a requisition.
If you are choosing a requisition:

6.Choose the Job Related option if you use the Project and Job Costing
module and this PO is a job related PO.
If the purchase order is job-related, all items must be for particular
contracts, projects and categories in Project and Job Costing. Posting

the purchase order updates committed quantities and amounts for the
jobs.
Also, you cannot add serialized items or items assigned to lots to jobrelated purchase orders. Instead, you must order them on a non-jobrelated PO, receive them into inventory, and then use the Material
Usage form in Project and Job Costing to move them from inventory
to jobs.
7.Fill in the remaining fields at the top of the Purchase Order Entry form.
If you want to change the vendor account set, you can only choose
from account sets that use the vendor's currency.
8.Tab into the detail entry grid (or click the grid) to start entering
purchase order details. You may have to press the Insert key to start a
new line.
9.If this is a job-related PO, double-click the Contract field and enter the
contract number, or click the Contract column heading to look up
contract numbers.
You must also enter or choose the project and category to which you
are allocating items.
10.Double-click the Item Number field and enter an item number.
You can also click the Item Number column heading to look up item
numbers. (Using the Finder.)
11. Use the tab key to move through the columns on the form. Or, you
can click the Item/Tax... button or press F9 to display an entry form for
adding items.
Some columns may not be displayed. Purchase Orders lets you
hide columns and change the column order.
The Location defaults from the Ship To Location field in the PO
header fields.
You must enter a Quantity Ordered.
For information on other detail fields, see Purchase Order Entry fields.
12.To add optional field information for the order, click the Optional Fields
tab.

13.To change currency exchange rates in a multicurrency system, click
the Rates tab.
14.To check the totals for the order, click the Totals tab.
15.Click Post to post the purchase order.
Purchase Order Entry lets you print the purchase order after posting.
You can also print the purchase order separately, from the P/O Forms
folder.
Related topics

Copy Purchase Orders
Overview

To create a new purchase order from one or more existing POs:
1.Open Purchase Orders > P/O Transactions > Copy Purchase Orders.
.

Click here for help on all Copy Purchase Orders fields

2.In the From Vendor Number field, type the code for the vendor whose
purchase order details you want to copy for the new PO.
3.In the To Vendor Number field, type the code for the vendor for whom
you are creating the new purchase order, or use the Finder or the
navigation buttons to select it.
4.In the From PO Number and To PO Number fields, enter the range of
existing From Vendor orders to use as the basis for the new purchase
order.
5.The tax group defaults to the tax group of the To Vendor, but you can
change it.
6.Choose the type of PO that you want to copy (Active, Standing,
Future, or Blanket).
7.Choose whether you are copying job-related purchase orders.
8.Select the Use PO Cost checkbox if you want to copy costs from the
original POs to the new PO that you are creating. (This choice is only
available if the From and To vendors use the same currency.)
9.Click the Go button ( ) to add the details from the existing purchase
orders to the new order.
10.In the PO Number field, type a purchase order number if you wish to
assign a number manually, or accept the ***New*** entry to let the
program assign the next number in the purchase order number
sequence.
11. In the PO Date field, enter or choose the date for the purchase order.
The program automatically displays the session date as the PO date.
12.If you need to put the purchase order on hold for some reason, select

the On Hold option.
13.Enter a description and a reference for the PO.
14.Use the detail grid on the Copy Purchase Orders form to edit the
details as you require.
To delete a detail line, you simply click the detail line, and then press
the Delete key on your keyboard.
15.When you have finished editing information for the purchase order,
click the Create button to generate the PO.
You can then view, edit, and post the order using the Purchase Order
Entry form.
Related topics

Enter Receipts
Overview

To receive goods:
1.Open Purchase Orders > P/O Transactions > Receipt Entry.
Click here for help on Receipt Entry fields.

2.Press the Tab key to accept *** NEW *** as the receipt number (in the
Receipt Number field).
Purchase Orders will assign a receipt number when you post the PO.
If you do not want Purchase Orders to assign the number
automatically, you can type the new number yourself, and then press
the Tab key.
3.Type the Vendor number or select it from the Finder.
Or, you can skip the Vendor Number field and directly enter or select
the PO number. (You must enter the Vendor number first if you are
receiving goods from several POs.)
You can also click:
The New button to add a new vendor record in Accounts Payable.
The Zoom button to check address and contact information.
WARNING! Although you can add a receipt before you add the
vendor record in Accounts Payable, you should not use this option in
a multicurrency system.
4.If you are receiving goods without a purchase order, you can change
the tax code, if necessary, before continuing.
Click the Taxes tab, make your tax changes, and then return to the
Receipt tab.
5.If you are receiving goods from one purchase order, in the PO
Number field, enter or select the purchase order number.
If you are receiving goods from several POs, click the Zoom button
( ) beside the From Multiple POs field to choose one or more
purchase orders from which you are issuing the purchase order.

To select several purchase orders:

If you are receiving goods without a purchase order number, tab
through the PO Number field to fill in other receipt fields.
Note: You must specify a vendor before you can complete the receipt
fields.
6.If you did not specify a purchase order, and you use the Project and
Job Costing module, you can choose the Job Related option if this
receipt is job-related.
If the purchase order that you selected is job-related, the job-related
checkbox will be automatically selected. You cannot mix job-related
and non-job-related POs on a receipt.
7.Fill in the remaining fields at the top of the Receipt Entry form.
The posting date is the date for transactions being posted to the
General Ledger, so it also determines the contents of the Fiscal
Year and Period fields. The date applies also to the invoice.
If you use Inventory Control, select a location code to which bills
for the receipt will be sent. You can also use the Zoom button ( )
to edit the address.
If you want to change the vendor account set, you can only choose
from account sets that use the vendor's currency.
8.Tab into the detail entry grid (or click the grid) to start entering receipt
details.
To receive all goods on purchase orders, click the Receive All
button.
To partially receive goods on purchase order:
Enter the quantity received for each item in the detail section.
You can also change other information, including item descriptions,
item costs (if you have appropriate security authorizations),
discount amounts, item weights, quantity canceled and
outstanding, number of item labels required, arrival date,
comments, and optional fields.
If you want, you can delete lines that are not being received (but it

isn't necessary if the amount received is "0").
Note: You cannot add detail lines if you are receiving specific
purchase orders.
9.Use the tab key to move through the columns on the form. Or, you
can click the Item/Tax... button or press F9 to display a form for
editing receipt details.
Some columns may not be displayed. Purchase Orders lets you
hide columns and change the column order.
You must enter a Quantity Received for all goods you receive
unless you use the Receive All button.
For information on other detail fields, see P/O Receipt Entry fields.
10.To add optional field information for the receipt, click the Optional
Fields tab.
11. To change currency exchange rates in a multicurrency system, click
the Rates tab.
12.To check the totals for the receipt, click the Totals tab.
13.Click Post to post the receipt.
Purchase Order Entry lets you print the receipt after posting.
You can also print the receipt separately, from the P/O Forms folder.
Related topics

Enter Additional Costs on Receipts
Overview

To enter additional costs:
1.Open Purchase Orders > P/O Transactions > Receipt Entry.
Click here for help on Receipt Entry fields.

2.On the Receipt tab, enter vendor and purchase order information,
along with receipt quantities.
3.Choose the Additional Cost tab to add charges to the shipment from
both primary vendors and secondary vendors.
4.On the Additional Costs tab, use the Finder or the navigation buttons
to select an existing additional cost vendor for which to enter or edit
an additional cost detail, or click the New button to add a new
additional cost vendor.
A new receipt will list the primary vendor only. To add a secondary
vendor,
a.

Click the new button beside the Additional Cost Vendors field.

b.

Click the Finder beside the Vendor Number field.

c.

Select the new additional cost vendor. You can also use the New
button to add a vendor to the Accounts Payable module.

5.When you have selected the correct vendor in the vendor number
field:
Click in the additional cost detail entry grid and enter or edit the
additional cost details.
Either click the Cost/Tax button or press the F9 key to display all
the information for a selected detail on a separate form and to edit
tax classes or the tax included fields for the detail, . Type the
customer number or select it from the Finder.

Choose to prorate each additional cost by quantity, cost, or weight.
If you are adding additional costs for non-inventory items, you
must choose No Proration. If you choose to prorate by quantity,
cost, or weight, the program will display an error message and
prevent you from posting the receipt.
For more information on prorating additional costs, see Calculating
prorated additional costs.
Click the Vendor Taxes button to change tax information for the
vendor.
To delete a detail, select it, and then click Delete. If a message
appears asking you to confirm the deletion, click Yes.
6.Click the Post button to post the receipt.
Related topics

Enter Invoices
Overview
To invoice received goods automatically on the Receipt Entry form:

To invoice one or more receipts using the Invoice Entry form:
1.Open Purchase Orders > P/O Transactions > Invoice Entry.
Click here for help on Invoice Entry fields.

2.Type the number of the invoice that you received from the vendor.
3.Type the vendor number or select it from the Finder.
If you are invoicing a single receipt for the primary vendor, you
can skip the Vendor Number field and enter or select the receipt
number in the Receipt Number field.
If the invoice is for several receipts, you must enter the vendor
number and then click the Zoom button ( ) beside the From Multiple
Receipts field.
If you are invoicing additional costs for a secondary vendor, you
must enter the secondary vendor number in the Vendor Number field
and then enter or select the receipt number Receipt Number field.
4.If you are invoicing only one shipment, type the number of the receipt,
or select the number using the Finder.
If you are invoicing several receipts, select the From Multiple Receipts
option, then click the zoom ( ) button beside the option. On the
Create Invoice From Receipts form that appears select the receipt
numbers using the Finder, then click the Invoice button.
The program will display all of the information from the receipts that
you selected, allowing you to edit the existing information or post the
default invoice.
Note: If you are invoicing a secondary vendor, the Finder will display
only the primary vendor number and name for the receipt. When you
choose the receipt the invoice amount will appear on the Additional
Costs tab — not in the detail section of the Invoice tab.
5.Check the

header information for the invoice

to make sure that it is correct.

6.You can

edit invoice details right on the detail entry grid, or on the Items/Taxes form.

7.Click the Additional Costs tab to edit invoice details for a secondary
vendor (and for primary vendor additional costs).
8.Click the Taxes tab to check the tax totals. You can change the tax
class and tax amount for each jurisdiction, if necessary.
9.Click the Totals tab to check the totals for the invoice.
10.Click Post to post the invoice.
When posting is finished, the program will let you print the invoice.
Related topics

Enter Additional Costs on Invoices
Overview

To enter additional costs:
1.Open Purchase Orders > P/O Transactions > Invoice Entry.
Click here for help on Invoice Entry fields.

2.On the Invoice tab, enter or edit vendor and receipt information, along
with invoice quantities.
3.Choose the Additional Cost tab to add charges to the invoice.
4.On the Additional Costs tab:
Click in the additional cost detail entry grid and enter or edit the
additional cost details.
Either click the Cost/Tax button or press the F9 key to display all
the information for a selected detail on a separate form and to edit
tax classes or the tax included fields for the detail, . Type the
customer number or select it from the Finder.
Choose to prorate each additional cost by quantity, cost, or weight.
To prorate additional costs for a single receipt:
i.

Select the additional cost on the Additional Cost entry grid.

ii.

Press F9 to open the Detail Costs/Taxes form.

iii.

Click the Zoom button beside the Distribute Proration field.

iv.

Distribute the additional cost (and billing rate for billable
details).
To prorate additional costs for several receipts:

i.

Select the additional cost on the Additional Cost entry grid.

ii.

Press F9 to open the Detail Costs/Taxes form.

iii.

Click the Dist. Cost button to display the Cost Allocation form.
(The Zoom button beside the Distribute Proration field will be
dimmed.)

iv.

Highlight the receipt you want, and click the Zoom button in the

column heading to display the Distribute Proration form.
v.

Distribute the additional cost (and billing rate for billable
details).
If you are adding additional costs for non-inventory items, you
must choose No Proration. If you choose to prorate by quantity,
cost, or weight, the program will display an error message and
prevent you from posting the receipt.
For more information on prorating additional costs, see Calculating
prorated additional costs.
To delete a detail, select it, and then click Delete. If a message
appears asking you to confirm the deletion, click Yes.

5.Check the Invoice total on the Totals tab.
6.Click the Post button to post the invoice.
Related topics

Enter Returns
Overview

To return items using the Return Entry form:
1.Open Purchase Orders > P/O Transactions > Return Entry.
Click here for help on Return Entry fields.

2.Press the Tab key to accept *** NEW *** as the return number (in the
Return Number field).
Purchase Orders will assign a return number when you post the
return.
If you do not want Purchase Orders to assign the number
automatically, you can type the new number yourself, and then press
the Tab key.
3.Type the vendor number or select it from the Finder.
You can also skip the Vendor Number field and go directly to the
Return Number field. However, entering the vendor first will limit the
length the receipt list.
4.Type or select the receipt number in the Receipt Number field.
The program will display all of the information from the receipt that
you selected, allowing you to return all items or edit the quantities and
then post the return.
5.Check the

header information for the return

to make sure that it is correct.

6.To return everything from the receipt, click the Return All button. You
can change quantities, if necessary, and delete lines which are not
being returned.
If you are entering returns for cleared receipts (the receipt no longer
exists), you enter:
The details of the returned items on the detail entry grid on the
Return tab of the Return Entry form. With each detail, you must
enter the item number, item description, location (if you use
Inventory Control), and quantity returned.

The unit and return cost, unit of measure, unit weight, extended
weight, vendor's item number, order number, and comments.
The general ledger account to which the returned cost is expensed
if the detail includes a non-inventory item.
For job-related returns, you enter contract, project, and category
information.
You do not enter the quantity received or extended cost.
7.You can

edit return details right on the detail entry grid, or on the Items/Taxes form.

8.Click the Taxes tab to check the tax totals. You can change the tax
class and tax amount for each jurisdiction, if necessary.
9.Click the Totals tab to check the totals for the return.
10.Click Post to post the return.
Prorating additional costs
After entering returns
Related topics

Enter a Credit/Debit Note for a Return or Invoice
Overview

To credit/debit a return or invoice:
1.Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.
Click here for help on Credit/Debit Note Entry fields.

2.Type the number of the credit/debit note in the Document Number
field, and then press the Tab key.
3.Type the vendor number or select it from the Finder.
4.Choose Credit Note or Debit Note as the document type.
5.Type the return or invoice number from which you are creating the
credit or debit note, or select it from the Finder.
The information from the original document is automatically displayed.
If the return or invoice has already been cleared from Purchase
Orders, the program displays a message stating that the document
does not exist.
Click the Close button in the message box to continue.
You will have to add all item details and additional costs for the
credit/debit note, and them match it to the invoice in the Accounts
Payable module.
6.Check and edit the credit/debit note date and posting date (if they
differ from today's date).
7.Enter the total for the credit/debit note in the Credit/Debit Note Total
field.
If you are entering a credit note from a return, the program will
display the total from the return by default.
If you are entering a credit or debit note for an invoice, the
program will display a zero total.
Note: The amount in this field must match the Credit/Debit Note Total
displayed on the Totals page before you can post this document.
8.You can also specify the vendor payment location and change the

vendor account set (to change the Accounts Payable control
accounts).
9.Enter a description and reference for the document.
10.Choose the action you want to take:
If this is a credit note for a return:
If this is a credit/debit note for an invoice:
If the return or invoice has been cleared and you are adding credit/debit note detail lines:

11. Once you are finished editing the credit/debit note detail lines, check
the information on the remaining credit/debit note tabs:
The Taxes tab to edit the vendor tax class and to edit the total tax
amounts for each jurisdiction.
The Additional Costs tax to credit/debit additional costs or to add
new additional costs to the credit/debit note.
The Optional Fields tab to add optional field information to this
credit/debit note.
The Rates tab (in a multicurrency system) to change currency
exchange rates.
The Totals tab to check the totals for the credit/debit note, and to
add an extended comment.
12.Check the Credit/Debit Note Total field on the Totals tab and make
sure that it matches the credit/debit note from the vendor.
13.Return to the Credit/Debit tab to check the Credit/Debit Note Total
field.
14.Click Post to post the credit note.
Related topics

Enter or Edit Additional Costs on Credit and
Debit Notes
Overview

To adjust existing additional costs:
1.Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.
Click here for help on Credit/Debit Note Entry fields.

2.On the Credit/Debit tab, specify the type of document and select the
return or invoice for which you are creating the credit note or debit
note.
3.In the detail section, enter the return/invoice quantities , along with
cost differences quantities.
4.Choose the Additional Cost tab to display the additional cost details.
The additional cost amounts for existing details appear as zero.
You enter the amount to be credited or debited.
Note: If this is a credit note for a return, the program will display
additional cost details for the primary vendor only.
5.On the Additional Costs tab:
a.

Click in the Amount field for the additional cost detail that you want
to adjust. The amount will initially be zero.

b.

Enter the credit or debit amount for the additional cost. You cannot
change the proration methods or accounts.

c.

Tab to the end of the detail line to enter a reference and comment.
To change the detail tax class for an additional cost:

a.

Select the additional cost on the Additional Cost entry grid.

b.

Click the Cost/Tax... button or press F9 to open the Detail
Costs/Taxes form.

c.

Change the detail tax class, and then click the Calc. Taxes button
to recalculate the tax.
To change the total tax amount for the credit/debit note

(including the tax for the additional cost):
a.

Select the Taxes tab.

b.

Enter the total tax amount to be credited or debited for each tax
authority in the Tax Amount column.

6.Click the Total tab to check the additional cost totals and tax totals.
To add new additional costs to debit notes:
1.Go to the Additional Costs tab.
2.Click in the additional cost detail entry grid, press the Insert key, and
click the Additional Cost column header to display the Finder
3.Choose the new additional cost from the Finder, and then:
a.

Tab to the Amount field and enter the amount for the additional
charge.

b.

Choose No Proration for the proration method. If you choose to
prorate, the program will display an error message and prevent
you from posting the debit note.

c.

Tab to the Expense Account field and enter or choose the expense
account for the additional charge.

d.

Tab to the Reference and Comments field to provide more
information about the cost.
To change the detail tax class for the new additional cost:

a.

Select the additional cost on the Additional Cost entry grid.

b.

Click the Cost/Tax... button or press F9 to open the Detail
Costs/Taxes form.

c.

Change the detail tax class, and then click the Calc. Taxes button
to recalculate the tax.
To change the total tax amount for the credit/debit note
(including the tax for the additional cost):

a.

Select the Taxes tab.

b.

Enter the total tax amount to be credited or debited for each tax
authority in the Tax Amount column.

4.Click the Total tab to check the additional cost totals and tax totals.
5.Click the Post button to post the credit/debit note.
Related topics

Change Tax Information and Tax Amounts on
Purchase Orders Documents
Overview

To change the total tax amount for a document:
1.Click the Taxes tab on the Purchase Orders, Receipt Entry, Invoice
Entry, Return Entry, or Credit/Debit Note Entry form.
2.Edit the Vendor tax class if necessary, and then click the Calc. Taxes
button to see the results of the change.
3.To manually change the total tax amount for the vendor, enter new tax
totals in the Tax Amount column.
4.Purchase Orders will distribute the updated tax amounts when you
move to another tab or post the transaction.
To change tax information for single items:
1.Click the Item/Tax... button on the first tab of the Purchase Orders,
Receipt Entry, Invoice Entry, Return Entry, or Credit/Debit Note Entry
form.
2.Change the tax class for an authority, or the tax included option, if
necessary.
Note:
You cannot change the Tax Included setting unless the tax
authority allows it. (Tax authorities are defined in Tax Services.)
The tax amount will not be automatically recalculated until you
close this window and move to another document tab.
The tax amount will not be recalculated if you overrode the total
tax amount on the Taxes tab. If you want to recalculate the tax,
you will have to use then Calc. Taxes button on the Order tab, the
Taxes tab, or on the Detail Item/Taxes window.
To change tax amounts for additional costs:
1.Click the Additional Costs tab, and then click the Vendor Taxes button.

2.Edit the tax class if necessary, then click the Calc. Taxes button to see
the results of the change.
3.To manually change the total tax amount for the vendor's additional
changes, enter new tax totals in the Tax Amount column.
4.Purchase Orders will distribute the updated tax amounts to the
additional charges when you move to another tab or post the
transaction.
To change tax information for a single additional cost detail:
1.Click the Additional Costs tab, and then click the Cost/Tax... button to
display the Detail Costs/Taxes form.
2.Change the detail tax class for a tax authority, or the tax included
option, if necessary.
Note:
You cannot change the Tax Included setting unless the tax
authority allows it. (Tax authorities are defined in Tax Services.)
The tax amount will not be automatically recalculated until you
close this window and move to another document tab.
The tax amount will not be recalculated if you overrode the total
tax amount on the Vendor Taxes form. If you want to recalculate
the tax, you will have to use the Calc. Taxes button on the Detail
Costs/Taxes form or on the Additional Costs tab.
Related topics

Create Purchase Orders from Requisitions
verview

O

To create purchase orders:
1.Open Purchase Orders > P/O Create Purchase Orders > Create POs
from Requisitions.
Click here for help on Create POs from Requisitions fields.

2.Specify the ranges of requisition numbers, dates, and vendors for
which to create purchase orders.
3.Choose from the following options:
Consolidate Items.
Include Blank Vendors.
Job Related.

4.Click the Optional Fields tab (if you use optional fields on the
purchase orders form), and specify entries for the optional fields that
appear on the purchase orders form.
If you use the same fields on requisitions and purchase orders, the
optional field entries on the requisition detail lines will appear by
default on the purchase orders unless you specify entries here.
When you create a purchase order from more than one requisition,
the fields on the Optional Fields tab will be taken from the first
requisition that you select.
5.Click the Detail Optional Fields tab (if you use optional fields with
purchase order details), and specify entries for the optional fields that
appear on detail lines.
6.Choose Process to create the purchase orders.
Purchase Orders creates a purchase order for each vendor for
whom details were entered on requisitions in the ranges you
specified.
When the purchase orders have been posted, you see a message
that lists the range of purchase order numbers that were assigned.

Related topics

Print a Requisition Immediately After Posting
Before you start

To print a purchase requisition immediately after posting it:
1.Click the Post button while the purchase requisition is displayed.
When Purchase Orders is finished posting the purchase requisition, it
displays a form which it lists the requisition number and asks whether
you want to print the requisition.
2.Click Yes to print the requisition. Purchase Orders opens the P/O
Requisitions form and selects the requisition you just posted.
3.Complete the information as follows:
Use Requisition. Use the default requisition report form that
appears or click the Browse button to select a different one. (P/O
displays the form that you used previously for requisitions.)
Sage ERP Accpac ships with three standard forms.
PORQN01.RPT — for printing on blank paper.
PORQN02.RPT — for printing on preprinted forms.
PORQN03.RPT — an alternative format for printing on blank
paper that includes optional fields.
4.Click Print.
If you are printing the purchase requisition on a printer, you can click
the Align button to print a sample copy of the requisition to check that
the information prints in the right places on preprinted forms. If the
sample form does not line up correctly, ensure that you have correctly
inserted the forms in the printer.
What business forms come with Purchase Orders?
Related topics

Print a Purchase Order Immediately After
Posting
Before you start

To print a purchase order immediately after posting it:
1.Click the Post button while the purchase order is displayed.
When Purchase Orders is finished posting the PO, it displays a form
which it lists the purchase order number and asks whether you want
to print the order.
2.Click Yes to print the purchase order . Purchase Orders opens the
P/O Purchase Orders form and selects the PO that you just posted.
3.Complete the information as follows:
Use Purchase Order. Use the default purchase order report form
that appears, or click the Browse button to select a different one.
(P/O displays the form that you used previously for purchase
orders.)
Sage ERP Accpac ships with four standard forms.
POPOR01.RPT — for printing on blank paper.
POPOR02.RPT — for printing on preprinted forms.
POPOR04.RPT — for printing on blank paper.
POPOR05.RPT — for printing on preprinted forms.
The first two reports connect directly to the P/O database and are
easier to change if you need to customize your purchase order
forms. The second two print POs more quickly but may be less
adaptable to your needs.
Delivery Method. Choose how you want to send the purchase
order to your vendor.
Select Print Destination to print to your usual print destination.
Select Vendor to use the delivery method specified in each
vendor record in the Accounts Payable program (such as email).

If you choose Vendor as the delivery method, select the ID for the
e-mail message you want to send with purchase orders for
vendors that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for purchase orders, click the Zoom button for the
Message ID field.
Include Details Already Printed. Choose whether to include the
details that you printed before (if you have now added to the PO)
or only details added later.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized purchase order form that requires it.
(This option is for custom forms that do not use the report
selection criteria sent by this print window.)
4.Click Print.
If you are printing the purchase order on a printer, you can click the
Align button to print a sample copy of the PO to check that the
information prints in the right places on preprinted forms. If the sample
form does not line up correctly, ensure that you have correctly
inserted the forms in the printer.
What business forms come with Purchase Orders?
Related topics

Print a Return Immediately After Posting
Before you start

To print a return immediately after posting it:
1.Click the Post button while the return is displayed.
When Purchase Orders is finished posting the return, it displays a
form which it lists the return number and asks whether you want to
print the return.
2.Click Yes to print the return. Purchase Orders opens the P/O Returns
form and selects the return that you just posted.
3.Complete the information as follows:
Use Return. Use the default return report form that appears, or
click the Browse button to select a different one. (P/O displays the
form that you used previously for returns.)
Sage ERP Accpac ships with two standard forms.
PORET01.RPT is used for printing on blank paper.
PORET02.RPT is used for printing on preprinted forms.
Delivery Method. Choose how you want to send the return to your
vendor.
Select Print Destination to print to your usual print destination.
Select Vendor to use the delivery method specified in each
vendor record in the Accounts Payable program (such as email).
If you choose Vendor as the delivery method, select the ID for the
e-mail message you want to send with returns for vendors that use
e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for returns, click the Zoom button for the Message
ID field.
Print Serial/Lot Numbers.
Require Mailing Labels. Choose whether to print the number of

labels on the Return Totals tab for each return (select the Require
Mailing Labels option) or only one label per return (do not select
the option).
Use Custom Form. Do not select the Custom Form option unless
you are using a customized return form that requires it. (This
option is for custom forms that do not use the report selection
criteria sent by this print window.)
4.Click Print.
If you are printing the return on a printer, you can click the Align
button to print a sample copy of the return to check that the
information prints in the right places on preprinted forms. If the sample
form does not line up correctly, ensure that you have correctly
inserted the forms in the printer.
What business forms come with Purchase Orders?
Related topics

Print Requisitions
Overview
Before you start

To print requisitions:
1.Open Purchase Orders > P/O Forms > Requisitions.
2.Fill in the fields as follows:
Use Requisition. Choose the report format that you want to use to
print requisitions.
You can accept the default requisition report form that appears or
click the Browse button to select a different one. (P/O displays the
form that you used previously for requisitions.)
Sage ERP Accpac ships with three standard forms.
PORQN01.RPT — for printing on blank paper.
PORQN02.RPT — for printing on preprinted forms.
PORQN03.RPT — an alternative format for printing on blank
paper that includes optional fields.
From Requisition Number/To Requisition Number. Specify the
range of requisition numbers that you want to print.
Include Requisitions Already Printed. Choose whether to print
new copies of requisitions that you printed before.
3.Click Print.
If you are printing requisitions on a printer, you can click the Align
button to print a sample copy of the label to check that the information
prints in the right places on a preprinted requisition form.
What business forms come with Purchase Orders?
Related topics

Print Purchase Orders
Overview
Before you start

To print purchase orders:
1.Open Purchase Orders > P/O Forms > Purchase Orders.
2.Fill in the fields as follows:
Use Purchase Order. Choose the report format that you want to
use for printing purchase orders.
You can accept the default PO report form that appears or click the
Browse button to select a different one. (P/O displays the form that
you used previously for purchase orders.)
Sage ERP Accpac ships with four standard forms.
POPOR01.RPT — for printing on blank paper.
POPOR02.RPT — for printing on preprinted forms.
POPOR04.RPT — for printing on blank paper.
POPOR05.RPT — for printing on preprinted forms.
The first two reports connect directly to the P/O database and are
easier to change if you need to customize your purchase order
forms. The second two print POs more quickly but may be less
adaptable to your needs.
From Purchase Order Number/To Purchase Order Number.
Specify the range of purchase orders that you want to print.
Delivery Method. Choose how you want to send the purchase
order to your vendors.
Select Print Destination to print to your usual print destination.
If printing to a printer, you can also print mailing labels for
purchase orders, and then mail the POs.
Select Vendor to use the delivery method specified in each
vendor record in the Accounts Payable program (such as e-

mail).
If you choose Vendor as the delivery method, select the ID for the
e-mail message you want to send with purchase orders for
vendors that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for purchase orders, click the Zoom button for the
Message ID field.
Include Active / Future / Standing / Blanket Orders. Choose the
types of purchase orders to print (Active, Future, Blanket,
Standing).
Include Purchase Orders Already Printed. Choose whether to
print new copies of purchase orders that you printed before.
Include Details Already Printed. Choose whether to include the
details that you printed before (if you have now added to the PO)
or only details added later.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized purchase order form that requires it.
(This option is for custom forms that do not use the report
selection criteria sent by this print window.)
3.Click Print.
If you are printing purchase orders on a printer, you can click the Align
button to print a sample copy to check that the information prints in
the right places on a preprinted PO form.
What business forms come with Purchase Orders?
Related topics

Print Receiving Slips
Overview
Before you start

To print receiving slips:
1.Open Purchase Orders > P/O Forms > Receiving Slips.
2.Fill in the fields as follows:
Use Receipt. Choose the report format that you want to use for
printing receiving slips.
You can accept the default receipt report form that appears or click
the Browse button to select a different one. (P/O displays the form
that you used previously for receiving slips.)
Sage ERP Accpac ships with four standard forms.
PORCP01.RPT — for printing on blank paper.
PORCP02.RPT — for printing on preprinted forms.
PORCP03.RPT — for printing on blank paper (include
quantities received and costs).
PORCP04.RPT — for printing on preprinted forms (include
quantities received and costs).
Note: Pre-printed forms PORCP03.RPT and PORCP04.RPT will
print cost information. If you want to hide costs on these forms,
you will need to customize them.
From Receipt Number/To Receipt Number. Specify the range of
receipts that you want to print.
Include Receipts Already Printed. Choose whether to print new
copies of receiving slips that you printed before.
Print Serial/Lot Numbers. Choose to print the serial and/or lot
numbers of any serialized or lotted items included in the receipts.
3.Click Print.
If you are printing receiving slips on a printer, you can click the Align

button to print a sample copy to check that the information prints in
the right places on a preprinted receipt form.
What business forms come with Purchase Orders?
Related topics

Print Returns
Overview
Before you start

To print returns:
1.Open Purchase Orders > P/O Forms > Returns.
2.Fill in the fields as follows:
Use Return. Choose the report format that you want to use for
printing returns.
You can accept the default return report form that appears or click
the Browse button to select a different one. (P/O displays the form
that you used previously for returns.)
Sage ERP Accpac ships with two standard forms.
PORET01.RPT — for printing on blank paper.
PORET02.RPT — for printing on preprinted forms.
From Return Number/To Return Number. Specify the range of
returns that you want to print.
Delivery Method. Choose how you want to send the return to your
vendor.
Select Print Destination to print to your usual print destination.
Select Vendor to use the delivery method specified in each
vendor record in the Accounts Payable program (such as email).
If you choose Vendor as the delivery method, select the ID for the
e-mail message you want to send with returns for vendors that use
e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for returns, click the Zoom button for the Message
ID field.
Include Returns Already Printed. Choose whether to print new
copies of returns that you printed before.

Print Serial/Lot Numbers. Choose to print the serial and/or lot
numbers of any serialized or lotted items returned.
Require Mailing Labels. Choose whether to print the number of
labels on the Return Totals tab for each return (select the Require
Mailing Labels option) or only one label per return (do not select
the option).
Use Custom Form. Do not select the Custom Form option unless
you are using a customized return form that requires it. (This
option is for custom forms that do not use the report selection
criteria sent by this print window.)
3.Click Print.
If you are printing returns on a printer, you can click the Align button to
print a sample copy to check that the information prints in the right
places on a preprinted PO form.
What business forms come with Purchase Orders?
Related topics

Print Mailing Labels
Overview
Before you start

To print mailing labels:
1.Open Purchase Orders > P/O Forms > Mailing Labels.
2.Fill in the fields as follows:
Use Label. Choose the report format that you want to use to print
labels.
You can accept the default label report file that appears, or click
the Browse button to select a different one. (P/O displays the form
that you used previously for labels.)
Sage ERP Accpac ships with two standard labels:
POLABEL.RPT — print 12 labels on an 8.5 x 11 page (2-up).
POLABELP.RPT prints 14 labels on an 8.5 x 11 page (2-up).
Select. Choose whether to print labels for purchase orders or
returns.
From/To. Specify the range of document numbers for which you
want to print labels.
Include Labels Already Printed. Choose whether to print new
copies of labels that you printed before.
Print Only Labels Marked Required. Choose to print either:
The number of labels on the Purchase Orders or Return Totals
tab (select the Print Only Labels Marked Required option)
3.Click Print.
If you are printing labels on a printer, you can click the Align button to
print a sample copy of the label to check that the information prints in
the right places on label stock.
What business forms come with Purchase Orders?
Related topics

View Pending Receipts
verview

O

To view pending receipts:
1.Open Purchase Orders > P/O Statistics and Inquiries > Pending
Receipts Inquiry.
2.Choose whether you want to inquire by item or by vendor, and then
select the item number or vendor number for which you want to view
details.
3.Select a range of locations, or skip the Location fields to display all
locations.
4.In the PO Date fields, leave the From and To fields blank to include all
purchase orders, or specify a range of PO dates.
5.In the Expected Arrival Date fields, leave the From field blank to
include all purchase orders with outstanding items, and enter the end
date for the inquiry in the To field.
6.Choose Include Completed Detail Lines to see if items were delivered
within the expected arrival times.
7.Choose Show Late POs Only to see incomplete detail lines that are
past their expected arrival dates.
8.Click the Go button ( ).
The program fills in the detail grid with PO line information that
matches the select criteria that you specified:
Purchase Order Number
Line Number
Item Number
Item Description
Vendor Number
Vendor Name
Location
Quantity Ordered
Expected Arrival Date

Date Received
Days Late
9.To view more information for any PO line item — such as receipt
quantities and days late — double-click the PO line on the detail grid,
or select the line and click the Details button.
The program displays the following additional information for each
receipt associated with the PO line:
Receipt Number
Contract, Project, Category (if job-related)
Quantity Ordered
UOM
Quantity Received
Date Received
Expected Arrival Date
Days Late
Related topics

Look Up Purchase History
Overview

To look up purchase history:
1.Open Purchase Orders > P/O Statistics and Inquiries > Purchase
History.
Click here for help on Purchase History fields.
Click here for help on Purchase History detail fields.

2.Select the range of year and period for which you want to see
purchase history.
3.Choose:
Vendor — to view all of the items ordered from and returned to a
particular vendor.
Item Number — to view all of the vendors who supplied a
particular item.
4.Choose your functional currency or the vendor currency, if you have a
multicurrency system.
5.Click the Go button ( ).
If you chose Vendor, above, the program lists all of the item details on
invoices or returns for the vendor.
If you chose Item Number, the program lists all of the invoices and
returns on which the item that you specified appears.
6.Highlight a line and click the Details button for more information on
the source document.
Related topics

Look Up Purchase Statistics
If you use the Accumulate Purchase Statistics option, you can view
purchase statistics for the years and statistical periods for which you
keep data.
To look up purchase statistics:
1.Open Purchase Orders > P/O Statistics and Inquiries > Purchase
Statistics.
Click here for help on Purchase Statistics fields.

2.Select the year, period, and currency for which you want to see
purchase statistics.
Related topics

Look Up Transaction History in Inventory
Control
The Inventory Control module lets you look up transactions created in
Sage ERP Accpac Purchase Orders, Order Entry, or Inventory Control.
To look up transactions:
1.Open Inventory Control > I/C Statistics and Inquiries > Transaction
History Inquiry.
2.To change the fiscal year and period, select a new one from the dropdown list beside the As At Year/Period field.
3.Enter the beginning and ending item numbers, or select them using
the Finders.
4.Enter the beginning and ending account set numbers, or select them
using the Finders.
5.Enter the beginning and ending location numbers, or select them
using the Finders.
6.When you are satisfied with your inquiry criteria, click the Go button.
7.A list of items matching your criteria is displayed. To view a list of
recent transactions involving an item, select the item from the list and
click the Details button.
8.The list includes the document number and other information about
the transaction.
9.To drill down to the original document, highlight a transaction and click
the Details button.
Sage ERP Accpac will display the original transaction unless it has been
cleared from the database.
Related topics

Perform Day-End Processing
Run day-end processing as part of your daily routine, to keep your audit
trail and reports up to date. You can run day-end processing as many
times a day as you want.
What does Day-End Processing do?
Before you start

To perform day-end processing:
1.If you have the Inventory Control module, open Inventory Control >
I/C Periodic Processing > Day End Processing.
If you do not have Inventory Control, open Purchase Orders > P/O
Periodic Processing > Day End Processing.
2.Click Process.
3.When the message appears to indicate that processing is complete,
click the OK button or press Enter to close the message and the Day
End Processing form.
Related topics

Create G/L Transaction Batch
Overview
Before you start

To create a batch of G/L transactions:
1.Open Purchase Orders > P/O Periodic Processing > Create Batch.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Optionally, select Post A/P Batch if you also want to post invoice
transactions created by Purchase Orders in the Accounts Payable
module. (See the Overview notes.)
4.Click Process.
After using
Related topics

Post Accounts Payable Invoice Batch
Overview
Before you start

To post a batch of invoices created by Purchase Orders in A/P:
1.Open Purchase Orders > P/O Periodic Processing > Create Batch.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Select Post A/P Batch to post invoice transactions created by
Purchase Orders in the Accounts Payable module. (See the Overview
notes.)
4.Click Process.
After using
Related topics

Set Up Manual Requisition Approval
verview

O

To set up requisition approval in Purchase Orders:
1.Turn on security for the system database in Sage ERP Accpac's
database setup program to use database security features.
a.

In MS Windows, click Start > Programs > Sage Software >
Database Setup.

b.

Enter your administrator password and click OK.

c.

Double-click the system database for which you are turning on
security.

d.

Select the Enable Application Security option, and click OK.

2.Create security groups in Sage ERP Accpac for requisition entry and
requisition approvers.
a.

In Sage ERP Accpac ERP, open Administrative Services >
Security Groups.

b.

Choose Purchase Orders from the drop-down list.
To create a security group of PO approvers:

i.

Choose an existing P/O security group ID or enter a new group
ID and description.

ii.

Select Requisitions Manual Approval to grant PO approval
rights.

iii.

Assign any other rights that you want to attach to this security
group.
To create a security group for requisition entry only:

i.

Choose an existing P/O security group ID or enter a new group
ID and description.

ii.

Select Requisitions Entry to allow users to enter requisitions.

iii.

Do not provide Purchase Order Entry rights or Requisitions
Manual Approval rights if you want to prevent users from

approving requisitions/POs.
iv.

Assign any other rights that you want to attach to this security
group.
For example, you can choose whether or not users can view
requisition and receipt costing information.

3.Assign employees to the appropriate security groups.
a.

In Sage ERP Accpac ERP, open Administrative Services > User
Authorizations.

b.

Choose the User ID that you want to assign to a security group.

c.

Select Purchase Orders from the list of applications.

d.

Choose the appropriate security group ID for the user.

Related topics

Add Optional Fields to Records and
Transactions
Overview
Before you start

To add optional fields to miscellaneous charges, transactions, and
transaction details:
1.Open Purchase Orders > P/O Setup > Optional Fields.
Click here for help on all Optional Fields setup fields

.

2.Select a record/transaction type from the Optional Fields For list.
.

Click here for more information

3.Click in the optional field entry grid, and then press the Insert key on
your keyboard to start a new line.
4.Click the Finder (or press F5) in the Optional Field column, then
choose an existing optional field from the Finder list. (The description
will appear automatically.)
5.Click the Finder in the Default Value column, then choose the value
for the optional field selected in step 3.
6.Toggle in the Auto Insert column to:
Choose Yes if you want to allow the optional field (and its default
value) to appear in new records and transactions.
Choose No if you do not want the optional field to appear
automatically.
7.Click the Settings button to select the G/L accounts that this optional
field will be included with for G/L transactions and transactions sent to
other subledgers.
Click here for a list of G/L accounts for purchase order, receipt, invoice, return, and credit/debit note transaction
details.

Consider carefully the purpose of each optional field that you add.
For example, only send optional fields to General Ledger that are
used for financial analysis, and only to the accounts where they are

required.
8.Click the Close button to close the Settings form. Click the add button
on the P/O Optional Fields form, and then click Close.
Make sure that no one else is using the Purchase Orders data and
that no other Purchase Orders forms are open for the company before
you save changes.
After adding optional fields to P/O
Related topics

Change Purchase Orders Processing Options
You cannot change settings on the Processing tab of the P/O Options
form if other Purchase Orders forms are open, or other users are working
with the Purchase Orders database.
Make sure that no one else is using the Purchase Orders data and that
no other Purchase Orders forms are open for the company before you
save changes.
Changing settings
Before you start

To change P/O processing options:
1.Open Purchase Orders > P/O Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
These are the options you can select or change on the Processing tab
in the P/O Options form.
Accumulate By
Accumulate Purchase History
Accumulate Statistics
Allow Edit of Statistics

(standalone Purchase Orders)

Allow Fractional Quantities
Allow Non-Existing Vendors
Allow Non-Inventory Items
Default Copy Costs to Purchase Order
Default Item Cost
Default Posting Date
Default Rate Type
Default Template Code

(standalone Purchase Orders)

Default Weight Unit of Measure
Functional Currency (display only)
Keep Transaction History
Multicurrency option (display only)

Post A/P Batches During Posting or Day End Processing / On Request Using Create Batch Icon

(if using

Inventory Control)
Period Type
Require Approval
Update Most Recent Cost and Last Cost at Receipt Costing or Invoice Costing
Warn for Non-Existing Items

Note:
Use the I/C Options form in Inventory Control to change whether

inventory is costed when posting Purchase Orders transactions or
during day end processing.
Costing items and creating subledger transactions and audit
information during posting will increase the time it takes to post
transactions in Inventory Control, Order Entry, and Purchase
Orders.
If you change from updating costs during day end processing to
updating costs during posting, you must first run day end to cost all
outstanding posted P/O, I/C, and O/E transactions.
3.Click the Save button to save any changes to processing options.
After changing P/O Options
Related topics

Change General Ledger Integration Options
You cannot change settings on the Integration tab of the G/L Integration
form if other Purchase Orders forms are open, or other users are working
with the Purchase Orders database.
Make sure that no other Purchase Orders forms are open for the
company before you save changes to the G/L Integration form.
Overview
Before you start

To change General Ledger integration options:
1.Open Purchase Orders > P/O Setup > G/L Integration.
2.The Integration tab lets you change these options:
Create G/L Transactions
Create G/L Transactions by
Consolidate G/L Batches
Transaction Type
Source Ledger
Source Type

3.Click the Transaction tab to change the information that appears with
G/L transactions for the G/L Detail Comment, G/L Detail Description, G/L Detail Reference, and
G/L Entry Description.
The Entry grid lists each of the transactions produced by Purchase
Orders, and displays the information that is currently included in G/L
transactions produced from these P/O transactions.
a.

Double-click the transaction description or transaction detail
information that you want to change.

b.

On the form that appears, highlight the information that you want
to add to the transaction field, and use the Include and Exclude
buttons to add or remove field information.
You can assign one or more pieces of information (segments) to
each G/L transaction field, provided that the combined length of
the segments and separators does not exceed 60 characters.
Fields exceeding this limit will be truncated when you post the
general ledger transactions.

c.

Click Save to save the contents of the G/L transaction field.

d.

Choose a different field to edit, or click Close to return to the
Transaction tab.

4.Click Save to save changes to the G/L Integration form.
After changing G/L Integration Options
Related topics

Change Posting and Day End Processing
Options
Note:
If you are using the Inventory Control Module, Day End Processing
options are set up in the Inventory Control module.
If you are not using Inventory Control, Day End Processing options
are set up in the Purchase Orders module.
These options also affect when the Purchase Orders module can post
General Ledger and Accounts Payable batches.
You cannot change day end processing options if any Inventory
Control forms are open, or if other users are working with Purchase
Orders.
Overview
Before you start

To change batch creation and posting options for A/P transactions
created by Purchase Orders:
1.Open Purchase Orders > P/O Setup > Options.
Click here for help on all P/O Options

.

2.Click the Processing tab.
3.Change the following option.
Post A/P Batches During Posting or Day End Processing/On Request Using Create Batch Icon

Note: If you choose to post A/P batches when you post P/O
transactions, and you cost inventory during transaction posting,
Purchase Orders will create and post an A/P batch each time you post
an invoice.
4.Click the Save button when you are finished.
To change batch creation and posting options for G/L transactions
created by Purchase Orders:
If you are now using the Create Batch form to create transactions, print a
copy of the latest G/L Transactions report, then create any outstanding

transactions before changing your choice for this option.
1.Open Purchase Orders > P/O Setup > G/L Integration.
Click here for help on all G/L Integration fields

.

2.Change the appropriate option.
Create G/L Transactions
Create G/L Transactions by
Consolidate G/L Batches

3.Click the Save button when you are finished.
Make sure that no one else is using the Purchase Orders data and
that no other Purchase Orders forms are open for the company before
you save changes.
To change day end processing options in the Inventory Control
module (or in Purchase Orders if you do not use Inventory Control):
1.Open Inventory Control > I/C Setup > Options.
(Or open Purchase Orders > P/O Setup > Options if you do not use
Inventory Control.)
2.Click the Costing tab.
3.Change the appropriate option.
Cost items during posting or Day End Processing
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing)

4.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control (or
Purchase Orders) data and that no other Inventory Control (or
Purchase Orders) forms are open for the company before you save
changes.
To change batch creation and posting options for G/L transactions
created by Inventory Control:
Inventory Control generates G/L transactions from purchase order
receipts and returns.
1.Open Inventory Control > I/C Setup > G/L Integration.
2.Change the appropriate option.
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by

3.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
After changing Day End Procesing and posting options
Related topics

Allow Editing of Sales Statistics
Overview
Before you start

To change P/O processing options:
1.Open Purchase Orders > P/O Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
3.Change the Allow Edit Of Statistics option.
4.Click the Save button to save any changes to processing options.
After changing statistics
Related topics

Print Purchase Orders Reports
What types of reports does Purchase Orders have?
Before you start

To print Purchase Orders reports:
1.Open Purchase Orders > P/O Setup Reports.
Or
Open Purchase Orders > P/O Analytical Reports.
Or
Open Purchase Orders > P/O Forms.
2.Choose the report that you want to print.
3.Press F1 when the print form appears for detailed information on
report options.
4.To begin printing, click the Print button.
Related topics

Select a Printer for Reports
Sage ERP Accpac lets you choose a default printer for all reports that
you print, and assign different printers to specific reports (such as
invoices or labels).
To change the default printer for all reports:
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
To assign a specific report to a specific printer:
1.Open the report form which you want to assign to a printer.
2.From the menu on the report form, Select File > Print Setup.
3.Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.
Note: By default, the specific printer is the one chosen as the printer
on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop.

The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Choose a paper source if you want to select a particular paper tray or
paper stock for this report.
5.Click OK Page Setup page.
To clear the assigned printer for this report
Prompt for printer each time you prnt
Related topics

Print Reports to a Printer
verview

O

If your printer is already set up, follow these instructions to change
the print destination back to Printer:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Printer as the print destination.
3.Click OK.
If you have not yet selected a printer for Sage ERP Accpac, follow
these instructions to choose a default printer for printing all reports
from Sage ERP Accpac.
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Microsoft Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
Related topics

Print Reports to the Screen
verview

O

To change the default print destination to Preview:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Preview to view a report on the screen.
You can also print from the Preview window by clicking the Printer
button.
3.Click OK.
Additional information regarding print destinations
Related topics

Print Reports to a File
verview

O

To change the default print destination to File:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select File to save your report as a file in your usual print file folder.
3.Click OK.
When you print to a file, the report is assigned a unique name, for
example, CS1000.TXT.
Related topics

Print Reports as an E-mail Attachment
verview

O

To change the default print destination to E-mail:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select E-mail to create a file that can be attached to an e-mail.
3.Select either Adobe Acrobat (PDF) or Rich Text Format (RTF) as the
file format for the e-mail attachment.
You can open PDF files with Adobe Acrobat Reader (available as a
free download from the Adobe Software website).
You can open RTF files with most Windows and Linux word
processing programs.
4.Click OK.
When you print with an e-mail destination
Related topics

Print Setup Reports
verview

O

To print setup reports:
1.Open Purchase Orders > P/O Setup Reports.
2.Choose the report that you want to print.
3.Press F1 when the print form appears for detailed information on
report options.
4.To begin printing, click the Print button.
Related topics

Save Personal Report Settings for Future
Printing
Sage ERP Accpac lets you save report settings as defaults for printing
Purchase Orders forms (such as purchase requisitions, POs, receiving
slips, returns, and mailing labels) and for several Purchase Orders
Analytical reports, including the Transaction List, Purchase Order Action
Report, Aged Purchase Orders, and Purchase History reports.
To save current settings as defaults:
1.Open the Purchase Orders form or report for which you want to save
printing settings.
2.Choose each of the settings on the print form that you want as a
default setting.
3.Select Settings > Save Settings As Defaults from the report menu.
To clear saved settings:
1.Open the Purchase Orders form or report for which you want to reset
printing settings.
2.Select Settings > Clear Saved Settings from the report menu.
Related topics

Importing and Exporting Purchase Orders Records
Choose the type of information you wish to import or export:
Importing and exporting Purchase Orders setup records
Importing and exporting Purchase Orders transactions

For information about restricting access to the importing and exporting
processes, see:
Export Processing security access
Import Processing security access

Entering Current Requisitions and Purchase
Orders
To properly set up your Purchase Orders system, you should enter and
post all requisitions and purchase orders that are open when you are
setting up.
When you post purchase orders, quantities on purchase order are
updated in Inventory Control.
You can run Day End Processing after posting requisitions and purchase
orders to update history and statistics in both Purchase Orders and
Inventory Control (if you keep history and statistics in both programs).
You can also add some statistical information from your previous system,
as described in Entering statistics for the current and previous periods.
You use the Requisition Entry and Purchase Order Entry forms to add the transactions.
See also
Steps for setting up Purchase Orders

Choosing Purchase Orders Options
Once you have activated Purchase Orders, your first task is to use the
Purchase Orders Options form to enter general ledger information and
choose which Purchase Orders options you want to use.
Your choices determine how your Purchase Orders system operates and
the types of data that it stores and displays. You can also use the form
after setup to review your entries and, as needed, change most of them.
Using the Purchase Orders Options data-entry form. You can record
the options you want to use on the Purchase Orders Options form, one of
the data entry forms shipped with Purchase Orders.
You can transfer the information from the completed form to the Options
form when you set up your system.
Company Information
You keep and update most company information using the Company
Profile form in Common Services. However, you can store the name of a
Purchase Orders contact person or position, and enter their telephone
and fax numbers on the Company tab of the Options form.
The Company tab also displays the name and address entered for the
company in Common Services. To change the company name and
address, use the Company Profile form in Common Services.
See also
Selecting processing options
Selecting document numbering options
Selecting optional fields
Selecting G/L integration options
Setting up Purchase Orders without Inventory Control (stand-alone)
Steps for setting up Purchase Orders

Setting Up Optional Fields
You must install Sage ERP Accpac's Transaction Analysis and Optional
Field Creator before you can use optional fields.

To set up optional fields:
1.Set up system-wide optional fields in Common Services.
Before adding optional fields for Purchase Orders, you first define
optional fields for all of your Sage ERP Accpac system using the
Optional Fields form in Common Services.
2.Use the Optional Fields form in the P/O Setup folder to:
a.

Assign optional fields to:
Requisitions, purchase orders, receipts, invoices, returns, and
credit/debit notes.
Requisition, purchase order, receipt, invoice, return, and
credit/debit note transaction details.
Additional costs and receipt additional costs.
Receipt additional cost details, invoice additional cost details, and
credit/debit note additional cost details.
Item records defined in Purchase Orders (if you are not using
Inventory Control).

b.

Specify a default value for each optional field that you add to
Purchase Orders (depending on the type of field), and indicate
whether the optional field will be automatically inserted in new
records or transactions.
If an optional field requires validation, you can select only a value
that is assigned to the optional field in Common Services. (If the
optional field allows blanks, you can leave the default value field
blank.)
If the optional field does not use validation, you can select a value
from the list (if any were assigned in Common Services), leave the
field blank, or enter any value that is consistent with the type of
field (yes/no, text, number, date, amount, and so on) and does not
exceed the maximum number of characters permitted for the
optional field.

c.

Use the Optional Fields Settings button to specify which optional

fields will be sent through to other Sage ERP Accpac subledgers,
and which will be included in transactions that will be passed to
General Ledger for posting to G/L accounts.
By default, all optional fields in Purchase Orders that match fields
in Accounts Payable and in General Ledger accounts will be
passed to A/P and G/L unless you restrict the fields using the
Settings button.
For example, the Settings button for invoice detail optional fields,
lets you choose the types of G/L accounts that will get optional
field information from invoice details, and the details in an
Accounts Payable invoice that will get optional field information.
Note: The Settings button is only active for those forms that pass
information to another Sage ERP Accpac program. For example,
invoice optional fields can be passed to Accounts Payable, but
requisitions are used only in the Purchase Orders program.
3.Make sure that you use the same optional fields for invoices in
Accounts Payable and for general ledger accounts in the General
Ledger program in order to pass information between programs.
Optional fields that flow to A/P. The following optional field
information can be passed to Accounts Payable from Purchase
Orders (and from Accounts Payable to G/L through payables
transactions):
Invoice/credit note/debit note header and detail optional fields if the
optional fields assigned to Accounts Payable invoices match the
optional fields assigned to Purchase Orders invoices and credit/debit
notes.
Optional fields that flow directly to G/L. The following optional field
information can be passed to General Ledger directly from Purchase
Orders:
Invoice/credit note/debit note detail optional fields if the transaction
optional fields assigned to G/L accounts match the optional fields
assigned to P/O invoice and credit/debit note details.
Receipt and return detail optional fields if the transaction optional
fields assigned to G/L accounts match the optional fields assigned to

P/O receipt and return details.
If you use Sage ERP Accpac Project and Job Costing, you can also
specify whether optional field information for job-related transactions
will be passed to Project and Job Costing (as an external cost
transaction).
See also
Selecting Processing options
Selecting Document Numbering options
Selecting G/L Integration options
Steps for setting up Purchase Orders

E-Mail Messages Form
You can create e-mail messages to use when sending purchase orders
and returns, specifying codes for adding information specific to the
vendor or specific to your company. Each e-mail message is identified by
a unique 16-character message ID code.
To e-mail purchase orders and returns,you must:
Choose E-mail or Contact's E-mail as the delivery method for the
vendor in the Accounts Payable.
You must select Vendor as the Delivery Method when you print
Returns and Purchase Orders. You select the particular e-mail
message that you want to use when print the purchase orders or
returns.
The form for creating e-mail messages is located in the P/O Setup folder.

To use the E-mail Messages form:
1.Select either Return or Purchase Order in the Message Type field.
2.In the Message ID field, enter a code to identify this message, using
up to 16 characters.
3.In the Description field, enter a description for the message, using up
to 60 characters.
4.Enter the subject of the message in the E-mail Subject field.
5.Enter the body of the message. Use information codes, preceded by a
dollar sign, to identify variable information that you want to include
with the message.
6.Click Add or Save when you are satisfied with the message.
Select the Inactive option only if you wish to make this message
unavailable for use.
The Last Maintained field shows the last time you modified this e-mail
message.
See also

E-mail Message Information Codes

Using Forms
To open a form, double-click the corresponding icon on the desktop (or
click it, if you are using Sage ERP Accpac through your browser).
To display a tab on a form, click it.
See also
Changing column order in data-entry forms
Changing column widths in data-entry forms
Data entry tools and shortcuts
Using Help
Working with Detail Entry Grids

Glossary
1099 Form
A/R Invoice Type
Account Description
Account Groups
Account Number Segment Overrides
Account Number Segments
Account Number Structures
Account Segment
Account Set
Account Status
Account Types
Accounting Equation
Accounting Method
Accounting Period
Accounts Payable
Accrual
Accrual Carry-Over Date
Accrual Method
Accrual-Basis accounting method
Accrued Expenses
Activating taxes
Activation
Active Order
Actual Fiscal Sets
Adjustment Period
Adjustments
Advance
All Users
Allocated Tips
Allocation Account
Allow Posting to Previous Years
Allow Provisional Posting
Annual Maximum
Annualization
Assets
Assign UI Profile IDs
Audit Trail
Authentication Method
Automatic Reversal
Backdated document
Bad Debts
Balance Sheet
Base Account
Base Deductions
Base Earnings
Base Hours
Base Taxes
Base Wage Multiplier
Basic Account Information
Basic Project style
Batches
Benefit
Billing Type
Billings And Costs accounting method
Budget Fiscal Sets
Calculation Base
Calculation Methods
Calculator
Carrying Over Vacation, Sick, and Compensatory Time Accruals
Carry-Over
Cash Advance
Cash Benefit
Cash Flow Statement
Cash Method
Category
Category Percentage Complete accounting method
Ceiling
Chart of Accounts
Class Codes
Classified Statements

Clearing Exchange Gain or Loss
Close to Segment / Account
Closing Account
Closing Period
Closing the Books
Common Stock
Company Database
Company Desktop
Company Profile
Compensatory Time
Completed Project accounting method
Consolidated Batch
Control Account
Control Account for Subledgers
Conversion Rate
Corporation
Cost Accounting
Cost Center Overrides
Cost Center Segments
Cost of Goods Manufactured
Cost of Goods Sold
Cost Plus project
CPRS
Credit
Currencies
Currency Rate Type
Currency Rates
Currency Table
Current Assets
Current Liabilities
Custom (and Local) Taxes
Customization Directory
Customize User Interface
Database
Database ID
Date Matching
Debit
Decimal Places for Quantity
Deduction
Default Closing Account
Default Currency
Default Hours
Default Rate Type
Default Source Code
Defining a Source Journal
Defining Meaningful Account Number Segments
Delimiter Character
Depreciation
Detail and Consolidated Posting Options
Detailed Batch
Details
Direct Labor Costs
Distribution Accounts
Distribution Code
Distribution Set
Dividend
Drilldown
Earning/Deduction
Earning/Deduction Frequencies
Earnings
Edit Imported Entries
Effective Date
Employee History
Employee Level Security
Employee Selection List
EMU
Equity
Euro Conversion Rates
Euro Currency
Euro Option
Exchange Gain or Loss
Exchange Rate
Expense Reimbursement
Expenses
Exporting

Factory Overhead
Federal and State Taxes
Field
Financial Statements
Finder
Fiscal Calendar
Fiscal Periods
Fiscal Sets
Fiscal Year
Fixed Assets
Fixed Price project
FOB Point
Force Listing of Batches
Foreign-currency Bank
Functional Currency
Functional Currency Code
Functional-Currency Equivalent
Future Order
G/L Batch
G/L Options -- Account tab
G/L Options -- Company tab
General Ledger Account
Gross Pay
Gross Profit on Sales
History
Imported Account Data
Imported Batches
Importing
Income
Income Statement
Information in G/L Accounts
Integration Access Pack
Integrity Check
Inventory
Invoice Type
Journal
Journal Entry
Labor Hours Percentage Complete accounting method
LanPak
Last Run Date
Last Year Information
Ledger
Level
Liabilities
Local and Other Custom Taxes
Lock Budget Sets (1-5)
Long-Term Liabilities
Lookup Table
Macro
Maintain Quantities Options
Manual Check
Matching Concept
Menu Bar
Miscellaneous Charge
Multicurrency Accounting
Multicurrency Bank
Multicurrency Fiscal Sets
Multicurrency G/L Accounts
Multicurrency G/L Option
Net Pay
No Users
Normal (Account) Balance
Number of Fiscal Periods
Optional Fields
Original Invoice
Override Segments
Overtime Rate Multiplier
Overtime Schedule
Owner Equity
Partnership
Pay Factors
Payroll Class Codes
Payroll Distribution Accounts
Period Minimum and Period Maximum
Periods Per Year

Picking Slip
Post in Specified/All Currencies
Posting
Posting Statistics
Posting tab in G/L Options
Preferred Stock
Prepaid Expenses
Price List
Printing Scheduled Reports
Printing Source Journal Definitions
Profile ID
Profit
Profit and Loss Statement
Profit Center
Programs (Applications)
Project Percentage Complete accounting method
Project Type
Provisional Fiscal Sets
Provisional Posting
Provisional Posting Journal
Quantities in G/L Accounts
Quantity Fiscal Sets
Quarter With 4 Periods
Quote
Rate Operation
Rate Type
Rates
Realization
Realized Exchange Gain or Loss
Reallocation Account
Recognized Exchange Gain or Loss
Reconcile (Bank)
Record
Record of Employment
Recurring Transaction
Remit-to Location
Repayment Deduction
Reported Tips
Reporting Currency
Restart Record
Retainage Accounting
Retainage Invoice
Retained Earnings
Revaluation
Revaluation Codes
Revenues
Reversed Unrealized Exchange Gain or Loss
Salary and Wages
Salary and Wages Payable Account
Sales
Sales Table
Sample Account Segments
Schedule Code
Schedule Reports
Schedule Transactions
Script
Security Group
Segment Codes Validation
Selection List
Service Years
Services
Session Date
Settlement Rate
Settling Transactions
Shareholders
Shareholders' Equity
Shift Differential Rate
Shift Differential Schedule
Ship-Via Code
Sick Time
Sole Trader
Source Codes
Source Currency
Source Document
Source Journal Profiles

Source Journals and Consolidated Transactions
Specific User
Spread
Standard Project style
Standing Order
Statement of Retained Earnings
Status
Stock
Subsidiary Ledger
Surtax Multiplier
Suspense Account
System Database
Tax Authorities
Tax Classes
Tax Groups
Tax Tables
Template (employee setup)
Time And Materials projects
Timecards
Tip Disbursement
Total Cost Percentage Complete accounting method
Transaction Rate Type
Trial Balance
Type
UI Profile ID
UI Profile Maintenance
Unrealized Exchange Gain or Loss
User Authorization
User Record
Vacation Time
Wage Bracket Table
Wage Garnishment
Web Desktop
Withdrawal
Workers' Compensation Code
Worksheet
Years of Fiscal Sets
Years of Transaction Detail

New Features in Purchase Orders 5.6
Purchase Orders version5.6A includes reporting enhancements as well
as features for handling serialized and lotted inventory, which previously
required installation of a separate Accpac application.

Serialized Inventory and Lot Number Features
Previous to the 5.6 release, a separate Sage ERP Accpac application
was required to handle inventory items with serial or lot numbers.
Purchase Orders 5.6 now has integrated features for serialized and lotted
inventory items. You may be prompted to generate or enter serial and/or
lot numbers when specifying quantities during the following tasks:
Entering Receipts
Generating Invoices
Creating Debit or Credit Notes
Processing Returns

New Reporting Features
The Purchase Order Action report now allows you to select by document date and
sort by item number.
The Purchase History Report now has options to include serial and lot numbers
on the report and select by document date. As well, when the
Purchase History Report is opened using the Purchase History inquiry
form, the selections made in the original inquiry are used to
automatically fill in fields in the Purchase History Report form.
The Purchase History inquiry form allows you to view serial and lot numbers for
selected transaction that involve serialized or lotted items.
You can now include serial and lot numbers when printing Posting Journals and
transaction listings.
The Purchase History Report now has an option to print by document date.
You can include serial and lot numbers when printing Receiving Slips and
Return Forms.
In addition to the new program features, there are also changes to the
documentation included in Purchase Orders 5.6 program.
See also
Features Added in Purchase Orders 5.5A
Features Added in Purchase Orders 5.4A
Features Added in Purchase Orders 5.3A and 5.3B

Features Added in Purchase Orders 5.5
This topic lists the features added to Purchase Orders in version 5.5A,
and provides further explanation for some of these features.
Purchase Orders 5.5 included the following enhancements:
Specify costs on requisitions.
Copy Purchase Orders like the Order Entry feature Copy Orders.
Optionally require approvals for requisitions.
Choose whether POs are allowed for non-existing vendors.
Inquire on items that are expected to arrive within a specified date range.
Support for multiple customers in each contract.
Support for units of measure conversions in job-related transactions.
Optionally update the most recent cost and last cost at receipt time or at invoice time.
Cost inventory items during posting but delay creating transactions and audit information until you run Day End
Processing.
Transfer assets to the Sage Fixed Assets (FAS) module when receiving items for internal use.
Turn off warnings that items do not exist.
Enter different document dates and posting dates for transactions.
Specify the source type codes for G/L transactions.
Override the vendor account set during purchase order entry.
Post transactions faster.

See also
Features Added in Purchase Orders 5.4A
Features Added in Purchase Orders 5.3A and 5.3B
Adding Optional Fields to Purchase Orders Forms
Integration with Project and Job Costing
Retainage Accounting for Job-Related Receipts and Invoices
?Use Custom Form? Check box for Purchase Orders and Returns
Purchase Orders Documentation

Features Added in Purchase Orders 5.4
This topic lists the features added to Purchase Orders in version 5.4, and
provides further explanation for some of these features.
Purchase Orders 5.4 added the following features:
Set up contract pricing for inventory items, including regular vendor
costs, volume discounts, sale costs, item tax statuses, and default
units of measure.
All vendors — contract costs appear in the Finder on the Purchase
Order, Receipt, Invoice, Return, and Credit/Debit Note entry forms. As
a result, users can easily review vendors — contract cost information
while entering a purchase order documents.
Vendor contract costs provide the default unit cost of items in
Purchase Order documents. If contract costs don't exist for an item,
the program uses the default unit cost specified in P/O Options in the
Purchase Order Entry or Receipt Entry form.
Report taxes on retainage amounts when you issue the original
invoice or when you issue the retainage amounts.
Purchase Orders uses the settings for the tax authority in Tax
Services, and the Report Tax setting in Accounts Payable to decide
whether to report all tax on the original invoice or hold back the tax
amount for the retainage portion.
Print the invoice posting journal showing audit information for the
invoices that are created in Accounts Payable and for any General
Ledger entries created from posting the invoice.
Posting Journals -- Features

Assign specific users security rights to view and enter item costs
during receipt entry.
In version 5.4, users with Receipt Entry rights only can create receipts
from POs, specify quantities received, and post receipts, but they
cannot see any cost information.
This means that receiving dock staff can fill in receipts without seeing
any other accounting system information.

Automatically post General Ledger and Accounts Payable batches
created from Purchase Orders.
Create G/L Transactions by
Post A/P Batches

Specify a tax reporting currency and automatically calculate taxes in
source currency, functional currency, and tax reporting currency. (This
feature provides support for legislation in several tax jurisdictions.)
Tax Reporting Currency

If you are not using Inventory Control, set up weight units of measure
and assign them to items on the purchase item list. This allows you to
accurately prorate additional costs by weight.
Setting Up Weight Units of Measure

Other features added to all Sage ERP Accpac 5.4 applications:
Optional Fields in Finders
Optional fields now appear in Finders for Purchase Orders records, so
you can search for and select records using the entries in optional
fields.
Required Optional Fields without Default Values
In version 5.3 of Sage ERP Accpac, you had to specify a default value
for any optional fields that were required in transaction forms or
records. This is no longer the case. Note, however, that you must
make an entry for all required fields before you can save records or
post transactions.
Setting Up Optional Fields

G/L Integration Options
Like other Sage ERP Accpac 5.4 products, Purchase Orders lets you
choose the information that appears in description, reference and
comment fields for General Ledger transactions generated from P/O
transactions.
You specify this information on the G/L Integration form, where you
can also choose to automatically post all General Ledger batches that
are created by Purchase Orders.
Choosing G/L Integration Options

See also
Features Added in Purchase Orders 5.5A
Features Added in Purchase Orders 5.3A and 5.3B
Adding Optional Fields to Purchase Orders Forms
Integration with Project and Job Costing
Retainage Accounting for Job-Related Receipts and Invoices
"Use Custom Form" Check box for Purchase Orders and Returns
Purchase Orders Documentation

Selecting G/L Integration Options
General ledger transactions are created from Purchase Orders
transactions at one of the following times:
Whenever you choose, using the Create Batch Icon in the Purchase
Orders Periodic Processing folder.
You choose this option from the G/L Integration form in the Purchase
Orders Setup folder.
When you post transactions.
Choose to cost inventory items during posting (in the Inventory
Control Options form, if you are using the Inventory Control
module, or in the P/O Options form if you are not using I/C).
Do not choose to create G/L transactions using the Create Batch
icon in the G/L Integration form. Choose to create G/L transaction
during posting. (Note: If the program is set to cost items during
Day End Processing, choose During Day End Processing, and
then change the setting for costing inventory items.)
When you run Day End processing.
Choose to cost inventory items during Day End Processing (in the
Inventory Control Options form, if you are using the Inventory
Control module, or in the P/O Options form if you are not using
I/C).
Do not choose to create G/L transactions using the Create Batch
icon in the G/L Integration form. Choose to create G/L transaction
during Day End Processing. (Note: If the program is set to cost
items during posting, choose During Posting, and then change the
setting for costing inventory items.)
If you installed and activated Sage ERP Accpac General Ledger,
Purchase Orders, and Inventory Control for the same database, the
general ledger transactions are automatically placed in new general
ledger batches (and optionally posted) or added to existing batches either
when you post Purchase Orders transactions, or run day-end processing,
or use the Create Batch icon at a later time that you choose.

If your general ledger is at another location or in a separate database,
Purchase Orders' general ledger transactions are appended to a file you
can import into another general ledger, or print, then enter manually into
your general ledger.
The G/L Integration options you can select include:
Adding G/L Transactions to Existing Batch
Posting Transactions Automatically to the General Ledger
Consolidating G/L Batches
Create G/L Entries for Expensed Additional Costs
Create G/L Entries for Non-Inventory Expenses from Receipts/Returns
Create General Ledger Transactions
G/L Reference Field
G/L Entry Description Field
G/L Detail Description Field
G/L Detail Comment Field
Default Inventory Expense Account
Default Cost Expense Account
Expensed Additional Cost Payables Clearing Account
Non-Inventory Payables Clearing Account

The Integration tab in the G/L Integration form also displays the day-end
number up to which you have created general ledger batches. You can
compare this number to the current day end number in the P/O Options
form to make sure you have created all outstanding general ledger
transactions.

Changing your choices for General Ledger
options
You can change your selections for all the general ledger options in the
Purchase Orders G/L Integration form at any time. Your new choices are
used only in the general ledger transactions that are created after you
make the change, and do not affect general ledger batches that already
exist.

Using Purchase Orders and General Ledger at
the same site
If you use Sage ERP Accpac General Ledger with Purchase Orders, the
Purchase Orders general ledger batches are created in General Ledger.
To avoid making accidental changes to General Ledger batches created
by Purchase Orders, select No Edit for the Edit Imported Entries option in
the General Ledger Options form.
See also
Reporting General Ledger data
Selecting Processing Options
Selecting Document Numbering Options
Selecting Optional Fields
Steps for setting up Purchase Orders

Entering Purchase Orders Setup Information
Before you add transactions to Purchase Orders, define the transactionentry templates you want to use and add records for the shipping
methods and additional costs (such as service and handling charges) you
frequently enter with purchase orders and other transactions.
You do not have to use templates or ship-via codes in Purchase Orders,
and you need to add records for additional costs only if you enter these
costs as separate amounts on transactions.
Choose icons from the Setup folder to add these records:
Setting up account sets (stand-alone program)
Setting up additional cost codes
Setting up items (stand-alone program)
Setting up ship-via codes
Setting up templates
Setting up vendor details

See also
Designing Purchase Orders codes
Importing and exporting Purchase Orders setup records
Setting up Purchase Orders without Inventory Control (stand-alone)
Steps for setting up Purchase Orders

Allowing Transactions That Use Fractional
Quantities
The option Allow Fractional Quantities is available in Purchase Orders
only if you do not use Inventory Control.
To allow transactions that use fractional quantities (you can use up to four
decimal places), select the Allow Fractional Quantities option on the
Processing tab in the Options form. You can select the Allow Fractional
Quantities option at any time but, once you select the option, you cannot
change back.
Fractional quantities are useful if your inventory includes homogeneous
items. (Homogeneous items are those with identical elements which can
be broken down into multiple, smaller units, such as oil or grain.) These
items can require a wide range of units of measure.
Instead of using the smallest unit (such as ounces) as the stocking unit,
use a larger stocking unit (such as pounds) and fractional quantities for
amounts less than a pound.
If you do not intend to enter any transactions that use fractional
quantities, you can simplify transaction entry by not selecting the Allow
Fractional Quantities option. This means you do not have to enter
decimal places for quantities, and it means that unnecessary decimal
places do not appear on reports.

Defining a Unit of Weight for Items
If you do not use Inventory Control, you can specify a weight unit of
measure (such as pounds or kilograms) that you will use for all items in
the Purchase Orders item list.
Purchase Orders can use the weight unit of measure to prorate
(distribute) additional costs on orders.
If you change the weight unit of measure, you need to update the weight
in each previously added item record to make it consistent with the new
weight unit of measure.
For example, suppose the weight unit of measure is kilograms and you
add an inventory item that weighs one kilogram. If you then change the
weight unit of measure to pounds, you need to change the item’s weight
to 2.2 to agree with the new weight unit of measure.

Setting Up Account Sets
The Account Sets form is available in Purchase Orders only if you do not
use Sage ERP Accpac Inventory Control. If you use Inventory Control,
you set up account sets using that program.
Account sets are groups of general ledger accounts to which you post
Purchase Orders transactions. By defining more than one account set,
you can separate information for different types of items in your general
ledger.
You can use as many account sets as you need for your inventory items.
For example, you may wish to use separate account sets for different
item categories, for items assembled in different areas, or for items
obtained from different suppliers.
When you add an account set, you enter a unique code of up to six
characters to identify the set, and a description (for example, Assembled
Items). Account set codes can contain letters and numbers.
For each account set, you enter account numbers for the following
general ledger accounts:
Payables Clearing. A suspense account to which Purchase Orders
posts the "other side" of the accounting entries for items you receive
(and for previous receipts you return to suppliers).
Purchase Orders normally generates credit entries to this account for
items you receive. Therefore, the account can be thought of as the
accrued amount payable for goods received. Purchase Orders debits
this account when you enter receipt returns.
As you post the related vendor invoices in Sage ERP Accpac
Accounts Payable, offsetting journal entries (debits) related to the
items purchased are generated against the Payables Clearing
account to clear the balance that is left in this account from posting
the inventory receipt.
Inventory/Expense.The account that you debit when you when you
receive items and credit when you enter returns.
For step-by-step instructions on using the Account Sets form to add, edit,

or delete an account set record, see Account Sets form.
Return to Setting up Purchase Orders without Inventory Control.

Setting Up Items
Before you can enter inventory transactions, you need to add item
records. Item records contain information about items that you regularly
purchase from your vendors for sale to your customers.
The Items form is available in Purchase Orders only if you do not use
Sage ERP Accpac Inventory Control. If you use Inventory Control, you
set up items in that program.
Note that you must set up account sets before you can add item records
to Purchase Orders.
You record the following information for each item that you want to add to
your inventory list:
The number you use to identify the item. Item numbers can be up to
24 characters, and can contain blanks and special characters.
A description of the item.
The account set the item uses. (You assign an account set to define
the general ledger balance-sheet accounts for the item.)
(Optional) A commodity number if your company reports a valueadded tax (VAT).
The unit weight (the weight of one stocking unit of the item). The
weight must be in the same weight units (such as pounds) that you
specified in the Options form.
The name of the unit of measure and the conversion factor associated
with one stocking unit of the item. (For example, if the unit of measure
is "dozen," you type 12.)
(Optional) Tax information used to calculate tax amounts, including
the taxing authority and tax classes for purchases and sales of the
item.
Up to 300 characters of additional item information.
For step-by-step instructions on using the Items form to add, edit, or
delete an item record, see Items form.
You can import item records into Purchase Orders from non-Sage ERP

Accpac programs, instead of entering them in the Items form. For
information about importing item records, see Importing and Exporting Setup Records.
Return to Setting up Purchase Orders without Inventory Control.

Setting Up Vendor Details
The Vendor Details form is available in Purchase Orders only if you do
not use Sage ERP Accpac Inventory Control. If you use Inventory
Control, you set up vendor details in that program.
You use the Vendor Details form to link each item record to up to nine
vendors. You also use this form to record details about each vendor and
the costs for the item.
When a vendor is linked to an item record, you can select the vendor's
item number as you enter item details on requisitions and purchase
orders. Purchase Orders fills in the cost of the item for you, and prints the
vendor's item number, rather than your company's item number, on the
purchase order.
You normally assign vendors to an item record in order of priority. For
example, if you buy the same item from more than one vendor, you would
assign Vendor 1 to the vendor you use most often.
Note that before you can add vendor detail records, you need to add item
records in Purchase Orders and add the vendor records in Accounts
Payable.
For step-by-step instructions on using the Vendor Details form to add,
edit, or delete a vendor details record, see Vendor Details form.
Return to Setting up Purchase Orders without Inventory Control.

Setting Up Weight Units of Measure
If you do not use the Inventory Control module, you set up weight units of
measure using the Weight Units of Measure form, and you specify the
default weight unit of measure in the P/O Options form.
Weight units of measure are the different units that you use for
measuring item weights — such as pounds, tons, kilograms, and metric
tons.
Weight units of measure are all defined in terms of a default weight unit
of measure, which is the unit used to express total order weights in
Purchase Orders.
For example, you could use the pound for the default weight unit of
measure, and be able to convert the weight of items using metric
measures.
Weight UOM

Conversion Factor

1 pound equals

Pound
Kilogram
Ton

default UOM 1
2.2
2,000

Pound — 1 lb.
.4545 kg.
.0005 tons

Default weight UOM
The default weight unit of measure is the unit for expressing the weight of
orders in Purchase Orders.
Note the following points concerning weight units of measure:
• The conversion factor for a default weight unit of measure is always 1.
• You can use fractions in weight conversion factors even if you do not
use fractional inventory quantities.
For step-by-step instructions on using the Weight Unit of Measure form to
add, edit, or delete a weight units of measure, see Weight Units of Measure form.
Return to Setting up Purchase Orders without Inventory Control.

Processing Multicurrency Transactions
You enter multicurrency transactions in Purchase Orders in the same
way as functional-currency transactions. The only extra consideration
arises if you need to change exchange rates or assign a different tax
group to the transaction.
The currency for a transaction is displayed along with the current
exchange rate when you enter a vendor number or select a tax group.
(You can change the tax group for a document only to another tax group
that also uses the vendor's currency.)
To change exchange-rate information, use the Rates tab (it appears only
with multicurrency transactions for vendors who do not use the functional
currency). You can change the rate type, rate date, and exchange rate for
the document.
When you post multicurrency transactions, Purchase Orders converts the
amounts to the functional currency, using the exchange rate information
entered with the transaction.

See also
Using multicurrency accounting in Purchase Orders

Restricting Access to Purchase Orders Data
If you are the system administrator (the ADMIN user), you can turn on
security for Sage ERP Accpac and restrict access to Purchase Orders
data.
You use Database Setup to turn on security for the system database.
You use Administrative Services to grant security authorization to users.
(First, you define security groups for Purchase Orders, selecting the
tasks that members of each security group can perform. Then, you
assign individual users to the security groups you defined).

Common Inquiry
With this security assignment users can:
View all setup icons, including Options, Ship-Via Codes, Vendor
Contract Costs, Templates, Additional Costs, E-mail Messages,
Optional Fields, and G/L Integration.
Print and preview setup reports, including Options, Ship-Via Codes,
Vendor Contract Costs, Templates, Additional Costs, E-mail
Messages, Optional Fields, and G/L Integration.
Also, in a stand-alone system, users can setup and access setup reports
for Account Sets, Items, Vendor Details, and Weight Units of Measure.

Account Sets Form Field List
Account Set Code
Description
Inactive
Last Maintained
Inventory/Expense Account
Payables Clearing Account

Finder or
The Finder lets you search the various lists of codes maintained in or
used by Purchase Orders (such as vendor numbers, terms codes, and
item numbers).
Color options let you highlight a field using color for the text or for the
background.
The Search First option lets the user decide the starting point for the
Finder: either to start in the Filter field or in the first line of the display.
Searches can be done on any field, including number fields.
The Field Name as Column Heading option lets users use field
descriptions or internal field names as column headings.
The Columns option displays all the processing fields.
If the user does not have rights to view information, that information
will not be displayed in the Finder.
The Finder is active only in fields that display the Finder icon.
You can use Auto Search option in the Finder to locate a record quickly in
a long list. Select the Auto Search option and the criteria by which you
want to search, for example the letters in a customer name. Then, in the
space provided, begin typing the characters that start or are contained in
the field you are searching on, until the program displays the record you
need.
Note that the records that appear with the Finder are restricted by any
selection criteria you have applied to this field. If you cannot find the record
you are looking for with the Finder or the navigation buttons, check the
Finder to see whether any criteria are being used to limit the selection. If
necessary, remove the selection criteria.
Press the F1 key when the Finder appears for more information about
using the Finder.

Navigation Buttons
Click the buttons next to a field to display the first, previous, next, or last
record, batch, or entry.
If you cannot find the record you want, check the Finder to whether any
criteria are being used to limit the selection. (Choose the Finder, then
click the Set Criteria button to see or change the current criteria.)

New Button
Click the New button to begin creating a new record.

Additional Costs Form Field List
Additional Cost (code)
Amount
Currency (multicurrency ledgers)
Description
Expense Account
Inactive
Last Maintained
Optional Fields
Proration
Return Account
Return Proration
Tax Authority Description (display only)
Tax Authority
Tax Class Description
Tax Class
Vendor Number

Setting Up Additional Cost Codes
You can use additional cost codes to identify the extra costs, such as for
shipping and handling, that your vendors or carriers charge on the orders
they send to you. When you enter the codes with receipts, invoices,
credit notes, or debit notes, the corresponding information is displayed for
you to accept or change, as needed.
You can also add additional costs to transactions without using additional
cost codes.
To set up an additional cost code, you create a record that includes:
A unique code of up to six characters to identify the cost.
An optional description of the cost.
The vendor number (optional).
The amount of the cost (optional).
The method by which you prorate the cost over items on a receipt.
The general ledger expense account to which you post amounts for
costs you expense (do not prorate).
The method you use to reprorate additional costs that were prorated to
items that you returned.
The general ledger account to which you post cost amounts on
returns when you expense the costs (that is, you do not prorate
them).
Optional field information if you added fields to the Additional Cost
form.
The tax authorities and purchase tax classes that apply to the cost, if
any.
If the cost is taxable, you specify all the tax authorities and purchase
tax classes that apply to the cost, so that Purchase Orders can
calculate correct tax amounts for you when you enter transactions for
the cost. When you prorate taxable additional costs, the tax amount is
added to the additional cost, then the total amount is prorated.

You select from the tax authorities and purchase tax classes you have
set up for your company in the Tax Services forms in Common
Services.
Creating additional cost records. Choose the Additional Costs icon
from the Setup folder to create records for the additional costs in your
Purchase Orders system.
For more information about how Purchase Orders handles additional
costs, see Entering additional costs on receipts.

G/L Integration Form Field List
Integration tab
G/L Transactions Generated Through Day End Number
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by
Create G/L Entries for Non-Inventory Expenses from Receipt/Return
Create G/L Entries for Expensed Additional Costs
Default Inventory Expense Account
Default Cost Expense Account
Non-Inventory Payables Clearing Account
Expensed Additional Cost Payables Clearing Account
Transaction Type
Source Ledger
Source Type

Transactions tab
G/L Detail Comment
G/L Detail Description
G/L Detail Reference
G/L Entry Description

G/L Integration — Transactions Tab
Use this form to:
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in G/L
transactions arising from invoices and shipments.
Look up the last Day End Number for which you have created general
ledger batches.
Click the field list button or one of the links below for more information on
selecting G/L integration options.
Integration tab

Changing Settings
You can change any of your choices in the G/L Integration form at any
time. However, you should be aware that any changes you make will
apply only to general ledger transactions created after the change, and
will not affect existing general ledger batches.

Before using the G/L Integration form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact the options have
on processing within Purchase Orders.
See also
Additional Costs
Choosing Purchase Orders options
G/L Integration
Optional Fields
Options report
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Changing settings

Changing Settings
You can readily change most of your choices in the Options form.
Before changing settings — Before changing any of the settings or
other information in the Options form, make sure you understand the
impact the options have on processing within Purchase Orders.
Before attempting to save changes to the Options form, make sure that
no other users are using the data for the Purchase Orders company and
that no other Purchase Orders forms are open for the company on your
computer. You cannot save most changes if other Purchase Orders forms
are open.

Company name and address
To change the contact name, telephone number and fax number for the
Purchase Orders administration, use the Options form in the Setup folder.
Use the Company form in Common Services to change the company
name and address, or to change the contact name, telephone number,
and fax number at the company level.

Multicurrency option
You make your choice about the Multicurrency option in the Accounts
Payable Options form, turning it on or not for Purchase Orders as well.
Once you select the option in Accounts Payable, you cannot turn it off.
If you will be using the Multicurrency option in Purchase Orders, you also
specify a default rate type to use when converting multicurrency
Purchase Orders transactions to the functional currency.

History and statistics
You should change the type of year and period by which you keep
statistics only at year end. If you change partway through a year, figures
will be distorted in some periods and you will have to make corrections in
all records for which you keep statistics.
Note: The Small Business Edition accumulates statistics by fiscal year

and fiscal period.
Go back to Options Form — overview

Items Form Field List
For help about the fields in the Items form, select from the keywords
listed below:
Item tab
Account Set Code
Comment
Commodity Number
Description
Inactive
Item Number (code)
Last Maintained
Unit Weight

Units tab
Unit Of Measure
Conversion Factor

Item Taxes tab
Purchase Tax Class
(Tax) Authority
Tax Class Description

Optional Fields tab
The Optional Fields tab contains optional fields added by your company
to the Items form. These fields will appear by default on transaction forms
as long as the transaction forms contain the same optional fields.
This tab will appear only if you have Sage ERP Accpac's Transaction
Analysis and Optional Field Creator.

Items Form — Items Tab
Use this tab to:
Enter identifying information about the item, such as the item number
and description, the account set code to be used for the item in
transactions, the commodity number (if you are required to report VAT
amounts), the unit weight for the item, as well as additional
description item information that you can print on customized forms.
Click these buttons for help on using them:
Finder

Navigation
buttons

New

For information about another tab, click the corresponding link:
Units

Taxes

Optional Fields

See also
Items report
Options form
Setting up items
Setting up Purchase Orders without Inventory Control
Steps for setting up Purchase Orders

Items Form — Units Tab
Use this tab to:
Enter units of measure and the conversion factor for each. (You must
enter a stocking unit of measure with a conversion factor of 1.)
Click these buttons for help on using them:
Finder

Navigation
buttons

New

For information about another Items tab, click the corresponding link,
below:
Items

Taxes

Optional Fields

See also
Items report
Options form
Setting up items
Setting up Purchase Orders without Inventory Control
Steps for setting up Purchase Orders

Items Form � Taxes Tab
Use this tab to:
Codes for the taxing authorities you want to assign to the item. (You
define taxing authorities in the Tax Services folder of Common
Services.)
Codes for the tax classes you want to assign to the item for
purchases for each selected tax authority.
Click these buttons for help on using them:
Finder

Navigation
buttons

New

For information about another Items tab, click the corresponding link:
Items

Units

See also
Items report
Options form
Setting up items
Setting up Purchase Orders without Inventory Control
Steps for setting up Purchase Orders

Items Form — Optional Fields Tab
This tab appears if you have assigned optional fields to the Items form
(using the Optional Fields form in the Setup folder).
Use the tab to:
Add or change information in the optional fields that are assigned to
this item.
If you have assigned the same optional fields to transaction entry forms,
this information in these fields will appear by default on new transaction
details for this item.
To enter optional information, type or choose your entry for each
optional field.
If the optional field has a Finder, you can select one of the entries from
the Finder list. Depending on how the list has been set up, you may be
able to leave the field blank.
Click this icon for information about using the Finder:
Finder

For information about using a different tab on the Items form, click the
corresponding link:
Items

Units

Taxes

See also
Items report
Options form
Setting up items
Setting up Purchase Orders without Inventory Control
Steps for setting up Purchase Orders

Optional Fields Form Field List
uto Insert

A
Default Value and Description
Optional Field and Description
Optional Fields For
Required
Value Set

Optional Field Settings
Optional Field settings let you restrict the amount of information that is
passed to Accounts Payable and General Ledger when you post
transactions in Purchase Orders that use optional fields.
When defining an optional field for use with transactions, click the
Settings button (or double-click the line on the Optional Fields grid). A
separate form opens, listing the groups of accounts in other ledgers that
are affected when you post transactions of the type for which you are
defining the optional field.
Select whether you want to pass optional field information to Accounts
Payable with invoices, credit notes and debit notes, and select the
account groups for which you want to pass values to General Ledger
when you post transactions that include the optional field.
Note:
You must also use the same optional fields in Accounts Payable
Invoices to pass information to Accounts Payable, and use the same
optional fields in General Ledger accounts to pass information to
General Ledger.
Although all account groups are initially selected for new optional
fields, you need to consider carefully the purpose of the optional field
you are defining. You should send values to General Ledger only for
optional fields that require financial analysis, and only to accounts
where they are required. For example, you might want to send
optional fields that contain vendor numbers only to revenue accounts.
If you send all the optional fields you use in Purchase Orders
transactions to General Ledger, your G/L may become unwieldy, and
you may slow down processing considerably.
If you use Sage ERP Accpac Project and Job Costing, you can also
specify whether optional field information for job-related transactions will
be passed to Project and Job Costing, if the optional fields match those
used for billings.

Selecting Processing Options
Use the Processing tab of the Options form to record whether your
Purchase Orders system:
Permits entry of transactions using item numbers that are not included
in Inventory Control (Allow Non-inventory Items option). See Allowing entry
of non-inventory item numbers.
Saves transaction history (all details of posted transactions) to a file
for reporting (Keep Transaction History option). See Accumulating purchasing
history and statistics for reporting.
Keeps a list of all the vendors from whom you purchase individual
items (Accumulate Purchase History option). See Accumulating purchasing history
and statistics for reporting.
Saves statistical totals from posted transactions (Accumulate
Statistics option). See Accumulating purchasing history and statistics for reporting.
Requires requisition approval before they can be added to purchase
orders. See Requiring approval for requisitions.
This tab also lets you:
Enter a code that sets the default information to appear in fields you
enter on a purchase order or requisition (Default Template Code). See
Assigning a default template code.
Select the costing method by which to display default item costs on
transaction detail lines (Default Item Cost), if you use Inventory
Control. See Assigning a default item cost. (If you do not use Inventory Control,
the default item cost is set to Vendor Cost.)
Set the following options for items, if you do not use Inventory Control:
Choose whether to process transactions that use fractional quantities of
items.
Set the weight unit of measure that Purchase Orders will use to
allocate additional charges to items by weight. If necessary, you
can change the weight unit of measure after setting up your system.
However, if you have entered any weights in item records, you will

need to change them so they correspond to the new unit of
measure.
Set the default aging periods by which the program groups
outstanding orders on reports. See Defining aging periods.
You also use the Processing tab to check the functional currency for the
ledger and the choice for the Multicurrency option. In multicurrency
systems, you can specify a default rate type. See Specifying currency information.
See also
Selecting Document Numbering options
Selecting Optional Fields
Selecting G/L Integration Options
Setting Up Purchase Orders without Inventory Control (stand-alone)
Steps for Setting Up Purchase Orders

Selecting Document Numbering Options
Purchase Orders can automatically assign document numbers to each
purchase order, requisition, receipt, and return document you add, or you
can type your own document numbers as you enter the transactions.
(When entering invoices, credit notes, and debit notes, you use the
document numbers assigned by your vendors.)
To automatically assign the consecutive, unique document numbers you
need to requisitions, purchase orders, receipts, and returns, specify the
numbers to use on the Document tab of the P/O Options form. You can
probably continue using the numbering scheme from your old purchase
order system.
When you first activate your Purchase Orders system, the program
provides default document number lengths, prefixes, and numbers.
You can change all of the default information, setting a different length,
prefix, and next number for each type of document.
For more information, choose from the following topics:
Changing the next document number
Entering your own document numbers with transactions
Number of characters in document numbers
Reusing document numbers
Using default document numbers
Using Purchase Orders document numbers in Inventory Control and Accounts Payable

See also
Selecting Processing Options
Selecting Optional Fields
Selecting G/L Integration Options
Steps for setting up Purchase Orders

Options Form Field List
For help about the options and fields in the Options form, select from the
keywords listed below:
Company tab

Processing tab
Accumulate By
Accumulate Purchase History
Accumulate Statistics
Allow Edit of Statistics

(standalone Purchase Orders)

Allow Fractional Quantities
Allow Non-Existing Vendors
Allow Non-Inventory Items
Default Copy Costs to Purchase Order
Default Item Cost
Default Posting Date
Default Rate Type
Default Template Code

(standalone Purchase Orders)

Default Weight Unit of Measure
Functional Currency (display only)
Keep Transaction History
Multicurrency option (display only)

Post A/P Batches During Posting or Day End Processing / On Request Using Create Batch Icon

(if using

Inventory Control)
Period Type
Require Approval
Update Most Recent Cost and Last Cost at Receipt Costing or Invoice Costing
Warn for Non-Inventory Items

Documents tab
Aging
Document Type (display only)
Length
Next Day End Number (display only)
Next Number
Prefix

Costing tab (standalone Purchase Orders)
Cost Items During Posting or Day End Processing (standalone Purchase Orders)
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing) (standalone
Purchase Orders)

Options Form — Company Tab
This tab lets you:
Change the contact name, telephone number, and fax number for
Purchase Orders.
Depending on the choice of the Format Phone Numbers option in the
Company Profile in Common Services, parentheses and hyphens may be
inserted in telephone-number fields.
For information about another tab on the Options form, choose the
corresponding link:
Processing

Documents

Costing

For an overview of the Options form, see Options Form — overview.
Company name and address
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company form in Common Services.
Contact name and telephone and fax numbers for Purchase Orders
To change the contact name, telephone number, and fax number for the
Purchase Orders administration, use the Company tab.
See also
Additional Costs
Optional Fields
Options report
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure

Options Form — Processing Tab
This tab lets you:
Select a default rate type if your Purchase Orders system uses
multicurrency accounting.
See Using multicurrency accounting in Purchase Orders.
Change settings that determine whether you can order non-inventory
items, keep transaction history, and use a default template.
Specify the default cost type to display for item costs on transactions.
If you do not use inventory control, you can also change settings for
the item lists that you keep for Purchase Orders: whether you allow
fractional quantities, the weight unit of measure, and whether you cost
items during posting or during day-end processing.
Select settings that determine whether to keep purchase history and
statistics and the type of year and period by which you accumulate
the history and statistics.
For information about another tab on the Options form, choose the
corresponding link:
Company

Documents

Costing

Changing option selections
At any time, you can change your choices for all Processing options you
can select on this tab.
See also
Additional Costs
Optional Fields
Options report
Selecting processing options
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Details
Weight Units of Measure

Options Form — Documents Tab
This tab lets you:
Set the default aging periods for the Aged Purchase Orders report.
Assign or change the maximum length (number of characters) to use
in the document numbers Purchase Orders assigns to purchase
orders, requisitions, receipts, and returns.
Specify an optional prefix and the next number to assign for each type
of document (if you allow Purchase Orders to assign document
numbers automatically, rather than type them in yourself).
Purchase Orders uses the purchase order numbers you specify to assign
numbers to purchase orders you create automatically from requisitions,
Inventory Control reorder information, and Order Entry sales orders.
For information about another tab on the Options form, choose the
corresponding link:
Company

Processing

Costing

Changing options
At any time, you can change your choices for all document-numbering
options. To keep the document numbers unique, however, be careful not
to change to a prefix or next number that will create duplicate numbers
for a particular type of document. You cannot post requisitions, purchase
orders, receipts, or returns with duplicate document numbers.
See also
Additional Costs
Optional Fields
Options report
Selecting document numbering options
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Contract Costs
Weight Units of Measure

Options Form — Costing Tab
The costing tab appears only if you are not using the Inventory Control
module.
This tab lets you:
Specify when the Purchase Orders module should cost inventory —
either each time you post a transaction or only when you run Day End
Processing.
Specify when it should create sub-ledger and audit information.
Note: These settings have a large impact on how Sage ERP Accpac
handles transactions. They apply to all transactions created in Purchase
Orders.
If you cost inventory during posting, purchase order posting will take
longer.
If you create sub-ledger batches during posting, you may also create
and post A/P invoice batches at the same time that you post purchase
order invoices.
For information on other processing options, see selecting processing options.

Changing costing options
After setup, you can change your costing options, with the following
exceptions and restrictions:
You can switch from costing during posting to costing during day end
processing at any time.
However, you must run Day End Processing before switching to
costing during posting to make sure that you complete item costing
and to make sure that all G/L transactions have been created
properly.
For information about other tabs, click the following links:
Company

Processing

Documents

Click here for hints on using forms.

See also
Additional Costs
Optional Fields
Options report
Selecting processing options
Ship Via codes
Steps for setting up Purchase Orders
Templates
Vendor Details
Weight Units of Measure

Ship-Via Codes Field List
Address
Comment
Contact
Fax Number
Name
Ship-Via Code
Telephone

Templates Form Field List
Template Code and description

Order tab
Bill-To Location
Comment
Description
FOB Point
On Hold
PO Type
Reference
Ship-To Location

Vendor tab
Ship Via
Tax Group
Terms

Templates Form — Order Tab
Use this tab to:
Enter default information for the Order tab and for use on the first tab
of the transaction forms.
Modify default template information.
Click these buttons for help on using them:
Finder

Navigation
buttons

New

For information about the Vendor tab, click this link:
Vendor

See also
Additional Costs form
Options form
Ship Via Codes form
Steps for setting up Purchase Orders
Templates report

Templates Form — Vendor Information Tab
Use this tab to:
Enter default information for the Vendor tab in the transaction-entry
forms.
Modify default vendor information.
Click these buttons for help on using them:
Finder

Navigation Buttons

New

For information about the Order tab, choose its tab:
Order

See also
Additional Costs form
Options form
Ship Via Codes form
Steps for setting up Purchase Orders
Templates report

Using Templates
Purchase Orders templates let you speed up and simplify transaction
entry by providing default settings which appear when you start a new
transaction.
You can specify the following information for each template that you
define:
Purchase order type
FOB point
On hold
Ship-to and bill-to locations (if you use Inventory Control)
Description
Reference
Comment
Ship-via code
Tax group
Terms
You must specify the purchase order type and tax group in a template;
the other information is optional. Note that the information in a number of
the template fields can also come from other records. For example, the
On Hold, Terms, and Tax Group fields are also in the vendor records.
Default templates. You can specify a default template in the Options
form to have a standard set of default vendor and purchase order
settings appear for each new transaction you create.
Changing templates and vendors. The default template provides initial
settings, but these are overridden by settings from the vendor record —
and from another template if you choose another one after selecting the
vendor.
Vendor tax group and terms. Templates override a vendor's tax group
and terms. When you select a new template code, the vendor's tax group
and terms will be changed consistent with the new template code.

Setting Up Templates
A template is a set of default information for transaction headers (the
information that applies to all transaction details such as transaction date,
vendor, FOB point, description, and reference).
You use templates to automatically fill in fields in the Requisition Entry,
Purchase Order Entry, Receipt Entry, Invoice Entry, Return Entry, and
Credit/Debit Note Entry forms with the information and selections you use
most often, so you do not have to retype standard information every time
you add a transaction.
Templates are optional. You can enter transactions without using
templates.
If you want to use templates, use the Templates form, selected from the
Setup folder, to define them. For example, you may want to set up a
template for the vendor from whom you most frequently purchase items,
or for the types of purchase orders you enter.
For each template, you assign a unique code of up to six characters and
a description to identify the template.
You must specify the purchase order type (Active, Standing, Future,
Blanket) and the tax group for each template. You can also select codes
for the shipping and billing locations (if you use Inventory Control),
shipping method, and payment terms you want to use. You can type an
FOB point, 60-character description, 60-character reference, and
comment of up to 250 characters.
After setting up your templates, you can specify a default template code
in the Options form. This template then provides the initial settings for
every transaction you enter.
You can change the default settings in a transaction by entering a vendor
number that uses a different tax group or terms code from the default
template, or by selecting another template code that uses different
settings. You can also change any of the individual settings provided by a
template.
Multicurrency ledgers. In multicurrency systems, you can change a
transaction's template only to another template with a tax group that uses

the vendor's currency.
For information about using templates during transaction entry, see Using
templates.
Go back to Entering Purchase Orders Setup Information

Vendor Contract Costs Form Field List
Item Number
Vendor Number

Costs
Description
Base Unit Cost Type
Base Unit Cost
Base Unit of Measure
Default
Sale Unit Cost Type
Sale Unit Cost Based On
Percentage / Amount
Sale Unit Cost
Default
Sale Starts / Sale Ends

Discounts
Discount Based On
Rounding Method
Round to a Multiple
From / To
Discount Percentage / Discount Amount

Taxes
Vendor Tax Authority
Vendor Tax Class

Vendor Contract Costs Form — Costs Tab
Use this tab to:
Change the description for the item on the purchase orders to match
the vendor's description.
Choose the base unit cost type (single unit of measure or multiple
units of measure).
Enter the base cost or costs.
Enter the unit of measure for a single base cost.
If entering costs for multiple UOMs, specify the default cost and
UOM for purchase orders.
Choose the sale unit cost type (single unit of measure or multiple
units of measure).
Enter the sale cost or costs.
Specify how the sale cost is calculated:
Base unit cost minus a percentage.
Base unit cost minus an amount.
Fixed amount.
Enter the unit of measure for the cost.
If entering costs for multiple UOMs, specify the default cost and
UOM for purchase orders.
Enter the sale dates for the item.
For information about other tabs in the Vendor Contract Costs form, click
the following links:
Discounts

Taxes

For information about fields in the Vendor Contract Costs form, select the
Field List button beside the title of this help topic.
See also
Additional Costs

Options form
Ship-Via Codes
Steps for setting up Purchase Orders
Templates

Vendor Contract Costs Form — Discounts
Tab
This tab lets you:
Select the method for calculating volume discounts on costs, and
enter the discount percentages or amounts to use.
For information about other tabs in the Vendor Contract Costs form, click
the following links:
Costs

Taxes

For information about fields in the Vendor Contract Costs form, select the
Field List button beside the title of this help topic.
See also
Additional Costs
Options form
Ship-Via Codes
Steps for setting up Purchase Orders
Templates

Vendor Contract Costs Form — Taxes Tab
Use the tab to assign the tax authorities and vendor tax classes that
apply to the item.
For information about other tabs in the Vendor Contract Costs form, click
the following links:
Costs

Discounts

For information about fields in the Vendor Contract Costs form, select the
Field List button beside the title of this help topic.
See also
Additional Costs
Options form
Ship-Via Codes
Steps for setting up Purchase Orders
Templates

Adding Vendor Contract Costs
1.Double-click the Vendor Contract Costs icon in the P/O Setup folder
to open the P/O Vendor Contract Costs form.
2.Click the New button to start adding vendor contract costs.
If reviewing costs, choose whether to view costs for an item number
or a vendor.
3.On the form which appears, enter the vendor number for whom you
want to set up contract costs or select it using the Finder.
4.The Contract Costs form is similar to the I/C Item Pricing form in the
Inventory Control module. It lets you specify basic and sale costs for
single or multiple units of measure, and specify percentage or flat
amount discounts based purchase volumes.
5.Select the first item number for which you want to enter costs.
6.Fill in the cost, discount, and tax information for the item.
7.Click the Add button to add the contract cost information.

Editing Vendor Contract Costs
1.Double-click the Vendor Contract Costs icon in the P/O Setup folder.
2.Choose to edit costs by vendor number or item number.
3.Enter or select the number of the vendor or item that you want to edit.
4.Double-click the line containing the costs that you want to edit.
5.Press F1 again for help on editing item cost details when the Vendor
Contract Costs form appears.
The changes you make have no effect on current transactions. You will
see the changes the next time you select the item in a new transaction.

Deleting Vendor Contract Costs
1.Double-click the Vendor Contract Costs icon in the P/O Setup folder.
2.Choose to delete costs by vendor number or item number.
3.Enter or select the number of the vendor or item that you want to edit.
4.Click (select) the line containing the costs that you want to delete.
Double-click the line to review cost details before deleting.
5.Click the Delete button. Click Yes if you are asked for confirmation.
Deleting contract costs has no effect on current transactions. You will see
the P/O default costs the next time you select the item in a new purchase
order.

Printing Vendor Contract Costs
Choose Print from the File menu in the Vendor Contract Costs form to
print a list of your vendor detail records. You can also choose Vendor
Contract Costs from the Setup Reports folder.

Setting Up Vendor Contract Costs
The Vendor Contract Costs form lets you set up contract pricing that you
have arranged with specific vendors.
Vendor Contract costs appear by default when you add purchase orders,
receipts, invoices, returns, and credit/debit notes. If no contract cost
exists for an item and vendor, Purchase Orders displays the Default Item
Cost specified in the P/O Options form.
You can also view all vendors’ contract costs in the item Finder for the
Unit Cost field in the Purchase Order, Receipt, Invoice, Return, and
Credit/Debit Note Entries forms.
Note: Vendor Contract Costs are not available in Sage ERP Accpac 100.

To set up vendor contract pricing:
1.Double-click the Vendor Contract Costs icon in the P/O Setup folder
to open the P/O Vendor Contract Costs form.
2.Click the New button to start adding vendor contract costs.
If reviewing costs, choose whether to view costs for an item number
or a vendor.
3.On the form which appears, enter the vendor number for whom you
want to set up contract costs or select it using the Finder.
The Contract Costs form is similar to the I/C Item Pricing form in the
Inventory Control module. It lets you specify basic and sale costs for
single or multiple units of measure, and specify percentage or flat
amount discounts based purchase volumes.
4.Select the first item number for which you want to enter costs.
5.Fill in the cost, discount, and tax information for the item.
6.Click the Add button to add the contract cost information.
Click the Field List button at the top of this topic for information about
fields on the form:
See also
Vendor Contract Costs form

Vendor Details Form Field List
Cost Unit
Item Number (code)
Vendor Contact
Vendor Cost
Vendor Currency
Vendor Item Number
Vendor Name
Vendor Number
Vendor Type

Weight Units of Measure Field List
1 (default unit) Equals
Default Weight Unit of Measure
Description
Weight Conversion Factor
Weight Unit of Measure

Optional Fields Report — Features
You print the Optional Fields report whenever you need a listing of all the
optional fields set up for Purchase Orders.
For each type of optional field, the report shows the optional field codes,
descriptions, default values, and whether an optional field is set for
automatic insertion in new records.
If you need instructions on printing the report, see Optional Fields Report — Printing.

Related Topics

Purchase Orders Menu Commands
The menu bar appears in all Purchase Orders forms immediately below
the form title, but the menu titles and commands differ from one form to
the next because each form displays only the menus and commands that
apply to it.
For more information about menu commands, select one of the following
menu titles:
File menu
Settings menu
Help menu

See also
Using Help

Using Help
Welcome to Sage ERP Accpac online Help! Context-sensitive Help is
available when you use Sage ERP Accpac on your desktop or from a
Web browser.

Obtaining Online Help
For help on using Sage ERP Accpac:
Click Help Topics on the Help menu on the Sage ERP Accpac
desktop, or
Press F1 in your browser from an open Sage ERP Accpac form.
To view the Help contents for a specific module, open a form for the
module, then click Contents on the Help menu.
For form-specific help, display the form, and then press F1.

Go Button

or

Sage ERP Accpac uses the Go button where you must fill in a number of
fields before the program can select a particular item.
For example, you may have to select a fiscal year and period before
Purchase Orders can display the correct data. When you have made
your selections, you click the Go button or press the F7 key on your
keyboard.

Changing Column Order in Data Entry Forms
You can change the order in which columns appear on many Sage ERP
Accpac forms.
For example, you can change the order of detail columns to match the
field order of a document from which you are entering data.
To move a column

1.Point at the column heading.
2.Hold down the left mouse button.
3.Move the column to its new location.
4.Release the button.
The columns will be in the new order the next time you open the form.
To restore the original column order
From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
The next time you use the form, the columns will be arranged in the
original order.
See also
Changing column width
Data entry tools and shortcuts
Using forms
Using Help

Changing Column Width in Data Entry Forms
Double-clicking on the division between columns resizes the column on
the left to its minimum size based on the data it contains.
To change the width of columns
1.Position the mouse pointer on the vertical line separating a column
heading from the next heading to the right.
2.Drag the column to the right (to make the column wider) or to the left
(to make it narrower).
3.When you reach the width you want, release the mouse button.
To restore your original settings
From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
The next time you use the form, the columns will be arranged in the
original order.
See also
Changing column order in data-entry forms
Data entry tools and shortcuts
Using Help
Using forms

Print
Use this command to print reports, lists, and forms.
See also
Purchase Orders reports

Printer Setup
Use this command to set up your printer. You can select the default
printer or specify another from the list of installed printer names.
See also
Purchase Orders reports

Customize
Use the Customize command in the File menu of an open form to hide
fields for users assigned to a UI Profile ID for that form. When these
fields are hidden, data that would normally appear in these fields cannot
be printed.
For more information, see the UI Profile Maintenance topic in the System
Manager help.

Import
Use this command to transfer (import) data from non-Sage ERP Accpac
programs to Purchase Orders.
For example, you could use a spreadsheet program to enter current
requisitions or purchase orders when setting up your Purchase Orders
system, then import the transactions into Purchase Orders.

For step-by-step instructions on importing or
exporting
Click Import on the File menu of a transaction-entry form or a setup
record, then press the F1 key to display System Manager help that will
guide you through the import process.
See also
Importing and exporting Purchase Orders setup records
Importing and exporting Purchase Orders transactions
Using Help

Export
Use this command to transfer (export) data from Purchase Orders to nonSage Accpac programs.
For example, you could export purchase statistics from Purchase Orders
for use in a spreadsheet program or database program.

For step-by-step instructions on exporting
Click Export on the File menu of a transaction-entry form or a setup
record, then press the F1 key to display System Manager help that will
guide you through the export process.
See also
Importing and exporting Purchase Orders setup records
Importing and exporting Purchase Orders transactions
Using Help

Close
Use this command to close the current form.
Shortcut keys: Alt + F4

Entering Header and Vendor Information for
Purchase Orders
The information in this topic is presented in the order in which you enter it
on the Purchase Order Entry form (assuming that no one has changed
the order of columns on the detail entry grid on the Order tab).
For each transaction, you enter the following:
Purchase order number
Vendor number
Template code

(optional).

From requisition (number)
On hold

(optional).

(optional)

Job-related — if the purchase order is job-related, all items must be
for particular contracts, projects and categories in Project and Job
Costing. Posting the purchase order updates committed quantities
and amounts for the jobs.
Purchase order date

FOB Point — the location at which the vendor begins charging freight
(optional).
Arrival date — the date on which you expect to receive the goods,
and that you want to use as the default expected arrival date for item
details (optional).
Purchase order type (Active — purchase orders you intend to process
immediately: Standing, Future, or Blanket ).
Original amount

(blanket purchase order)

Ship-via code — identifies the carrier or delivery method (optional).
— the location to which you want the vendor to ship the
order (optional).
Ship-to location

— the location to which you want the vendor to send the bills
for the order (optional).
Bill-to location

Terms code — the code defined in Accounts Payable to identify the
vendor's payment terms.
Description — up to 60 characters (optional).
Reference — up to 60 characters (optional).
Comment — information or instructions for the vendor, up to 250
characters (optional — on the Totals tab).
Vendor's address, phone and fax numbers, and the name of a contact
person or position in the vendor's office (from the vendor record, but
you can change information for the PO).
— the code identifying the vendor's tax group. You can change
it to another group that uses the same currency).
Tax group

Adding Purchase Order Details
You enter the information for each item on a purchase order as a
separate detail line. There are no restrictions on the number of detail
lines you can add to a purchase order.
You do not enter additional costs (such as shipping and handling
charges) on purchase orders. You add those amounts when entering
receipts.
With each item detail, you specify:
Completed

— whether the ordered items have been received or canceled.

Item Number

— of the item being ordered.

Item description — supplied for existing Inventory Control item
numbers, or typed in for non-inventory items.
— for the job in Project and Job Costing if the
purchase order is job-related. If you use different terms than
"Contract," "Project," and "Category" in Project and Job Costing, the
program displays them instead.
Contract, project, category

to which the ordered goods will be delivered, if you use
Inventory Control.
Location

the address where the vendor is to ship the items on the detail
line (if it is not to the location specified for the line), such as to your
customer's address (optional).
Drop-ship

Quantity ordered
Unit of measure
Unit cost

— the number of units ordered.
— the unit of measure for the quantity being ordered.

— displayed from the item record; can be edited.

Extended cost

— the number of units times the unit cost.

Discount % or Discount Amount.

Unit weight — the weight of one unit of the item, in the unit of
measure you specified for the detail (optional).
Extended weight — the quantity ordered multiplied by the unit weight
you entered for the detail.

Vendor's item number — the code or number used by the vendor to
identify the ordered item (optional).
Expected arrival date — the date you expect to receive the item.
Order number

— a sales order number of up to 22 characters (optional).

Comments and instructions — about the item or detail, up to 75
characters (optional).
— the number of item units that have not yet been
received or canceled.
Quantity outstanding

— the general ledger account to which you post the
expense of non-inventory items.
G/L expense account

— the general ledger account number you debit
when you receive non-stock items and credit when you ship them.
Non-stock clearing account

- other numbers or codes that you use for your
inventory items - such as bar codes or part numbers used by the
manufacturer.
Manufacturer's Item Number

- company-defined fields added to each of the detail lines in
a purchase orders transaction. If the Optional Fields column appears,
you can click the column heading to display the Optional Fields form.
Optional Fields

Displayed information
Purchase Orders also displays the following information with each detail
(you cannot enter or edit this information on the Order tab or on the Detail
Items/Taxes form):
The amount of tax that is included in the extended item cost. (Tax
amounts are not displayed until you click the Calculate Taxes button
or the Totals tab, or you post the purchase order.)
The net cost of items with tax included in their prices (the tax base).
Total allocated tax amount — the amount of tax that will be allocated
to the cost of the item.
The quantity of each detail that has been received (this number is
updated when you post receipts for the detail).
To check or edit tax distributions for a detail line, select a detail, then click
the Item/Tax button. For each tax authority, you can change the item's tax
class and, if permitted by the authority, specify whether tax is included in
the item cost.
For information about calculating and editing taxes, see Editing vendor and detail tax
information.
When you add an item line, the program updates the purchase order
subtotal displayed at the bottom of the form.
See also
Entering Optional Fields information
Purchase Order Entry Detail Items/Taxes form
Purchase Order Entry — Order tab

Entering Optional Fields Information
Purchase Orders supports Sage ERP Accpac Transaction Analysis and
Optional Field Creator, a separately licensed package that lets you add
optional fields to transaction documents and to each detail line of a
transaction.
It also lets you pass optional field information through the complete
transaction cycle - from purchase requisitions, to purchase orders, to
receipts, to invoices, and even to downstream ledgers like Accounts
Payable and General Ledger.

Optional fields provide exceptional flexibility by letting you customize your
Purchase Orders system as much as you wish. You can use an unlimited
number of optional fields to store more information with purchase orders
transactions (such as requisitions, purchase orders, receipts, and
invoices).
Information can be transferred to A/P and G/L. When you create
invoices or general ledger transactions in Purchase Orders, the program
passes the optional field values used in the transactions to Accounts
Payable and to General Ledger if the optional fields in Purchase Orders
are the same as the optional fields assigned in those programs. Optional
field information will even appear in the General Ledger journal entries for
Purchase Orders accounts, as well as in the Transaction Details Optional
Fields report.
And, if the optional fields that you assign to Purchase Orders documents
match the optional fields used for Accounts Payable vendors and
Inventory Control items, the information entered in those programs will
appear by default on transactions that you add in Purchase Orders.
Generated transactions also use optional fields. Purchase orders that
are generated from requisitions, from low stock levels in Inventory
Control, and from backorders in Order Entry will also include optional

fields.
If you use the same optional fields for invoices, credit notes, and debit
notes as you use in the Accounts Payable Invoice Entry form, the
optional entries are transferred to Accounts Payable with Purchase
Orders transactions.
See also
Selecting optional fields

Entering Exchange Rates
If you use multicurrency accounting, you can enter exchange rate
information for vendors who do not use the functional currency or are not
EMU member-currencies.
When you select a vendor who does not use the functional currency (or if
the exchange is between an EMU member and a non-EMU member), a
Rates tab appears in the transaction form. This tab displays the vendor's
default rate type, the rate date that corresponds to the document date,
and the exchange rate for the rate date. You can enter different
information for each transaction.
If you are entering a transaction with retainage, you specify on the
Retainage tab whether the retainage invoice uses the same exchange
rate as the original document or the current rate.

Adding Requisitions
Use the Requisition Entry form to create or edit requisitions. You fill in the
following information:
The requisition number, including up to 22 characters. You can also
let Purchase Orders assign the requisition number, using the prefix,
length, and next number you specified for requisitions in the Options
form.
An optional vendor number. If you specify a vendor number, it becomes the
default vendor number for each new detail line you add to the
requisition, but you can select a different vendor number for each
detail or use a blank vendor number. You can also enter new vendor
numbers and add them to the Vendors form in Accounts Payable
while entering requisitions in Purchase Orders.
Requisition date.
An optional expiration date on which the requisition will be cleared by
Day End Processing, whether completed or not. (Leave the date
blank if you do not want the requisition to be cleared.)
Whether the requisition is on hold
If you use requisition approval, the requisition is automatically placed
on hold unless it is posted by a user with approval security
permissions. You cannot convert an on-hold requisition to a purchase
order.
Whether the requisition is job-related.
You can allocate items directly to jobs if you have Project and Job
Costing, and assign them to jobs rather than receive them into
inventory.
You cannot mix job-related and non-job-related items on a requisition.
Also, you cannot add serialized items or items assigned to lots to jobrelated transactions. Instead, you must order them as non-job-related
items, receive them into inventory, and then use the Material Usage
form in Project and Job Costing to move them from inventory to jobs.

Requested by, the person or department requesting the purchase
(optional).
The approval status and the approver's name.
Date required, the date by which you need to be able to issue the
purchase order (optional).
Inventory location (optional). This field appears only if you use
Inventory Control.
A description and reference for the requisition (optional).
Details of the items being requisitioned, including:
Item number and description
Contract, project, category (for a job-related requisition)
Vendor number and name (optional)
Location (from Inventory Control). Note that this field is available
only if you use Inventory Control.
Drop-ship address (optional)
Quantity ordered
Unit of measure (from Inventory Control item record)
Unit cost and extended cost
Whether you want to copy costs on the requisition to the purchase
order
Weight UOM, unit weight and extended weight
Vendor's item number (optional)
Expected arrival date (optional)
Order number (optional)
Comments and instructions (optional)
Manufacturer's item number (automatically added if you entered it
in the item number field)
Optional fields that have been assigned to requisition transaction
detail lines. For example, you might want to use an optional field to

enter a requester code for each detail line in the requisition.
Optional fields that have been assigned to the requisition as a whole
(on the Optional Fields tab) such as an authorization code.
Requisition comments and totals.
You do not enter tax information on requisitions.
See also
Create a New Purchase Requisition
Approve a Purchase Requisition
Requiring Approval for Requisitions
Set Up Manual Requisition Approval
Processing requisitions

Completing Requisitions
A requisition is completed when all its detail lines have a Completed
status (Yes appears in the Completed column or field).
You complete requisitions by:
Posting purchase orders for all the requisitioned items.
Canceling outstanding requisition details.
Specifying an expiration date, then automatically clearing the
requisition during Day End processing.
When you post a purchase order for a requisition detail line, the line is
automatically completed, whether you ordered the full quantity or not.
Once a detail line is completed, you cannot change it, even if you want to
order the remaining quantity. However, you can still create purchase
orders for quantities that remained unordered when the requisition detail
was completed.
When you post a purchase order for all the outstanding details on a
requisition, the requisition is completed. You cannot make further
changes to the completed details, but you can add details to a completed
requisition, making it active again.
If you do not keep history, completed requisitions are deleted from your
Purchase Orders system the next time you run Day End processing. You
can also delete completed requisitions by displaying the requisition in the
Requisition Entry form, then choosing the Delete button.

Deleting Requisitions
You can delete requisitions or requisition details at any time, even if a
purchase order has been posted for the requisition or line.

Editing Requisitions
As long as a requisition exists in your Purchase Orders system, you can
edit it and issue purchase orders from it. You can add new detail lines
and make other changes to requisitions, whether a purchase order has
been posted to the requisition or not.
Even if a requisition is complete, you can edit it and issue purchase
orders from it. You can add new detail lines, delete others, and make
changes to incomplete lines.

Using Security with Requisitions
You can use security (passwords) with the Requisition Entry form,
separately specifying the persons who can add, edit, and delete
requisitions; print requisitions; and import and export requisitions.
For more information about using security, see Purchase Orders security.
See also
Requisition Entry security
Requisition printing security

Future Purchase Orders
Future purchase orders are purchase orders you enter with a future date
on which you expect to activate and issue the purchase order.
Day End Processing automatically activates future purchase orders on
the purchase-order date (or the first time you run Day End processing
after the purchase-order date). Alternatively, you can change the status
of a future purchase order to Active before the purchase-order date, or
change the activation date.
Day End Processing posts newly activated future purchase orders so that
purchasing statistics are updated and items are placed on purchase
order in Inventory Control.
Tip: If you usually run Day End Processing at the end of the work day,
future purchase orders set to be activated on a certain day will not
become active until the end of the day. To be sure a future purchase
order is ready to be processed on the correct date, assign a date earlier
than the desired date.

Blanket Purchase Orders
You can set up purchase orders for a certain monetary amount, then
order items from them until you use up all available funds.
When to use blanket purchase orders. You might use blanket
purchase orders when you want to make a number of purchases over
time, but want to avoid having to post a new requisition and purchase
order for each purchase. For example, you might use a blanket purchase
order to periodically replenish office supplies.
Blanket purchase orders are not normally used to buy inventory items. If
you plan to buy a lot of inventory over time, you should process it through
a large active purchase order, with all the details, rather than by using a
blanket purchase order.
Setting up and using blanket purchase orders. When you set up a
blanket purchase order, you specify the total amount (cost) of items that
can be purchased. With each new purchase, you add detail lines to the
blanket purchase order.
You can change the total amount allowed for a blanket purchase order at
any time. If you wish, you can assign security to the Original Amount field
on the Order tab, so that only authorized persons can change the
amount.
When you post new details, the amount still available is calculated and
displayed.
When the available amount reaches zero, the blanket purchase order is
completed and you cannot use it to make any further purchases.
Posting additional costs for blanket purchase orders. Because you
do not enter additional costs on purchase orders, and you can change
costs on receipts without updating the purchase order, you may post a
receipt total that exceeds the available amount on the blanket purchase
order. Although Purchase Orders lets you post this type of receipt, your
procedures may not permit you to exceed the amount specified on the
blanket purchase order.

Standing Purchase Orders
You can create standing purchase orders that contain items you often
order together, then create active purchase orders from the standing
purchase orders.
Placing active purchase orders from standing purchase orders
To create an active purchase order from a standing purchase order, you
call up the standing purchase order and change the type to Active (you
can also select Future or Blanket to create other types of purchase
orders), make the changes you need, then post the new order with a new
purchase order number you typed or a number assigned automatically by
the program.
When you post a purchase order you created from a standing purchase
order, the standing purchase order is retained in the system, unchanged
and with its original number, regardless of how many purchase orders
you issue from it.
Editing standing purchase orders
To change the contents of a standing purchase order, you display the
purchase order, make the changes you need, then post them. You can
change everything about an existing standing purchase order except its
number and type. If you change the purchase order number or type, the
program assumes you are creating a new purchase order.

Purchase Order Type
Select Active, Standing, Future, or Blanket. The type of purchase order
you select determines how the purchase order is processed.
You can select:
Active — purchase orders you intend to process immediately.
— orders that contain items you often order together. You can issue
active purchase orders from standing purchase orders, as frequently as
needed.
Standing

— purchase orders you enter with a future date on which you expect
to activate and issue the purchase order.
Future

— purchase orders for a certain monetary amount, from which you
issue active purchase orders until you have used up all the available
funds.
Blanket

Checking Purchase Order Totals
Use the Taxes tab on the Purchase Order Entry form to check taxes
for the order, to change the vendor's tax group or the tax classes for
the order, or to edit tax amounts.
Use the Totals tab to:
Check the estimated weight of the shipment.
Edit tax information, check the number of detail lines (to be sure
you entered all the lines you need), and look up the purchase
order subtotal, excluded-tax total, and grand total.
Enter a comment for the purchase order.
Enter a discount percentage or a total discount amount for the
purchase order. When you enter a discount on this tab, the
program distributes the total amount to the purchase order details,
overwriting any discounts you entered for details.
If you wish to print mailing labels for a purchase order, you enter the
number of labels to print on the Totals tab, then use the Mailing
Labels form to print the labels. The number of labels you enter
specifies how many labels will be printed for the order when you
select the Print Only Labels Marked As Required option in the Mailing
Labels form.

Day-End Processing of Purchase Orders
Note: If you cost inventory during posting instead of during Day End
Processing, almost all Day End processing tasks will also take place
when you post transactions.
If you are concerned with transaction processing speed, you should
cost inventory transactions during Day End Processing—not during
posting. (You change this setting on the Processing tab of the I/C
Options form if you are using the Inventory Control module.)
Day End Processing (or posting, if you cost inventory during posting):
Creates active purchase orders from future purchase orders that have
reached their activation dates.
Updates quantities on purchase order in Inventory Control (that can
also be viewed in Order Entry).
Updates committed quantities in Project and Job Costing for jobrelated purchase orders.
If you keep history and statistics, updates purchase order history and
updates the number of purchase orders for the year and period in the
Purchase Statistics form and on the Purchase Statistics report.
If you do not keep transaction history, deletes completed purchase
orders. (Posting will delete the purchase orders if you cost items
during posting).
If you use Sage ERP Accpac Inventory Control with Purchase Orders,
you choose the Day End Processing icon from the Periodic Processing
folder in Inventory Control.
If you use Purchase Orders as a stand-alone program (without Inventory
Control), you choose the Day End Processing icon from the Periodic
Processing folder in Purchase Orders.

Deleting Purchase Orders
You can delete purchase orders and individual details at any time until
you post a receipt to the purchase order. After posting receipts to
purchase orders, you cannot delete the purchase orders or any of their
details. To cancel a purchase order detail after posting a receipt, you
cancel the outstanding quantity.
To remove a completed purchase order from your system, you run Day
End Processing if you do not keep history. If you keep transaction history,
you remove completed purchase orders by using the Clear History form.

Editing Purchase Orders
You can change information on any incomplete active or blanket
purchase order, and on all future and standing purchase orders. You can
even delete a posted purchase order until you post receipts against it.
Multicurrency ledgers. If you use multicurrency accounting, you can
change the tax group on a transaction until you add details, but only to
another tax group that uses the vendor's currency.
What you can change after posting. After you post a purchase order,
you can change everything you entered on the order except the purchase
order number, vendor number, and completed detail lines.
You can add detail lines to a purchase order at any time, even after
posting receipts for all the purchase order details and completing all
detail lines. You can delete detail lines for which you have not received
any items, and you can change the outstanding amounts of partially
received details.
If you change quantities or delete purchase order details, quantities on
purchase order are updated in Inventory Control.

Posting Purchase Orders
When you post a purchase order, item quantities on purchase order are
increased in Inventory Control.
If the purchase order is job-related, Purchase Orders also update the
committed quantities and costs for the job in Project and Job Costing.
If you use the automatic-numbering option, posting assigns and displays
the purchase order number. Posting also updates the information for the
Purchase Order List, so that you can print an accurate list immediately.
After posting, you can also print copies of the purchase order.
Posting completes purchase order lines that you set to Completed. You
cannot edit these lines after posting.
Effect on requisitions. If you specified requisition numbers for the
purchase order, the requisition detail lines you add to the purchase order
are completed on the requisitions when you post the purchase order.
If a purchase order completes all the details on any specified requisition,
the requisition itself is completed when the purchase order is posted.

Printing Purchase Orders
To print purchase orders, choose the Purchase Orders icon from the
Forms folder. You can also print a single purchase order from the
Purchase Order Entry form, right after posting it. You can reprint
purchase orders until they are complete.
If you wish, you can print purchase orders by type (Active, Future,
Standing, Blanket), and you can choose to reprint or exclude previously
printed purchase orders, or print only incomplete purchase orders. You
can also print copies of edited purchase orders, including only the details
added since the last time you printed a purchase order.
You can print purchase orders using the forms that come with the
program, or you can change the forms. For instructions on creating your
own forms or adapting the sample purchase order forms, see the online
form, "Customizing Printed Forms with Crystal reports."
Printing drop-ship addresses. If the purchase order includes drop-ship
addresses, all details with the same drop-ship address are printed
together on the purchase order, followed by the address, rather than
printing an address with each detail line that uses it.
E-mailing purchase orders. The Purchase Orders program also lets
you email purchase orders and purchase returns to vendors.&#45;
If you want to email purchase orders to vendors, you use the Email
Messages form in the P/O Setup folder to create the email message that
you want to send to vendors.&#45;&#45;&#45;
For each vendor that you want to email, you must set the Delivery
Method to Email or to Contact's Email on the Processing tab of the
vendor record in Accounts Payable.&#45;&#45;&#45;

Using Security with Purchase Orders
You can use security with the Purchase Order Entry form, separately
specifying the persons who can:
Add, edit, post, or delete, requisitions, purchase orders, receipts,
returns, invoices, and credit or debit notes.
Create purchase orders automatically from requisitions, Inventory
Control, and Order Entry.
Approve purchase requisitions.
View cost information.
Edit invoiced quantities or costs.
Print requisitions, purchase orders, receiving slips, returns, or mailing
labels.
Edit setup information and options.
Import or export purchase orders.
On blanket purchase orders, you can also assign security to the Original
Amount field on the Order tab of the Purchase Order Entry form (see Edit
blanket PO amount security access). By restricting access to this field, you can ensure
that no unauthorized changes are made to the amount.
You can assign security to item costs in Inventory Control if you do not
want to display the item costs from Inventory Control on purchase order
detail lines. The Unit Cost and Extended Cost fields will then display only
zeroes in Purchase Orders, and you then type in cost amounts when
entering transactions.
For more information about using security, see Purchase Orders security.
See also
Create Purchase Orders (automatically) security access
Purchase Order Entry security access
Purchase Order Printing security access
Purchase Orders security

Calculating Prorated Additional Costs
You can prorate additional costs to items on a receipt either automatically
or manually. For documents created in version 5.3A and earlier
multicurrency ledgers, you can manually prorate costs only if they are in
functional currency.
If you prorate automatically, the extra cost amounts do not appear as part
of the item detail costs in the Receipt Entry form, although they are
reported on the posting journal for each transaction.
If you prorate manually, you click the Distribute Proration zoom button,
and enter the prorated cost amounts in the Distribute Proration form.

Prorating automatically
Additional costs you choose to prorate automatically are apportioned
across all items on a receipt during posting or Day End Processing,
based on each detail's total quantity received, total weight, or extended
cost, as a percentage of the receipt's total quantity, weight, or cost,
respectively.
You can prorate by:
Quantity
Weight
Cost

Entering Receipts
This topic describes the information you enter for receipts and receipt
adjustments in the Receipt Entry form.
Specifying vendors and purchase orders. You can enter receipts for
vendor numbers that exist in your Accounts Payable data and for new
vendors, and you can add a vendor to Accounts Payable from the
Receipt Entry form. You can also apply receipts to existing purchase
orders or you can enter a receipt that doesn't reference a purchase order.
Job-related receipts. If the receipt is for a project you are managing with
Project and Job Costing, different fields appear for the details to let you
enter job-related information. If the retainage option is selected in
Accounts Payable, you can choose retainage accounting for the receipt.
Note: If the receipt is being created from multiple purchase orders, all
purchase orders must be either job-related or non-job-related.
Specifying item and cost details. You can enter individual item receipts
and additional costs (such as shipping charges) as separate details, and
you can edit tax information for each detail and cost, and for the vendor.
You can enter additional cost details for the primary vendor (the vendor
from whom you received the goods) or for secondary vendors (vendors
who charged costs on the shipment but did not supply the goods).
If necessary, you can assign a different vendor and tax group to each
additional cost detail. In multicurrency ledgers, you enter all details in the
primary vendor's currency.
During receipt entry, you can look up purchasing history by vendor or
item number. You can also print receipts after posting them using the
standard form for receiving slips supplied with Purchase Orders, or using
forms you design.
Note: You must Allow Receipt of Non-Stock Items in Inventory Control in
order to enter receipt transactions for non-stock items.
Editing receipts. You can use the Receipt Entry form to edit existing
receipt details for a vendor if you have not posted an invoice for the
vendor and receipt. A receipt is complete when you have posted invoices

for all vendors on the receipt. You cannot change a completed receipt.
Invoicing receipts. You can post invoices for receipts from the Receipt
Entry form, invoicing the items received and additional costs charged by
the primary vendor (the receipt vendor), as well as additional costs
charged on receipts by other vendors (secondary vendors). You can also
use the Invoice Entry form to post invoices.
Enter 1099 codes and remit-to locations in Invoice Entry or
Accounts Payable. Note, however, that if you need to record 1099
codes and amounts or remit-to locations, you must enter invoices in the
Invoice Entry form, or edit Purchase Orders invoices in Accounts Payable
to add the codes and 1099 amounts.
If you also use Serialized Inventory, you can assign serial numbers to items after
inserting an amount in the quantity field.
See also
Processing receipts
Units of Committed and Actual Quantities

Entering Receipt Header and Vendor Information
This topic discusses the header and vendor information you enter only
with receipts.
Most of the information you enter with a receipt is the same as with
requisitions and purchase orders, and is described under Processing purchase
orders.
Information that you enter only for receipts includes:
(a unique number, up to 22 characters in length, to
distinguish the transaction from other receipts for audit control
purposes).
Receipt number

Vendor number (the vendor from whom you purchased the goods).
(the number assigned to the single purchase order for which
you are receiving items).
PO number

(the numbers of all purchase orders you have chosen to
receive from the vendor).
From multiple POs

(if the receipt is for a project you are managing with Project
and Job Costing).
Job related

(if the retainage option is selected in Accounts Payable,
you can choose retainage accounting for the receipt.
Retainage accounting

Receipt date

(the transaction date for the receipt).

Year and period

(to which you want to post the general ledger transaction).

On new receipts, you can also enter:
Template code
Bill-to location
Ship-to location
FOB point
Ship via code
Terms code
Description
Reference
Comment

(on the Totals tab)

When you select a valid purchase order for a receipt, the Receipt Information tab
displays the number of receipts that have been posted to the purchase

order and the last receipt number that was posted to the purchase order.
Go back to Entering receipts

Entering Receipt Details
You can enter receipt details against existing purchase orders or enter
receipts without referencing any purchase order.
When you are entering new receipts for an existing purchase order, the
incomplete details from the purchase order are displayed. (Completed
details are omitted.) You can edit and delete details but you cannot add
details.
You can add as many details as you need on a receipt that does not
include a purchase order number.
You can enter the following information with receipt details:
Whether the receipt completes the purchase order detail (that is, the detail
line has been fully received or canceled).
Item number, description, and location (on receipts that do not
reference a purchase order).
If you use manufacturers' item numbers, you can enter them here.
The program will substitute them for your item numbers, and insert
the manufacturer's item numbers in the manufacturer's item number
field.
You can also receive items identified as non-stock items, if you allow
them to be received in Inventory Control or if you use Purchase
Orders as a stand-alone system.
If you are editing a previously posted receipt or you specified a
purchase order number for the receipt, you can change the
description for each detail line, but you cannot change the item
number or location.
Contract, project, category, cost class, A/R item number, billing type,
billing rate, and resource (if the receipt is job-related).
If you use different terms than "Contract," "Project," and "Category" in
Project and Job Costing, the program displays them instead.
If the retainage option is selected in Accounts Payable, and you
chose retainage accounting for the receipt, you also enter the

retainage amount and retention period for each detail item for which
holdbacks apply.
(for any item details that were shipped to a different
address from the inventory location specified for the detail).
Drop-ship address

Quantity received

(the number of units of each item that you received).

Note: If you use Project and Job costing, use the same unit of
measure that is on the estimate. (See Units of Committed and Actual Quantities)
A discount amount or discount percentage. Note that if you enter a
discount for the total receipt (on the Totals tab), any discounts you
entered for details will be overwritten.
(the total amount of all additional costs, including
allocated taxes, that you wish to prorate manually to an item detail).
You calculate the total amount to prorate to each detail, then type in
the amount.
Manually prorated amount

Unit of measure, unit cost, extended cost, unit weight, and extended
weight. If you specify a valid Inventory Control item number, this
information is supplied from Inventory Control or calculated by
Purchase Orders, but you can change it. If you use a non-inventory
item number, you must enter the information yourself.
Quantity canceled (the number of units, if any, that you do not expect
to receive). You enter canceled quantities only on receipts that specify
a purchase order number.
Quantity outstanding on purchase order (the number of units not yet
received or canceled; you can change the number when working with
an existing receipt or purchase order).
When you post the receipt, the outstanding quantities are updated on
the purchase order. If you post a receipt for the full outstanding
quantity or for a larger quantity than was specified on the purchase
order, the purchase order detail is completed.
Vendor's item number (displayed from the purchase order, if any, you
specified for the receipt).
You can enter the vendor's item number or change a displayed
number. You can also omit the item number.

(the number of labels that you want to print in Inventory
Control for the received items).
Number of labels

Arrival date (the date on which the items were received).
The program displays the session date, but you can edit it.
Order number

(the Order Entry sales order or other order number you

enter).
Comments.
You can enter as many comments as you need with each receipt
detail. If the receipt references an existing purchase order, the
comments entered for the purchase order details are displayed on the
receipt, and you can edit them.
G/L expense account

(for non-inventory items).

Discount % or Discount Amount for each detail. When you enter a
discount amount, the program calculates the discount percentage,
and displays the result in this field. If you enter a percentage, the
program calculates and displays the discount amount.
Note that if you enter a discount for the receipt on the Totals tab, the
program distributes the total discount amount to the details,
overwriting any detail discounts you entered.
Optional fields

(for the item detail).

These are company-defined fields that can be added to each of the
detail lines in a receipt if you use Sage ERP Accpac's Transaction
Analysis and Optional Field Creator. The entries in these fields will
flow from the requisition and purchase order if you use the same
fields for those forms. They can also be passed on to Accounts
Payable invoices and General Ledger transactions.
If the Optional Fields column appears, you can click the column
heading to display the Optional Fields form.
The quantity received to date for each detail is displayed on the receipt.
This figure is updated on the purchase order when you post receipts to
the detail.

Entering Additional Costs on Receipts
When entering a receipt, you can add additional costs charged on the
shipment, such as handling charges, service charges, and duty. You can
expense costs or prorate them to received items.
You can also edit additional-cost amounts on previously posted receipts
that are not yet fully invoiced. If you return items, you can specify how to
reallocate costs that were prorated to the returned items on the receipt.
You enter additional cost details by vendor on the Additional Costs tab of
the Receipt Entry form. You can include additional costs charged by the
primary vendor, and you can include costs charged by other vendors. If
you wish, you can post an invoice for each vendor's costs from the
Receipt Entry form or you can enter the invoices in Invoice Entry.
Non-inventory items
If you are adding additional costs for non-inventory items, you must
choose No Proration. If you choose to prorate by quantity, cost, or weight,
the program will display an error message and prevent you from posting
the receipt.
See also
Calculating prorated additional costs
Expensing job-related additional costs
Information entered with additional costs
Specifying vendors for additional costs

Expensing Job-Related Additional Costs
If job-related additional costs are expensed rather than prorated, you can
specify the contract, project, category, cost class, resource, billing type,
billing rate (if appropriate), currency, A/R item number, and unit of
measure for the additional cost.
Depending on the category, you may choose to calculate overhead or
labor burden for the additional cost. Overhead and labor are calculated
by Project and Job Costing and passed back to Purchase Orders when
you post the receipt.
Expensed additional costs are assigned their own transaction numbers,
because they are sent to Project and Job Costing as separate
transactions.
Note: Once you post a receipt, you cannot change the billing type, billing
currency, A/R item number, A/R unit of measure, overhead calculation, or
labor calculation for additional costs.

Importing Receipts
Use the Import command on the File menu in the Receipt Entry form to
transfer receipts created in non-Sage ERP Accpac applications (or in
another Purchase Orders database at a different location) to Purchase
Orders.
Purchase Orders posts imported receipts and returns as they are
imported, but does not delete the original file of transactions. To avoid
importing the same transactions twice, you should delete the file when
you are finished.
You must make sure that the receipts and returns for importing use
unique document numbers. You cannot import a transaction that uses a
document number you have posted and not cleared in Purchase Orders.
You can also import additional costs only for the primary vendor.

Multicurrency ledgers
You cannot import multicurrency transactions into a single-currency
ledger. Edit import files to remove multicurrency fields before importing.

Guidelines for importing
If the file does not contain valid data, Purchase Orders will not import it.
For an example of valid data, export receipts using the fields you plan to
import later and use this as a guide.
Note that the import file you specify must be located on the drive and in
the directory that you select. If you are on a network, you must have
access rights to the import file and the directory.

For step-by-step instructions on importing
receipts
Click Import on the File menu of the Receipt Entry form, then press the
F1 key to display System Manager help that will guide you through the
import process.

After importing
Check data integrity.
Run Day End Processing to create journal entries from the imported
data.
Print the posting journal for the type of transaction imported and use it
to check the posted details and the general ledger distributions
generated from Purchase Orders transactions.
Unless you need to use it again, delete the file from which you
imported the transactions.

Prorating Additional Costs on Receipts
You can choose from five proration methods for each additional cost:
You can choose not to prorate the cost (No Proration), and expense it
instead.
Non-inventory items. If you are adding additional costs for noninventory items, you must choose No Proration. If you choose to
prorate by quantity, cost, or weight, the program will display an error
message and prevent you from posting the receipt.
You can prorate by:
Item cost.
Item quantity.
Item weight.
You can choose to prorate the cost manually.
You cannot change the proration method after you post a receipt.
For examples and information about how costs are prorated, see Calculating
prorated additional costs.
Expensing additional costs. If you do not prorate an additional cost,
you expense it to the general ledger account you assigned to the
additional cost record or to another account you specify when entering
the additional cost transaction.
Job-related proration. If you want to apportion an additional cost to
several jobs, you need to add a detail line for each job.
Returns and adjustments. You specify the reproration (return proration)
method (how a cost is reprorated) when you enter a return to a receipt
you posted previously or when you return items to which costs were
prorated.
If you used an additional cost code, the program displays the reproration
method specified in the cost record, but you can select another method
for the detail. You cannot change the proration or reproration method
after you post the receipt.

You can choose to leave the cost as originally prorated, reprorate it using
the original proration method, or expense it to the general ledger account
you specify, as follows:
Select the Prorate option to have the program prorate the "returned"
additional cost amount over the remaining goods on the receipt, using
the original proration method.
Select the Leave option if you do not want to reprorate the additional
cost to the remaining goods on the receipt.
You can also use the Adjustments form in Inventory Control to write
off the additional cost to a general ledger write-off account, rather than
add it to other item costs.
Select the Expense option if you want the program to debit a general
ledger expense account for the returned portion of the additional cost
amount. Enter the general ledger account number to which the
expensed amount is posted.

Editing tax distributions
The tax information for each additional cost detail is determined by the
vendor's tax group. For each detail, you can change the tax class and
specify whether tax is included in the cost amount (if allowed by the tax
authority).
You can also check the tax amount for the detail and the allocated,
recoverable, and expensed tax amounts. For more information, see Editing
vendor and detail tax information.

Reporting prorated amounts
The Receipts Posting Journal lists the additional cost amounts prorated
to each item on a receipt. Use the journal to check the amounts that were
prorated automatically during posting or Day End Processing, and to
check the amounts you prorated manually.

Checking Receipt Totals
The Receipt Entry form contains separate totals for the primary vendor
and for each secondary vendor (if any).
Checking totals for the primary vendor.
Use the Taxes tab to view total tax amounts for each tax authority
assigned to the primary vendor. Tax information includes the totals of
included and excluded taxes. You can edit the total tax amount for
each authority. The program then calculates the total included and
excluded tax for each authority.
Use the Totals tab to:
Check totals for the primary vendor. Information includes the total
weight and number of details and additional cost details on the
receipt, total of item details, and total of additional costs charged
by the primary vendor. An additional cost total is shown on the
Totals tab only for the primary vendor.
Enter a comment for the receipt.
Enter a discount percentage or a total discount amount for the
receipt. When you enter a discount on this tab, the program
distributes the total amount to the receipt details, overwriting any
discounts you entered for details.
If you manually prorate additional costs, the Totals tab shows you
whether you have fully allocated all additional costs and their
associated taxes that you chose to prorate manually. The Totals tab
also shows any discrepancy between the additional costs that were to
be allocated manually and the amount you have actually prorated to
details.
Checking totals for the secondary vendor.
Use the Additional Cost Vendor Taxes form to view or to edit tax
classes and tax amounts for the tax authorities assigned to the
individual secondary vendors.
To display the Additional Cost Vendor Taxes form for a particular

vendor, select the additional cost vendor on the Additional Costs tab,
then click the Vendor Taxes button.

Editing Receipts
After posting a receipt, you can no longer change the purchase order
numbers, template code, or tax group, and you cannot delete any item or
additional cost details that were posted with the receipt. You can add new
additional cost details and, if the receipt does not reference a purchase
order number, you can add item details. In multicurrency ledgers, you
cannot edit exchange rates.
If you change receipt quantities, quantities on hand are updated with the
changes in Inventory Control.
Job-related changes to receipt quantities will change the committed and
actual quantities and costs in Project and Job Costing.
If you edit an existing receipt that was created from a purchase order, you
see only the detail lines (from the purchase order) that have a received
quantity or have a non-zero amount (other than the received quantity),
such as a manual proration or a canceled quantity.
You cannot change the proration or reproration method you assign to any
additional cost after you post the receipt. If you need to change the
method, either on the receipt or for a return, you post the change as an
adjustment in Inventory Control.
Editing receipts after invoicing
Once you have posted an invoice for the primary vendor, all the vendor's
details are complete and you cannot edit them. When you have posted
invoices for all the vendors on a receipt, the receipt is complete and can
no longer be changed.

Posting Receipts
When you post a receipt in Purchase Orders, item quantities on purchase
order are reduced and quantities on hand are increased in Inventory
Control.
If the receipt is job-related, Purchase Orders also updates the actual and
committed quantities and costs for the job in Project and Job Costing.
If you specified a purchase order number on a receipt, posting also
enters or updates outstanding and received quantities on detail lines in
the purchase order, and completes purchase order detail lines that have
been fully received or canceled. Posting also deletes purchase order
details for which no quantity was received on the receipt, so that they do
not appear on the receipt if you select it for editing after you have posted
it. You should make sure you have entered all the received quantities you
want to include on a receipt before you post it.
After posting a receipt, you cannot change additional cost information
(except for the amounts) and you cannot delete detail lines — although
you can change the quantity received and cost amounts, and you can
add additional costs for the primary vendor on the invoice. In
multicurrency ledgers, you cannot edit exchange rates.

Day End Processing of Receipts
Note: Most day end processing tasks will be performed during posting if
you choose the Inventory Control option to cost inventory items during
posting.
When you run Day End processing to process a Purchase Orders
receipt, Day End Processing:
Inserts the item costs as the most recent costs in Inventory Control
item records (unless you chose the option to cost items when you
post transactions).
For items using LIFO or FIFO costing, posting or Day End Processing
creates a new LIFO or FIFO bucket for the receipt, quantity, and cost.
For receipt adjustments, Day End Processing updates the buckets
created for the original receipt. If a bucket has been cleared, Day End
Processing posts any receipt adjustments to the offset bucket.
If an item is processed at more than one cost, posting or Day End
Processing uses the cost from the last detail processed for an item as
the most recent cost in the item record, unless the receipt cost on the
last detail is zero or a negative amount.
If the last item cost is zero, posting or Day End Processing uses the
last non-zero cost processed for the item, or if no other details are
processed for the item, does not change the most recent item cost.
Prorates any additional costs posted with a receipt to the items on the
receipt using the methods you specified.
Creates the Receipts Posting Journal and general ledger transactions
for the processed receipts.
The general ledger accounts affected by receipts are shown in Journal
entries generated by posted transactions.
Day End Processing does not create general ledger entries for noninventory item details and additional cost details that you expense
rather than prorate, because these details are posted to general
ledger expense accounts, rather than to Inventory Control accounts.
Journal entries for non-inventory items and expensed additional costs

are created when the transactions are posted in Accounts Payable.
If you adjust a receipt after running Day End Processing, journal
entries are created for the amount of the adjustment, including
additional costs, the next time you run day-end.
Completes all receipt details for vendors with invoices posted to the
receipt.
Deletes completed receipts if you do not keep transaction history.
Updates history and statistics in Purchase Orders and Inventory
Control, if you keep history and statistics.
See also
Purchase Orders general ledger transactions
Posting Journals

Using Security with Receipts
You can use security with the Receipt Entry form, separately assigning
the persons who can:
Add, edit, and invoice receipts.
View receipt costing information.
Print receiving slips.
Import receipts.
Export receipts.
Purchase Orders provides a security permission to "Show Receipt
Costing Information." This allows you to have warehouse staff receive
goods and enter quantities received, but prevent them from viewing cost
information.
If users do not have the "Show Receipt Costing Information" security
right, they will not be able to view item unit cost information on receipts —
including totals, taxes, discounts, and additional cost amounts. (In other
words, the Taxes tab, Additional Costs tab, and Totals tab will not appear
on the Receipt Entry form for users do not have this right.)
Note: Pre-printed forms PORCP03.RPT and PORCP04.RPT will print
cost information. If you want to hide costs on these forms, you will need
to customize them.
You can also assign security to item costs in Inventory Control if you do
not want to display the item costs from Inventory Control on receipt detail
lines. The Unit Cost and Extended Cost fields will then display only
zeroes in Purchase Orders, although you can type in cost amounts when
entering transactions.
Note that item cost security in I/C does not apply to any Vendor Contract
Costs entered in Purchase Orders.
For more information about using security, see Purchase Orders security.
See also
Receipt Entry security access
Receiving Slip Printing security access

Using Purchase Orders with Other Sage ERP
Accpac Programs
You must install and activate Sage ERP Accpac Accounts Payable before
you can activate Purchase Orders.
If you plan to use Purchase Orders with Inventory Control, rather than as
a "stand-alone" program, you must install and activate Inventory Control
before activating Purchase Orders.
If you do not install and activate Inventory Control first, the installation
program sets up Purchase Orders as a "stand-alone" program; it will not
integrate with Inventory Control.
You can also use Purchase Orders with Sage ERP Accpac General
Ledger, Order Entry, and Accounts Receivable.
For information about how Purchase Orders works with other Sage ERP
Accpac programs, choose from the following topics:
Accounts Payable
Accounts Receivable
General Ledger
Inventory Control
Order Entry

Entering Invoices
Most of the information you enter with an invoice is the same as with
receipts and purchase orders, and is described under Processing purchase orders.
To read about the information you enter only with invoices, click the
following links:
Entering invoice header information and vendor information
Entering invoice details
Entering additional cost details on invoices
Entering optional data on invoices
Entering exchange rate information on invoices
Checking invoice totals
Editing payment terms
Entering units of committed and actual quantities

Posting Invoices
During posting, the total of all details and taxes is compared to the
invoice total you entered on the Invoice Information tab. The invoice is
posted only if the two totals are the same.
Posting assigns the invoice number you entered and completes the
invoice and the receipt details for the selected vendor. You cannot
change or delete an invoice after posting it, and you cannot change the
receipt details for the vendor.
If you changed the quantity received on an invoice, the quantity on hand
in Inventory Control is adjusted during posting. Otherwise, invoice posting
in Purchase Orders has no effect on Inventory Control data.
Job-related invoices update Project and Job Costing quantities and
costs only if the invoice differs from the posted receipt.
If you use the Keep Transaction History option, you can display posted invoices
in the Invoice Entry form and print them on the Transaction List until you
clear them from Purchase Orders. If you do not keep transaction
history, posted invoices are deleted during posting or Day End Processing in
Inventory Control (depending on when you cost inventory).

Day End Processing of Invoices
Note: If you cost inventory during posting instead of during Day End
Processing, almost all Day End processing tasks will take place when
you post transactions.
If you are concerned with transaction processing speed, you should
cost inventory transactions during Day End Processing—not during
posting. (You change this setting on the Processing tab of the I/C
Options form if you are using the Inventory Control module.)
Day End Processing (or posting, if you cost inventory during posting):
Creates and optionally posts a batch of invoices in Sage ERP Accpac
Accounts Payable, with a batch type of Imported. Information for each
invoice includes the remit-to location and 1099 code and amount, if
any.
Updates costs in Inventory Control for non-job-related invoices, if you
use Inventory Control.
Updates quantities and costs in Project and Job Costing for jobrelated invoices.
If you keep history and statistics, updates history and statistics with
invoice data.
Creates the Invoice Posting Journal that lists details of the invoice
transactions and the corresponding general ledger distributions
Note that the general ledger transactions for invoices are created in
Accounts Payable when the invoice batch is posted in Accounts
Payable.
If you posted invoices with new prorated additional costs, Day End
Processing prorates the costs to the items on the receipt, updates
costs in Inventory Control, and creates adjusting entries for your
general ledger.
You must run Day End Processing to:
Delete invoices from Purchase Orders if you do not keep transaction
history.

Activate future purchase orders.
See also
Purchase Orders general ledger transactions
Posting Journals

Using Security with Invoices
You can use security with the Invoice Entry form, separately specifying
the persons who can add invoices, edit quantities, edit costs, and export
invoices.
For more information about using security, see Purchase Orders security.
See also
Invoice Entry security access
Edit Invoiced Quantity security access
Edit Invoiced Cost security access

Exporting Invoices
Use the Export command on the File menu in the Invoice Entry form to
transfer invoice transactions created in Purchase Orders to non-Sage
ERP Accpac applications.
Before exporting, decide which fields to include in the export file. You
must select fields for each type of record used for the selected
transaction type. You should also find out the path for the export file you
want to use or create.
When you choose Export, Purchase Orders exports all the transactions
of the selected type currently in the system. If you do not want to export
everything, use the Set Criteria option to specify the documents to export.

Entering Header and Vendor Information on
Returns
As with other Purchase Orders transactions, you can enter your own
document numbers for returns or allow the program to assign them, using
the length, prefix, and next number you specified for returns in the
Options form. You can also enter non-existent vendor numbers and, if
you wish, add them to Accounts Payable from the Return Entry form.
If you select a receipt number for a return, the vendor number is inserted
for you, and default information from the receipt appears in the
corresponding fields on the Return Information and Vendor Information
tabs. You can change everything but the template code, purchase order
number, and tax group.
If you do not select a receipt number for the return, you fill in the
information you need on the Return Information and Vendor Information
tabs. You can also select a template code to fill in some of the fields
automatically.
Note that if you select a receipt number for a return, you cannot then
erase the receipt number. If you specify a receipt number accidentally,
cancel the transaction and start a new return, leaving the Receipt
Number field blank.
Multicurrency ledgers. If you use multicurrency accounting, the
currency for the document is determined by the vendor number and
corresponding tax group. You can change the tax group for a vendor only
to another group that uses the vendor's currency.

Entering Returns for Existing Receipts
When you return items from an existing receipt, Purchase Orders
displays information from the original receipt in the Return Entry form.
You can edit all the information on the Return tab except for the purchase
order number (if any), vendor number, and template code.
You enter the returned quantity for each item in the detail entry grid on
the Return tab. You can either delete the details that you are not
returning, or leave the returned quantity at zero.
If you are returning all items from a receipt, you can use the Return All
button to enter the full quantity received on each detail line. If necessary,
you can change all of the returned quantities inserted by the Return All
button.
Detail information you can edit. On each detail line, you can enter a
return cost (the total cost of the returned items) and edit the item
description, location (if you use Inventory Control), unit of measure, unit
and return cost, unit and extended weight, vendor's item number, order
number, comments, and optional fields. For non-inventory items, you can
edit the general ledger expense account.
Detail information you cannot change. You cannot add detail lines to
the return, and you cannot change the item number, quantity received,
and extended cost (from the receipt detail).
If the return is job-related, you cannot change job information.
Tax information. Detail taxes are calculated for the returned quantities
only. As with other Purchase Orders transaction types, you use the Detail
Items/Taxes form to change tax class and tax-included options for a detail
line. (Select the line, then click the Item/Tax button.) You cannot change
tax information on the line itself.
Prorating additional costs. No additional cost details appear on a
return. You cannot edit costs or add new costs. When you return items to
which you prorated additional costs on the receipt, the costs are allocated
according to the reproration method specified on the receipt.
If you return all items on a receipt that included additional costs and used
Prorate as the return proration method, the costs remain allocated as

specified on the receipt.

Entering Returns for Non-Existing Receipts
When you enter returns to cleared receipts, you can enter and change all
the default information that appears from the vendor record and template
code. You can also add as many detail lines as you need to match the
information on the cleared receipt.
You enter the details of the returned items on the detail entry grid on the
Return tab of the Return Entry form. With each detail, you must enter the
item number, item description, location (if you use Inventory Control), and
quantity returned. You can also enter the unit and return cost, unit of
measure, unit weight, extended weight, vendor's item number, order
number, and comments. If the detail includes a non-inventory item, you
also enter the general ledger account to which the returned cost is
expensed.
For job-related returns, you enter contract, project, and category
information.
You do not enter the quantity received or extended cost.
Tax information. You edit tax information as for returns to receipts. Click
the Item/Tax button on the Return tab to open the Detail Items/Taxes for
to edit the tax class and tax-included option for detail lines; use the Taxes
tab to edit the tax class, and tax amount for the vendor.

Entering Credit Notes and Debit Notes
When you select an existing invoice for a credit note or debit note, or a
return for a credit note, the information from the original document is
displayed in the Credit/Debit Note Entry form.
If you are creating a credit note or debit note from an invoice, the
quantities received from the invoice are displayed and you can either
accept or change the figures. The unit and extended costs are displayed
as zeroes. You specify the credit or debit amount for the items you are
crediting or debiting. You then delete details you are not crediting or
debiting, or leave the amounts for them at zero.
If you are creating a credit/debit note from a return, the program displays
the quantities returned and the unit and extended costs. If you have
security rights to these fields, you can change the amounts, but cannot
delete detail lines. If the credit/debit pertains to an serialized or lotted
item, you can allocate lot numbers and/or serial numbers when entering the
note.
You cannot change certain information from an invoice or return, such as
the vendor number, template code, currency (in multicurrency ledgers),
and key information from each detail line, such as the item number,
location, and unit of measure.
If you are creating a credit note from a return, the additional cost details
for the primary vendor are also displayed from the originating receipt, if
any. If you are creating a credit note or debit note from an invoice, the
additional cost details are displayed from the invoice. The additional cost
amount appears as zero and you enter the amount to be credited or
debited. You cannot change the additional cost code, proration and reproration methods, or the expense and return general ledger accounts.
You can add new additional costs on credit notes and debit notes but you
must select No Proration as the proration method, so that the cost is
expensed to a general ledger account.
Tax information.You can edit tax information for the vendor and for
details just as you could on the invoice or return.
Entering credits or debits to non-existing invoices or returns. When

you enter credit notes and debit notes to cleared or non-existing invoices,
you can enter and change all the default information that appears from
the vendor record and template code. You can also add as many detail
lines and additional cost details as you need.

Entering Additional Costs on Credit Notes and
Debit Notes
If you are creating a credit note from a return, the additional cost details
for the primary vendor are displayed from the originating receipt, if any. If
you are creating a credit note or debit note from an invoice, the additional
cost details are displayed from the invoice. The additional cost amount
appears as zero and you enter the amount to be credited or debited.
You cannot change the additional cost code, proration and reproration
methods, or the expense and return general ledger accounts. You can
add new additional costs on credit notes and debit notes but you must
select No Proration as the proration method, so that the cost is expensed
to a general ledger account.
Note: If you are adding additional costs, you must choose No Proration.
If you choose to prorate, the program will display an error message and
prevent you from posting the credit note or debit note.

Checking Credit Note and Debit Note Totals
Use the Taxes tab on the Credit/Debit Note Entry form to edit tax
classes and tax amounts for the credit note or debit note.
Use the Totals tab on the Credit/Debit Note Entry form to look up the
total weight for the debit or credit, the number of item details and
additional cost details, subtotals of credits or debits for items,
additional costs, excluded tax, and the grand total.

Posting Credit Notes and Debit Notes
During posting, the total of all details and taxes is compared to the
document total you entered. The document is posted only if the two totals
are the same.
Posting assigns the document number you entered and completes the
credit note or debit note and any returns to which you posted credit
notes. You cannot change or delete a credit note or debit note after
posting it.
If the credit note affects item quantities, posting updates the quantities in
Inventory Control.
Job-related credit notes update Project and Job Costing quantities and
costs only if the credit note differs from the posted return.
If you use the Keep Transaction History option, you can display posted
credit notes and debit notes in the Credit/Debit Note Entry form until you
clear them from Purchase Orders. If you do not keep transaction history,
the transactions are deleted during posting or Day End processing
(depending on when you cost inventory).

Day End Processing of Credit Notes and Debit
Notes
Note: If you cost inventory during posting instead of during Day End
Processing, almost all Day End processing tasks will also take place
when you post transactions.
If you are concerned with transaction processing speed, you should
cost inventory transactions during Day End Processing—not during
posting. (You change this setting on the Processing tab of the I/C
Options form if you are using the Inventory Control module.)
When you run Day End Processing to process credit notes that included
changes to costs, the program updates item costs in Inventory Control.
Day End Processing creates the Credit/Debit Note Posting Journal and
the general ledger transactions for the G/L Transactions report, if you
print it in Purchase Orders. It also adds information from each credit note
and debit note to the invoice batch that is created for Sage ERP Accpac
Accounts Payable. (The general ledger transactions are created when
you post the credit and debit notes in Accounts Payable.)
When a credit note is applied to an invoice, the invoice number appears
in the Apply To field when you display the transaction in Accounts
Payable's Invoice Entry form.
Finally, Day End Processing updates history and statistics, if kept, in
Purchase Orders and Inventory Control. If you do not keep transaction
history, it deletes all credit and debit notes.
For information on the general ledger accounts affected by credit notes
and debit notes see Journal entries generated from posted Purchase Orders transactions.
See also
Posting Journals

Using Security with Credit Notes and Debit Notes
You can use security with the Credit/Debit Note Entry form, separately
specifying the persons who can add credit notes and debit notes, edit
quantities, edit costs, and export credit notes and debit notes.
See also
Credit/Debit Note Entry security access
Edit Credit Note Quantity security access
Edit Credit Note Cost security access

General Ledger Journal Entries Generated from
Receipts
Receipts are assigned source code PO-RC on the G/L Transactions
report.
Receipt transactions debit the item's inventory control account and credit
the item's payables clearing account with the total of extended item cost,
allocated taxes, and any prorated additional costs and their allocated
taxes.
If an item uses the LIFO or FIFO costing method, the receipt number and
date, item quantity received, and item cost are added to Inventory
Control's receipt buckets for the item.
Receipt adjustments.Additional general ledger transactions are created
if receipts are edited to change item quantities or costs. The journal
entries debit the inventory control (or Inventory/Expense) account and
credit the payables clearing account with quantity or cost increases, or
credit the inventory control account and debit the payables clearing
account with quantity or cost decreases.
Non-inventory items. When you post a receipt for a non-inventory item
in Purchase Orders, the expense is posted during posting or day-end
processing, and the non-inventory payables clearing account is credited.
Posting the invoice in Accounts Payable generates a general ledger entry
to debit the non-inventory payables clearing account and credit the
payables control account.
New prorated additional cost added on an invoice. When a new
additional cost is added on an invoice, general ledger journal entries are
created to prorate the cost to the receipt items, if applicable, debiting the
inventory control accounts for the items and crediting the payables
clearing account.
Job-related receipts. Items received for projects do not go into
inventory; instead, the value of the item goes into a Work-In-Progress
account specified for the contract in Project and Job Costing.
When you post job-related receipts or invoices, credit notes, and debit
notes with changes to the receipt information, Purchase Orders creates

general ledger journal entries to update the Work-In-Progress and
Payables Clearing accounts with the total of extended item cost,
allocated taxes, and any prorated additional costs and their allocated
taxes.
The program also updates the committed and actual quantities and costs
for the contract in Project and Job Costing.
PO will also create transactions for any overhead associated with the
items or additional costs, and for non-inventory items (such as labor)
received for the job.

General Ledger Journal Entries Generated from
Invoices
Invoices are assigned source code PO-IN on the G/L Transactions report.
The journal entries for invoices are created when the Purchase Orders
batch is posted in Accounts Payable.
If a receipt is invoiced without changes to quantities and costs, a journal
entry is created to debit the item's payables clearing account and credit
the vendor's payables control account (with the total of the extended item
cost, allocated taxes, and any prorated additional costs and their
allocated taxes).
If quantities or costs were changed on the invoice, Purchase Orders
creates general ledger journal entries that:
Debit or credit the item's inventory control (or inventory/ expense)
account for the difference between the receipt amount and the invoice
amount.
Debit or credit the item's payables clearing account for the difference
between the receipt amount and the invoice amount.
Debit the Payables Clearing account for the original amount of the
receipt, net of any adjustments as listed above.
For example, if the item cost increases on an invoice, the difference
between the invoice cost and the receipt cost is debited to the item's
inventory control or inventory/expense account.
New prorated additional cost added on an invoice. When a new
additional cost is added on an invoice, general ledger journal entries are
created by Day End Processing to debit the Inventory Control account
with the amount of the cost and credit the payables clearing account.
Non-inventory items. When invoices are posted for non-inventory items,
the general ledger journal entries created in Accounts Payable debit the
expense account specified for the non-inventory item and credit the
vendor's payables control account.
If you choose the P/O option to create G/L entries for non-inventory
expenses from receipts/returns (on the Integration Options tab of

Purchase Orders' G/L Integration form), Purchase Orders will create debit
entries to expense accounts and credit entries to the non-inventory
payables clearing account when you post receipts. (Posting the invoices
later in A/P will credit the payables control account and debit the noninventory payables clearing account.)
Expensed additional costs. If additional costs are expensed (rather
than prorated to the items on a receipt), Day End Processing creates an
Accounts Payable invoice that will debit the additional cost expense
account and credit the vendor's payables control account when it is
posted in Accounts Payable.
If you choose the P/O option to create G/L entries for expensed
additional costs, Purchase Orders will create debit entries to expense
accounts and credit entries to the Expensed Additional Cost Clearing
Account when you post additional costs. (Posting the invoices later in A/P
will credit the payables control account and debit the Expensed
Additional Cost Clearing Account.)
Note: If the additional costs are job-related, Purchase Orders will always
create G/L entries for expensed additional costs during posting —
whether you select this option or not.
Job-related items. Purchase Orders sends transactions to Project and
Job Costing if an invoice includes an adjustment to the receipt — such as
a change to the cost, quantity, or billing rate. These transactions do not
affect the G/L or A/P.
For example:
If you change the billing rate, Purchase Orders generates a new
transaction for the difference between the old billing rate and the new
billing rate.
If you also change quantities, Purchase Orders will also create a
billing adjustment transaction for the quantity difference.
If the receipt originated from a purchase order and you change the
quantity outstanding, Purchase Orders will update the committed
quantities and costs in Project and Job Costing.
Do not change invoices in Accounts Payable. Job-related invoices
transferred to A/P from P/O will not update Project and Job Costing when

posted in Accounts Payable. Purchase Orders directly updates Project
and Job Costing with invoice amounts.

General Ledger Journal Entries Generated from
Returns
Returns of items to vendors are assigned source code PO-RT on the G/L
Transactions report.
In Inventory Control, returns debit the item's payables clearing account
and credit the item's inventory control/expense account with the value of
the returned items, prorated additional costs, and allocated taxes. When
additional costs prorated to returned items are reprorated, additional
entries are created to debit or credit the Inventory Control and Payables
Clearing accounts for the remaining items on the receipt.
When a credit note is posted for the return and you have run Day End
processing, a credit note is created in the Accounts Payable batch. When
the credit note is posted in Accounts Payable, the transaction will debit
the vendor's payables control account and credit the vendor's payables
clearing account with the value of the returned items, prorated additional
costs, and allocated taxes.
Non-inventory items. When non-inventory items are returned, Day End
Processing does not create any journal entries for Inventory Control
accounts. The transaction is sent to Accounts Payable as an invoice or
credit note which will debit or credit the G/L expense account specified
for the item and post the corresponding credit or debit to the vendor's
payables control account.

General Ledger Journal Entries Generated from
Credit Notes
Credit notes are assigned source code PO-CR on the G/L Transactions
report.
Credit notes debit the vendor's payables clearing account and credit the
vendor's payables control account when the transaction is posted in
Accounts Payable.
Additional cost credits. When a credit note is posted for an additional
cost credit, the credit is debited to the expense account you assign and
credited to the vendor's payables control account.
Credits to returns. When you post a credit note to a return with no
quantity or cost changes, the vendor's payables control account is
debited and the item's payables clearing account is credited.
If a credit note is posted to a return and there are cost changes,
Purchase Orders debits or credits the payables clearing and inventory
control accounts. When the credit note is posted in Accounts Payable,
the payables control account is debited and the payables clearing
account is credited.
When a credit note is posted for an invoice, Purchase Orders creates
journal entries to debit the payables clearing account and credit the
inventory control account, and Day End Processing creates a credit note
for the transaction in the Accounts Payable batch. When you post the
batch in Accounts Payable, a journal entry is created to debit the
payables control account and credit the payables clearing account.
Item cost adjustments. When credit notes are posted to adjust item
costs, Day End Processing creates general ledger journal entries to debit
the payables clearing account and credit the item's inventory control
accounts.
When the credit note is posted in Accounts Payable, a journal entry is
created to debit the vendor's payables control account and credit the
payables clearing account.
Taxes. Allocated taxes from credit notes are posted to the same general

ledger accounts as costs. Recoverable and expensed taxes are posted to
the accounts specified for the tax authorities in Tax Services and the
inventory control or payables accounts used for the related costs.

General Ledger Journal Entries Generated from
Debit Notes
Debit notes are assigned source code PO-DB on the G/L Transactions
report.
When a debit note is posted for an invoice in Purchase Orders, a general
ledger journal entry is created during posting or Day End Processing to
debit the item's inventory control account and credit the item's payables
clearing account.
When the debit note is posted in Accounts Payable, the payables
clearing account is debited and the vendor's payables control account is
credited.
Taxes. Allocated taxes from debit notes are posted to the same general
ledger accounts as their related costs. Recoverable and expensed taxes
are posted to the accounts specified for the tax authorities in Tax
Services and the inventory control or payables accounts used for the
related costs.

Creating General Ledger Batches
If you do not use the option to create general ledger transactions during
posting or during day-end processing, you must use the Create Batch
form when you want to create a general ledger transaction batch to
record the inventory transactions and entries to payables clearing. You
can then process the batch in Sage ERP Accpac General Ledger, if you
use it, or post it manually to another general ledger.
If you want to print the G/L Transactions report you must print it before
you create the general ledger batch. When you create the batch,
Purchase Orders deletes the information in the G/L Transactions report.
The Create Batch form also lets you post a batch of invoices in Accounts
Payable from invoices or credit/debit notes posted in Purchase Orders.
You can use this form to post A/P invoices created by Purchase Orders
only if you selected On Request Using Create Batch Icon for the Post A/P
Batches option on the Processing tab of the P/O Options form.
See also
Create Batch Form
Periodic processing

Serial Numbers
Serial numbers are used for tracking stock from the point of receipt
through to the point of sale, and can be used to track returned items from
the customer and back to the vendor.

Serialized Inventory Pop-ups Field list
For information about fields and buttons in a Purchase Orders Serialized
Inventory pop-up form, click the following links:
Fields:
Auto-Allocate From
Next Serial Number
Unit of Measure

Buttons:
Add
Auto Alloc.
Auto Gen
Clear
Return All

Count section:
Allocated / Generated / Returned
Remaining
Serial No'sRequired

P/O Lot Tracking Pop-ups Field List
For information about fields and buttons in a Purchase Orders Lot
Tracking pop-up form, click the following links:
Fields:
Auto-Allocate From
Make Lots OR Each Lot Has
Next Lot Number

Buttons:
Add
Auto-Alloc
Auto Gen
Clear
Close

Count Section:
Allocated / Generated / Returned
Lot Qty Required
Remaining

Copy Purchase Orders Field List
From/To Vendor Number
From/To PO Number
Tax Group
PO Type
Job Related
Use PO Cost

Copy POs tab
Amount Available
Description
On Hold
Original Amount
PO Date
PO Number
PO Type
Reference

Detail grid
Contract, Project, Category, Cost Class (if job-related)
Copy Detail
Description
Drop-Ship
Expected Arrival Date
Item Number
Line Number
Location
Optional Fields
Quantity Ordered
Unit of Measure
Unit/Extended Cost
Unit/Extended Weight
Weight unit of Measure

Optional Fields tab
Optional Field and Description
Value Set
Value and Description

Credit/Debit Note Entry Field List
Document Number
Vendor Number (and name)
Vendor Information form (opened from the Vendor Number field)
Credit/Debit tab
Detail entry grid (on the Credit/Debit tab)
Taxes tab
Retainage tab
Additional Costs tab
Distribute Proration (if prorating additional cost manually)
Distribute Cost (if distributing costs among several receipts)
Optional Fields tab
Rates tab (multicurrency ledgers)
Totals tab

Editing Vendor and Detail Tax Information
Purchase Orders calculates a tax amount on purchase orders, receipts,
invoices, returns, credit notes, and debit notes if all three of the following
conditions apply:
You have entered tax rates for the applicable tax authorities and
classes in Tax Services.
The vendor for the document is subject to tax.
The transaction contains taxable items or taxable additional costs.
In Purchase Orders, tax information is calculated and displayed for
individual details and for the total purchase order, receipt, invoice, return,
credit note, or debit note. (No tax information is displayed for
requisitions.)
Tax calculations are based on the rates entered for the various authorities
and tax classes in Tax Services.
You can edit some tax information for individual detail lines, but you can
change tax amounts directly only for the document as a whole. To
change tax amounts for the primary vendor, use the Taxes tab; for
secondary vendors, use the Additional Cost Vendor Taxes form.
See also
Detail tax information
Document tax information

Exporting Credit Notes and Debit Notes
Use the Export command on the File menu in the Credit/Debit Note Entry
form to transfer credit note and debit note transactions created in
Purchase Orders to non-Sage ERP Accpac applications, or to a file to be
edited and imported later.
Before exporting, decide which fields to include in the export file. You
must select fields for each type of record used for credit notes and debit
notes. You should also find out the path for the export file you want to use
or create.
When you choose Export, Purchase Orders exports all the credit notes
and debit notes currently in the system. If you do not want to export
everything, use the Set Criteria option to specify the documents to export.

Credit/Debit Note Entry — Credit/Debit Tab
Use this tab to enter:
The credit note or debit note date.
The invoice or return number to which the transaction applies.
The billing address for the credit note or debit note.
The remit-to address where you send the payments to the vendor.
An optional description and reference.
The credit note or debit note total.
Enter new details for a credit note or debit note you are entering
without an invoice or return number.
Edit the item detail lines for a credit note or debit note for an existing
invoice or return from a primary vendor. (You cannot add new detail lines
when working with an existing invoice or return, and you cannot
delete detail lines displayed from returns.)
Open a separate form to edit tax or other information for a single
detail. The Detail Items/Taxes form displays all the fields for a single detail,
including tax fields.
The Credit/Debit tab also lets you open the following additional forms:
Bill-To Location form
Remit-To Location form
Detail Comments form

For information about a button on the Credit/Debit tab, click the
corresponding link:
Item/Tax Calculate Tax

For information on the buttons that appear on this tab, click the
corresponding link, below:
or
Finder

Zoom

Click one of the links below for help on using the corresponding tab:

Taxes
Optional Fields

Additional Costs

Retainage

Rates

Totals

See also
Credit/Debit Note Entry — overview
Using Detail Entry Grids

Credit/Debit Note Entry — Taxes Tab
Use this form to
View or change the vendor's tax group.
Check tax information and edit the tax classes and amounts for the
vendor's tax authorities.
Click the Calculate Taxes button to cancel changes you made to tax
amounts. (The program recalculates tax amounts using the tax tables in
Tax Services.)
Click one of the links below for help on using the corresponding tab:
Credit/Debit

Retainage

Additional Costs

Optional Fields

Rates

Totals

Credit/Debit Note Entry — Retainage Tab
This tab appears only for credit/debit notes for job-related items that had
amounts retained on the receipt or invoice.
If the items were originally received in another currency, you use this tab
to:
Choose whether to use the original retainage exchange rate for the
credit/debit note, or use the current exchange rate.
For information on using other tabs on the Credit/Debit Note Entry form,
click the corresponding links:
Credit/Debit

Taxes

Additional Costs

Optional Fields

Rates

Totals

See also
Credit/Debit Note Entry Form — overview

Credit/Debit Note Entry — Additional Costs
tab
Use this tab to:
Add the additional costs on the credit notes and debit notes you
receive from your vendors.
Specify how to reprorate the costs if you returned the items.
Note: If you are adding additional costs, you must choose No
Proration. If you choose to prorate, the program will display an error
message and prevent you from posting the credit note or debit notes.
Edit additional cost details from invoices you are crediting or debiting.
Allocate new additional costs (added to the credit note/debit note) to
one or more receipts.
To prorate additional costs for a single receipt:
1.

Select the additional cost on the Additional Cost entry grid.

2.

Press F9 to open the Detail Costs/Taxes form.

3.

Click the Zoom button beside the Distribute Proration field.

4.

Distribute the additional cost (and billing rate for billable details).
To prorate additional costs for several receipts:

1.

Select the additional cost on the Additional Cost entry grid.

2.

Press F9 to open the Detail Costs/Taxes form.

3.

Click the Dist. Cost button to display the Cost Allocation form. (The Zoom
button beside the Distribute Proration field will be dimmed.)

4.

Highlight the receipt you want, and click the Zoom button in the
column heading to display the Distribute Proration form.

5.

Distribute the additional cost (and billing rate for billable details).

Click one of the links below for help on using the corresponding tab:
Credit/Debit

Taxes

Retainage

Optional Fields

Rates

Totals

For information about using the buttons that appear on this tab, click
the corresponding button or link:
or
Finder

Zoom

Cost/Tax

Calculate Tax

See also
Credit/Debit Note Entry — overview

Credit/Debit Note Entry — Optional Fields
Tab
This tab appears if you have assigned optional fields to the Credit/Debit
Note Entry form. You see only the fields that you added using the
Optional Fields form in the Setup folder.
Use the tab to:
Add or change information in the optional fields that are assigned to
the form.
For information about defining optional fields for the Credit/Debit Note
Entry form, see the Optional Fields form.
Click one of the links below for help on using the corresponding tab:
Credit/Debit

Taxes

Retainage

Additional Costs

Rates

Totals

To enter optional information, type the entry or choose it from the
Finder (if the Finder is active).
If you can choose from a list of codes, the program displays the
description, if any, entered for the code in the Optional Fields form.
You cannot change the description here. If you want to change the
description, you must do so in the Optional Fields form in Common
Services.
If there is a Finder beside the field, choose one of the entries in the
Finder list. (You must select one of the choices if the "validate" option
was selected for this field and blank is not allowed.)
See also
Entering optional fields information
Credit/Debit Note Entry Form — overview
Using optional fields

Credit/Debit Note Entry — Rates Tab
This tab appears only in multicurrency ledgers when you are entering a
credit note or debit note for a vendor who does not use the functional
currency.
Use the Rates tab to:
Change the rate type, rate date, and exchange rate for converting the
credit note or debit note amount from the vendor's currency to your
functional (home) currency.
Look up the rate information entered with the invoice or return, if any,
to which you are posting a credit note or debit note.
Click one of the links below for help on using the corresponding tab:
Credit/Debit
Additional Costs

Taxes
Optional Fields

See also
Credit/Debit Note Entry Form – overview

Retainage
Totals

Credit/Debit Note Entry — Totals Tab
Use this tab to:
Enter a comment for the credit or debit note.
Enter a discount that applies to the whole transaction.
Verify credit note or debit note totals for the vendor.
Check tax amounts.
Check the estimated weight of the goods for which you were credited
or debited.
Check the number of item and additional cost details entered for the
vendor on the credit note or debit note.
Check the document subtotal and total additional costs for the vendor.
Click one of the links below for help on using the corresponding tab:
Credit/Debit

Taxes

Retainage

Additional Costs

Optional Fields

Rates

See also
Checking Credit/Debit Note totals
Credit/Debit Note Entry form – overview

Purchase Orders Processing Overview
This topic contains an overview of how posting, day-end processing, and
audit trails relate to transaction processing in Purchase Orders.
Purchase Orders lets you enter requisitions, purchase orders, receipts,
invoices, returns, credit notes, and debit notes. Using Sage ERP Accpac
Purchase Orders, your purchase-order processing cycle can include:
Posting requisitions.
Creating and posting purchase orders from requisitions or without
using requisitions.
Posting receipts to purchase orders or without referencing particular
purchase orders.
Posting returns to receipts or without referencing receipts.
Posting invoices to receipts or without receipts (for additional costs).
Posting credit notes to invoices or returns or without referencing
invoices or returns.
Posting debit notes to invoices or without invoices.
Purchase Orders uses online transaction processing rather than batch
processing. This means that you post each transaction individually after
you enter it.
Posting updates quantities. When you post transactions, Purchase
Orders immediately updates item quantities in Inventory Control so you
always know your inventory levels. Depending on when you cost
inventory, item costs and other accounting and statistical information may
be updated by posting or by Day End Processing.
Day End updates everything else. You run Day End Processing to create
batches of Accounts Payable summary invoices, credit notes, and debit
notes. If you cost inventory during Day End Processing, it will also update
purchasing history, statistics, and audit information.
Day End Processing/posting also creates batches of general ledger
transactions and the Purchase Orders posting journals.
If necessary, you can run Day End Processing several times a day to

keep this information more current.
See also
Adding new vendor records during transaction entry
Keeping Transaction History
Processing credit/debit notes
Processing invoices
Processing purchase orders
Processing receipts
Processing requisitions
Processing returns

Invoice Entry Field List
Currency (display only)
Invoice Number
Subtotal (display only)
Vendor Number (and name)
Vendor Information Form (opened from Vendor Number field)
Invoice tab
Detail entry grid (on the Invoices tab)
Taxes tab
Terms tab
Retainage tab
Additional Costs tab
Distribute Proration (if prorating additional cost manually)
Distribute Cost (if distributing costs among several receipts)
Optional Fields tab
Rates tab (multicurrency ledgers)
Totals tab

Entering Additional Cost Details on Invoices
When entering an invoice for a receipt, you see additional costs only for
the vendor selected for the invoice. Additional costs for secondary
vendors appear on separate invoices.
You can add new additional costs to an invoice, as described under Entering
additional costs on receipts, and you can select any proration method except
manual proration.
You can also edit the cost amounts displayed from a receipt, except for
amounts that were manually prorated on the receipt.
Information you can edit for additional cost details includes:
Description, reference, and comment.
Amount.
You can change all additional cost amounts, except those that were
manually prorated on the receipt. Although you cannot delete an
additional cost detail, you can change the amount to zero.
General ledger accounts.

Non-inventory items
If you are adding additional costs for non-inventory items, you must
choose No Proration. If you choose to prorate by quantity, cost, or weight,
the program will display an error message and prevent you from posting
the invoice.

Displayed tax information
Purchase Orders displays the following tax information for each
additional cost detail:
Amount of tax that is included in the extended item cost.
Net cost of additional cost items with tax included in their prices (the
tax base).
Total allocated tax amount — the amount of tax that will be allocated
to the cost of the item.
Use the Cost/Tax button on the Additional Cost tab to view and edit tax
information for the additional cost, as described below.

Allocating additional costs to multiple receipts
To prorate a new additional cost to multiple receipts, select the detail line
and then click the Distribute (Dist.) Cost button to open the Cost
Allocation form. You can manually enter amounts to allocate to each
receipt, or you can let Purchase Orders calculate the amount to allocate
according to the proration method you selected on the Additional Costs
tab.
If you want to prorate or expense a job-related cost to several jobs, you
must have a receipt detail for each of the jobs to which you want to
apportion costs.
You can also specify retainage for job-related costs.

Editing the tax distribution
To check or edit tax distributions for an additional cost detail, select the
detail line on the Additional Costs tab, then click the Cost/Tax button to
open the Costs/Taxes form.
The Costs/Taxes form lets you specify, for each tax authority, the tax
class for the item and whether tax is included in the cost (if allowed by
the authority). The Costs/Taxes form also displays the recoverable and
expensed tax amounts in the tax distribution pop-up form.
If you change the tax class for an additional cost that was manually
prorated on the receipt, any resulting difference in the tax amount is
posted to the default cost expense account specified in the Options form.
You can override the additional cost tax amount by changing the total tax
on the Taxes tab; however, the program will prorate the tax change to
each of the details. You can use the Calc. Taxes button to recalculate all
of the tax on the invoice.

Invoice Entry — Detail Costs/Taxes Form
Use the Detail Costs/Taxes form to:
View or edit an additional cost detail.
Instead of presenting the details of an additional cost in a tabular
format, the Detail Costs/Taxes form displays all the fields for a single
detail on a data entry form. In addition, it includes fields that allow you
to change the tax information or enter a comment for a detail.
Check tax information and calculations for a selected additional cost
detail.
Edit the tax class and tax-included options for the tax authorities.
Add a comment for an additional cost detail.
Add a new additional cost detail.
To use the Detail Costs/Taxes form
1.On the Additional Cost tab, select the cost detail for which to review
taxes.
2.Click the Cost/Tax button, or press the F9 key.
3.Make any required changes to the selected additional cost detail.
You can select a different detail using the navigation buttons beside
the Line Number field.
You can enter a new detail by clicking the New button near the Line
Number field.
4.When you have finished, click Close to return to the Additional Costs
tab.
Click the following icons for information about using these buttons:
or
Finder

Zoom

For information about one of the following buttons on the Detail
Cost/Taxes form, click the link:

Add Save Calculate Tax Close

Go back to the Additional Costs tab
See also
Invoice Entry Form — overview

Invoice Entry — Bill-To Location Form
Use this form to edit an existing bill-to location address or to type a new
billing address for the invoice.
You do not have to enter a bill-to location code or address information.
To use the Bill-To Location form
1.If you use Inventory Control, type the location code to use in the BillTo Location field, or select it from the Finder.
2.To enter or edit address information, or if you do not use Inventory
Control, click the Zoom button beside the Bill-To Location field or
press the F9 key in the field.
3.Type the name, address, and contact information to use for the
location, or edit displayed information (from the receipt or the location
record in Inventory Control).
4.When finished, choose the Close button or press F9 to return to the
Invoice tab.
Opening and closing the Bill-To Location form
Click the Zoom button to open the Bill-To Location form with a mouse.
Use the F9 key on your keyboard to open or close the Bill-To Location
form.
Choose the Close button to close the Bill-To Location form.
Go back to the Invoice tab.

Invoice Entry — Detail Comments Form
Use this form to enter, edit, or delete comments that apply to the detail
line.
To enter or edit comments
1.Open the Detail Comments form. Either:
Select the detail line, then click the Zoom button beside the
Comments field, or
With the insertion point in the Comment field for the detail, press the
Shift and F9 keys.
2.Type the remarks, or make the changes you need, pressing Enter to
start each new line.
3.When finished, click the Close button or press Shift and F9 to close
the form.
To delete comments
1.Open the Detail Comments form.
2.Highlight the text to delete, then press the Delete key on your
keyboard. If a message appears asking you to confirm the deletion,
click Yes.
3.When finished, click the Close button or press Shift and F9 to close
the form.
You can also delete comments by changing the entry for the field to
No in the detail entry grid on the Invoice, or by deselecting the
Comments box on the Detail Items/Taxes form (click the field or press
the Shift and F9 keys at the same time in it).
If you use this method, your remarks are not immediately deleted. If
you decide before posting the invoice that you want to use the
remarks, enter Yes (or reselect the Comments field on the zoomed
detail-entry form). The original remarks will reappear.
Go to the Invoice tab.

Invoice Entry Form — Create Invoice From
Receipts
Use this form to select several receipts and add them to the invoice.
To use the Create Invoice From Receipts form
1.Either click the Zoom button ( ) beside the From Multiple Receipts
field, or click the option to select it, then press the F9 key.
2.In the form that opens, either use the Finder to select, one at a time,
the receipts you wish to use or type the numbers in the Receipt
Number column.
3.When you have selected all the receipts you need, click the Invoice
button to add the receipt details to the invoice
4.Click the Close button to close the form when you have finished.
Note: When you create an invoice from more than one receipt, all of the
invoice header information (including the fields on the Optional Fields
tab) will come from the first receipt that you select.
Return to the Invoice tab.

Invoice Entry Form — Remit-To Location Form
Use this form to look up the address information entered for the selected
remit-to location. Address information appears only if you select a remitto code for the vendor.
You cannot edit information in this form. Use Accounts Payable to add
and edit remit-to locations for vendors.
To display the Remit-To Location form, on the Invoice tab of the
Invoice Entry form either:
Click the Zoom button ( ) next to the Remit-To Location field, or
With the insertion point in the Remit-To Location field, press the F9
key.
To close the Remit-To Location form, either press the F9 key or click the
Close button.

Invoice Entry — Invoice Tab
Use this tab to enter:
The receipt number (or numbers) to which the invoice applies.
The invoice date.
The invoice total.
The billing address for the invoice.
The remit-to location.
An optional description and reference.
The 1099/CPRS code and amount (for vendors who are subject to
1099 or CPRS reporting).
Invoice details.
The detail entry grid (at the bottom of the tab) lets you:
Edit or remove item detail lines for an invoice from a primary vendor.
Note: You cannot add more detail lines to the invoice tab. All lines
must have been on the receipt. You can, however, add costs to the
Additional Costs tab, and you can change the quantity being invoiced.
Edit received quantities, item costs, and detail discounts, if you have
security rights to do so.
Enter comments and optional fields for the details.
Display all the fields, including tax fields, for a selected detail on the
Item/Tax form.
The Invoice tab also lets you open the following additional forms:
Bill-To Location form
Create Invoice From Receipts form
Detail Items/Taxes form
Detail Comments form
Remit-To Location form

Click the following icons and links for information about using the
buttons:
Item/Tax Calc.Taxes

or
Finder

Zoom

For help on using a different tab on the Invoice Entry form, click the
corresponding link, below:
Taxes
Optional Fields

Terms
Rates

Retainage
Totals

See also
Entering Invoice Details
Invoice Entry Form — overview
Using Detail Entry Grids
Entering units for job-related invoices

Additional Costs

Invoice Entry — Taxes Tab
Use this tab to:
Check or change the vendor's tax group.
Check tax information or edit the tax class and tax amount for the
vendor's tax authorities.
Click the Calc. Taxes button to have the program recalculate tax
amounts after changing tax classes or the tax included option.
If you changed tax totals on the invoice, the Calc. Taxes button
restores the original amounts.
Click the icon below for information on using the Finder:
Finder

For help on using a different tab on the Invoice Entry form, click the
corresponding link, below:
Invoice
Optional Fields

Terms
Rates

See also
Checking invoice totals
Invoice Entry Form — overview

Retainage
Totals

Additional Costs

Invoice Entry Form — Terms Tab
Use this tab to:
Check the vendor's terms.
Enter or edit the due date and discount terms of an invoice.
Edit a payment schedule when you are making a series of payments
over time.
Payment terms can be as simple as a due date and a discount date and
rate, or they can include payment schedules to allow for several
installment payments.
All payment terms are defined in Accounts Payable but you can change
them on the Terms tab before you post the invoice.
Click the icon below for information on using the Finder:
Finder

For help on using a different tab on the Invoice Entry form, click the
corresponding link, below:
Invoice
Optional Fields

Taxes
Rates

See also
Checking invoice totals
Invoice Entry Form — overview

Retainage
Totals

Additional Costs

Invoice Entry — Retainage Tab
This tab appears only if you check the Retainage checkbox for jobrelated invoices. (The Retainage checkbox appears only if you use
retainage accounting in Accounts Payable.)
You use this tab to:
Choose the payment terms for retained amounts.
Choose whether to use the original retainage exchange rate for the
receipt or use the current exchange rate (if the items were originally
received in another currency).
For information on using other tabs on the Invoice Entry form, click the
corresponding links:
Invoice
Optional Fields

Taxes
Rates

See also
Invoice Entry Form — overview

Terms
Totals

Additional Costs

Invoice Entry — Additional Costs Tab
Use this tab to:
Add additional costs charged on the shipment by either a primary vendor or
a secondary vendor, such as for handling charges, service charges, and
duty.
Specify how to prorate new additional costs or reprorate the costs if
you return the items.
Allocate new additional costs (added to the invoice) to one or more
receipts.
To prorate additional costs for a single receipt:
1.

Select the additional cost on the Additional Cost entry grid.

2.

Press F9 to open the Detail Costs/Taxes form.

3.

Click the Zoom button beside the Distribute Proration field.

4.

Distribute the additional cost (and billing rate for billable details).
To prorate additional costs for several receipts:

1.

Select the additional cost on the Additional Cost entry grid.

2.

Press F9 to open the Detail Costs/Taxes form.

3.

Click the Dist. Cost button to display the Cost Allocation form. (The Zoom
button beside the Distribute Proration field will be dimmed.)

4.

Highlight the receipt you want, and click the Zoom button in the
column heading to display the Distribute Proration form.

5.

Distribute the additional cost (and billing rate for billable details).

You can also open the Detail Costs/Taxes form to display or edit all the information
for a single additional cost detail on a separate form. You can also enter
a comment for the additional cost detail using the Detail Costs/Taxes
form.
For information about a button on the Additional Costs tab, click its name:
Dist. Cost

Cost/Tax

Click one of the links below for help on using a different Invoice Entry
tab:
Invoice
Optional Fields

Taxes
Rates

See also
Invoice Entry Form — overview

Terms
Totals

Retainage

Invoice Entry — Optional Fields Tab
This tab appears if you have assigned optional fields to the Invoice Entry
form (using the Optional Fields form in the Setup folder).
Use the tab to:
Add or change information in the optional fields that are assigned to
this invoice.
If you have assigned optional fields to invoice and additional cost details,
you can enter optional field information for each item on the individual
detail lines.
To enter optional information, type or choose your entry for each
optional field.
If the optional field has a Finder, you can select one of the entries from
the Finder list. Depending on how the list has been set up, you may be
able to leave the field blank.
Click this icon for information about using the Finder:
Finder

For information about using a different tab on the Invoice Entry form,
click a link for help on using the corresponding tab:
Invoice
Additional Costs

Taxes
Rates

Terms
Totals

See also
Entering Optional Fields Information
Invoice Entry Form — overview
Using optional fields

Retainage

Invoice Entry — Rates Tab (multicurrency
ledgers)
This tab appears only if you use multicurrency accounting and you are
entering an invoice for a primary vendor who does not use the functional
currency.
Use the Rates tab to:
Change the rate type, rate date, and exchange rate for converting the
invoice amount from the vendor's currency to your functional (home)
currency.
Look up the rate information entered with the receipt.
Click this icon for information about using the Finder:
Finder

For help on using a different tab on the Invoice Entry form, click the
corresponding link, below:
Invoice
Additional Costs

Taxes
Optional Fields

See also
Invoice Entry Form — overview

Terms
Totals

Retainage

Invoice Entry — Totals Tab
Use this tab to:
Verify invoice totals for the vendor.
Enter a discount percentage or a total discount for the invoice.
Enter comments for the invoice.
Check the estimated weight of the goods for which you were invoiced.
Check the number of item and additional cost details entered for the
vendor on the invoice.
Check the invoice subtotal and total additional costs and excluded
taxes for the vendor.
For help on using a different tab on the Invoice Entry form, click the
corresponding link, below:
Invoice
Additional Costs

Taxes
Optional Fields

See also
Checking invoice totals
Invoice Entry Form — overview

Terms
Rates

Retainage

Purchase Order Entry Field List
Last Receipt Number (display only)
Purchase Order Number
Vendor Number (and name)
Vendor Information form (opened from Vendor Number field)
Order tab
Detail entry grid (on Order tab)
Taxes tab
Optional Fields tab
Rates tab
Totals tab

Consolidating Requisition Details on Purchase
Orders
You can consolidate details from separate requisitions into single details
on purchase orders for the same vendor, item, unit of measure, and (if
you use Inventory Control) inventory location. The program combines all
related details, with the exception of details that include drop-ship
addresses. A separate purchase order detail is created for each
requisition detail with a drop-ship address.
Consolidation deletes order numbers. Any order numbers entered in
requisition details are lost if you consolidate when creating purchase
orders, but you can edit the new purchase orders to re-enter the order
numbers you need.
Sample consolidations. For example, assume the following detail
lines exist for a vendor on the requisitions from which you are creating
purchase orders and you have chosen to consolidate details:
Line Item

DropLoc. Qty. Unit Ship Order No.

1

A1-103/0

1

10 Ea.

Yes

None

2

A1-103/0

1

15 Ea.

No

21234

3

A1-103/0

1

7

Ea.

No

37288

4

A1-103/0

2

9

Ea.

No

None

The following details are included on the purchase orders:
Line Item

DropLoc. Qty. Unit Ship Order No.

1

A1-103/0

1

10

Ea.

Yes

None

2

A1-103/0

1

22

Ea.

No

None

3

A1-103/0

2

9

Ea.

No

None

Lines 2 and 3 were combined because they are identical except for the
quantity and order number. Notice that the line now has no order number
and that the quantities are combined.

Line1 was not consolidated because it contains a drop-ship address.
Line4 was not consolidated because it is for a different location.
Also note: Lines will not be consolidated if they have optional fields, and
they will not be consolidated if the vendor item numbers are different.
Go back to Creating purchase orders from requisitions.

Day End Processing of Job-Related Transactions
Project and Job Costing actual and committed costs are updated during
Day End processing with the total cost, plus the allocated and expensed
taxes that are payable when a receipt is invoiced (excludes tax on
retainage).
Project and Job Costing is also updated with taxes on retainage amounts
when the retainage is invoiced in Accounts Payable.
For example, assume a series of transactions for 440.00 cost, plus 27.72
in expensed taxes — for a total of 467.72.
The following transactions are sent from to Project and Job Costing after
you post a purchase order and run Day End Processing:

Extended cost
Labor amount
Overhead amount
Total cost

Committed Costs

Actual Costs

470.80
0.00
0.00
470.80

0.00
0.00
0.00
0.00

The following transactions are sent from to Project and Job Costing after
you post a receipt and run Day End Processing:

Extended cost
Labor amount
Overhead amount
Total cost

Committed Costs

Actual Costs

3.08
0.00
0.00
3.08

467.72
0.00
0.00
467.72

The 3.08 committed amount is the expensed tax portion for the retainage.
When the retainage is invoiced in Accounts Payable, the committed and
actual costs are updated for the retainage tax amount.
See also
Posting Journals
Journal entries generated from posted Purchase Orders transactions

Entering Blanket Purchase Orders
To enter a blanket purchase order
1.Choose Purchase Order Entry from the P/O Transactions folder to
add purchase orders.
2.Use the PO Order Number field to add a new purchase order. Press
the Tab key or click the New button.
If you do not want Purchase Orders to assign the order number, type
the new number yourself.
3.Type the vendor number or select it from the Finder. You can also
type a new vendor number, not yet added in Accounts Payable.
4.Choose Blanket in the PO Type field.
5.Enter the total amount that can be used for the blanket purchase
order in the Original Amount field.
6.Complete the remaining Purchase Order Information and Vendor Information tabs with the
information you need for the purchase order.
7.Add the details you are ready to order from the purchase order. (You do
not have to add all the details at once.)
8.Add optional field entries (if used) and other information for the purchase
order.
9.In multicurrency ledgers, edit the exchange rate information, if necessary.
10.Choose the Post button to post the purchase order.
For more information, see Blanket purchase orders
See also
Processing purchase orders

Entering Future Purchase Orders
To enter a future purchase order
1.Choose Purchase Order Entry from the P/O Transactions folder to
add purchase orders.
2.Use the PO Order Number field to add a new purchase order. Press
the Tab key or click the New button.
If you do not want Purchase Orders to assign the order number, type
the new number yourself.
3.Type the vendor number or select it from the Finder. You can also
type a new vendor number, not yet added in Accounts Payable.
4.Type the date when you want to activate the purchase order.
5.Select Future in the PO Type field.
6.Complete the remaining Purchase Order Information and Vendor Information tabs with the
information you need for the purchase order.
7.Add the details and optional field entries (if used) and other information for the
purchase order.
8.In multicurrency ledgers, edit the exchange rate information, if necessary.
9.Click the Post button to post the purchase order.
For more information, see Future purchase orders

See also
Processing purchase orders

Entering Standing Purchase Orders
To enter a standing purchase order
1.Choose Purchase Order Entry from the P/O Transactions folder to
add purchase orders.
2.Use the PO Order Number field to add a new purchase order. Press
the Tab key or click the New button.
If you do not want Purchase Orders to assign the order number, type
the new number yourself.
3.Type the vendor number or select it from the Finder. You can also
type a new vendor number, not yet added in Accounts Payable.
4.Choose Standing in the PO Type field.
5.Complete the remaining Purchase Order Information and Vendor Information tabs with the
information you need for the purchase order.
6.Add the details and optional field entries (if used) and other information for the
purchase order.
7.In multicurrency ledgers, edit the exchange rate information, if necessary.
8.Choose the Post button to post the purchase order.
For more information, see Standing purchase orders
See also
Processing purchase orders

Importing Purchase Orders
You can import purchase orders that you previously exported for reuse,
but you must change the PO numbers before you import them.
You cannot import purchase orders with numbers that you have already
assigned in Purchase Orders, unless you have cleared the transactions
with those numbers.
The original file from which you imported the information is retained until
you delete it.

For step-by-step instructions on importing or
exporting purchase orders
Click Import on the File menu of the Purchase Order Entry form, then
press the F1 key to display System Manager help that will guide you
through the import process.
See also
Processing purchase orders

Purchase Order Entry — Order Tab
Use this tab to enter:
An optional template code to specify the default entries in purchase
order header and vendor information fields.
Whether the purchase order is on hold.
Whether to create the purchase order from one or more requisitions.
The purchase order date.
Arrival date.
The purchase order type (active, blanket, future, standing).
An optional FOB (free-on-board) location.
Ship via information, and the default shipping and billing locations
code for the purchase order.
A terms code for the vendor.
An optional description and reference.
Add, edit or delete purchase order details.
Specify canceled quantities.
For information on buttons you can use with order details, click the links
below:
Item/Tax Calculate Taxes Consolidate

Click these buttons or the links for additional help:
or
Finder

Zoom

Drop-down Lists

For help on using a different Purchase Order Entry tab, click the
corresponding link, below:
Taxes

Optional Fields

Rates

Totals

See also
Adding Purchase Order Details
Purchase Order Entry — overview
Using Detail Entry Grids

Purchase Order Entry — Taxes Tab
Use this form to
View or change the tax group for the vendor for this purchase order.
Edit the tax classes and tax-included options for this purchase order.
Check tax information for the document and edit the vendor tax
classes and amounts.
You can change a tax class to another tax class that is assigned to the
authority, and you can change the choice for the Tax Included option (if
the tax authority permits tax-included costs).
Click the Calculate Taxes button to have the program recalculate taxes
based on the new tax class or tax included status and the tax tables in
Tax Services.
Choose one of the links below for help on using the corresponding tab:
Order

Optional Fields

Rates

Totals

See also
Purchase Order Entry — Overview

Purchase Order Entry — Optional Fields Tab
This tab will appear only if you have Sage ERP Accpac's Transaction
Analysis and Optional Field Creator, and if you have assigned optional
fields to the Purchase Order Entry form. You see only the fields that you
added using the Optional Fields form in the Setup folder.
The Optional Fields tab contains optional fields added by your company
that apply to the purchase order as a whole. Optional fields on detail lines
apply to the individual details.
If the optional field has a Finder, you can select one of the entries
from the Finder list. Depending on how the list has been set up, you
may be able to leave the field blank.
If no Finder appears, you do not have to enter data in the optional
field, or you can enter any data you wish, depending on the field type
and number of characters permitted in the field.
Optional field information can pass through the complete transaction
cycle — from purchase requisitions, to purchase orders, to receipts, to
invoices, and even to downstream ledgers like Accounts Payable and
General Ledger — as long as you assign the same optional fields to each
of the transaction forms and to the general ledger accounts.

Use this tab to:
Add or change information in the optional fields that are assigned to
the form.
For information about defining optional fields for the Purchase Order
Entry form, see Options Form - Processing tab.
Choose one of the links below for help on using the corresponding tab:
Order

Taxes

Totals

Rates

See also
Entering Optional Fields Information
Purchase Order Entry — overview
Selecting optional fields

Purchase Order Entry — Rates Tab
This tab appears only in multicurrency ledgers when you are entering a
purchase order for a vendor who does not use the functional currency or
when the functional currency is an EMU currency but the vendor is not.
Use the Rates tab to:
Change the rate type, rate date, and exchange rate for converting the
document amount from the vendor's currency to your functional
(home) currency.
This tab appears only if you use multicurrency accounting and you are
entering a document for a vendor who does not use the functional
currency (or the vendor and functional currency are not both EMU
currency members).
Choose one of the links below for help on using the corresponding tab:
Order

Taxes

Optional Fields

Totals

See also
Purchase Order Entry — overview

Purchase Order Entry — Totals Tab
Use this tab to:
Enter a comment for the purchase order.
Enter a discount percentage or a total discount amount for the
purchase order.
Verify purchase order and tax totals.
Specify the number of mailing labels to print for the purchase order.
Check the estimated weight of the goods on the purchase order.
Choose one of the links below for help on using the corresponding tab:
Order

Taxes

Optional Fields

Rates

See also
Purchase Order Entry — Overview

Purchase Order Entry — Bill-To Location
Form
Use this form to edit an existing bill-to location address or to type a new
billing address for the purchase order.
To use the Bill-To Location form
You do not have to enter a bill-to location code or address information.
1.If desired, type the location code to use in the Bill-To Location field, or
select it from the Finder.
2.To enter or edit address information, click the Zoom button beside the
Bill-To Location field or press the F9 key in the field.
3.Type the name and address information to use for the location, or edit
displayed information (from the location record in Inventory Control).
4.When finished, click the Close button to return to the Order tab.
Go back to the Order tab

Purchase Order Entry — Detail
Comments/Instructions
Use this form to type comments or instructions which apply to the detail
line.
You can enter both comments and instructions for a detail line. You can
also print the remarks on the purchase order.
To enter comments or instructions
1.Click the Zoom button ( ) beside the Comments/Instructions field, or,
while the insertion point is in the field, press the Shift and F9 keys at
the same time.
2.Choose whether to enter a comment or an instruction.
3.Type the remarks, pressing Enter to start each new line.
4.When finished, click Close to close the form.
To edit comments or instructions
1.Click the Zoom button ( ) beside the field, or, while the insertion point
is in the field, press the Shift and F9 keys at the same time.
2.Choose whether to edit a comment or an instruction.
3.Make the changes you need.
4.When finished, click Close to close the form.
To delete comments or instructions
1.Click the Zoom button ( ) beside the field, or, while the insertion point
is in the field, press the Shift and F9 keys at the same time.
2.Choose whether to delete a comment or an instruction.
3.Highlight the line to delete, then press the Delete key on your
keyboard. If a message appears asking you to confirm the deletion,
choose Yes.
4.When finished, click Close to close the form.
You can also delete comments or instructions by changing the entry in

the field to No on the Order tab, and by deselecting the
Comments/Instruction box on the Detail Items/Taxes form (click the field
or press the Shift and F9 keys at the same time in it).
If you use this method, your remarks are not deleted (although they
would not be printed on the purchase order). If you later decide you want
to use the remarks, enter Yes (or reselect the Comments/Instructions
field on the Detail Items/Taxes form). Your original remarks will reappear.
See also
Detail Items/Taxes form
Drop-Shipment Address form
Purchase Order Entry — Totals tab

Purchase Order Entry — Detail Items/Taxes
Form
The Detail Items/Taxes form displays all the fields for a single detail,
rather than rows of data for all the details of an order. The form also
displays additional tax information for the detail that doesn't appear on
the detail-entry grid.
Use this form to:
Add, edit, and delete purchase order detail lines.
To open or close the Detail Items/Taxes form, select the detail line,
then click the Item/Tax button or press the F9 key. Press F9 or choose
Close to return to the Order tab.
To add or edit details in the Detail Items/Taxes form
1.To start a new detail line, click the New button next to the Line
Number field. To open an existing detail you want to edit, type its line
number or use the navigation buttons beside the Line Number field to
display the detail you need.
2.Type the information or changes for the detail, then choose Add or
Save.
To delete details in the Detail Items/Taxes form
1.To open an existing detail you want to delete, type its line number or
use the navigation buttons to display the line.
2.Click the Delete button.
For information about a button on the Detail Items/Taxes form, click the
corresponding link below:
Add Save

Delete

New Calculate Taxes Close

Click the Zoom button ( ) or press the Shift and F9 keys to open the
Drop-Shipment Address or Detail Comments form. Click the Close button
or press the F9 key to close the Drop-Shipment Address or Detail
Comments form.

To check tax amounts for a purchase order and compare the totals on the
screen with the totals on the source document, click the Totals tab.
See also
Adding Purchase Order Details
Comments/Instructions form
Drop-Shipment Address form
Purchase Order Entry — Order tab
Purchase Order Entry — Overview

Purchase Order Entry — Drop-Shipment
Address Form
Use this form to enter or edit address information for a detail you wish the
vendor to ship directly to an address other than the inventory location
specified for the detail line (by the code you entered in the Location field.)
To open the Drop-Shipment Address form
Press the Shift and F9 keys in the Drop-Ship field to open or close the
form using your keyboard.
Click the Zoom button beside the Drop-Ship field to open the form
with a mouse.
To enter a drop-shipment address
1.Open the Drop-Shipment Address form, then select the type of
address to enter.
2.If applicable, select the location code, customer number, or ship-to
address code for the address.
3.Type the address or edit displayed information.
4.Choose Close.
To edit drop-shipment addresses
1.Open the Drop-Shipment Address form.
2.Make the changes you need. You can change all the information in
the form, including the type of address.
3.When finished, choose Close to close the form.
To delete drop-shipment addresses
Change the entry in the Drop-Ship field to No on the detail entry grid, or
deselect the Drop-Ship box on the Detail Items/Taxes form (click the field
or press the Shift and F9 keys at the same time in it).
See also
Comments/Instructions form
Detail Items/Taxes form

Purchase Order Entry — Totals tab

Purchase Order Entry — Create PO From
Requisition Form
Use this form to:
Select a requisition from which to create a purchase order.
Select several requisitions from which to create a single purchase
order.
Using requisitions is optional. You can create purchase orders without
requisition numbers.
To use the From Requisition Number field
1.Click the Zoom button beside the From Requisition Number field, or
tab to the field, then press the F9 key.
2.Type the requisition number to use or select it from the Finder.
3.Choose whether to select requisition details with no vendor numbers
for your purchase order.
4.If you are including details with blank vendor numbers, choose the
vendor type (optional).
5.Choose other requisition numbers, if applicable.
Note: When you create a purchase order from more than one
requisition, the fields on the Optional Fields tab will be taken from the
first requisition that you select.
6.When ready, choose the Order button. Yes appears in the Ordered
column for each requisition and the session (sign-on) date appears in
the Date Ordered column.
7.Choose Close to close the form.
Use the following buttons to:
Order — To select the specified requisition details, insert Yes in the
Ordered column for each requisition, and insert the session (sign-on)
date in the Date Ordered column.
Close— To close the Create PO From Requisition form.

Go back to the Order tab

Purchase Order Entry — Ship-To Location
Form
Use this form to edit an existing ship-to location address or to type a new
ship-to address for the purchase order. If you select an Inventory Control
location code, the code appears as the default location code for the
purchase order detail lines.
To use the Ship-To Location form
You do not have to enter a ship-to location code or address information.
1.If desired, type the location code to use in the Ship-To Location field,
or select it from the Finder.
2.To enter or edit address information, click the Zoom button beside the
Ship-To Location field or press the F9 key in the field.
3.Type the name and address information to use for the location, or edit
displayed information (from the location record in Inventory Control).
4.When finished, click the Close button to return to the Order tab.
Go back to the Order tab.

Zoom Button or
The Zoom button and the F9 key let you view or enter supplementary
information for a transaction detail or for a field.
In any detail entry grid, you can select a detail line, then click the F9
button to open a form that displays all the fields for a single detail,
including additional tax-related fields that don't appear on the detail entry
grid. You can edit existing details, and even add new details for the
document.
Beside any field that displays a Zoom button, you can click the button, or
press the F9 key while the insertion point is in the field, to open a form
that lets you view and enter supplementary information specific to that
field. In a detail entry grid, you press the Shift + F9 keys while the
insertion point is in the field.

Receipt Entry Field List
Receipt Number
Vendor Number (and name)
Receipt tab
Receipt details
Taxes tab
Retainage tab
Additional Costs tab
Additional cost details
Distribute Proration (if prorating additional cost manually)
Optional Fields tab
Rates tab (multicurrency ledgers)
Totals tab

Receipt Entry — Receipt Tab
Use this tab to enter:
A name for new vendor accounts that are not yet added to Accounts
Payable.
The vendor's address, phone numbers, and contact name on the
Vendor Information form.
The code that identifies the vendor's payment terms for the receipt.
An optional template code to specify the default entries in receipt
header and vendor information fields.
The receipt date.
An optional FOB (free-on-board) location.
An optional shipping method or carrier.
The default shipping and billing location codes for the receipt.
An optional description and reference.
Use the detail information section at the bottom of the Receipt tab to:
Add item detail lines to the receipt.
Edit or delete existing detail lines.
Specify received quantities and discounts. If you use Project and Job
costing, use the same unit of measure that is on the estimate. (See
Units of Committed and Actual Quantities)
Enter additional receipt information using comments fields and
optional fields.
Identify items as fixed assets for management by the Sage Fixed
Assets (FAS) module.
Open a zoomed detail-entry form so that you can view all the fields for
the detail at once.
You also use the Detail Items/Taxes form to change tax information for
the detail.
Use the F9 key on your keyboard to open or close the Detail Items/Taxes form.

Note: You cannot view or edit costs unless you are assigned the security
right to "Show Receipt Costing Information."
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Taxes

Retainage

Additional Costs

Optional Fields

Rates

Totals

Click these buttons for more help:
or
Finder

Zoom

Drop-Down
Lists

See also
Entering Receipt Details
Receipt Entry form — overview
Using Detail Entry Grids

Receipt Entry — Taxes Tab
Use this tab to specify:
The vendor's tax group.
Tax classes for each tax authority.
Tax-included options and amounts for the vendor's tax authorities
Click the Calculate Taxes button to cancel changes you made to tax
amounts and reinsert the taxes originally calculated for the receipt by the
program.
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Receipt

Retainage

Additional Costs

Optional Fields

Rates

Totals

See also
Receipt Entry — overview

Receipt Entry — Retainage Tab
If you are entering a job-related receipt, and you use retainage
accounting in Accounts Payable, you can specify that the receipt is
subject to retainage. Purchase Orders adds a retainage tab for receipts
that are subject to holdbacks.
The Retainage tab will also appear on the Invoice Entry form and Debit
note forms which reference this receipt.
You can change only the retainage rate and retainage terms on this tab.
You enter job-related retainage amounts, retention periods, and retainage
due dates with each job detail.
For detailed information about another tab on the Receipts Entry form,
click the corresponding link, below:
Receipt

Taxes

Additional Costs

Optional Fields

Rates

Totals

For more information about processing retainage, see Using Retainage Accounting.

Receipt Entry — Additional Costs Tab
Use this tab to:
Add additional costs charged on the shipment by both primary vendors and
secondary vendors, such as for handling charges, service charges, and duty.
Edit additional-cost amounts on previously posted receipts which are
not yet fully invoiced.
Assign or edit the terms code and tax group for the additional cost
vendor.
Check the number of details and the total amount of additional costs
entered for the vendor.
In multicurrency ledgers, edit exchange rate information for vendors
who do not use the functional currency.
Specify how to reallocate prorated costs of received items that you
return.
Open a form to check and edit tax information for the vendor.
Open a form to check and edit tax information for the detail.
To display additional costs you have entered for a vendor, use the
navigation buttons beside the Additional Cost Vendors field or enter the
vendor number in the additional cost Vendor Number field. Individual
additional cost details appear in the detail entry grid on the tab. Totals for
the selected vendor are displayed at the bottom of the Additional Costs
tab.
Non-inventory items
If you are adding additional costs for non-inventory items, you must
choose No Proration. If you choose to prorate by quantity, cost, or weight,
the program will display an error message and prevent you from posting
the receipt.
For step-by-step instructions on using the Additional Costs tab, see Adding,
editing, or deleting additional cost details.
To open secondary forms that provide more information about the

additional costs
Choose the Vendor Taxes button to open the Additional Cost Vendor Taxes form.
With the additional cost detail selected, choose the Cost/Tax button or
press the F9 key to open the Detail Costs/Taxes form.
With the pointer in the Vendor Number field, press the F9 key or click
the Zoom button to open the Vendor Information form for secondary vendors.
Use the Calculate Taxes button to cancel changes you make to tax amounts
on the additional costs for the secondary vendor in this form.
Use the Close button to close any of the secondary forms and return to
the Additional Costs tab.
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Receipt

Taxes

Retainage

Optional Fields

Rates

Totals

See also
Additional Cost Codes
Additional Cost Vendor Information
Entering Additional Costs on Receipts
Prorating Additional Costs
Receipt Entry form — overview

Receipt Entry — Optional Fields Tab
This tab appears if you have assigned optional fields to the Receipt Entry
form. You see only the fields that you added using the Optional Fields
form in the Setup folder.
Use the tab to:
Add or change information in the optional fields that are assigned to
the form.
For information about defining optional fields for the Receipt Entry form,
see Optional Fields form.
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Receipt

Taxes

Retainage

Additional Costs

Rates

Totals

To enter optional information, type the entry or choose it from the
Finder (if the Finder is active).
If you can choose from a list of codes, the program displays the
description, if any, entered for the code in the Optional Fields form.
You cannot change the description here. If you want to change the
description, you must do so in the Optional Fields form in Common
Services.
If there is a Finder beside the field, choose one of the entries in the
Finder list. (You must select one of the choices if the "validate" option
was selected for this field and blank is not allowed.)
See also
Entering optional fields Information
Receipt Entry — overview
Using optional fields

Receipt Entry — Rates Tab
This tab appears only in multicurrency ledgers when you are entering a
receipt for a primary vendor who does not use the functional currency.
Use the Rates tab to:
Change the rate type, rate date, and exchange rate for converting the
receipt amount from the vendor's currency to your functional (home)
currency.
Look up the rate information entered with the purchase order (if you
are entering a receipt to a purchase order).
This tab appears only if you use multicurrency accounting and you are
entering a receipt for a vendor who does not use the functional currency.
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Receipt

Taxes

Retainage

Additional Costs

Optional Fields

Totals

See also
Receipt Entry — overview

Receipt Entry — Totals Tab
Use this tab to:
Enter comments for a receipt.
Enter a discount percentage or a total discount amount for the receipt.
Verify receipt totals for the primary vendor.
Check tax amounts for the primary vendor.
Check manual proration amounts to be sure you have fully allocated
allmanually prorated charges for the receipt.
Check the estimated weight of the goods on the receipt.
Check the number of item and additional cost details entered for the
vendor on the receipt.
Check the receipt subtotal and total additional costs and excluded
taxes for the primary vendor .
For more information about the Receipt Entry form, choose one of the
links below for help on using the corresponding tab:
Receipt

Taxes

Retainage

Additional Costs

Optional Fields

Rates

See also
Additional cost vendor totals
Checking receipt totals
Receipt Entry — overview

Receipt Entry — Additional Cost Vendor
Taxes Form
Use this form when entering additional costs for secondary vendors to:
Check tax information and calculations for the selected additional cost
vendor.
Edit the tax class and tax-included options for the tax authorities.
To use the Additional Cost Vendor Taxes form
1.On the Additional Costs tab, select the secondary vendor for which
you need to review totals.
2.Click the Vendor Taxes button on the Additional Costs tab.
3.Make any changes you need to tax classes and the tax-included
options.
4.When you have finished, click the Close button to return to the
Additional Costs tab.
To change tax information for a single additional cost detail, you use the
Detail Costs/Taxes form. (On the Additional Costs tab, select the additional cost
detail, then click the Cost/Tax button or press the F9 key.)
See also
Adding, Editing, or Deleting Additional Costs
Additional Costs tab
Additional Cost Vendor Information form

Receipt Entry — Bill-To Location Form
You open the Bill-To Location Form from the Receipt tab of the Receipt
Entry form.
Use this form to edit an existing bill-to location address or to type a new
billing address for the receipt.
You do not have to enter a bill-to location code or address information.
To use the Bill-To Location form
1.If you use Inventory Control, you can type the location code to use in
the Bill-To Location field on the Receipt tab, or you can select it using
the Finder.
2.To enter or edit address information, click the Zoom button beside the
Bill-To Location field or press the F9 key in the field. If you do not use
Inventory Control, click the Zoom button ( ) to open the form; you will
not be able to use the F9 key.
3.Type the name and address information to use for the location or edit
displayed information (from the location record in Inventory Control).
4.When finished, click the Close button or press F9 to return to the
Receipt tab.
Opening and closing the Bill-To Location form
Click the Zoom button to open the Bill-To Location form with a mouse.
Use the F9 key on your keyboard to open or close the Bill-To Location
form.
Choose the Close button to close the Bill-To Location form.
Go back to the Receipt tab.

Receipt Entry — Detail Comments Popup Form
Use this form to type comments which apply to the detail line. You can
also print the remarks on the receiving slip.
To open the Detail Comments form
From the Receipts tab
1.

Click the Comments field for the detail line you need.

2.

Click the Zoom button ( ) or press the Shift and F9 keys to open
the Detail Comments form.
From the Detail Items/Taxes form

1.

Click the Zoom button beside the Comments field.

To enter a comment or an instruction
1.Open the Detail Comments form.
2.In the Type field, select Comment or Instruction.
3.Type the comment or instruction, pressing Enter to start each new
line.
4.When finished, click Close to close the form.
To edit comments
1.Open the Detail Comments form.
2.Make the changes you need.
3.When finished, click Close to close the form.
To delete comments
1.Open the Detail Comments form.
2.Highlight the text to delete, then press the Delete key on your
keyboard. If a message appears asking you to confirm the deletion,
choose Yes.
3.When finished, click Close to close the form.
You can also delete comments by changing the entry in the field to No on

the Receipt tab, or by deselecting the Comments box on the detail
Items/Taxes form (click the field or press the Shift and F9 keys at the
same time in it).
If you use this method, your remarks are not deleted (although they
would not be printed on the receiving slip). If you later decide you want to
use the remarks, enter Yes (or reselect the Comments field on the
zoomed detail-entry form). The original remarks will reappear.
See also
Drop-Shipment Address form
Receipt Information

Receipt Entry — Create Receipt From PO Form
You use the Create Receipt From PO form to select purchase orders you
are receiving from the vendor.

To use the Create Receipt From PO form
1.Click the From Multiple POs option, then either click the Zoom button
( ) next to the field or press the F9 key to open the Create Receipt
From PO Form.
2.Enter or select purchase orders from the Finder list of the vendor’s
incomplete purchase orders. All purchase orders must have the same
tax group.
3.When you have finished entering purchase orders click the Receive
button.
If you enter an incorrect purchase order number, highlight it and press
Delete. To delete all the purchase order numbers or to cancel all the
numbers press Close without pressing Receive.
4.Press Close to return to the Receipt Entry form.
All the details of the specified receipts will be listed in the detail entry
section on the Receipt tab. If you wish, you can edit quantities received
and you can delete lines you did not receive (or reduce the quantity to
zero).

Receipt Entry — Detail Items/Taxes Form
Use this form to add, edit, and delete receipt detail lines.
You also use this form to edit the tax classes and tax-included options for
individual receipt details.
This form displays the fields for a single detail in a separate window,
letting you see all the information you entered for the detail, including tax
information.
To open the Detail Items/Taxes form, select the detail on the Receipt
tab, then press F9 or click the Item/Tax button.
To close the Detail Items/Taxes form, press F9 or click the Close
button to return to the Receipt tab.
To add or edit details in the Detail Items/Taxes form
1.To start a new detail line, click the New icon next to the Line Number
field.
To open an existing detail you want to edit, type its line number or use
the navigation buttons beside the Line Number field to display the line
you want.
2.Enter the information or changes for the detail.
Note that you can change a tax class to another tax class that is
assigned to the authority, and you can change the choice for the Tax
Included option (if the tax authority permits tax-included costs).
3.When you are finished, choose Close.
4.To check tax amounts for a receipt and compare the totals on the
screen with the totals on the source document, view the Totals tab.
To delete details in the Detail Items/Taxes form
You cannot delete details after you have posted the receipt.
1.To open an existing detail you want to delete, type its line number or
click an arrowhead beside the Line Number field until the line you
want is displayed.
2.Choose Delete. If you see a message asking you to confirm the

deletion, choose Yes.
Click the links below for additional help on using the corresponding
buttons on the Detail Items/Taxes form:
Save

Delete

Calculate Taxes

Close

Click the Zoom button ( ) or press Shift+F9 to open the DropShipment Address form or the Detail Comments form.
See also
Detail Comments form
Drop-Shipment Address form
Entering Receipt Details
Receipt Entry form — overview
Receipt Entry — Receipt tab

Receipt Entry — Detail Costs/Taxes Form
This form displays the fields for a single detail in a separate window,
letting you see all the information you entered for the additional cost
detail, including tax information.
Use this form to:
Add, edit, or delete additional cost detail lines.
Edit the tax classes and tax-included options for additional cost
details.
To open the Detail Costs/Taxes form, select the additional cost vendor
and the detail on the Additional Cost tab, then press F9 or click the
Cost/Tax button.
To close the Detail Costs/Taxes form, press F9 or click the Close
button to return to the Additional Costs tab.
To add or edit details in the Detail Costs/Taxes form
1.To start a new detail line, click the New icon next to the Line Number
field.
To open an existing detail you want to edit, type its line number or use
the navigation buttons beside the Line Number field to display the line
you want.
2.Type the information or changes for the detail.
Note that you can change a tax class to another tax class that is
assigned to the authority, and you can change the choice for the Tax
Included option (if the tax authority permits tax-included costs).
3.When you are finished, click the Close button.
To view total tax amounts for an additional cost vendor for a
selected receipt
Display the additional cost vendor on the Additional Costs tab, then
click the Vendor Taxes button.
To delete details in the Detail Costs/Taxes form
You cannot delete details after you have posted the receipt.

1.Display the detail you want to delete by typing its line number or using
the navigation buttons beside the Line Number field to display it.
2.Click the Delete button. If you see a message asking you to confirm
the deletion, click Yes.

Receipt Entry — Drop-Shipment Address
Form
Use this form to enter or edit address information for a detail where the
goods were shipped directly to an address other than the inventory
location specified for the detail line.
To open the Drop-Shipment Address form
Press the Shift and F9 keys in the Drop-Ship field to open or close the
form using your keyboard.
Click the Zoom button beside the Drop-Ship field to open the form
with a mouse.
To enter a drop-shipment address
1.Open the Drop-Shipment Address form, then select the type of
address to enter.
2.If applicable, select the location code, customer number, or ship-to
location code for the address.
3.Type the address or edit displayed information.
4.Choose Close.
To edit drop-shipment addresses
1.Open the Drop-Shipment Address form.
2.Make the changes you need. You can change all the information in
the form, including the type of address.
3.When finished, choose Close to close the form.
To delete drop-shipment addresses
Change the entry in the Drop-Ship field to No in the detail entry section
on the Receipt tab, or deselect the Drop-Ship box on the Detail
Items/Taxes form (click the field or press the Shift and F9 keys at the
same time in it).
Return to the Receipt tab.
See also

Detail Comments form

Receipt Entry — Invoice Form
Use this form to create invoices for the primary and secondary vendors on a
receipt.
To create invoices
1.Click the Invoice button.
2.To create an invoice for the primary vendor, type the invoice number
in the Invoice Number field at the top of the form.
To create invoices for secondary vendors, type the invoice number in
the Invoice Number field on the line for the vendor whose invoice you
are creating.
3.When finished, click Close to close the form.
4.When ready, click Post.
Invoices are created during posting. You can post only one invoice for
each vendor on the receipt, and the invoice includes all charges entered
for the vendor on the receipt.
After posting, you cannot change information in the Invoice form or on the
receipt for item and additional costs you have invoiced.
You can also enter invoices for your vendors in the Invoice Entry form. Use
this form if you want to enter 1099 information for vendors.
See also
Receipt Entry form — overview

Receipt Entry — Ship-To Location Form
Use this form to edit an existing ship-to location address or to type a new
ship-to address for the receipt.
You do not have to enter a ship-to location code or address information.
To use the Ship-To Location form
1.If you use Inventory Control, you can type the location code to use in
the Ship-To Location field, or select it from the Finder.
2.To enter or edit address information, click the Zoom button beside the
Ship-To Location field or press the F9 key in the field. If you do not
use Inventory Control, click the Zoom button to open the form; you will
not be able to use the F9 key.
3.Type the name and address information to use for the location, or edit
displayed information (from the location record in Inventory Control).
4.When finished, click the Close button or press F9 to return to the
Receipt tab.
Opening and closing the Ship-To Location form
Click the Zoom button ( ) to open the Ship-To Location form with a
mouse.
Use the F9 key on your keyboard to open (if you use Inventory
Control) or close the Ship-To Location form.
Click the Close button to close the Ship-To Location form.
Go back to the Receipt tab.

Receipt Entry — Vendor Information Form
You open the Vendor Address Information Form from the Vendor Number
field on the Receipt Entry form.
Use this form to edit an existing address or to type a billing address for
the vendor.
To open the form, click the Zoom button ( ) beside the Vendor Number
field.

Entering a Purchase Order Number
If you wish to enter one or more purchase order numbers from which to
receive goods, you have three choices. You can:
Enter a single number in the PO Number field (to receive from one
purchase order for the vendor).
Press the From Multiple POs field to receive all the outstanding purchase
orders from the vendor.
Press the Zoom button ( ) next to the From Multiple POs field to open
the Create Receipt From PO form and select the outstanding purchase orders
to receive from the vendor.

Using P/O with Sage Fixed Assets (FAS)
Sage ERP Accpac provides full integration with the Sage Fixed Assets
program, allowing you to enter asset transactions in Inventory Control,
Purchase Orders, Accounts Payable, and Intercompany Transactions.
Sage FAS integration lets you:
In Inventory Control, identify items as financial assets when you
withdraw them from inventory for internal use by your Company.
In Purchase Orders, Accounts Payable, and Intercompany
Transactions, identify items as financial assets when you purchase
them.
Send asset information to Sage FAS to set up program assets that
you have identified in Sage Accpac ERP.
Sage Fixed Assets works with Purchase Orders 5.5 and higher.

Recording the Receipt of Items for Sage FAS
You use the Receipt Entry form in Sage ERP Accpac Purchase Orders to
receive items for use by your company (or organization) and identify
them as fixed assets for Sage FAS.
To record the purchase of an asset for Sage FAS:
1.In Purchase Orders, from the P/O Transactions folder, choose Receipt
Entry.
2.Create a new receipt transaction, entering header information as
usual. (See Enter Receipts for detailed instructions on entering receipt
transactions.)
3.Click the detail-entry grid (or click the Item/Tax... button or press the
F9 key to display the form for detail entry).
4.Enter information for the item detail, including the item number for the
asset you are receiving, location, quantity, and unit of measure, as
usual.
5.Select the Fixed Assets option (double-click the column cell to display
"Yes," and then click the Zoom button to open the Fixed Assets form.
6.Enter information for the asset record as follows:
a.

If you want to use a different template than the one displayed on
the Fixed Assets form, use the Finder for the Sage FAS Template
field to select a different one. Otherwise, either accept the default
template code that appears or clear the entry from this field. (You
do not have to use a template to create the asset in Sage FAS.)

b.

Use the Description field to enter the description that you want to
use for the asset in Sage FAS.

c.

If you are using more than one asset item and you want to create
separate asset records for each one in Sage FAS, select the
Separate Assets option.
The program allocates the Sage FAS value entered on the Fixed
Assets form proportionately to each Sage FAS record it creates.
For example, for a quantity of 10 and a value of $25,000, the

program creates 10 asset records with a value of $2,500 each.
d.

In the Sage FAS Quantity field, type the quantity of asset items
you are receiving.

e.

In the Sage FAS UOM field, type the unit of measure for the
quantity that you entered.

f.

In the Sage FAS Value field, type the value to book for the asset in
Sage FAS.

7.Click Close to return to the item detail entry form.
8.When you have finished adding details for the transaction, click Close
to return to the main Receipt Entry form.
9.Click Add, and then click Close.
Note: You must run Create Assets in the Sage FAS Integration module to
update Sage FAS with the asset information.

Requisition Entry Field List
Requisition Number
Vendor Number (and name)
Requisition tab
Detail entry grid (Requisition tab)
Optional Fields
Totals tab

Requiring Approval for Requisitions
Purchase Orders provides a requisition approval system so you can
ensure that only particular employees can approve purchase requisitions.
You must turn on security to use requisition approval
You must turn on security for the system database in Sage ERP Accpac's
database setup program to use database security features.
Requisition approval is based on the Requisitions Manual Approval
security right which you can assign to users in the Security Group form in
Administrative Services.
If you have the requisitions approval security right, all requisitions that
you post are automatically approved, and your User ID appears in the
Approver Name field.
If you do not have the requisitions approval security right, all
requisitions that you post are automatically put on hold, and the
Approval Status field will stay Entered until the requisition is posted by
a user with the approval rights.

Requisition Entry Form — Requisition Tab
Use the Requisition tab to:
Specify the requisition date, required date, and expiration date.
Put a requisition on hold or remove the hold.
Say who requested the merchandise.
Select an optional location code to be the default location for the
requisition details, if you use Inventory Control, or type the name of a
location.
Type a description, reference, and comment for the requisition.
Add requisition details.
Edit or delete existing incomplete details.
You can work with details in either in:
The detail entry grid on the Requisition tab.
The Detail Items form that appears when you highlight a detail line and then
click the Detail button or press the F9 key.
To add details
For the first detail, on the detail-entry grid, tab to the Item Number
field, then type the item number or select it from the Finder.
If you wish to use the Detail Items form, after selecting the line, click
the Detail button or press F9.
To add more details using the detail entry grid, press the Insert key or
tab past the end of the last line. To insert a new line in a particular
location, highlight the line above the location, then press the Insert
key.
To add new lines using the Detail Items form, click the New icon
beside the Item Number field. To select an existing detail, type the
number of the detail line or use the navigation buttons beside the field
to display the detail.
A detail is saved as you enter it on the detail entry grid or when you click

Add or Save in the Detail Items form.
To edit details
Select the detail you want to edit on the detail entry grid or on the Detail
Items form, then enter your changes. You can change all the information
you entered for the detail except the item number.
To delete details
1.Select the detail you want to delete on the detail entry grid or on the
Detail Items form.
2.Press the Delete key if you are using the detail entry grid, or click the
Delete button on the Detail Items form.
3.If you see a message asking you to confirm the deletion, choose Yes.
Click these icons for information about using the buttons on this tab:
New

Navigation Buttons

Finder

Click one of the links below for help on using the corresponding tab:
Optional Fields

Totals

See also
Requisition Entry — Detail Items form
Requisition Entry — Overview

Requisition Entry Form — Optional Fields Tab
This tab will appear only if you have Sage ERP Accpac's Transaction
Analysis and Optional Field Creator, and if you have assigned optional
fields to the Requisition Entry form. You see only the fields that you
added using the Optional Fields form in the Setup folder.
The Optional Fields tab contains optional fields added by your company
that apply to the requisition as a whole. Optional fields on detail lines
apply to the individual details.
If the optional field has a Finder, you can select one of the entries
from the Finder list. Depending on how the list has been set up, you
may be able to leave the field blank.
If no Finder appears, you do not have to enter data in the optional
field, or you can enter any data you wish, depending on the field type
and number of characters permitted in the field.
Optional field information can pass through the complete transaction
cycle — from purchase requisitions, to purchase orders, to receipts, to
invoices, and even to downstream ledgers like Accounts Payable and
General Ledger — as long as you assign the same optional fields to each
of the transaction forms and to the general ledger accounts.

Use this tab to:
Add or change information in the optional fields that are assigned to
the form.
For information about defining optional fields for the Receipt Entry form,
see the Optional Fields form.
Click one of the links below for help on using the corresponding tab:
Requisition

Totals

See also
Requisition Entry — overview
Using optional fields

Requisitions Entry Form — Totals Tab
Use this tab to:
Enter a comment for the requisition.
Check the estimated weight of the goods on the requisitions.
Check the number of detail lines and the requisition total.
Choose one of the links below for help on using the corresponding tab:
Requisition

Optional Fields

See also
Requisition Entry Form -- Overview

Return Entry Field List
Return Number
Vendor Number (and name)
Vendor Information form (opened from the Vendor Number field)
Return tab
Detail Entry section of the Return tab
Taxes tab
Retainage tab
Optional Fields tab
Rates tab (multicurrency ledgers)
Totals tab

Day End Processing of Returns
Note: If you cost inventory during posting instead of during Day End
Processing, almost all Day End processing tasks will take place when
you post transactions.
If you are concerned with transaction processing speed, you should
cost inventory transactions during Day End Processing�not during
posting. (You change this setting on the Processing tab of the I/C
Options form if you are using the Inventory Control module.)
Day End processing (or posting, if you cost inventory during posting):
Updates costs in Inventory Control for non-job-related invoices, if you
use Inventory Control.
Updates quantities and costs in Project and Job Costing for jobrelated returns
Creates general ledger transactions for the processed returns, and
creates the Return Posting Journal.
The general ledger accounts affected by return transactions are
described in Journal entries generated from posted Purchase Orders transactions.
Adjusts and reprorates or expenses any additional costs posted with a
receipt to remaining items on the receipt using the methods you
specified.
If you choose to expense or prorate additional costs that were
originally prorated to the items being returned, Day End Processing
expenses the costs or prorates them to the remaining items on the
original receipt. You can check the prorated amounts on the Return
Posting Journal.
Also deletes completed returns if you do not keep history and, if you
keep history and statistics, updates Purchase Orders and Inventory
Control history and statistics with return data.

Editing Returns
If you change return quantities or return costs, Inventory Control item
quantities are updated with the changes, and Day End Processing
creates new general ledger transactions to reflect the changes.
Job-related changes to returned quantities will change the actual
quantities and costs in Project and Job Costing.

Entering Returns
You can enter returns with or without referencing particular receipt
numbers. For more information, see:
Entering returns for existing receipts
Entering returns for non-existing receipts
Entering units for job-related returns

Exporting Returns
Use the Export command on the File menu in the Return Entry form to
transfer return transactions created in Purchase Orders to non-Sage ERP
Accpac applications, or to a file to be edited and imported later.
Before exporting, decide which fields to include in the export file. You
must select fields for each type of record used for returns. You should
also find out the path for the export file you want to use or create.
When you choose Export, Purchase Orders exports all the posted returns
currently in the system. If you do not want to export everything, use the
Set Criteria option to specify the returns to export.

Posting Returns
When you post a return, item quantities on hand are immediately reduced
in Inventory Control. If you use the automatic-numbering option, posting
also assigns the return number.
If the return is job-related, Purchase Orders also updates the actual
quantities and costs for the job in Project and Job Costing.

Using Security with Returns
You can use security with the Return Entry form, separately specifying
the persons who can add and edit returns, print returns, import returns,
and export returns.
For more information about using security, see Purchase Orders security.
See also
Return Entry security access
Return Printing security access

Return Entry Form — Return Tab
Use this tab to enter:
The return date.
The receipt number to which the return applies (if any).
The billing address for the return.
An optional description, reference, and comment.
The details of items you are returning to a vendor.
Note that the information you can enter is restricted if the return
includes a receipt number or you have already posted the return.
This tab also lets you:
Open the Bill-To Location form.
Edit details on a return you posted previously. (You cannot change the
information on this tab for a return that was posted previously.)
Open the Detail Items/Taxes form on which to enter details instead of using the
spreadsheet-style grid you see on the Return tab. (The Detail
Items/Taxes form displays all the fields for a single detail, including tax
fields.)
For information on using other tabs on the Return Entry form, click the
corresponding links:
Taxes

Retainage

Rates

Totals

Optional Fields

Click these icons for information on using the buttons:
Finder

Zoom

See also
Return Entry Form — overview
Using Detail Entry Grids

Return Entry — Taxes Tab
Use this tab to:
Check the vendor's tax group.
Check tax information and edit the tax-included options and amounts
for the vendor's tax authorities.
To cancel changes you make to tax amounts, click the Calculate Taxes
button. The program recalculates the taxes using the tax tables in Tax
Services.
For information on using other tabs on the Return Entry form, click the
corresponding links:
Return

Retainage

Rates

Totals

Optional Fields

See also
Checking return totals
Return Entry Form – overview

Return Entry — Retainage Tab
This tab appears only for returns of job-related items that had amounts
retained on the receipt or invoice.
If the items were originally received in another currency, you use this tab
to:
Choose whether to use the original retainage exchange rate for the
return, or use the current exchange rate.
For information on using other tabs on the Return Entry form, click the
corresponding links:
Return

Taxes

Rates

Totals

Optional Fields

See also
Return Entry Form — overview

Return Entry — Optional Fields Tab
This tab appears if you have assigned optional fields to the Return Entry
form. You see only the fields that you added using the Optional Fields
form in the Purchase Orders Setup folder.
Use this tab to:
Add or change information in the optional fields that are assigned to
the Return Entry form.
For information about defining optional fields for the Return Entry form,
see the Optional Fields form.
For information on using other tabs on the Return Entry form, click the
corresponding links:
Return

Taxes

Rates

Totals

Retainage

To enter optional information, type the entry or choose it from the
Finder (if the Finder is active).
If there is a Finder beside the field, choose one of the entries in the
Finder list. (You must select one of the choices if the "validate" option
was selected for this field and blank is not allowed.)
The program displays the descriptions, if any, defined for selectable
codes. You cannot change the descriptions here. If you want to change
the descriptions, you must do so in the Optional Fields form in Common
Services.
See also
Entering Optional Fields Information
Return Entry Form — overview
Using optional fields

Return Entry Form — Rates Tab
This Rates tab appears only in multicurrency ledgers when you are
entering a return for a vendor who does not use the functional currency.
Use the Rates tab to:
Change the rate type, rate date, and exchange rate for converting the
return amount from the vendor's currency to your functional (home)
currency.
Look up the rate information entered with the receipt.
Click these icons for information about using the buttons:
Finder

For information on using other tabs on the Return Entry form, click the
corresponding links:
Return

Taxes

Optional Fields

Totals

Retainage

See also
Return Entry Form — overview

Return Entry Form — Totals Tab
Use this tab to:
Enter a comment for the return.
Enter the discount percentage or amount for the entire return.
Verify return totals for the vendor.
Check the estimated weight of the goods for that you are returning.
Check the number of item details entered for the vendor on the return.
Check the return subtotal and tax amounts for the vendor.
For information on using other tabs on the Return Entry form, click the
corresponding links:
Return

Taxes

Optional Fields

Rates

Retainage

See also
Checking return totals
Return Entry Form – overview

Creating Purchase Orders from Requisitions
Using the Create POs From Requisitions form, you can specify ranges of requisition
numbers, dates, and vendor numbers for which to automatically create
purchase orders. You can create purchase orders for requisition details
that do not have vendor numbers, assigning the vendors either by
creating purchase orders for only one vendor number or by selecting a
vendor type used with items in Inventory Control.
Optional Fields. When you create a purchase order from more than one
requisition, the fields on the Optional Fields tab will be taken from the first
requisition that you select.
Purchase orders created by vendor type.You can create purchase
orders by vendor type. The following example describes the purchase
order details that are created when a vendor type is specified.
Assume purchase orders will be created from the following requisition
details, and that details with blank vendor numbers are selected for
vendors who are Vendor1 in the item records:
Line
Item
Vendor Vendor 1 in
Number Number Number Item Record
1
A1-103/0 Blank
1200
2
A1-400/0 Blank
1400
3
A1-401/0 Blank
1350
4
A1-650/0 1200
1500
These details would create three purchase orders, one each for vendors
1200, 1400, and 1350.
The purchase order for vendor 1200 would include two item details
because vendor 1200 is assigned in the item record as the selected
vendor type for line1, and specified as the vendor number for line 4.
Note: You cannot mix job-related and non-job-related requisitions when
creating purchase orders. If you use Project and Job Costing and are
creating POs from both types of requisitions, you must run this function
twice.

For more information, choose:
Consolidating requisition details on purchase orders
Posting purchase orders created from requisitions

Go back to Creating purchase orders automatically.

Create POs From IC Field List
Above Maximum
Above Projected Sales for [ ] Days
All Items
Create If The Vendor Is
From/To Item Number
From/To Location
From/To Vendor Number
Items Below Minimum
Items Below Projected Sales for [ ] Days
Reorder Quantities For
Run Date
Up to Maximum
Up to Projected Sales for [ ] Days
Optional Fields
Detail Optional Fields

Determining the Quantity to Order
This topic contains an example to demonstrate how to choose the
Reorder Quantity option that will order the number of items you need.
For example, assume you are reordering an item for which the Reorder
Quantities form shows the following figures:
Minimum quantity = 10
Projected sales = 25
Maximum quantity = 30
Reorder quantity = 10
Quantity on hand = -13
You can order up to the maximum quantity or projected sales (for the
period), or over the maximum quantity or projected sales, as follows:
To order up to, but not exceeding, the maximum quantity, you would
order 40 stocking units (4 x 10) bringing the on-hand quantity to 27.
(Choose the Up To Maximum option.)
To order up to at least the maximum quantity, you would order
50 stocking units (5 x 10) bringing the on-hand quantity to 37.
(Choose the Above Maximum option.)
To order up to, but not exceeding, the projected sales quantity for the
number of days in the period (selected by the run date), you would
order 30 stocking units (3 x 10) bringing the on-hand quantity to 17.
(Choose the Up To Projected Sales option.)
To order up to at least the projected sales quantity for the period, you
would order 40 stocking units (4 x 10) bringing the on-hand quantity
to 27. (Choose the Above Projected Sales option.)
Go back to Creating purchase orders from Inventory Control reorder quantities

Create POs From O/E Field List
Consolidate Items
Create Purchase Order for Each
Drop-Ship Items
From/To Customer Number
From/To Expected Ship Date
From/To Order Date
From/To Order Number
I/C Vendor Type
Include Non-stock Items
Reorder

(All Items, Items on Backorder, Items with Insufficient Quantities)

Detail Optional Fields
Optional Fields

Create POs From Requisitions Field List
Consolidate Items
From/To Requisition Date
From/To Requisition Number
From/To Vendor Number
Include Blank Vendors
Job Related
Using [I/C] Vendor Type
Detail Optional Fields
Optional Fields

Accumulating Purchasing History and Statistics for
Reporting
Purchase Orders includes three options you can select to specify the
type of transaction information to keep on file until you decide to delete
the data:
Keep Transaction HistoryAccumulate Purchase History
Accumulate Statistics

Return to Selecting Processing options

Purchase History Form Field List
From/To Year and Period
Select By (Vendor Number / Item Number)
Item Number and Name
Vendor Number and Name
Currency (display only, multicurrency ledgers)
Currency (Functional Currency / Vendor Currency; multicurrency ledgers)

Item/Vendor Detail Grid
Credit Note Adjustment
Credit Note Amount
Credit Note Qty. Adjustment
Debit Note Amount
Invoice Adjustment
Invoice Qty. Adjustment
Invoice Amount
Item Number and Description
Number of Credit Notes
Number of Debit Notes
Number of Invoices
Number of Receipts
Number of Returns
Quantity Received
Quantity Returned
Return Amount
Receipt Amount
Year and Period

Purchase History Document Details form
Contract, Project, and Category
Days to Receive
Document Number
Extended Cost
Item Number and Description
Vendor Number and Name
Location
Quantity
Transaction Date
Transaction Type
Unit of Measure
Year and Period

Purchase History Detail Form
Use this form to check and edit the details of transactions posted for the
selected vendor or item number in the year and period you specified.
Information includes the year and period, transaction type and date,
document number, quantity, unit of measure, cost, and number of days
between the time you issued the purchase order and posted the receipt.
If working with transactions that include serialized and lotted items, you
can click Serial/Lot Numbers to display the numbers.
To open the Detail form
Select a transaction line in the Purchase History form, then press F9
or click the Details button, or
Press the Alt + D keys.
Click the Close button or press the F9 key in the detail form to return to
the main Purchase History form.
Go back to the Purchase History form.

Accumulate Purchase History
Use the Accumulate Purchase History option to keep information about
the items you have purchased and the vendors who supplied them. The
option also keeps information about invoices, credit notes, debit notes,
and items you returned.
You can view the information in the Purchase History form, use the
History button to look it up when you are entering transactions, and print
it on the Purchase History report.
Purchase Orders keeps purchase history by the type of year (fiscal or
calendar) and period you select for the Accumulate By and Period Type
options on the Processing tab of the Options form.
If you choose to accumulate by calendar year, the starting date for the
year will be January 1. If you accumulate by fiscal year, the starting date
will be the first day of your fiscal year.
You can turn on or turn off the Accumulate Purchase History option at
any time. If you turn off the option after you have used it, Purchase
Orders keeps the figures already accumulated until you clear them. If you
turn on the option again before clearing the history you accumulated
previously, the data will still be available, but there will be no figures for
the period during which the option was off.

Purchase Statistics Field List
Average Credit Note/Debit Note
Average Invoice
Currency
Largest Credit Note/Debit Note
Largest Invoice
Net Invoice Amount
Net Purchase Amount
Net Quantity Purchased
Number of Credit Notes/Debit Notes
Number of Invoices
Number of POs
Number of Receipts
Period
Smallest Credit Note/Debit Note
Smallest Invoice
Vendor (with largest credit note/debit note)
Vendor (with largest invoice)
Vendor (with smallest credit note/debit note)
Vendor (with smallest invoice)
Year

Accumulate Statistics
Select this option if you want to accumulate statistics from posted
transactions.
When you use the option, Purchase Orders retains statistics from the
transactions processed for up to 53 periods per year (54 periods in leap
years), for any number of years. The program displays these statistics in
the Purchase Statistics form and prints them on the Purchase Statistics
report.
You can turn on or turn off the Accumulate Statistics option at any time. If
you turn off the option after you have used it, Purchase Orders keeps the
statistics already accumulated until you clear them using the Clear
History form. If you turn on the option again before clearing the statistics
you accumulated previously, those statistics will still be available, but
there will be no statistics for the period during which the option was off.

Pending Receipts Inquiry Field List
Select By
Vendor Number
Item Number
From/To Location
From/To PO Date
From/To Expected Arrival Date
PO Type
Include Completed Detail Lines
Show Late POs Only

List of purchase order detail lines that match
selection criteria
Completed
Date Received
Days Late
Expected Arrival Date
Item Number and Description
Location
PO Date
PO Number
PO Type
Quantity Ordered
Unit of Measure
Vendor Number and Name

Receipt details window for purchase order lines
Item Number and Description
PO Number and Description
Vendor Number and Name

For each Receipt, the program displays:
Contract, Project, Category
Date Received
Days Late
Expected Arrival Date
Location
Order Unit of Measure
Quantity Ordered
Quantity Received
Receipt Unit of Measure
Receipt Number

Tasks Performed by Day End Processing
Note: Most Day End Processing tasks will be performed during posting if
you choose the option to cost inventory items during posting.
Unless you cost inventory during posting, Day End Processing performs
the following tasks:
Activates and posts future purchase orders that have reached their
activation dates.
Tip. If you usually run Day End Processing at the end of the work day,
future purchase orders set to be activated on a certain day will not
become active until the end of the day. To be sure a future purchase
order is ready to be processed on the correct date, assign a date that
is one or more days earlier than the desired date for the purchase
order.
Deletes requisitions with expiration dates on or before the session
date for day-end processing.
Unless you update costs during transaction posting, Day End
Processing calculates unit costs for each item on a receipt or return
(or on an invoice, credit note, or debit note where costs change),
using the item’s costing method if you use Inventory Control.
Updates costing information if you use Inventory Control (unless you
update costs during transaction posting).
Updates statistics and history in both Inventory Control and Purchase
Orders, if you selected the options to keep this data in both programs.
Deletes completed transaction details if you do not keep transaction
history.
Creates a batch of Accounts Payable invoices, credit notes, and debit
notes from posted Purchase Orders transactions.
Creates posting journals for the receipts, returns, invoices, credit
notes, and debit notes posted in Purchase Orders since the last time
you ran Day End Processing.
Creates general ledger transactions from posted receipts returns,

invoices, credit notes, and debit notes (unless you update costs
during transaction posting).
General ledger transactions from invoices, credit notes, and debit
notes are created by Accounts Payable when it posts batches.
Updates actual and committed costs in Project and Job Costing with
amounts from job-related receipts, invoices, returns, and credit and
debit notes.
Updates the Next Day End Number field in the Purchase Orders
Options form.

Purchase Orders Reports
Purchase Orders Reports are divided into two categories:
Reports provide you with order status information, statistics,
transaction information, and basic setup record information.
Forms include requisitions, purchase orders, receiving slips, returns,
and mailing labels.
If you have a multicurrency ledger, some of these reports can also
include source and functional-currency (home-currency) information.

Analytical Reports
Aged Purchase Orders
G/L Transactions
Item Transaction History (stand-alone program)
Payables Clearing Audit
Posting Journals
Purchase History
Purchase Order Action
Purchase Statistics
Shippable Backorders
Transaction List

Forms
Mailing Labels
Purchase Orders
Receiving Slips
Requisitions
Returns

Setup Reports
Account Sets (stand-alone program)
Additional Cost Codes
E-Mail Messages
G/L Integration
Items (stand-alone program)
Optional Fields
Options
Ship-Via Codes
Templates
Vendor Contract Costs
Vendor Details (stand-alone program)
Weight Units of Measure (stand-alone program)

See also
Choosing E-mail as the print destination
Choosing File as the print destination
Choosing Printer as the print destination
Choosing Screen as the print destination
Reporting Purchase Orders Data

Crystal Reports
All reports in Purchase Orders use Crystal Reports and have the
extension RPT. You can:
Modify any report using Crystal Reports or Crystal Enterprise (both
from Business Objects).
View previous tabs in the Print Preview form without having to restart
the report.
Attach reports to an e-mail using the E-mail print destination in
System Manager.
Use Crystal Enterprise to print scheduling in the Enterprise Series of
Sage ERP Accpac (if you install Crystal Enterprise).
Export reports (for the Pint Preview form) to a large number of
formats, including:
Comma-Separated Values (CSV)
Data Interchange Format
Excel 2.1, 3.0, 4.1, and 5.0
HTML
Lotus 1-2-3
ODBC
Text
Paginated test
Columnar text
Rich Text Format (RTF)
Word for Windows
Lotus Notes
Microsoft Mail
Modifying forms
If you want to modify or create forms using Crystal Reports, you must

install Crystal Reports. Follow the details in the online document,
“Customizing Printed Forms” (available from the Help menu on the Sage
ERP Accpac desktop).

Clear History Field List
For help about the options and fields in the Clear History form, select
from these field names:
Credit/Debit Notes/To
From/To
Invoices
Payables Clearing Audit
Period
Printed Posting Journals
Purchase Statistics
Purchasing History
Receipts
Returns
Select By
Through
Through Day End Number
Through Year
Transaction History

Post A/P Batches
Specify when to post A/P batches generated from Purchase Orders
invoices, credit notes and debit notes:
During Posting or Day End Processing
On Request Using Create Batch Icon
During Posting or Day End Processing
This option lets you post Accounts Payable invoice batches created by
Purchase Orders when you post invoices or when you run day end
processing in Inventory Control (if you have it) — depending on when you
cost transactions in Inventory Control.
You choose when to cost transactions with the Cost Items During option
on the Processing tab of the I/C Options form. The Cost Items During
option gives you two choices:
During Posting
Day End Processing
Note: These choices can have a large impact on the speed of processing
transactions in Purchase Orders and on the number of A/P batches that
Purchase Orders produces.
If you post A/P batches during transaction posting, Purchase Orders will
create and post an A/P batch for each invoice it creates.
If you are processing a large volume of receipts, you should cost
inventory during day end processing or use the Create Batch icon to post
A/P batches.
On Request Using Create Batch Icon
This option lets you decide when to post Accounts Payable invoice
batches created by Purchase Orders. Use the Create Batch form in
Purchase Orders and select the option to Post A/P Batches.
If you wish, you can also post the A/P batches created by Purchase
Orders using the Post Batch form in the Accounts Payable module.
You can change your selection any time. If you were using the Create

Batch form to create the transactions, print a copy of the latest G/L
Transactions report, and then create any outstanding transactions before
changing your choice for the option.

Delete Inactive Records Form (stand-alone
program) Field List
For help about the options and fields in the Delete Inactive Records form,
select from these field names:
Delete Inactive Items From/To
Delete Inactive Account Sets From/To
Inactive Dates From/To

Account Sets Report (stand-alone program) —
Features
The Account Sets report lists descriptions and numbers of the general
ledger accounts in your Purchase Orders account sets.
The report lists, for each account set,
The account numbers for the Payables Clearing and
Inventory/Expense accounts.
The date on which the account set was last edited (Last Maintained).
The date the account set became inactive. The date appears in the
Inactive On column.
For instructions on printing the report, see Account Sets report — printing.
See also
Purchase Orders reports

Additional Cost Codes Report — Features
The Additional Cost Codes report lists the information entered to define
each of the additional cost codes used in your Purchase Orders system.
(Additional costs are extra charges, such as for shipping and handling,
that are entered separately from the costs of the items you purchase,
then prorated to item costs, if you wish.)
If you list the costs by vendor number, additional costs entered
without vendor numbers appear first.
The report lists each cost's default amount and proration and
reproration methods. You can change this information when you enter
the cost on a new transaction.
When you edit an additional cost or make it inactive, the dates are
listed in the Last Maintained/Inactive On column.
The multicurrency report shows the currency for the cost.
For instructions on printing the report, see Additional Cost Codes report — printing.

See also
Purchase Orders reports

G/L Integration Report — Features
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Purchase Orders system sends transactions to General
Ledger.
For instructions on printing the report, see Printing the G/L Integration Report.

Information printed on the report
General ledger integration options.
Information transferred from source transactions to G/L transaction
fields.
See also
Purchase Orders Reports

Items Report (stand-alone program) — Features
Use the Items report to print the information entered for each item in the
Items form, for example when you need a quick reference list of item
information or after adding, deleting, or changing item records.
Depending on your selections, the report can list the following
information:
Information entered on the Item Information tab of the Items form.
Text entered in the Comment fields on the Item Information tab.
All defined units of measure, as entered on the Item Units tab, and the
corresponding conversion factors for each unit.
The authorities and other tax information entered on the Item Tax
Classes tab.
Optional field information entered on the Optional Fields tab.
Item vendor information from the Vendor Details form, including
vendor type, vendor number, vendor name, and vendor item number.
For instructions on printing the report, see Items report — printing
See also
Purchase Orders reports

Optional Fields in Additional Cost Records
Optional fields are fields that have been added by your company to the
records or transactions in purchase orders. You must have Sage ERP
Accpac's Transaction Analysis and Optional Field Creator to add and use
optional fields.
If Optional Fields appear on the Additional Costs form, you can click the
Zoom button ( ) to display the optional fields that have been assigned to
additional costs, and edit their contents.
If you assign the same optional fields to additional cost records and to
invoice additional costs, the optional field entries in additional cost
records will appear on invoice additional cost details by default.
Optional field information can pass from invoices (or credit/debit notes) to
downstream ledgers like Accounts Payable and General Ledger.

Options Report — Features
The Options report lists the information you entered and the options you
selected when you set up your Purchase Orders system, or when you
changed the information using the Options form.
For instructions on printing the report, see Options report — printing.

Information printed on the report
The report lists:
The company address, and the Purchase Orders contact person and
telephone number.
In multicurrency ledgers, the functional (home) currency and the
default exchange rate type.
Processing options specified in the options form:
Whether you allow entry of non-inventory item numbers with
Purchase Orders transactions.
Whether you keep transaction history.
The default template you use for entering new orders.
The default item cost you use when displaying item costs in
transactions.
Whether and how you accumulate purchase statistics.
Whether and how you accumulate purchase history.
The number of days in the default aging periods for the Aged
Purchase Orders report.
The size, prefix, and next number to assign as the document number
for requisitions, purchase orders, receipts, and returns.
How you process general ledger transactions for your Purchase
Orders system, as well as the default inventory expense account,
default cost expense account, and non-inventory payables clearing
account you use.
See also
Purchase Orders reports

Ship-Via Codes Report — Features
This report lists the ship-via codes that are defined in Purchase Orders.
Ship-via codes are specified on requisitions, purchase orders, receipts,
and returns to identify the shipping method or carrier by which your
vendors ship goods to you or which you will use to return goods to
vendors (for example, courier, air mail, parcel post).
For instructions on printing the report, see Ship-Via Codes report — printing.
Information printed on the report
Ship-via codes and descriptions.
Names, addresses, telephone numbers, and contacts for all listed
ship-via codes.
See also
Purchase Orders reports

Templates Report — Features
The Templates report lists the information entered to define the templates
that are used in your Purchase Orders system.
For instructions on printing the report, see Templates report — printing.
Information printed on the report
Template codes and descriptions.
The information entered and selections made to define the templates.
See also
Purchase Orders reports

Vendor Contract Costs Report — Features
The Vendor Contract Costs report lists the vendors from whom you
purchase items and the costs of the items that each supplies.
Note:
The report includes only the item costs that you have entered using
the Vendor Contract Costs report.
The Vendor Contract Cost report uses the Rate Type specified for the
vendor.
Purchase Order lets you specify the following vendors’ prices for
inventory items:
Base unit costs for single or multiple units of measure.
Sale unit costs for single or multiple units of measure.
Volume discount amounts or percentages.
Tax authorities and tax statuses for the contract cost.
The order in which information appears on the report depends on your
sorting selection — either the item number or the vendor number.
For instructions on printing the report, see Vendor Contact Costs report — printing.
See also
Purchase Orders reports

Vendor Details Report (stand-alone program) —
Features
The Vendor Details report lists vendors from whom you purchase items
and the items each supplies. The report includes only the vendors you
have assigned to item numbers on the Item Vendors tab of the Items
form.
The order in which information appears on the report depends on your
sorting selection. The Vendor Details report lists:
The number you assign to identify a vendor in Accounts Payable.
The number you use to identify an item in Purchase Orders.
A number you assign to the vendor (vendor type) in the vendor details
record, usually to identify vendors from whom you most frequently
order the item.
For instructions on printing the report, see Vendor Details report — printing.
See also
Purchase Orders reports

Weight Units of Measure Report — Features
The Weight Units of Measure report lists the information entered to define
the inventory weight units of measure used in your Purchase Orders
system (if you do not use the Inventory Control module).
For instructions on printing the report, see Printing the Weight Units of Measure Report.

Information printed on the report
The report lists the weight units of measure along with their
descriptions and weight conversion factors. It also identifies the
default weight unit of measure.
See also
Purchase Orders reports

Requisitions — Features
A printed requisition is a detailed list of the items you want to include on
the purchase order you plan to issue from the requisition. The form can
also list the vendors from whom you plan to purchase the items.
Purchase Orders provides two standard 8½-inch by 11-inch or A4
requisition layouts that you can use as is or change to suit your needs
using Sage Accpac's report designer.
For instructions on printing requisitions, see Requisitions — printing.
Contents — Purchase Orders provides three standard 8½-inch by 11inch or A4 requisition layouts (PORQN01.RPT for printing on blank
paper, PORQN02.RPT for preprinted forms, and PORQN03.RPT, an
alternative format for printing on blank paper that includes optional fields).
Creating requisition formats — You can adapt the format for
requisitions or create your own requisition format using Sage ERP
Accpac's report designer. (Refer to the online document "Customizing
Printed Forms with Crystal Reports" for information.)
See also
Purchase Orders reports

Purchase Orders — Features
A purchase order is a detailed list of the items you plan to purchase from
a particular vendor you selected for the purchase order.
The Purchase Orders program provides four standard 8½-inch by 11-inch
or A4 purchase order report layouts (including two formats for preprinted
forms) and one default e-mail message that you can use for POs.
You can either use one of the purchase order reports or the e-mail
message that comes with the program, adapt it to your needs, or design
your own.
For instructions on printing purchase orders, see Purchase orders — printing.

Contents
Printed forms — Purchase Orders provides four standard 8½-inch by
11-inch or A4 purchase order layouts (POPOR01.RPT and
POPOR04.RPT for printing on blank paper, and POPOR02.RET and
POPOR05.RPT for preprinted forms). POPOR04.RPT and
POPOR05.RPT are non-datapiped for greater flexibility.
You can adapt the format for purchase orders or create your own
purchase order format using the report designer.
Creating purchase orders e-mail formats — You can use the E-mail
Messages form in the Setup folder to create e-mail messages for sending
purchase orders and returns. Within the e-mail message, you can include
codes for adding information specific to the vendor or specific to your
company. Each e-mail message is identified by a unique 16-character
message ID code.
See E-mail Message Information Codes.
Printing drop-ship addresses.If the purchase order includes drop-ship
addresses, all details with the same drop-ship address are printed
together on the purchase order, followed by the address, rather than
printing an address with each detail line that uses it.
See also
Purchase Orders reports

Receiving Slips — Features
A receiving slip is a detailed list of the items you received from vendors
and any additional costs posted with the receipt. Purchase Orders
provides four standard 8½-inch by 11-inch or A4 receiving slip layouts
that you can use as is or change to suit your needs using Sage ERP
Accpac's report designer.
For instructions on printing receiving slips, see Receiving slips — printing.

Contents
Purchase Orders provides four standard 8½-inch by 11-inch or A4
receiving slip layouts (PORCP01.RPT and PORCP03.RPT for printing on
blank paper, and PORCP02.RPT AND PORCP04.RPT for preprinted
forms). PORCP03.RPT and PORCP04.RPT show the quantities
received.
Note: Pre-printed forms PORCP03.RPT and PORCP04.RPT also print
cost information. If you want to hide costs on these forms, you will need
to customize them.
Creating receiving slip formats — You can adapt the formats for
receiving slips or create your own receiving slip format using the report
designer.
See also
Purchase Orders reports

Returns — Features
A purchase return is a detailed list of the items you are returning to a
vendor. Purchase Orders provides two standard 8½-inch by 11-inch or A4
reports for printing returns and one default return e-mail.
You can either use one of the purchase order report or e-mail message
formats that comes with the program, adapt it to your needs, or design
your own.
For instructions on printing returns, see Returns — printing.
Contents of returns — Purchase Orders provides two standard 8½-inch
by 11-inch or A4 return layouts (PORET01.RPT for printing on blank
paper, and PORET02.RPT for preprinted forms).
Creating return print formats — You can adapt the formats for returns
or create your own return format. (Refer to the online document
customizing printed forms in the System ManagerHelp) .
Creating purchase return e-mail formats — You can use the E-mail
Messages form in the Setup folder to create e-mail messages for sending
purchase orders and returns. Within the e-mail message, you can include
codes for adding information specific to the vendor or specific to your
company. Each e-mail message is identified by a unique 16-character
message ID code.
See E-mail Message Information Codes.
See also
Purchase Orders reports

Drop-Down Lists and Calendars
Drop-down lists and drop-down calendars are used throughout Sage
ERP Accpac programs.
Click the down arrow to have the program display a list or a drop-down
calendar from which you can choose an option or a date.
You can also:
Tab to the list field and press the down arrow to scroll through list
choices, or
Tab to the list field and press Alt+down arrow to display the list or a
calendar.

Mailing Labels — Features
You can print mailing labels to attach to envelopes in which you are
mailing documents to vendors and to shipments you are returning to
vendors. You can either use the label format that comes with Purchase
Orders, adapt it to your needs, or design your own.
For instructions on printing mailing labels, see Mailing labels — printing.
Contents — Purchase Orders comes with two label formats that print
labels on an 8.5 x 11 page. POLABEL.RPT prints 12 labels [2-up] and
POLABELP.RPT prints 14.
Creating label formats — You can change the format for mailing labels
to suit your needs, or you can create your own labels. (Refer to the online
document "Customizing Printed Forms with Cyrstal Reports" for
information.)
See also
Purchase Orders reports

Aged Purchase Orders Report — Features
Use the report to quickly spot purchase orders that have been
outstanding for a long time, and that may require action.
For instructions on printing the report, see Aged Purchase Orders report — printing.

Information printed on the report
The Aged Purchase Orders report compares the Aged As Of dates to the
order dates to determine the aging category to which each order belongs.
The report contains the following:
The Aged As Of date which determines the aging period to which
each purchase order belongs.
The subtotal for the current period and each aging period, and the
grand total of all aged purchase orders.
The amount of purchase orders for each period, expressed as a
percentage of the grand total (single-currency ledgers only). (Shows
where the bulk of aged purchase orders occurs.)
Amounts in the functional or vendor currency (multicurrency ledgers).
Report subtotals and, in multicurrency ledgers, a grand total for each
currency.
See also
Purchase Orders reports

G/L Transactions Report — Features
The G/L Transactions report is a list of the general ledger journal entries
created from all transactions posted in Purchase Orders since the last
time you created the general ledger batch.
For instructions on printing the report, see G/L Transactions report — printing.

Information printed on the report
The Detail report includes, for each transaction:
The posting sequence number, which is the number of the day-end
processing run when the transaction was created.
The Batch-Entry column is blank because Purchase Orders does not
use batches.
The source code that identifies the source program (Purchase
Orders) and the type of transaction in your general ledger. Purchase
Orders source codes are:
PO-CO — consolidated transactions
PO-CR — credit notes
PO-DB — debit notes
PO-IN — invoices
PO-RA — adjustments to receipts
PO-RT — returns
The Reference and Description columns contain the data specified by
your selections for the G/L Reference Field and G/L Description Field
options (document number, source code/day end number/entry
number, description, reference, vendor number, vendor name, PO
number) in the Options form. The sample data uses the document
number and the header description for these options.
Totals by account number. You can also sort the report and see totals
by fiscal year and period.
The debit and credit totals of the transactions on the report.
The Summary G/L Transactions report lists a single line for each general
ledger account number, with the total debit and credit amount for the
account.
See also
Purchase Orders reports

Item Transaction History Report (stand-alone
program) — Features
The Item Transaction History report lists all transactions posted for the
items assigned to the account sets and period that you select for the
report.
The Item Transaction History report shows the following information for
each item:
The date, fiscal year, and fiscal period of each transaction.
The document number entered with the transaction.
Day-end numbers, assigned sequentially each time Day End
Processing is run, and entry numbers indicating the order in which
each transaction was processed by Day End Processing.
If you use multicurrency ledgers, the source currency and exchange
rate for each transaction.
The amount of the transaction in source currency. Amounts that credit
the Inventory/Expense account (such as returns) are displayed
according to your Windows settings (for example, with a leading
minus sign or in parentheses).
Debit or credit amounts for each transaction to be posted to the
account set’s Inventory/Expense account. In multicurrency ledgers,
these amounts are in functional currency.
For each account set, the net change posted to the
Inventory/Expense account from all transactions posted for the item.
Additional cost amounts are included on the report only if they have
been prorated for the item.
For instructions on printing the report, see Item Transaction History report — printing.
See also
Purchase Orders reports

Payables Clearing Audit List — Features
This report lists the debits and credits posted to the Payables Clearing
account and processed by the Day End Processing function. It includes
receipts, invoices, returns, credit notes, and debit notes.
Data for the report includes everything back to the year and period from
which you keep history. If you do not keep history, the report prints only
transactions created by the last time you ran Day End Processing.
For more information on the contents of this report, see Payables Clearing Audit list
— printing .

Information printed on the report
The report shows the account sets, fiscal years, and periods you choose
and, if you have a multicurrency ledger, it also reports in the currency you
choose.
1.In a multicurrency ledger, the report shows whether you chose the
functional currency or a combination of the functional and source
currencies. When you choose to print the report in source and
functional currency, a Currency heading appears. The currencies are
listed under each account set and the vendors are grouped by the
currency they use.
2.The details of the transaction are shown, including the vendor
numbers and names.
3.The report shows the amount debited or credited to the account for
each receipt, invoice, return, debit note, and credit note transaction.
4.The report shows the total debits and credits by period and the total
for each account set (AVG. in the example) during the time specified
for the report.
If you have a multicurrency system and include source currencies for
the report, there are also totals for each currency.
See also
Purchase Orders reports

Posting Journals — Features
The Receipts, Return, Invoice, and Credit/Debit Note Posting Journals
are part of your Purchase Orders audit trail. The journals contain the
detailed record of the general ledger transactions arising from the
receipts, invoices, returns, credit notes, and debit notes that you posted
in Purchase Orders.
In multicurrency systems, posting journals list the vendor's currency code
for each transaction, along with the exchange rate, rate type, and rate
date. The journals include amounts in both the vendor's currency and the
functional currency.
Note that return posting journals and credit note posting journals display
numbers as negative amounts. (This applied to quantities, extended
amounts, prorated additional costs, tax summary amounts, retained
amounts, and job expensed amounts.) For example, if you post a return
of 5 items, the return posting journal will display a quantity of "-5." If you
later adjust the return to 2 items, the Return Posting Journal will show a
+3 to record the change in quantity.

Information printed on posting journals
On the Receipts Posting Journal, the additional cost amount prorated
to each item detail.
Details of each transaction of the selected type. (You can list
transactions by day end number, transaction date, vendor number, or
transaction number.)
On the Receipts Posting Journal, the secondary (additional cost)
vendor, description, amount, tax, and proration information. (Select
the Include Additional Costs option to include this section).
Tax information for the document. (Select the Include Tax Summary
option to include this section.)
Job-related information if you have Project and Job Costing.
Serial and lot numbers for applicable items. (Select the Include
Serial/Lot Numbers checkbox to include.)
Optional field information if you use Optional Fields.
On multicurrency reports, the totals for the journal in both functional
and source (vendor) currencies.
A General Ledger Distribution Summary, which includes the debit and
credit totals for each account affected by the transactions on the
journal. The multicurrency version of the summary lists totals in both
functional and source (vendor) currencies.
For instructions on printing the report, see Posting journals — printing.
See also
Purchase Orders reports

Purchase History Report — Features
This report provides summary or detailed purchase information by vendor
or inventory item. You can use the report as a purchases journal, to
record purchases by vendor or item, and to indicate the strengths and
weaknesses in company purchasing history.
For instructions on printing the report, see Purchase History report — printing.

Information printed on the report
Transactions can be listed by vendor number or item number.
The detail report includes all item details posted for the vendor in the
selected periods, and lists the year, period, transaction type, date,
transaction number, location (if you use Inventory Control), quantity,
cost, and unit of measure, and the number of days between the
purchase order and receipt posting dates for each item detail.
The detail report lists all purchases of an item from the vendor in the
selected period, and it also lets you include job details if you use
Purchase Orders with Project and Job Costing.
The detail report can provide serial and lot numbers for applicable
items if the Include Serial/Lot Numbers checkbox on the Purchase
History Report window is selected. You will be prompted to enter a
start and end range for serial and lot numbers you want included in
the report.
The summary report lists the year and period, total quantity received
of each item (in stocking units), total cost, quantity returned, and
return, credit note, and debit note totals.
The summary report consolidates details with the same item number,
year, period, and date into single details.
The multicurrency version of the report includes each vendor's
currency code. You can print amounts in the functional currency or in
the vendors' currencies.
See also
Purchase Orders reports

Purchase Order Action Report — Features
The Purchase Order Action report lists current purchase orders. It
includes report options which allow you to produce a wide variety of
reports.
For instructions on printing the report, see Purchase Order Action report — printing.
Information printed on the report
Depending on the options you select, the report:
Displays the item (detail) status you selected for the report. (You can
list all details, or only those details that are either completed with no
receipts, completed, or incomplete.)
Shows the currency in which amounts are listed (multicurrency
systems only).
Shows the vendor's currency (multicurrency systems only).
Lists the amount and percentage by which received quantities differ
from the quantities entered with the purchase order.
Lists the item details on the purchase order.
Lists job-related information entered with purchase orders (If you have
Project and Job Costing).
Includes optional field information (If you use Optional Fields).
The summary report lists the date, expected arrival date, vendor number
and name, and the purchase order amount for each purchase order
selected for the report. The detail report allows you to sort by Item
Number and filter by Item Status.
See also
Purchase Orders reports

Purchase Statistics Report — Features
This report lists statistics accumulated from Purchase Orders
transactions since you last cleared the purchase statistics data for the
period you specify. Statistics are reported for the type of year (fiscal or
calendar) and period you specified for the Accumulate Statistics option in
the Options form.
The report can help you understand and analyze the level of processing
in your Purchase Orders system. Note that you must use the Keep
Purchase Statistics option in the Options form to print this report.
For instructions on printing the report, see Purchase Statistics report — printing.

Information printed on the report
Amounts in source (vendor) currencies (multicurrency reports).
Source-currency code and description. The program prints a set of
statistics for each source currency (multicurrency reports).
The net purchase amount.
(The net purchase amount does not include additional costs or taxes.
All other dollar amount items on the report do include additional costs
and taxes.)
See also
Purchase Orders reports

Shippable Backorders Report — Features
The Shippable Backorders report lists the sales orders that you may be
able to fill as a result of receipts you have posted in Purchase Orders.
For instructions on printing the report, see Shippable Backorders report — printing.
Information printed on the report
The report lists receipt details that were posted with order numbers,
showing the item and amount received at each location. (Location
information appears only if you use Inventory Control).
See also
Purchase Orders reports

Transaction List — Features
The Transaction Lists let you print detailed or summary listings of all
current Purchase Orders transactions. You can sort transaction reports
by transaction number or vendor number, and you can specify a range of
transaction numbers, vendor numbers, and currency codes (if you have a
multicurrency system) by which to select the transactions to report.
For instructions on printing the report, see Transaction List — printing.
Information printed on the report
Depending on the printing options you select, the report lists:
The currencies selected for the report (multicurrency systems only).
The optional information selected for the report.
The serial and lot numbers when working with transactions involving
serialized and/or lotted items.
Total amount of the purchase order. In multicurrency systems, the
vendor currency is identified and the total is shown in both source
(vendor) and functional currencies.
The summary report includes the outstanding purchase order total,
together with the numbers, dates, and totals of any receipts, invoices,
returns, credit notes, and debit notes that were posted with the purchase
order number.
See also
Purchase Orders reports

Posting Purchase Orders Created from
Requisitions
Posting assigns item costs based on the default item cost type in the
Options form and the amount entered for the cost type in the item records
(in Inventory Control, if you use it).
Posting also enters the current session date as the purchase order date,
and completes the selected requisitions. The requisitions will be deleted
the next time you run Day End Processing unless you keep transaction
history.

Adding, Editing, or Deleting Additional Costs
Use the Additional Costs tab for both primary and secondary vendors to:
Enter the details of the costs the vendor charged on the receipt.
Specify whether to prorate the cost to the items on the receipt.
Indicate how to reprorate the cost if received items are returned.
Non-inventory items
If you are adding additional costs for non-inventory items, you must
choose No Proration. If you choose to prorate by quantity, cost, or weight,
the program will display an error message and prevent you from posting
the receipt.

To enter, edit, or delete additional cost details
1.On the Additional Costs tab, use the Finder or the navigation buttons
to select an existing additional cost vendor for which to enter or edit
an additional cost detail, or click the New button to add a new
additional cost vendor.
2.When you have displayed the correct vendor in the vendor number
field:
Enter or edit the additional cost details for the selected vendor in
the detail entry grid.
Prorate additional cost by quantity, cost, or weight.
Post
To delete a detail, select it, and then click Delete. If a message
appears asking you to confirm the deletion, click Yes.
To display all the information for a selected detail on a separate form,
or to edit tax classes or the tax included fields for the detail, select the
detail, then either click the Cost/Tax button or press the F9 key.
Click the links below for additional help on using the corresponding
buttons:
Delete Cost/Tax Calc. Taxes Vendor Taxes Close

See also
Additional Cost Vendor Information form
Additional Cost Taxes tab
Additional Costs tab
Detail Costs/Taxes form
Entering Additional Costs
Prorating Additional Costs

Entering Optional Data on Transactions
Optional fields are company-defined fields that can be added to any of
the transaction entry forms and to transaction entry detail lines if you use
Sage ERP Accpac's Transaction Analysis and Optional Field Creator.
The entries in these fields will flow from the requisition and purchase
order to the receipt and invoice if you use the same fields for those forms.
The Optional Fields tab contains information that applies to the receipt as
a whole, where the optional fields on detail lines apply only to the single
detail line. Changing the information in any of these fields has no effect
on the transaction.
If Accounts Payable invoice header and detail optional fields match
Purchase Orders invoice header and detail optional fields, the optional
field data will be passed automatically to Accounts Payable.
If General Ledger transaction details optional fields defined for the
General Ledger accounts match the transaction header and detail
optional fields defined for invoices, the optional field data can be passed
automatically to General Ledger (depending on your optional fields
settings).

Using Optional Fields
Purchase Orders supports Sage ERP Accpac Transaction Analysis and
Optional Field Creator, a separately licensed package that lets you add
optional fields to transaction documents (like purchase orders and
invoices) and to each detail line of a transaction.
You can only use optional fields if you have Sage ERP Accpac's
Transaction Analysis and Optional Field Creator.
You add optional fields to transaction entry forms using the Optional
Fields form in the Setup folder.
If you add the same fields to all of the PO translation forms, the optional
field information from one form will appear as default entries in the next
form in the transaction cycle — from purchase requisitions, to purchase
orders, to receipts, to invoices, and even to downstream ledgers like
Accounts Payable and General Ledger — as long as you assign the
same optional fields to each of the transaction forms and to the general
ledger accounts.

You can also change the optional field information in each form, or
change which fields appear in each form.
See also
Requisition Entry Form — Optional Fields tab
Requisition Entry Form — Overview

Forms
Use the icons in the Forms folder to print:
Mailing Labels
Purchase Orders
Receiving Slips
Requisitions
Returns

Purchase History Detail Form Field List
Contract, Project, and Category
Days to Receive
Document Number
Extended Cost
Item Number and Description
Vendor Number and Name
Location
Quantity
Transaction Date
Transaction Type
Unit of Measure
Year and Period

Processing Transactions
This topic describes how posting, day-end processing, and audit trails
relate to transaction processing in Purchase Orders. The transaction
types in Purchase Orders include requisitions, purchase orders, receipts,
invoices, returns, credit notes, and debit notes.
Online posting. Purchase Orders uses online transaction processing
rather than batch processing. This means that each transaction is posted
when you choose the Post button after entering the transaction.
When you post transactions, Purchase Orders immediately updates item
quantities on purchase order and on hand in Inventory Control so you
always know your inventory levels.
Item costs may be updated by posting or by running Day End Processing
- depending on your setting for the Inventory Control option "Cost Items
During Posting or Day End Processing".
Also, depending on your I/C and P/O options, posting may add G/L
transactions to new or existing batches, or they may be added during
Day End Processing or, manually, using the Create Batch window.
Job-related transactions. For job-related transactions, posting updates
committed and actual quantities and costs in Project and Job Costing.
(Most updates to jobs will arise from purchase orders and receipts;
however, PO will also update Project and Job Costing whenever invoices
differ from the originating receipts, or if you have returns (with credit
notes) and debit notes.
Day End Processing Updates Everything Else. You must run Day End
Processing to create posting journals and update history and statistics in
both Inventory Control (if you use it) and Purchase Orders (if you keep
history and statistics). You may also update item costs during Day End
Processing - depending on your options in Inventory Control.
Day End Processing also creates batches of Accounts Payable invoices,
credit notes, and debit notes from Purchase Orders transactions, and
creates general ledger transactions (if you use the option to create them
during posting day end processing, and you cost items during day-end
processing).

If necessary, you can run Day End Processing several times a day to
keep this information more current.
Using P/O without Inventory Control. If you use Purchase Orders
without Sage ERP Accpac Inventory Control, the program treats all items
as non-stock items. It does not maintain item quantities on order or on
hand, nor does it update item costs. It uses the most recent cost of an
item from a vendor as the default item cost in Purchase Orders forms.
Keeping transaction history. If you use the Keep Transaction History
option, Purchase Orders keeps transaction details until you remove them
using the Clear History form. You can print reports of the data — and
reprint requisitions, purchase orders, receiving slips, and returns — until
you clear the transaction history for them.
If you do not keep transaction history, completed transactions are deleted
when you run Day End Processing. Purchase Orders considers the
following transactions to be completed:
Requisitions and purchase orders with a Completed status (all detail
lines are completed).
Receipts for which an invoice has been posted for every vendor
specified on the receipt.
Returns for which credit notes have been posted.
Invoices, credit notes, and debit notes (complete on posting)
transferred to Accounts Payable.
If you do not keep history, you cannot display completed transactions
after you run Day End Processing.
Posting journals (the audit trail). You can print posting journals for
receipts, invoices, returns, credit notes, and debit notes after running Day
End processing. You can print the journals until you delete the
information for them, using the Clear History form.
See also Transaction Lists and Posting Journals.

Using Optional Fields
Purchase Orders supports Sage ERP Accpac's Transaction Analysis and
Optional Field Creator, a separately licensed package that you can use
with any edition of Sage ERP Accpac Advantage Series.
Optional fields provide exceptional flexibility. Optional fields let you
customize your Purchase Orders system as much as you wish. You can
use an unlimited number of optional fields to store more information with
your purchase orders transactions (such as requisitions, purchase
orders, receipts, and invoices).
Note: Like all other Sage ERP Accpac modules, Purchase Orders lets
you add optional fields to transaction documents and to each detail line of
a transaction. It also lets you pass optional field information through the
complete transaction cycle - from purchase requisitions, to purchase
orders, to receipts, to invoices, and even to downstream ledgers like
Accounts Payable and General Ledger.

Optional field information can originate with vendor and item records, and
flow through requisitions, purchase orders, receipts and invoices.
Information can be transferred to A/P and G/L. When you create
invoices or general ledger transactions in Purchase Orders, the program
passes the optional field values used in the transactions to Accounts
Payable and to General Ledger if the optional fields in Purchase Orders
are the same as the optional fields assigned in those programs. Optional
field information will even appear in the General Ledger journal entries for
Purchase Orders accounts, as well as in the Transaction Details Optional
Fields report.
And, if the optional fields that you assign to Purchase Orders documents
match the optional fields used for Accounts Payable vendors and
Inventory Control items, the information entered in those programs will
appear by default on transactions that you add in Purchase Orders..

Generated transactions also use optional fields. Purchase orders that
are generated from requisitions, from low stock levels in Inventory
Control, and from backorders in Order Entry will also include optional
fields.
For more information, see Setting Up Optional Fields.
See also
Selecting Processing options
Selecting Document Numbering options
Selecting G/L Integration options
Steps for setting up Purchase Orders

Optional Fields in Transaction Details
Optional fields are fields that have been added by your company to the
detail lines in purchase orders transactions. You must have Sage ERP
Accpac's Transaction Analysis and Optional Field Creator to add and use
optional fields.
If the Optional Fields column appears, you can click the column heading
to display the optional fields that have been assigned to this form, and
edit their contents.
Optional field information can pass through the complete transaction
cycle — from purchase requisitions, to purchase orders, to receipts, to
invoices, and even to downstream ledgers like Accounts Payable and
General Ledger.

Adding Optional Fields to POs that Use Datapipes
You can add purchase order header and detail optional field information,
as well as optional fields for vendors and inventory items, to purchase
orders sent to your vendors.
The optional fields must be added to the detail sections of the purchase
orders using the Crystal Reports designer.
Purchase Orders comes with four standard purchase orders forms:
Two use datapipes (POPOR01.rpt and POPOR02.rpt).
Datapipes are programs that extract and organize data to increase
the efficiency of particular reports.
Two read data directly from the Sage ERP Accpac database
(POPOR03.rpt and POPOR04.rpt).
The datapipe for printing purchase orders allows you to extract fields
from the following database tables:
APVENO — optional fields for Accounts Payable vendors.
POPORHO — optional fields for purchase order headers.
ICITEMO — optional fields for inventory items.
POPORLO — optional fields for purchase order details.
You select the optional field tables that you want to print by:
1.Setting the datapipe query parameters to &rdquor;1? in PORPT.INI (in
folder \Sage ERP Accpac\PO54A).
The purchase orders datapipe identifies the various types of details
that it prints by parameters in PORPT.INI and by different LNTYPE
codes. (LNTYPE is a field in the datapipe record provided to the
Crystal report.)
All optional fields are initially turned off in PORPT.INI.
2.Adding the optional fields to a new Crystal report detail section, which
must have a suppression formula based on line type (see Detail
LNTYPE Codes).

Note: The datapiped reports that ship with Purchase Orders 5.4 do
not include detail sections for printing optional fields. However, they
do include detail sections for printing comments/ instructions.
You can print purchase order optional fields and optional fields for the
purchase order details by adding similar detail sections.

Parameters in PORPT.INI
The first step to printing optional fields is to change the optional fields
parameters to &rdquor;1? (true), so that the optional fields will be
processes by the datapipe.
To change the datapipe query for printing purchase orders:
1.Open \Sage ERP Accpac\PO54A\PORPT.INI using notepad.
2.Search for &rdquor;POPOPRN.DLL.?
3.Turn off Word Wrap so the parameter numbers appear properly under
the parameters.
4.Edit the following parameters:
Parameter 12:
1 to print comments/instructions
0 to skip comments/instructions
Parameter 15:
1 to print vendor optional fields
0 to skip vendor optional fields
Parameter 16:
1 to print PO header optional fields
0 to skip PO header optional fields
Parameter 17:
1 to print item optional fields
0 to skip item optional fields
Parameter 18:

1 to print PO detail optional fields
0 to skip PO detail optional fields
Detail LNTYPE Codes
Each detail type associated with a purchase order is identified by a
particular line type code. The standard Crystal Reports purchase order
forms shipped with P/O use a suppression formula to select the type of
detail appearing in each detail section.
For example, the suppression formula &rdquor;LNTYPE <> 1? prints
purchase order header optional fields, but you could refine the formula to
print only a single optional field.
The purchase orders datapipe provides six different detail line types:
0 — Accounts Payable vendor optional fields
1 — Purchase order header optional fields
2 — Normal purchase order details
3 — Inventory Control item optional fields
4 — Purchase order detail optional fields
5 — Comments / instructions
Updating an Older Datapiped Purchase Orders Form
If the changes that you made to previous Purchase Orders forms were
minor — like the addition of a logo or a change in fonts — you might want
to make exactly the same changes to the newest forms, rather than
update your old forms.
To update previous forms to version 5.4, follow these steps:
1.Install the new version of Purchase Orders, ensure that the Optional
Fields Conversion utility lists all optional fields (if you use them), and
activate Purchase Orders 5.4.
2.Copy the custom form that you want to update from Sage ERP
Accpac\PO5XX\ENG to Sage ERP Accpac\PO54A\ENG.
Note: If the old form filenames are the same as your new forms,
rename your old forms before copying them to the PO54A\ENG

folder.
3.Open the old report in Crystal Reports, and do a database verify.

Analytical Reports
Use the icons in the Analytical Reports folder to print reports of:
Aged Purchase Orders
G/L Transactions
Item Transaction History
Payables Clearing Audit
Posting Journals
Purchase History
Purchase Order Action
Purchase Statistics
Shippable Backorders
Transaction List

Setup Reports
Use the icons in the Setup Reports folder to print reports of:
Account Sets
Additional Cost Codes
E-Mail Messages
Items (stand-alone)
G/L Integration Report
Optional Fields
Options
Ship-Via Codes
Templates
Vendor Contract Costs
Vendor Details

Importing and Exporting Purchase Orders Setup
Records
If you presently have a computerized purchase order system, you may be
able to transfer records directly into Sage ERP Accpac Purchase Orders.
This process is called importing.
You can also export records from another Sage ERP Accpac Purchase
Orders database, edit them in a spreadsheet or other program to change
codes, amounts, and other information, then import them into the new
Sage ERP Accpac Purchase Orders system you are setting up.
Purchase Orders setup records you can both import and export include:
Additional cost codes
Ship-via codes
Vendor contract costs
Templates
E-mail messages
Optional fields (with Transaction Analysis and Optional Field Creator
module)
Account Sets (PO standalone system)
Items (PO standalone system)
Vendor details (PO standalone system)
Weight units of measure (PO standalone system)
You can also import and export requisitions, purchase orders, and
receipts. You can export returns, invoices, credit notes, and debit notes.
For additional information about importing and exporting all Purchase
Orders records and transactions, see the System Manager Help.
See also
Steps for setting up Purchase Orders

Purchase Orders Documentation
Sage ERP Accpac 6.0 and 5.6 do not ship with user manuals. All the
information you need to use Purchase Orders is contained in the
Purchase Orders help, except as follows:
Information about late product changes for all Sage ERP Accpac
programs is contained in the Sage Accpac Readme file, which is
located in the Docs folder of your install directory and also included on
the installation DVD.
Information about installing and activating Sage ERP Accpac
programs is included in the Installation and Activation Guide, which
you will also find in your install directory and on the installation DVD.
Information about upgrading from earlier versions is included in the
Sage ERP Accpac Update Notice, available in your install directory
and on the installation DVD.
Manuals for all version 5.5 programs are available for download from
our Web site, at http://community.sageaccpac.com/resources/.
Technical information, such as database table changes, is available
for download from our Web site, at
http://community.sageaccpac.com/resources/.
Please visit the Sage Online Community for additional documentation,
expert's tips, user discussions, and our knowledge base.

Program features added in PO 5.4 and earlier
If you are upgrading from version 5.3 or earlier, see Changes in Purchase Orders5.4A.
If you are upgrading from version 5.2 or earlier, see Changes in Purchase Orders5.3.

Features Added in Purchase Orders 5.3A and 5.3B
If you are upgrading from Purchase Orders 5.2, note the following
features added in Purchase Orders 5.3A and Purchase Orders 5.3B
Purchase Orders 5.3A
Purchase Orders 5.3A included two major feature enhancements that
provided tighter integration throughout Sage ERP Accpac accounting
modules and an increased ability to adapt Sage ERP Accpac to your
requirements.
Customize Purchase Orders with an unlimited number of optional
fields for transactions and transaction details.
Print optional field information for purchase orders, purchase order
details, vendors, and items on purchase orders forms.
Purchase Orders 5.3B
Purchase Orders 5.3B added two major enhancements, along with
several smaller features:
.

Integration with Sage ERP Accpac Project and Job Costing

.

Retainage accounting on job-related receipts, invoices, returns, and credit and debit notes

Other changes in Purchase Orders 5.3B
Purchase Orders version 5.3B included several other changes and
features, especially when manually prorating additional costs:
Manual proration in Purchase Order 5.3B changed, so you now enter
the manually prorated amount for each detail in a Distribute Proration
window.
You can now manually prorate additional costs for invoices.
You can manually prorate additional costs to details in the currency
used by the additional cost vendor. Previous versions of Purchase
Orders required proration in the functional currency.
Purchase Orders now provides an option to directly create general
ledger entries for expensed additional costs. This lets you choose
when Sage ERP Accpac generates entries for expensed additional

costs during PO posting/day end or when the invoices are posted in
Accounts Payable.
If you generate entries in PO, the program debits the expense
account and credits the payables clearing account.
If you are using Project and Job Costing, the optional fields for
transaction details in Purchase Orders will include settings for Labor
and Overhead G/L accounts and for Project and Job Costing External
Cost Transactions.
The Return Posting Journal and the Credit Note Posting Journal now
display numbers as negative amounts. (This applies to quantities,
extended amounts, prorated additional costs, tax summary amounts,
retained amounts, and job expensed tax amounts.)
For example, if you post a return of five items, the return posting
journal will display a quantity of "-5." If you later adjust the return to
two items, the Return Posting Journal will show a "+3" to record the
change in quantity.
See also
New Features in Purchase Orders 5.5
Features Added in Purchase Orders 5.4
Consolidation Settings in P/O 5.4 (compared to "Do Not Consolidate? in Purchase Orders 5.2 and earlier)

Integration with Project and Job Costing
If you use Project and Job Costing, Purchase Orders lets you track
committed and actual quantities and costs by contract, project, category,
and, on standard contracts, resource.
Note: If you want to track quantities and costs for non-materials
categories (such as equipment, labor, or subcontractors), you should
select the Allow Non-Inventory Items option on the Purchase Orders
Options Processing tab.
Purchase Orders lets you enter job information with each detail on all jobrelated transactions. To track quantities and costs, select the Job Related
check box when entering requisitions, purchase orders, and receipts.
When you enter an invoice or a return for a job-related receipt, or when
you adjust a job-related document using a credit note or a debit note, the
Job Related check box is selected for you, and the job-related details from
the original document appear.
When you process job-related purchase orders, receipts, and invoices
from job-related purchase orders, the program updates committed
quantities and costs in Project and Job Costing. When you process jobrelated receipts, invoices, returns, credit notes, and debit notes, the
program updates actual quantities and costs.
Note: You must receive goods using the same units of measure that
are used in the estimates in Project and Job Costing. Purchase Orders
does not convert the different units of measure when it updates PJC.
When you invoice received goods in Purchase Orders, the program sends
job-related invoices to Accounts Payable.
Optional field information updates Project and Job Costing
Optional field information from purchase order details, receipt details,
receipt additional cost details, invoice details, invoice additional cost
details, credit/debit note details, and credit/debit note additional cost
details also flow from Purchase Orders to Project and Job Costing

external cost transactions if the detail optional fields are the same in both
programs.
Committed Costs Audit in Project and Job Costing
The Project and Job Costing module includes a Committed Costs Audit
list that shows which purchase orders, receipts, and invoices from jobrelated purchase orders updated committed costs in Project and Job
Costing.
This report helps you reconcile committed costs outstanding on purchase
orders to committed quantities reported for contracts, projects, and
categories.
The report is updated by Day End Processing and cleared using the
Clear History form.
See also
Invoices for Job-Related Receipts
Retainage Accounting for Job-Related Receipts and Invoices
Overhead and Labor Calculation
Units of Measure for Committed and Actual Quantities
New Features in Purchase Orders 5.4

Retainage Accounting for Job-Related Receipts
and Invoices
If you use retainage accounting in Accounts Payable, you can specify
retainage options for job-related transactions in Purchase Orders.
When you select the retainage accounting option on a job-related receipt,
invoice, credit note, or debit note, the program displays:
Retainage fields for each detail line, letting you enter a different
retainage percentage or retainage amount and retention period for
each detail line in the document. (By default, these settings come
either from the vendor record or from the category to which you
assign the cost.)
A Retainage tab, where you specify retainage terms and, in a
multicurrency system, the type of exchange rate to be used when you
process outstanding retainage.

Reporting Tax on Retainage Documents
Sage ERP Accpac lets you specify when to report tax on retainage
amounts to meet the requirements of your tax jurisdictions.
For example, in Canada, you report the GST for a retained amount when
you issue the retainage invoice.
You can choose from three options when you set up Tax Authorities in
Tax Services:
No Reporting
At Time of Retainage Document
At Time of Original Document

"Use Custom Form" Check box for Purchase
Orders and Returns
The report selection window for printing purchase orders and returns
contains a new checkbox, Use Custom Form, that was added to increase
record selection efficiency when printing purchase orders and returns.
If the box is unchecked, the report selection window creates a report
selection formula and passes it to the Crystal Reports runtime.
If the box is checked, the report selection window will not pass the
selection formula to the Crystal Reports runtime. You must define all
selection criteria within the Crystal report form.
If you have created a custom form that uses different report selection
criteria than the forms shipped with Purchase Orders, you may have to
check Use Custom Form in order to print your forms properly.

Create G/L Transactions By
Purchase Orders lets you choose whether to add new general ledger
transactions to new batches or create new batches and optionally post
them automatically to the general ledger.
Specifically, you can choose to:
Add general ledger transactions to an existing Sage ERP Accpac
General Ledger batch.
Create a new General Ledger batch each time you generate G/L
transactions.
Create a new General Ledger batch each time you generate G/L
transactions, and automatically post the batch in the General Ledger
program.
Note: Remember to create and post G/L batches for outstanding
transactions before locking periods for General Ledger.
To create only one batch
To have only one General Ledger batch to which all transactions are
appended, select the Adding To An Existing Batch option. Purchase
Orders must use the same database as Sage ERP Accpac General
Ledger.
If you don’t use Sage ERP Accpac G/L
If you do not use Sage ERP Accpac General Ledger — or if your Sage
ERP Accpac General Ledger system is at another location — Purchase
Orders appends its general ledger transactions to a file in your
company’s data directory called pogltran.csv, which can be imported by a
remote site Sage ERP Accpac General Ledger, or transferred to another
general ledger that you use. The file is in a Comma Separated Values
(CSV) format.

Tax Reporting Currency
This feature allows you to report taxes in a currency that is not the vendor
currency or the functional currency. (This can be a requirement in some
jurisdictions.)
The Tax Reporting currency fields appear on purchase orders, receipts,
invoices, returns, credit notes, and debit notes only if the tax reporting
currency for one or more of the tax group authorities is different from your
functional currency and the vendor's currency.
Taxes are set up in Common Services
You set the tax reporting currency for taxes in the Tax Services module in
Common Services.
You can change the tax reporting currency amounts in transactions
You can change the total tax reporting amount on the Taxes tab during
transaction entry (along with the total tax amount). If you do change the
tax reporting amount, you can use the Derive button on the Rates tab to
derive the effective tax reporting exchange rate.

Create G/L Entries for Expensed Additional
Costs
This choice lets you update your general ledger with additional cost
expenses directly from Purchase Orders, or wait until invoices are posted
in Accounts Payable.
Select this option to create debit entries to expense accounts and credit
entries to the Expensed Additional Cost Clearing Account when you post
additional costs. (Posting the invoices later in A/P will credit the payables
control account and debit the Expensed Additional Cost Clearing
Account.)
Leave the box unchecked to send expenses with invoices to Accounts
Payable, where posting will debit the expense accounts and credit
payables control.
Job-Related Additional Costs. Note that for job-related documents,
Purchase Orders will always create G/L entries for expensed additional
costs during posting — whether you select this option or not.

Create G/L Transactions During Posting/Day End
Processing or Using the Create Batch Icon
Use the Create G/L Transactions option to specify when to generate
general ledger transactions: either when you post transactions or run
day-end processing or, at a later time of your choosing, using the Create
G/L Batch form.
To create a batch or append to an existing batch or transaction file only
when you are ready, use the On Request Using Create Batch Icon
option. When you are ready to create general ledger transactions, you
then use the Create Batch form. Select this option if you want to be able
to consolidate general ledger transaction details and print Purchase
Orders' G/L Transactions report.
You must also select On Request Using Create Batch Icon if you want to
use the Consolidate G/L Batches option and to print the G/L Transactions
report in Purchase Orders. (The G/L Transactions report is a listing of the
general ledger transactions created by Purchase Orders that you might
need to print as part of your audit trail.)
To create a batch or append to an existing batch or transaction file when
you post or run day-end processing, use the During Posting or Day End
Processing option. (G/L transactions will be created when you cost
inventory items — that is, either during posting, or when you run Day End
Processing.)
If you select the During Posting or Day End Processing option for
creating the general ledger batch, you cannot print the G/L Transactions
report from Purchase Orders. If you need this information for your audit
control, print it from Sage ERP Accpac General Ledger. If you do not use
General Ledger, you may be able to print it from the general ledger
system that you are using.

Expensed Additional Cost Payables Clearing
Account
This is the general ledger account that is used if you choose the option to
create G/L entries for expensed additional costs in Purchase Orders.
If you create G/L entries in P/O, when you process the additional cost,
Purchase Orders credits the payables clearing account and debits the
expense account during day-end processing (or when you run Create
Batch).
When you post the invoice in Accounts Payable, Sage ERP Accpac
debits the payables clearing account and credits the payables control
account.
If you do not choose the option to create G/L entries for non-inventory
expenses in Purchase Orders, Sage ERP Accpac will generate G/L
entries when the invoice is posted in A/P, and this account will only be
used for job-related transactions.
Job-Related Additional Costs. Note that for job-related documents,
Purchase Orders will always create G/L entries for expensed additional
costs during posting — whether you select the option or not.
You can change the account number for individual transactions, as
needed. You can also change the default account number in the Options
form at any time.

Designing Purchase Orders Coding Schemes
This topic describes the codes you assign to the records for the optional
templates, additional costs, and shipping methods you can add to
Purchase Orders, and offers some tips to help you decide on the codes
to use.

Code Name
Additional cost
code
Account set code
(stand alone
program)

Maximum Permitted
Length Characters
6

numbers and letters

6

numbers and letters

Item code (stand
alone program)

24

Ship-via code
Template code
Requisition,
purchase order,
receipt, or
return document
number

6
6

alphanumeric, plus
blanks and special
characters
numbers and letters
numbers and letters

22

alphanumeric prefix,
numbers

When you design new coding schemes, you should assign codes that
make it easy to identify each record type and that list records in the order
you want them to appear on reports and in Finder forms.
Each code of a single type (such as an additional cost code) must be
unique. In most cases, you should also assign unique codes to all your
records, so there is no chance of confusing one type of record with
another.
You can use any combination of numbers and letters in all Purchase
Orders codes. For example, all of the following would be valid ship-via
codes:
A1
123

A01
123A
AB1234
To simplify codes, we recommend that you:
Use the same number of characters in all codes of the same record
type.
Use codes of at least three characters, to allow for future expansion.
Use a system that is significant for your business, such as codes that
identify a geographical region, or a type of template or cost.
If possible, use only numbers in your codes, for consistency of
sorting.

Sorting Order of Codes
Purchase Orders sorts codes on screens and reports in a specific order,
which you should take into consideration when designing codes.
Purchase Orders reads codes from left to right, and uses the following
sequence to put them in order:
[Blank] ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C
D E F G H I JK L MN O P Q R S T U V W X YZ [ \ ] ^ _ ` a b cdefg h i
jklmno p q r s t u v w x yz { | } ~
The codes listed in the introduction to this discussion would be sorted by
Purchase Orders into the following order:
123
123A
A01
A1
AB1234
Codes containing fewer than the maximum number of permitted
characters are left-justified in Purchase Orders Finders, forms, and on
reports.

See also
Steps for setting up Purchase Orders

Set Criteria
Criteria restrict the records that are displayed in the Finder and when you
use the navigation buttons. If the Finder uses criteria, the Finder might
not display all records.

To check or remove the criteria
Click the Finder, then click the Set Criteria button.
Choose the Clear button from the form that appears.
For instructions on setting criteria, click the Help button when the Set
Criteria form appears.

Allowing Entry of Non-inventory Item Numbers
All purchase order documents require item numbers and details before
you can save and post the transactions. The Allow Non-inventory Items
option lets you use item numbers in Purchase Orders that you have not
added to your Sage ERP Accpac Inventory Control system.
Non-inventory items can include non-stock items you have not added to
Inventory Control, items you plan to add to Inventory Control later, onetime purchases, services, and items needed for use in your business.
Purchase Orders does not update item quantities or other information in
Inventory Control when you post transactions for non-inventory items.
The general ledger entries for non-inventory details are created in
Accounts Payable, so are not listed on the G/L Transactions List if you
print it from Purchase Orders.
When entering details for non-inventory items, you must type an item
number, using up to 24 characters (including separators), and a
description of up to 60 characters. You also specify a general ledger
expense account number for each non-inventory detail.
When not to use the option. Do not select the option if you want to
enter transactions only for items that are defined in Inventory Control, so
that item details posted in Purchase Orders always update item
quantities and other information in Inventory Control.
Changing your choice. You can change your selection for this option at
any time. If you change from allowing non-inventory items to not allowing
them, you must edit any open purchase orders and other transactions to
remove non-inventory item numbers, or add the item numbers in
Inventory Control.
Return to Selecting Processing options

Assigning a Default Template Code
After setting up templates, use the Default Template Code option to
specify a default template that contains the general information that you
want to appear on transaction-entry forms when you start entering a new
requisition, purchase order, or other type of transaction.
This option can help you speed up data entry by automatically inserting
the information you use most often when entering these types of
documents.
For more information, see Setting up templates.
Return to Selecting Processing options

Assigning a Default Item Cost
If you use Sage ERP Accpac Inventory Control, you can specify during
setup the type of cost you want the program to use when selecting
default unit cost amounts to display for the item details you enter on
transactions. The option displays costs by location for the item numbers
in your Inventory Control system.
You can choose to display Most Recent Cost, Standard Cost, Average
Cost, Last Unit Cost, Vendor Cost, or either of the two user-defined costs
you can enter with item records in Inventory Control.
If you do not use Inventory Control, Vendor Cost is set as the default item
cost and you cannot change it.
When entering transaction details, you can change the cost amount that
appears. You can also change your choice for the Default Item Cost
option at any time.
Return to Selecting Processing options

Defining Aging Periods
Purchase Orders groups outstanding transactions for the Aged Purchase
Orders report into five periods, a current (not due) period and four
previous periods. You specify the length of each aging period on the
Processing tab of the Purchase Orders Options form.
You can specify different periods when you are printing the report and
you can change the default periods at any time.
Return to Selecting Processing options

Specifying Currency Information
The "functional currency" is the home currency in which the company
books are kept.
You select the functional currency for your Sage ERP Accpac
database in the Company Profile form in Common Services when you
first set up your Sage ERP Accpac system.
You cannot change the functional currency once you have selected it.
For more information, see the System Manager Help.
The Multicurrency option for Purchase Orders is set by Accounts
Payable
The Processing tab in the P/O Options form indicates whether your
Purchase Orders system is multicurrency or single-currency. The setting
depends on your selection in Accounts Payable. If Accounts Payable is
multicurrency, Purchase Orders is multicurrency also. If Accounts
Payable is single-currency, Purchase Orders is single-currency. You
cannot change either of these fields.
Information about creating multicurrency records is included throughout
these Help topics in discussions of records and activities affected by
currency. For a summary of the steps to take to set up a multicurrency
ledger, see Using multicurrency accounting in Purchase Orders.
Default rate type. If the Multicurrency option is turned on, the company's
default rate type for converting source-currency amounts to functionalcurrency equivalents is displayed. You can select a different default rate
type to use for Purchase Orders.
You can change the default rate type at any time. You can also select
different rate types for individual transactions as you enter them.
The default rate type is displayed on transactions you enter for
multicurrency vendors you have not yet added to Accounts Payable. You
can assign another rate type for the transaction.
Return to Selecting Processing options.

Adding Job-Related Details
If you use Project and Job Costing, Purchase Orders lets you flag
transactions as job-related, so you can:
Track committed and actual quantities and costs by contract, project
and category (and resource if using standard contract).
Receive goods for a job rather than into inventory.
Update jobs in Project and Job Costing with billing information.
Create invoices with retainage amounts and information for Accounts
Payable.
Note that if a transaction is job-related:
All transaction details must be job-related. You cannot mix job-related
details and non-job-related details in the same transaction.
Different fields appear for the details to let you enter job-related
information.
You must specify a contract and a project for each transaction detail,
and, depending on the project type, specify the project category, cost
class and resource for the job. If you use different terms than
"Contract," "Project," and "Category" in Project and Job Costing, the
program displays those field names instead.
If the transaction uses retainage accounting, you must specify the
holdback percentage and retention period for each transaction detail.
You specify the retainage rate (for a multicurrency transaction) and
terms for receipts, invoices and debit/credit notes on the retainage
tab.
Purchase Orders
If the purchase order is being created from multiple requisitions, all
requisitions must be either job-related or non-job-related.
Receipts and Invoices
Receipt entries that originated with purchase orders will update the
actual and committed quantities and costs in Project and Job Costing.

Invoice Entry will only send transactions to Project and Job Costing if
the invoice creates an adjustment to the receipt for the quantity
received, the item costs, any additional costs, or for the billing rate.
Job-related returns update actual quantities and costs for contracts in
Project and Job Costing, and will also update appropriate work-inprogress (or expense) accounts.
Credit notes that apply to returns affect quantities and costs in
Inventory Control and quantities in Project and Job Costing only when
the credit note changes the returned quantities and costs.
Additional Costs
If you prorate additional costs manually, you can assign costs to as
many different jobs as you wish.
If you prorate additional costs by cost, weight, or quantity, all item
details for the transaction will be affected.
You can also allocate additional costs to several contracts by adding
separate additional cost detail lines for each job and choosing no
proration.
Changing Invoices after posting
Do not change job-related invoices in Accounts Payable. If you change a
job-related invoice in Accounts Payable that originated with Purchase
Orders, Project and Job Costing will not be updated with the transaction
changes. You must process the changes in Purchase Orders, or with an
Accounts Payable transaction such as an adjustment (which will update
Project and Job Costing).
Accounts Payable does not update Project and Job Costing when it posts
invoices that originated with Purchase Orders (because Purchase Orders
has already directly updated Project and Job Costing).
See also
Entering Optional Fields information
Purchase Order Entry Detail Items/Taxes form
Purchase Order Entry — Order tab

Purchase Orders Security
The Purchase Orders program provides several options you can use to
control access to program forms and to certain fields and tasks.

Preparing to use Purchase Orders security
Turn on security.To restrict access to Sage ERP Accpac data, you first
turn on security for the system database using Database Setup.
Define security groups and assign to users. Sage ERP Accpac uses
security groups to restrict user access to data.
1.Choose Security Groups in the Administrative Services form to define
security groups for Purchase Orders users.
2.Select the tasks that members of each security group can perform.
3.Assign individual users to the security groups that you defined.

Assigning Purchase Orders security
Using the Security Groups form in Administrative Services, you can
assign security to the following Purchase Orders forms and tasks:
Common Inquiry
Setup Maintenance
Transaction Optional Fields
Item Maintenance (stand-alone systems only)
Cost Inquiry (in a stand-alone system)
Transaction inquiry
Requisition Entry
Requisition printing
Purchase Order Entry
Purchase order printing
Edit blanket PO amount
Create Purchase Orders Automatically
Receipt Entry
Show Requisition/Receipt Costing Information
Receiving slip printing
Invoice Entry
Edit invoiced quantity
Edit invoiced cost
Return Entry
Return printing
Credit/Debit Note Entry
Edit credit note quantity
Edit credit note cost
Mailing label printing
Import processing
Export processing

Day End Processing (in a stand-alone system)
History clearing
Requisitions Manual Approval
Dashboard

Converting Units of Measure for Committed and
Actual Quantities
You must receive goods using the same units of measure that are used
in the estimates in Project and Job Costing. Purchase Orders does not
convert the different units of measure when it updates PJC with
quantities from receipts or invoices.
The following example show what can happen it you receive goods using
different units of measure.
Assume that:
Your estimate includes 70 items that cost $10 each.
Shipment 1 includes 50 items, packed in 5 boxes.
Shipment 2 includes 20 items, packed individually.
Shipment 1
Material Category - Item 1001 - 5 boxes (conv. factor = 10) $500
Shipment 2
Material Category - Item 1001 - 20 items (conv. factor = 1) $200
When Project and Job Costing is updated with the quantities and costs of
these shipments, the actual quantity and cost for item 1001 will appear as
follows:
Material Category - Item 1001 - Qty = 25 items, Cost = $700

Information Entered with Additional Costs
Click the Additional Costs tab on a receipt to add an additional cost.
Use the Additional Cost Vendors browse buttons to select the primary
vendor (for the receipt items) or additional cost vendors that have
already been added to this transaction
Click the Finder button beside the Vendor Number field to add a new
additional cost vendor to this receipt.
After entering the tax group, exchange rate information (for multicurrency
vendors) and optional field information for the cost, enter the cost details
in the grid in the middle of the form, or press F9 or click the Cost/Tax
button to open the Detail Cost/Taxes form for entering additional costs.
You can add as many cost details as you need for the primary vendor
and secondary vendors.
Information you enter with each additional cost detail includes:
(the code you set up with the cost in the
Additional Costs form; you can also omit the code then enter a
description of a cost you have not added to Purchase Orders).
Additional cost code and description

Amount (the amount of the additional cost). The program displays the
amount if an amount is specified for the additional cost code, but you
can change it. If no amount is displayed, you type the amount.
In multicurrency ledgers, the amount is shown in the format of the
currency selected for the cost detail.
(the method, if any, by which you apportion a cost and
associated allocated taxes to received items).
Proration method

For examples and information about how costs are prorated, see
Calculating prorated additional costs.
If you do not prorate an additional cost, you expense it to the general
ledger account you assigned to the additional cost record or to
another account you specify when entering the additional cost
transaction.
If you want to prorate or expense a job-related cost to several jobs,

you must have a receipt detail for each of the jobs to which you want
to apportion costs.
You can also specify retainage for job-related costs.
(return proration) method (how a cost is reprorated when you
enter a return to a receipt you posted previously or when you return
items to which costs were prorated).
Reproration

(for each detail line). If these optional fields match the
Purchase Orders and Accounts Payable invoice detail optional fields,
the optional field data will be passed automatically to Accounts
Payable (depending on your optional fields settings).
Optional fields

The tax information for each additional cost detail is determined by the
vendor's tax group. For each detail, you can change the tax class and
specify whether tax is included in the cost amount (if allowed by the tax
authority).
You can also check the tax amount for the detail and the allocated,
recoverable, and expensed tax amounts. For more information, see Editing
vendor and detail tax Information.
Reporting prorated amounts. The Receipts Posting Journal lists the
additional cost amounts prorated to each item on a receipt. Use the
journal to check the amounts that were prorated automatically during
posting or Day End Processing, and to check the amounts you prorated
manually.
Go back to Entering additional costs on receipts

Specifying Vendors for Additional Costs
To add information about additional costs on a receipt, you first specify
the vendor who charged the cost, then you enter the costs charged by
each vendor.
You use the Additional Cost tab in the Receipt Entry form to specify the vendor
information, including:
Vendor number and name

(the code and name of the vendor who charged you

the cost).
(the tax authorities, classes, and related tax information that
apply to the cost). In multicurrency ledgers, the tax group you select
identifies the currency in which the additional cost was charged.
Tax group

(identifies the payment terms the vendor allows your
company).
Terms code

In multicurrency ledgers, you can enter the rate type, rate date, and
exchange rate for each secondary vendor. You use the Rate Information
tab to edit currency rate information for a primary vendor who does not
use functional currency.

Displayed information
The program displays the subtotal, tax included, and total amounts of the
additional costs you enter for each vendor.
Go back to Entering additional cost on receipts

Receipt Entry Security Access
The Receipt Entry security choice for Purchase Orders (in the Security
Groups form in Administrative Services) allows you to:
Use the Receipt Entry form to view, add, edit, and post receipts.
Users with Receipt Entry rights only can create receipts from POs,
specify quantities received, and post receipts, but they cannot see
any cost information.
This means that receiving dock staff can fill in receipts without seeing
any other accounting system information.
You can see default item costs:
If you are assigned the Show Receipt Costing Information right in
Purchase Orders.
Or
If you have Cost Inquiry security rights in Sage ERP Accpac
Inventory Control and are entering receipts without purchase order
numbers.
Add and post invoices from the Receipt Entry form (if you have
Invoice Entry security rights in Purchase Orders).
Look up data in the Purchase History form (if you also have
Transaction Inquiry security rights in Purchase Orders or Day End
Processing security rights in Inventory Control or Purchase Orders [if
you don't have I/C]).
Use the Vendors forms in Sage ERP Accpac Accounts Payable to
view, add, edit, and delete vendor records (if you have security rights
to the forms in Accounts Payable).
Select Sage ERP Accpac Order Entry order numbers for item details
on transactions (if you have security rights to orders in Order Entry).
View and print the Purchase Order List and the Receipt List, printed
from the Transaction List form (selected from the Analytical Reports
folder).
Purchase Orders provides a security permission to "Show Receipt

Costing Information." This allows you to have warehouse staff receive
goods and enter quantities received, but prevent them from viewing
cost information.
Note: If users do not have the "Show Receipt Costing Information"
security right, they will not be able to view item unit cost information on
receipts — including totals, taxes, discounts, and additional cost
amounts. (In other words, the Taxes tab, Additional Costs tab, and Totals
tab will not appear on the Receipt Entry form for users do not have this
right.)
Also note: Pre-printed forms PORCP03.RPT and PORCP04.RPT will
print cost information. If you want to hide costs on these forms, you will
need to customize them.

Receiving Slip Printing Security Access
The Receiving Slip Printing security choice for Purchase Orders (in the
Security Groups form in Administrative Services) allows you to open the
Receiving Slips form from the forms folder, and print receiving slips.
You can also print receiving slips from the Receipt Entry form
immediately after posting them (by choosing Yes at the "Posting
completed" message that appears).

Entering Invoice Header Information and Vendor
Information
Header and vendor information that you enter only for invoices
includes:
Invoice number

(up to 22 characters in length).

Vendor number

(up to 12 characters in length).

Receipt number

or From Multiple Receipts.

Invoice date (the transaction date for the invoice).
You can specify a fiscal year and period that do not correspond to the
invoice date.
Invoice total (the total amount of the invoice, including taxes and
additional costs).
When you post the invoice, the program checks the amount you
entered as the invoice total against the total of the details and taxes
you enter with the invoice. You cannot post the invoice if these totals
do not balance.
Vendor name (for vendors who are not defined in Accounts Payable).
The program displays the vendor name you entered on the receipt,
but you can change the name for the invoice.
Vendor address.
The program displays the vendor address, phone, and contact
information from the receipt, but you can change it.
Remit-to location

(the address where you send payment).

Bill-to location (the address where the vendor sends you invoices).
1099 code and amount

(for vendors who are subject to 1099 reporting).

The program displays the fiscal year and period for the invoice date you
entered, as well as any description, reference, and comment on the
receipt, and the tax group and terms code. You can change this
information.

Entering Invoice Details
The tabs that are available in the Invoice Entry form depend on whether:
You are entering an invoice for a primary or secondary vendor.
You have already posted an invoice for the primary vendor on the
receipt.
You use optional fields and have assigned any to the invoice form.
If the invoice is job-related, the invoice has retainage.
When you are invoicing a new receipt, the program displays all of the
vendor's receipt details, including item details and additional cost details,
if any, for the primary vendor. You can add new additional cost details on
an invoice, but you cannot add or delete item details. You also cannot
delete additional cost details, although you can change the amounts.
The invoice displays item details only for the primary vendor. You can edit
the following fields in the grid on the Invoice tab:
Quantity invoiced. If you increase or decrease the invoiced quantity, the
Quantity Invoiced field is updated on the purchase order. During posting
or during Day End Processing, item costs are updated in Inventory
Control and, if necessary, new general ledger transactions are created to
reflect the change.
You can assign security to the Quantity Invoiced field if you wish to
prevent unauthorized changes to the field.
Billing type, billing rate, retainage percentage, and retention period.
If the invoice is job-related, changes to the quantities, billing rate, and
cost will affect the committed and actual quantities and costs for the job
in Project and Job Costing. If the invoice is posted exactly like the receipt,
no transactions will be sent to Project and Job Costing.
Unit cost and extended cost. You can assign security to the Unit Cost
and Extended Cost fields, to prevent unauthorized changes to the fields.
Discount %/Discount Amount. You can enter a separate discount
percentage or amount for each detail. When you enter a discount
amount, the program calculates the discount percentage, and displays

the result in this field. If you enter a percentage, the program calculates
and displays the discount amount.
Note that if you enter a discount for the invoice on the Totals tab, the
program distributes the total discount amount to the details, overwriting
any detail discounts you entered.
Order Number.If you change an order number that is displayed with a
detail line, the new order number does not replace the previous number
on the corresponding receipt and will not be reported on the Shippable
Backorders report.
You also enter the unit weight, extended weight, vendor item number,
comments, and the G/L expense account specified for non-inventory
items.
Optional Fields. These are company-defined fields that can be added to
each of the detail lines in an invoice if you use Sage ERP Accpac's
Transaction Analysis and Optional Field Creator. The entries in these
fields will flow from the requisition, purchase order and receipt if you use
the same fields for those forms. They can also be passed on to Accounts
Payable invoices and General Ledger transactions.
If the Optional Fields column appears, you can click the column heading
to display the Optional Fields form.
See also
Entering additional cost details on invoices

Entering Exchange Rate Information on Invoices
If you use multicurrency accounting, you can also edit the invoice rate
type, rate date, and exchange rate for vendors who do not use the
functional currency or are members of the EMU.
If you selected a receipt for the invoice, the Rates tab displays the
vendor's rate date, type, and amount from the receipt and default entries
for the invoice rates. You can change the rate information for the invoice.
If you are entering a transaction with retainage, you specify on the
Retainage tab whether the retainage invoice uses the same exchange
rate as the original document or the current rate.

Checking Invoice Totals
Use the Totals tab on the Invoice Entry form to:
Check tax and detail totals.
Primary vendor. On invoices for the primary vendor, the Totals tab
shows the total weight of the invoiced items, number of item and
additional cost detail lines, tax information for the invoice, invoice
subtotal (net of taxes and additional costs), totals of additional
costs and taxes, and invoice total.
Secondary vendor. On invoices for a secondary vendor, the
Totals tab shows only the number of additional cost details, related
tax information, invoice subtotal, excluded tax amount, and invoice
total.
Enter a discount percentage or a total discount amount for the
invoice. When you enter a discount on this tab, the program
distributes the total amount to the invoice details, overwriting any
discounts you entered for details.
Enter a comment for the invoice
Use the Taxes tab to verify the invoice information and tax amount.

Editing Payment Terms
On the Terms tab of the Invoice Entry form, you can change the method
of calculating the due date, and the discount date, percentage, and
amount for the invoice.
For payment schedules, you can also edit the As Of date and each of the
payment amounts. (You can change the terms code only on the Vendor
Information tab.)

Make __ Lots OR Each Lot Has __
When you auto-generate lots, you must enter a number in one of these
fields to define how the lots are generated:
Make __ Lots. If you want to create a fixed number of lots, with the
quantity evenly distributed across all of the lots, enter the number of
lots.
For example, if you create 10 lots and have 400 items, each lot will
have 40 items.
OR
Each Lot Has __. If you want to distribute a fixed quantity to each lot,
enter the number to include in each lot.
For example, if you want to have 50 items in each lot, the process will
generate the number of lots needed to accommodate the quantity of
items.

Job-Related
If the return or invoice was job-related, the Job-Related checkbox will be
selected for the credit/debit note, and you will not be able to change this
selection.
The contract, project, category, cost class and resource for each detail
will be provided by the program — as will the customer billing type, billing
rate, and A/R item used for billing.
If you use different terms than “Contract,” “Project,” and “Category” in
Project and Job Costing, the program displays them instead.

Retainage Percentage and Period
If the invoice or return used retainage accounting, the program will
display additional percentage and period retainage fields for each detail
line.
The program will also display the Retainage tab to let you specify the
exchange rate that you want to use for the multicurrency retainage on
credit/debit notes.
If you uncheck the Retainage checkbox, the percentage and period
retainage fields will disappear from the item detail section, and the
Retainage tab will disappear.
You can check the retainage field for job-related transactions even if
retainage was not used on the original transaction.
Note that retainage accounting applies only to job-related transactions,
and is available only if you selected retainage accounting in the Accounts
Payable program.

Billing Information for Job-Related
Credit/Debit Notes
For job-related credit and debit notes, the program provides the Billing
Type, Billing Rate, and AR Item Number that was used for the invoice or
return.
The invoice or return must be job-related for these fields to appear.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Contract, Project, Category, and Item
Number/Resource for Job-Related Credit/Debit
Notes
If the return or invoice was job-related, the program will provide the job to
which each detail was assigned. If you use different terms than
“Contract,” “Project,” and “Category” in Project and Job Costing, the
program displays them instead. (The "resource" appears in the Item
Number column.)
Purchase Orders updates the actual quantities and costs for jobs with the
amounts on credit or debit notes. For example, costs are affected by
credit and debit notes, and quantities are affected by credit note returns.
(Quantities are not affected by credit notes that reference invoices or
debit notes.)
Note:
The Job-Related checkbox will be automatically selected if the invoice
or return was job-related. You cannot change it.
You enter/select the resource using the Item Number field.
You must select the Job-Related checkbox if the reference document
no longer exists in PO.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Optional Fields in Credit/Debit Note Details
Optional fields are fields that have been added by your company to the
transaction entry forms and detail lines in purchase orders transactions.
You must have Sage ERP Accpac's Transaction Analysis and Optional
Field Creator to add and use optional fields.
If the Optional Fields column appears, you can click the column heading
to display the optional fields that have been assigned to this form, and
edit their contents.
Optional fields on the Optional Fields tab apply to the transaction as a
whole. Optional fields on detail lines apply to the individual transaction
entry.
Optional field information can pass through the complete transaction
cycle — from purchase requisitions, to purchase orders, to receipts, to
invoices, and even to downstream ledgers like Accounts Payable and
General Ledger — as long as you assign the same optional fields to each
of the transaction forms and to the general ledger accounts.

Billing Information for Additional Costs on
Credit/Debit Notes
For additional costs on job-related credit and debit notes, the program
provides the Billing Type, Billing Rate, and AR Item Number that was
used for the invoice or return.
The invoice or return must be job-related for these fields to appear.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Calculate Labor (job-related costs only)
Select the Calculate Labor field if you want Project and Job Costing to
calculate labor amounts for this cost and pass the amount back to
Purchase Orders. (Purchase Orders creates the G/L entries for the
additional costs.)
Do not select this option for an additional cost for which you don't want to
calculate labor.
The program also lets you specify whether overhead or labor is
calculated if you expense the additional cost.

Calculate Overhead (job-related costs only)
Select the Calculate Overhead field if you want Project and Job Costing
to calculate overhead amounts for this cost and pass the amount back to
Purchase Orders. (Purchase Orders creates the G/L entries for the
additional costs.)
Overhead is usually calculated on the discounted extended amount.
For example, you would not select this option if a debit note had
additional shipping costs for which you didn't want to calculate overhead
or labor.
The program also lets you specify whether overhead or labor is
calculated if you expense the additional cost.

Contract, Project, Category, and Item
Number/Resource for Additional Costs on
Credit/Debit Notes
If the return or invoice was job-related, the program will provide the job to
which each cost was assigned. If you use different terms than “Contract,”
“Project,” and “Category” in Project and Job Costing, the program
displays them instead.
For job-related transactions, you can also specify the Billing Type, Billing
Rate, AR Item Number, and AR Item UOM for the customer invoice near
the end of the detail line.
Note:
You specify this information only if you are not prorating the cost to
individual detail lines (No Proration). The fields are disabled if you are
prorating by cost, quantity or weight, or prorating manually (where you
allocate costs to the individual lines on the Distribute Additional Costs
form).
You enter/select the resource using the Item Number field.
You cannot change these fields once you have added the detail line.
These fields appear only for job-related credit or debit notes.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Less Discount
Purchase Orders lets you enter a discount percentage or discount
amount for the entire document or enter discounts for individual detail
lines.
If you enter a discount for the entire document, Purchase Orders will
prorate the discount amount for the document details, overriding any
discounts you may have entered manually for the details.

Less Retainage & Net Credit/Debit Note
Totals(display only)
These fields appear if this credit or debit note is a job-related document
that includes retainage amounts.
The Net Total is the total after retainage is deducted.

Detail Information
You can select a detail on a detail-entry grid on any transaction-entry
form, then click the Item/Tax button to open a separate form that lets you
view, or edit, information for the selected detail and add new details.
If you are entering an additional cost, you can click the Cost/Tax button to
open a similar form that displays a single additional cost detail.
You can also open the form by selecting the item or additional cost detail,
then clicking the Zoom button ( ).
Tax Information on the Detail Form
The Detail Items/Taxes form and the Detail Costs/Taxes form provide
additional tax information for the detail that you do not see on the detailentry grid. You can check the tax information for the detail, and you can
change the tax class and the tax-included status for each tax authority (if
the vendor's tax authority allows tax-included costs).
The Detail Items/Taxes form shows, for the selected detail:
Tax authorities

and their descriptions in the vendor's tax group.

Detail tax class

— whether the item is taxable.

— whether tax is included in the cost (the default choice
for this option is provided from the vendor record in Accounts
Payable).
Tax Included option

— the total of allocated, recoverable, and expensed tax
amounts for each authority.
Tax amount

— the total tax amount that was allocated to the selected
detail line for the tax authority.
Allocated tax

Recoverable tax

— a tax amount that is refundable.

— if the tax is expensed rather than included in the value of
inventory.
Expensed tax

Tax included
Tax base

— the tax that is included in the cost of the item.

— the amount on which the tax is based.

You specify whether a tax is allocated, recoverable, or expensed, and

assign the general ledger account for the tax in the Tax Authorities form
in Tax Services.

Detail tax calculation
Tax amounts are calculated for details when you post the transaction or
click the Totals tab on the form.
To check tax amounts for details before posting a transaction, select the
detail on the detail entry grid, click the Item/Tax button to open the
Items/Taxes form, then click the Calculate Taxes button. The program
calculates taxes for the entire document, not just for the detail you were
editing.
If you edit a tax amount on the Taxes tab, and then use the Calculate Tax
button, the program uses the tax tables in Tax Services and your
selections for the tax class and the tax-included option to recalculate
taxes.
Once taxes are calculated, you can see the allocated tax, tax-included,
and net-of-tax amounts for a detail on the detail line, but you cannot
change any information in these fields.
See also
General ledger transactions for edited taxes
Tax information for additional cost details

Document Tax Information
The Taxes tabs in Purchase Orders forms display the tax calculations for
the document as a whole on purchase orders, invoices, returns, credit
notes, and debit notes. For receipts, total taxes are displayed on the
Taxes tab for the primary vendor, and on the Additional Cost Vendor
Taxes form for secondary vendors.
To see the tax information for an item detail line, you select the detail in
the detail entry grid, then click the Item/Tax button. To see tax information
for an additional cost detail, you select the additional cost, then click the
Cost/Tax button. When you choose the button, Purchase Orders
automatically calculates the tax amounts if you have not already posted
the transaction or used the Calculate Taxes button.
On the Taxes tab and on the Additional Cost Vendor Taxes form, you use
the Calculate Tax button to have the program recalculate taxes using the
tax tables from Tax Services after you have changed tax amounts. Taxes
are calculated automatically when you choose the Totals tab or when you
post the transaction.
Tax information for a transaction total includes:
Tax authority and description (for the vendor's tax authorities).
The vendor's tax class and description for each tax authority. You can
change to another tax class that is assigned to the tax authority. New
vendors you have not yet added to Accounts Payable are assigned
tax class 1 and its corresponding description for each tax authority in
the tax group selected for the transaction.
Changing the tax amount. You can change the total tax amount to
correct small discrepancies, such as rounding errors. (You should
correct large errors by updating the tax rates and other information for
the tax authorities in Tax Services.)
The total amount of tax that is included in the cost amounts entered
for the vendor. You cannot edit this amount.
The total amount of tax that is charged in addition to (not included in)
the cost amounts entered for the vendor. You cannot edit this amount.

Tax amount (the total of all tax amounts calculated for the
transaction). The total tax amount for an authority is the sum of the
tax included and tax excluded. If you change the tax amount, the
program adjusts the tax amounts on the details.
Editing taxes for the document vendor
Purchase Orders automatically calculates the vendor taxes on each
transaction, using the rates entered in Tax Services for the tax authorities
and classes assigned to the vendor in Accounts Payable.
You can change the tax class and the tax amount for each tax authority
assigned to the document vendor for a transaction on the Taxes tab of
the form you are using.

Return Entry Form — Detail Items/Taxes
Form
Use this form to check and edit return detail lines. The form contains a
form with fields, rather than columns, letting you see all the information
you enter for a single detail.
To open the Detail Items/Taxes form
Select the detail on the Return tab, then press F9 or click the Item/Tax
button.
To add details in the Detail Items/Taxes form
1.To add a detail, click the New icon next to the Line Number field. (If no
other detail is displayed, press tab to accept the number in the Line
Number field.)
2.Enter the information for the detail.
You can change a tax class to another tax class that is assigned to
the authority, and you can change the choice for the Tax Included
option (if the tax authority permits tax-included costs).
3.Click the Add button.
Note: You can add detail lines only if you are entering a return without a
receipt number
To edit details in the Detail Items/Taxes form
1.To open an existing detail you want to edit, type its line number or use
the navigation buttons beside the Line Number field until the line you
want is displayed.
2.Type the information or changes for the detail, then click the Save
button.
To compare tax amounts for a return on the screen with the totals on the
source document, check the Totals tab.
For information about a button on the Detail Items/Taxes form, click the
corresponding link:

Add

Save

Calculate Taxes

Close

To open and close the Detail Comments form
Click the Zoom button ( ) beside the Comments field, or (with the
insertion point in the field) press the Shift and F9 keys to open the
Detail Comments form.
Click the Close button, or press the F9 key, to return to the Return tab.
See also
Return Entry Form — overview
Return Entry form — Return tab

Credit/Debit Note Entry — Bill-To Location
Information Form
Use this form to edit an existing bill-to location address or to type a new
billing address for the credit note or debit note.
You do not have to enter a bill-to location code or address information.
To use the Bill-To Location form
1.If desired, type the location code to use in the Bill-To Location field, or
select it from the Finder.
2.To enter or edit address information, click the Zoom button ( ) beside
the Bill-To Location field or press the F9 key in the field.
3.Type the name and address information to use for the location, or edit
displayed information (from the receipt or the location record in
Inventory Control).
4.When finished, click the Close button or press F9 to return to the
Credit/Debit tab.

Credit/Debit Note Entry — Detail Comments Form
Use this form to type comments which apply to the detail line.
To open the Detail Comments form
Click the Zoom button ( ) beside the Comments field, or (with the
insertion point in the field) press the Shift and F9 to open the Detail
Comments form. Click the Close button or press the F9 key to close the
form..
To enter comments
1.Open the Detail Comments form.
2.Type the remarks, pressing Enter to start each new line.
3.When finished, click Close.
To edit comments
1.Open the Detail Comments form.
2.Make the changes you need.
3.When finished, click Close.
To delete comments
1.Open the Detail Comments form.
2.Highlight the text to delete, then press the Delete key on your
keyboard. If a message appears asking you to confirm the deletion,
choose Yes.
3.When finished, click Close.
You can also delete comments by changing the entry in the field to No on
the Credit/Debit tab, or by deselecting the Comments box on the Detail
Items/Taxes form.
If you use this method, your remarks are not immediately deleted. If you
decide before posting the invoice that you want to use the remarks, enter
Yes (or reselect the Comments field on the Items/Taxes form). The
original remarks will reappear.

Credit/Debit Note Entry — Cost Allocation
Form
Use this form to allocate an additional cost detail to more than one
receipt.
This form is available only if you are adding an additional cost to a debit
note/invoice that is based on multiple receipts.
You can prorate and allocate the additional cost amount manually, or you
can let Purchase Orders automatically allocate amounts to receipts
according to the proration method you chose.
To prorate a new additional cost on a debit note that uses multiple
receipts
1.On the Additional Costs tab of the Credit/Debit Note Entry form, select
the additional cost detail line. Then click the Dist. Cost button to
display the Cost Allocation form.
2.Prorate the additional cost and allocate amounts to the receipts using
one of the following methods:
To prorate the additional cost automatically for all the receipts
included on the invoice, click the Redist. button.
You can change the total amount displayed for the additional cost
detail. If you change the amount of the additional cost, do one of
the following:
Choose Reallocate to have the program automatically prorate
the new amount for the receipts according to the proration method you
selected on the Additional Costs tab.
Allocate the amounts manually.
To allocate the additional cost manually, double-click in the Amount
column beside the receipt and enter a different amount for each
receipt, ensuring that the sum of the amounts equals the total
amount of the additional cost.
To clear the amounts, choose the Clear button.
3.When you have finished, click the Close button to return to the

Additional Costs tab.
Use the Dist. Cost button to open the Cost Allocation form for an
additional cost detail.
Use the Redist. button to have Purchase Orders automatically prorate
the additional cost amount for the receipts.
Use the Clear button to clear all amounts in the form.
Use the Close button to close the Cost Allocation form and return to
the Additional Costs tab.
Go back to the Additional Cost tab.

Adding New Vendor Records During Transaction
Entry
You can add new vendor records to Accounts Payable from all of the
Purchase Orders transaction-entry forms, or type new vendor numbers
then add them later in Accounts Payable.
This feature lets you add new vendors "on the fly" so that you can enter
transactions for vendors who are not in your Accounts Payable data,
even if you do not have time or rights to add vendor accounts in Accounts
Payable.
To add a new vendor record from a Purchase Orders form, type the
vendor number, press Tab, then use the "New" icon next to the Vendor
Number field to open the Vendors form in Accounts Payable and add the
record. When you close the Vendors form, you are returned to the
Purchase Orders form you were using.
If you do not want to add the record in Accounts Payable while you are
entering Purchase Orders transactions, you can just type the new vendor
number and the name of the account in the Purchase Orders transactionentry form, then add the vendor to Accounts Payable later (before you
post the Purchase Orders transactions).

Keeping Transaction History
If you selected the Keep Transaction History option in the Purchase
Orders Options form, the program will keep details of posted transactions
until you remove them using the Clear History form. You can print
Transaction Lists of the data — and reprint requisitions, purchase orders,
receiving slips, and returns — until you clear the transaction history for
them.
If you do not keep transaction history, Purchase Orders will
automatically delete completed transactions when you run Day End
Processing, and you will not be able to drill down to Purchase Orders
transactions from General Ledger or Accounts Payable.
Purchase Orders considers the following transactions to be completed:
Requisitions, purchase orders, receipts, and returns with a Completed
status on all detail lines.
All invoices, credit notes, and debit notes (these transactions are
completed when you post them).
If you do not keep history, you cannot display or print copies of completed
requisitions, purchase orders, receipts, and returns after you run Day End
Processing, and you cannot look up the invoices, credit notes, and debit
notes you posted before posting or running Day End Processing.

Job-Related
If the receipt was job-related, the Job-Related checkbox will be selected,
and you will not be able to change this selection. If you use retainage
accounting, you can specify that the invoice uses retainage.
Because the invoice is job-related, fields will appear in the details section
to let you enter the contract, project, category, cost class and resource for
each detail. Additional detail fields let you enter the customer billing type,
billing rate, and A/R item used for billing.
If you use different terms than “Contract,” “Project,” and “Category” in
Project and Job Costing, the program displays them instead.

Billing Information for Job-Related Invoices
For job-related invoices, you also specify the Billing Type, Billing Rate,
and AR Item Number that will be used for the customer invoice.
The Job-Related checkbox in the top part of the form must be selected
for these fields to appear.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Contract, Project, Category, and Item
Number/Resource for Job-Related Invoices
If the invoice is job-related, specify for each purchase order detail where
the items or resources are going to be used. If you use different terms
than “Contract,” “Project,” and “Category” in Project and Job Costing, the
program displays them instead.
For job-related invoices:
You must select the Job-Related checkbox in the top part of the
Purchase Order Entry form for these fields to appear.
You also specify the Billing Type, Billing Rate, and AR Item Number
for the customer invoice near the end of the detail line.
You enter/select the resource using the Item Number field.
If the invoice is being created from multiple receipts, all receipts must
be either job-related or non-job-related.
Purchase Orders updates the committed quantities and costs for jobs
with the amounts on purchase orders.
Click the following items for more information:
Contract
Cost Class
Item Number (Resource)
Project

Invoice Entry Form — Detail Items/Taxes
Form
Use this form to check and edit invoice detail lines. This form displays
one invoice detail at a time using data entry fields, rather than in
columns, letting you see all the information for a single detail at a glance.
To open or close the Detail Items/Taxes form, select the detail on the
Invoices tab, then press F9 or click the Item/Tax button.
Press F9 or click Close to return to the Invoices tab.
To edit details using the Detail Items/Taxes form
1.To open an existing detail you want to edit, type its line number or use
the navigation buttons beside the Line Number field to display the line
you want.
2.Type the information or changes for the detail, then click Save.
For information about a button on the Detail Items/Taxes form, choose
the button:
Save Calculate Tax Close

See also
Invoice Entry Form — overview
Invoice Entry form — invoice tab

Invoice Entry — Detail Items/Taxes Form Field List
Allocated Tax (display only; total for detail)
Allocated Tax (display only; total for authority)
Comments
Detail Tax Class and Description
Expense Account
Expensed Tax (display only)
Extended Cost
Extended Weight
Item Description
Item Number (display only)
Line Number

(display only)
Net of Tax (display only)
Location

Optional Fields
Recoverable Tax (display only)
Order Number
Quantity Invoiced

(display only)

Receipt Number
Tax Amount (display only)
Tax Base (display only)
Tax Authority and Description (display only)
Tax Included
Unit Cost
Unit of Measure
Unit Weight
Vendor Item Number

Billing Information for Additional Costs on
Invoices
For additional costs on job-related invoices, you also specify the Billing
Type, Billing Rate, and AR Item Number that will be used for the
customer invoice.
These fields will only appear for job-related invoices.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Calculate Labor (job-related costs only)
Select the Calculate Labor field if you want Project and Job Costing to
calculate labor amounts for this cost and pass the amount back to
Purchase Orders. (Purchase Orders creates the G/L entries for the
additional costs.)
Do not select this option for an additional cost for which you don't want to
calculate labor.
The program also lets you specify whether overhead or labor is
calculated if you expense the additional cost.

Calculate Overhead (job-related costs only)
Select the Calculate Overhead field if you want Project and Job Costing
to calculate overhead amounts for this cost and pass the amount back to
Purchase Orders. (Purchase Orders creates the G/L entries for the
additional costs.)
Overhead is usually calculated on the discounted extended amount.
For example, you would not select this option if an invoice had additional
shipping costs for which you didn't want to calculate overhead or labor.
The program also lets you specify whether overhead or labor is
calculated if you expense the additional cost.

Contract, Project, Category, and Item
Number/Resource for Additional Costs on Invoices
If the invoice is job-related, specify for each additional cost detail where
the items or resources are going to be used. If you use different terms
than “Contract,” “Project,” and “Category” in Project and Job Costing, the
program displays them instead.
You will also specify the Billing Type, Billing Rate, AR Item Number, and
AR Item UOM for the additional cost.
Note:
You specify this information only if you are not prorating the cost to
individual detail lines (No Proration). The fields are disabled if you are
prorating by cost, quantity or weight, or prorating manually (where you
allocate costs to the individual lines on the Distribute Additional Costs
form).
You enter/select the resource using the Item Number field.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Detail Costs/Taxes Form Field List
Additional Cost (code) and Description
Allocated Tax (Total, display only)
Amount
Comment
Detail Tax Class and Description
Expense Account
Expensed Tax (display only)
Line Number
Net of Tax (display only)
Optional Fields (Additional Cost details)
Proration
Receipt Number (display only)
Recoverable Tax (display only)
Reference
Return Expense Account
Return Proration
Tax Amount (display only)
Tax Authority and Description (display only)
Tax Base (display only)
Tax Included (display only unless allowed by authority)
Vendor Number (display only)

Billing Information for Manually Prorated
Additional Costs on Invoices
For job-related additional costs that you are manually prorating, you also
specify the Billing Rate that will be used for the customer invoice. The
following billing fields from the invoice detail line are display-only on this
form: Billing Type, Billing Currency, AR Item Number, and AR Item UOM.
These fields will only appear for job-related invoices.
Click the following items for more information:
AR Item Number
AR Item UOM
Billing Currency
Billing Rate
Billing Type

Contract, Project, Category, and Item
Number/Resource for Manually Prorated Additional
Costs on Invoices
For job-related additional costs that are manually prorated, choose the
items/resources to which you are allocating the additional cost.
The program displays the “Contract,” “Project,” and “Category” that you
specified for each invoice detail line. The "resource" appears in the Item
Number column.
You also specify the Billing Rate for the additional cost.
Note:
The proration form is available only if you choose to manually prorate
additional costs to detail lines. The following fields from the invoice
detail lines are shown as display-only fields on this form: Contract,
Project, Category, Cost Class, Item Number, and Description.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Bill-To Location Form Field List
Address
Bill-To Location code (display only)
Contact Information (name, phone fax and e-mail)

\

Description
E-mail
Fax Number
Phone Number

Create Invoice From Receipts Field List
Receipt Number

Invoice Entry — Cost Allocation Form
Use this form to allocate an additional cost detail to more than one
receipt.
This form is available only if you are adding an additional cost to an
invoice that is based on multiple receipts.
Note: For a job-related invoice, the Billing Rate is also allocated with the
additional costs to more than one receipt.
You can prorate and allocate the additional cost amount manually, or you
can let Purchase Orders automatically allocate amounts to receipts
according to the proration method you chose.
To prorate a new additional cost on an invoice that uses multiple
receipts
1.On the Additional Costs tab of the Invoice Entry form, select the
additional cost detail line. Then click the Dist. Cost button to display
the Cost Allocation form.
2.Prorate the additional cost and allocate amounts to the receipts using
one of the following methods:
To prorate the additional cost automatically for all the receipts
included on the invoice, click the Redist. button.
You can change the total amount displayed for the additional cost detail.
If you change the amount of the additional cost, do one of the
following:
Choose Reallocate to have the program automatically prorate
the new amount for the receipts according to the proration method you
selected on the Additional Costs tab.
Allocate the amounts manually.
To allocate the additional cost manually, double-click in the Amount
column beside the receipt and enter a different amount for each
receipt, ensuring that the sum of the amounts equals the total
amount of the additional cost.
To clear the amounts, choose the Clear button.

3.When you have finished, click the Close button to return to the
Additional Costs tab.
Use the Dist. Cost button to open the Cost Allocation form for an
additional cost detail.
Use the Redist. button to have Purchase Orders automatically prorate the
additional cost amount for the receipts.
Use the Clear button to clear all amounts in the form.
Use the Close button to close the Cost Allocation form and return to the
Additional Costs tab.
Go back to the Additional Cost tab.

Distribute Cost Button
Use the Distribute Cost button to allocate a new additional cost to
multiple receipts.
Select the additional cost detail on the Additional Costs tab, then click the
Distribute Cost button to open the Allocate Cost form.
Purchase Orders automatically allocates the additional cost amount
according to the proration method you selected on the Additional Costs
tab. However, you can enter different amounts for each receipt manually.

Billing Information for Job-Related Purchase
Orders
For job-related purchase orders, you can also specify the Billing Type,
Billing Currency, Billing Rate, and AR Item Number (if appropriate) that
will be used for the customer invoice.
You must select the Job-Related checkbox in the top part of the
Purchase Order Entry form for these fields to appear.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Contract, Project, Category, and Item
Number/Resource for Job-Related Purchase
Orders
If the purchase order is job-related, you specify for each purchase order
detail where the items or resources are going to be used. If you use
different terms than “Contract,” “Project,” and “Category” in Project and
Job Costing, the program displays them instead.
For job-related purchase orders, you can also specify the Billing Type,
Billing Rate, and AR Item Number for the customer invoice near the end
of the detail line.
Purchase Orders updates the committed quantities and costs for jobs
with the amounts on purchase orders.
Note:
You must select the Job-Related checkbox in the top part of the
Purchase Order Entry form for these fields to appear.
If the purchase order is being created from multiple requisitions, all
requisitions must be either job-related or non-job-related.
You enter/select the resource using the Item Number field.
Cost plus and fixed price projects do not use an A/R item number.
You cannot change these fields once you have added the detail line.
Click the following items for more information:
Contract
Cost Class
Item Number (Resource)
Project

Purchase Order Entry — Items/Taxes Form Field
List
Allocated Tax (display only)
Comments/Instructions
Completed
Drop Ship
Expected Arrival Date
Expense Account
Expensed Tax (display only)
Extended Cost
Extended Weight
Item Description
Item Number (display only)
Line Number
Location
Net of Tax (display only)
Optional Fields
Order Number
Quantity Ordered
Quantity Outstanding
Quantity Received (display only)
Recoverable Tax (display only)
Tax Amount
Tax Authority (display only)
Tax Class and Description
Tax Included
Unit Cost
Unit of Measure
Unit Weight
Vendor Item Number (optional)

Comment (optional)
Type a comment for the purchase order, using up to 250 characters.

Number of Labels
Type the number of labels you wish to print for the purchase order, such
as to paste on envelopes you are mailing to the vendor.
The number of labels you specify is printed by the Mailing Labels form
when you print labels for the purchase order.

Ship-To and Bill-To Location Forms Field List
Address
Bill-To Location
Contact
Description
Fax Number
Phone Number
Ship-To Location

Purchase Order Entry — Comments/Instructions
Field List
Comments/Instructions
Type

New button
Click the New button beside the Line Number field to insert a new detail
line.

Purchase Order Entry — Drop-Shipment Address
Field List
Address, City, State/Prov., Zip/Postal Code, Country
Contact
Customer Number
Customer Ship-to Location
Description
E-mail
Fax Number
Location Code
Phone
Set Drop Shipment Address To

From Requisition Form Field List
Requisition Number
Use Blank Vendors
Use I/C Vendors
Ordered (display only)
Date Ordered (display only)

Billing Information for Additional Costs on
Receipts
For job-related additional costs on receipts, you also specify the Billing
Type, Billing Rate, AR Item Number, and AR Item UOM that will be used
for the customer invoice.
These fields will only appear for job-related receipts.
Click the following items for more information:
AR Item Number
AR Item UOM
Billing Currency
Billing Rate
Billing Type
Cost Class

Contract, Project, Category, and Item
Number/Resource for Additional Costs on Receipts
For job-related receipts, either expense the additional cost or specify
where the items or resources are going to be used. If you use different
terms than “Contract,” “Project,” and “Category” in Project and Job
Costing, the program displays them instead.
You also specify the Billing Type, Billing Rate, AR Item Number, and AR
Item UOM for the customer invoice.
Note:
You enter/select the resource using the Item Number field.
These fields will appear only for job-related receipts, and be enabled
only for No Proration additional costs.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Billing Information for Manually Prorated
Additional Costs on Receipts
For job-related additional costs that you are manually prorating, you also
specify the Billing Rate that will be used for the customer invoice. The
following billing fields from the receipt detail line are display-only on this
form: Billing Type, Billing Currency, AR Item Number, and AR Item UOM.
These fields will only appear for job-related receipts.
Click the following items for more information:
AR Item Number
AR Item UOM
Billing Currency
Billing Rate
Billing Type

Contract, Project, Category, and Item
Number/Resource for Manually Prorated Additional
Costs on Receipts
For job-related additional costs that are manually prorated, choose the
items/resources to which you are allocating the additional cost.
The program displays the “Contract,” “Project,” and “Category” that you
specified for each receipt detail line. The "resource" appears in the Item
Number column.
You also specify the Billing Rate for the additional cost.
Note:
The proration form is available only if you choose to manually prorate
additional costs to detail lines. The following fields from the receipt
detail lines are shown as display-only fields on this form: Contract,
Project, Category, Cost Class, Item Number, and Description.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Using Retainage (Holdback) Accounting
If you use retainage accounting in Accounts Payable, Purchase Orders
lets you account for retainage (or a holdback) that occurs when you
withhold a percentage of an invoiced amount, usually by mutual
agreement or according to a statute (such as a Builders Lien Act).
Note that you can only specify retainage if you are using Sage ERP
Accpac's Project and Job Costing module, and the transaction is jobrelated.
There are three steps in processing retainage:
1.First, you process a receipt, invoice, debit note or credit note that
specifies a holdback (retainage) for the document.
2.The invoice or debit note with the retainage is transferred to Accounts
Payable and posted in that program.
3.Later, you post a separate retainage invoice, debit note, or credit note
to invoice the outstanding retainage amount.

Before Using Retainage Accounting
Before you can process retainage in Purchase Orders, you must:
Set the option to use retainage accounting on the Processing tab of
the A/P Options form.
Specify default retainage settings for vendors on the Retainage tab of
the A/P Options form.
Specify a retainage control account for each account set in your
Accounts Payable system.
Set up contracts in Project and Job Costing.

Entering Original Documents with Retainage
An invoice, debit note, or credit note from which retainage is taken is
called an original document in Sage ERP Accpac Advantage Series.
You enter the receipt, invoice, debit note, or credit note using the
standard P/O entry forms. To indicate that retainage applies to the

document, however, you select the Job-Related Option and the
Retainage option. (Note that this option appears only if you selected the
Retainage Accounting option for your Accounts Payable system.)
The program then displays the Retainage tab for the entry form, where
you can specify the retainage rate and the retainage terms. You then
specify the retainage percentage and the retention period on each detail
line.
Retainage Percentage
Retention Period
Retainage Rate
Retainage Terms

Taxes on Retainage
Note that all tax amounts are included on the original retainage
document. No tax amounts are included on the retainage invoice, debit
note, or credit note that you process to clear the outstanding retainage
amount.

Posting original invoices, debit notes, and credit
notes
When you post the original retainage document in Accounts Payable, the
program deducts the retainage from the document total, and posts the
amount to the retainage control account.
For example, if you enter an invoice for $10,000 with 10% retainage, an
invoice is posted for $9,000 with retainage outstanding of $1,000.
The retainage amount remains in the control account until you invoice it
in accordance with:
The retention period or retainage due date specified for the invoice.
The number of days in advance specified on the A/P Options form for
generating retainage documents.

Adjusting Original Documents

Use Adjustment Entry in Accounts Payable to change retainage related
to existing invoices, debit notes, and credit notes. When you post the
adjustment, the program adjusts the outstanding retainage account.
Note that Accounts Payable does not calculate any retainage on
adjustment transactions. You must enter the retainage manually, whether
you are adding it for the first time, or adjusting existing retainage debits or
credits.

Receipt Entry — Additional Cost Vendor
Information Form
Use this form when adding or editing additional costs from secondary vendors to:
Enter or edit the vendor's address, contact information, phone
number, or fax number.
To use the Vendor Information form
1.On the Additional Costs tab, beside the Additional Cost Vendor field,
use the navigation buttons to display the secondary vendor or use the
Finder to view the secondary vendors associated with the receipt,
then select from the list the vendor whose information you want to
review.
The code for the secondary vendor appears in the Vendor Number
field beneath the Additional Cost Vendor field.
2.Beside the Vendor Number field (with the vendor code displayed),
click the Zoom button to display the address information for the
secondary vendor.
3.Enter and edit the information you need.
4.Click the Close button to return to the Additional Costs tab.
To see Help on other Additional Cost forms, choose:
Additional Costs tab
Additional Cost Vendor Taxes form

Go back to the Additional Costs tab

Calculate Taxes button
Click the Calculate Taxes button if you want to see tax amounts for a
detail before you have posted the receipt or opened the Totals tab. (Tax
amounts are not automatically calculated until you choose Post for the
receipt or click the Taxes tab or Totals tab.)
If you edit tax amounts on the Taxes tab, then use the Calculate Taxes
button, the program will replace your changes with amounts it calculates
using the tax tables in Tax Services.

Additional Costs — Detail Costs/Taxes Field List
Additional Cost (code)
Allocated Tax (display only)
Amount
Comment
Expense Account
Line Number
Net Of Tax (display only)
Proration (method)
Reference
Return Expense Account
Return Proration
Tax Included (display only)

Detail taxes
Allocated Tax (display only)
Expensed Tax (display only)
Recoverable Tax (display only)
Tax Amount (display only)
Tax Authority and Description (display only)
Tax Base
Tax Class and Description
Tax Included

Ship-To and Bill-To Location Forms Field List
Address
Bill-To Location
Contact, Phone, Fax and E-mail
Description
E-mail
Fax Number
Phone Number
Ship-To Location

Detail Items/Taxes Field List
Allocated Tax (display only)
Expensed Tax (display only)
Item Number (display only)
Recoverable Tax (display only)
Tax Amount (display only)
Tax Authority and Description (display only)
Tax Base
Tax Class and Description
Tax Included

Save button
Click the Save button to save the changes you made to a detail you
edited in the Detail Items/Taxes entry form.

Drop-Shipment Address Field List
Address
Contact, Phone, Fax, and E-mail
Customer Number
Customer Ship-to Location
Description
E-mail
Fax Number
Location
Phone
Set Drop Shipment Address To

Entering 1099 Information
The 1099 Code and 1099 Amount fields appear on the Vendor
Information tab in the Invoice Entry form only for vendors for whom the
Subject To 1099 Reporting option is selected in Accounts Payable.
The 1099 code specified in the vendor record appears, but you can
select another 1099 code from the Finder.
If you enter the 1099 code and amount with an invoice, the 1099
information is included on the invoice created by Day End Processing for
Accounts Payable.

Receipt Entry — Vendor Information Form Field
List
Address
Contact (and phone, fax and e-mail)
Fax Number
Phone
Vendor Name
Vendor Number

PO Number
If you are entering a receipt of a single purchase order, type the purchase
order number or select the number from the Finder of the vendor’s
purchase orders.
If you specify a single purchase order number in this field, you will not be
able to use the From Multiple POs field.
You do not have to specify purchase order numbers with receipts.
However, if you do specify a purchase order number, the purchase order
details are displayed and you cannot add new details or receive a
quantity that is greater than the quantity ordered on the purchase order.
The Finder for this field shows only incomplete purchase order numbers.
(You cannot post receipts to completed purchase orders.)
You cannot change the purchase order number after posting the receipt.

From Multiple POs
To receive all incomplete purchase orders from the vendor, click the
zoom button beside the From Multiple POs box, and choose the POs
from the form that appears.
Use the Finder to list and select POs.
Click the Receive button after choosing the POs and moving to a new
line.
All the details from the purchase orders will be listed in the detail entry
section of the Receipt tab. You can edit quantities and delete lines.
If you check the From Multiple POs checkbox, the PO Number field will
not be available.
The checkbox will be automatically checked if you click the zoom button
next to the field.
Note: When you create a receipt from more than one purchase order, all
of the receipt header information (including the fields on the Optional
Fields tab) will come from the first purchase order that you select.

Job-Related
Select the Job-Related checkbox if the requisition is for a project you are
managing with Project and Job Costing.
Once you select the job-related checkbox, different fields appear for the
details to let you enter the contract, project, category, cost class and
resource for the job. If you select the Job Related option, all requisition
details must be either job-related. You cannot mix job-related items and
non-job-related items on the same requisition.
If you use different terms than “Contract,” “Project,” and “Category” in
Project and Job Costing, the program displays them instead.
Note: You cannot add serialized items or items assigned to lots to jobrelated requisitions. Instead, you must use a non-job-related requisition,
receive them into inventory, and then use the Material Usage form in
Project and Job Costing to move them from inventory to jobs.

Contract, Project, Category, and Item
Number/Resource for Job-Related Requisitions
If the requisition is job-related, specify for each requisition detail where
the items or resources are going to be used. If you use different terms
than “Contract,” “Project,” and “Category” in Project and Job Costing, the
program displays them instead.
Note:
You must select the Job-Related checkbox in the top part of the
Requisition Entry form for these fields to appear.
All details on a requisition must be either job-related or non-jobrelated.
You enter/select the resource using the Item Number field.
You cannot change these fields once you have added the detail line.
Click the following items for more information:
Contract
Cost Class
Item Number (Resource)
Project

Requisition Entry Form — Detail Items Form
Use this form to add, edit, and delete requisition detail lines. The form
displays all the fields in a separate window, letting you see all the
information you enter for a single detail.
To open and close the Detail Items form
Click the detail line on the Requisition tab, then either click the Details
button or press F9 to open the Detail Items form.
Press F9 or click Close to close the form and return to the Requisition
tab.
To add or edit details in the Detail Items form
1.To start a new detail line, click the New icon next to the Line Number
field. To open an existing detail you want to edit, type its line number
or use the navigation buttons beside the field to display the detail.
2.Type the information or changes for the detail, then choose Add (for
new details) or Save.
To delete details in the Detail Items form
1.To open an existing detail you want to delete, type its line number or
use the navigation buttons to display the detail.
2.Click the Delete button.
For information about a button on the Detail Items form, click the link
below:
Add Save Delete Close

Click the Zoom button ( ) or press Shift + F9 on your keyboard to
open the Drop-Shipment Address or Detail Comments form. Click the
Close button or press F9 to close these forms.
See also
Requisition Entry — Requisition tab
Requisition Entry Form — overview

Comment
Type a comment for the requisition, using up to 250 characters.
Lines automatically wrap when you reach the end. If you want to start a
new line before the line wraps, press the Enter key.

Billing Information for Job-Related Returns
For job-related returns, the program provides the Billing Type, Billing
Rate, and AR Item Number that was used for the receipt.
The Job-Related checkbox in the top part of the form will be selected if
the receipt was job-related.
Click the following items for more information:
A/R Item Number
Billing Currency
Billing Rate
Billing Type
Unit of Measure

Contract, Project, Category, and Item
Number/Resource for Job-Related Returns
If the purchase order and receipt were job-related, the program will
provide the job to which each detail was assigned. If you use different
terms than “Contract,” “Project,” and “Category” in Project and Job
Costing, the program displays them instead.
Purchase Orders updates the actual quantities and costs for jobs with the
amounts on returns.
Note:
The Job-Related checkbox will be automatically selected if the
purchase order and receipt were job-related.
You enter/select the resource using the Item Number field.
Click the following items for more information:
Category
Contract
Cost Class
Item Number (Resource)
Project

Return Entry Form — Bill-To Location form
Use this form when entering returns without a receipt number, to specify
the address to which you want the vendor to send the credit note for the
return. If you are editing a return to a receipt, you cannot change the billto location.
To use the Bill-To Location form
1.If you use Inventory Control, you can type the location code to use in
the Bill-To Location field, or select it from the Finder.
2.To enter or edit address information, or if you do not use Inventory
Control, click the Zoom button ( ) beside the Bill-To Location field or
press the F9 key in the field.
3.Type the name and address information to use for the location, or edit
displayed information (from the receipt or the location record in
Inventory Control).
4.When finished, choose the Close button or press F9 to return to the
Return Information tab.
Opening and closing the Bill-To Location form:
Click the Zoom button ( ) to open the Bill-To Location form with a
mouse.
Use the F9 key on your keyboard to open or close the Bill-To Location
form.
Click the Close button to close the Bill-To Location form.
Go back to the Return Information tab

Checking Return Totals
Use the Totals tab to check totals for the return and to specify the
number of shipping labels to print.
The Totals tab lets you enter:
A comment for the return.
A discount percentage or a total discount amount for the return.
When you enter a discount on this tab, the program distributes the
total amount to the return details, overwriting any discounts you
entered for details.
The Totals tab also displays:
The weight of the returned items.
Totals for the primary vendor. Information includes the total weight
and number of details on the return and total of item details.
Use the Taxes tab to view or to edit vendor tax classes or the tax
amount for the tax authorities assigned to the vendor.

Accumulate Purchase History
Use the Accumulate Purchase History option to keep information about
the items you have purchased and the vendors who supplied them. The
option also keeps information about credit notes, debit notes, and items
you returned.
You can view the information in the Purchase History form, use the
History button to look it up when you are entering transactions, and print
it on the Purchase History report.
Selecting the type of year. Purchase Orders keeps purchase history
by the type of year (fiscal or calendar) and period you select using the
Accumulate By and Period Type options on the Processing tab of the
Options form.
If you choose to accumulate by calendar year, the starting date for the
year will be January 1. If you accumulate by fiscal year, the starting date
will be the first day of your fiscal year.
Selecting the type of period. You can also keep the data for up to 53
periods per year (54 periods in a leap year), for any number of years.
Use the Period Type option to select from these period types: weekly
(Sunday = day 1), seven days (beginning on the first day of the week in
your fiscal calendar), bi-weekly (Sunday = day 1), four weeks, monthly,
bi-monthly, quarterly, semi-annually, annually, or fiscal period (use the
Period Type option).
Return to Accumulating purchasing history and statistics for reporting

Accumulate Statistics
Use the Accumulate Statistics option to keep statistical totals from all the
transactions you post in Purchase Orders, including for each period:
The number of posted purchase orders, receipts, invoices, returns,
credit notes, and debit notes.
The net quantity purchased, net purchase amount, and net invoice
amount.
The largest and smallest invoice, credit note, and debit note amounts,
and the vendors for whom you posted them.
The average invoice, credit note, and debit note amount.
You can see the information in the Purchase Statistics form and print it on the
Purchase Statistics report.
Selecting the type of year. Purchase Orders keeps purchase statistics
by the type of year (fiscal or calendar) and period you select using the
Accumulate By and Period Type options on the Processing tab of the
Options form.
If you choose to accumulate by calendar year, the starting date for the
year will be January 1. If you accumulate by fiscal year, the starting date
will be the first day of your fiscal year.
Selecting the type of period. You can also keep the data for up to 53
periods per year (54 periods in a leap year), for any number of years.
Use the Period Type option to select from these period types: weekly
(Sunday = day 1), seven days (beginning on the first day of the week in
your fiscal calendar), bi-weekly (Sunday = day 1), four weeks, monthly,
bi-monthly, quarterly, semi-annually, annually, or fiscal period (use the
Period Type option).
Editing statistics. If you use the Allow Edit Of Statistics option, you can
edit and import the statistical totals that are kept by Purchase Orders.
Use the Purchase Statistics form to edit the statistics.
Normally, you do not need to change statistics, because they are updated
automatically and accurately by Purchase Orders. However, if you set up
your Purchase Orders system partway through a fiscal year, you may

want to select the Allow Edit Of Statistics option so that you can enter
statistics from your old purchase order system for previous periods of the
current year or for previous years.
For more information, choose from the following topics:
Turning the options on or offChanging the method of reporting statistics

See also
Purchase History report
Purchase Statistics report

PO Type
You can choose to review all pending receipts, or select a particular type
of purchase order, either active, standing, future, or blanket POs.

Consolidation Settings in Purchase Orders 5.4
Do Not Consolidate previously consolidated transaction details
In earlier versions of Purchase Orders, the Do Not Consolidate choice
actually consolidated general ledger details within each transaction, so
the G/L transactions that originated with P/O usually had only a single
detail line posted to each general ledger account.
In version 5.4, Do Not Consolidate choice does not consolidate any
details
For Purchase Orders 5.3 and 5.4, however, the Do Not Consolidate
choice does not consolidate any details — to ensure that optional field
information in transaction details is not removed from G/L transactions.

The consolidation choices in G/L Integration
perform the following functions:
Do Not Consolidate. All the details posted in Purchase Orders will
be included in the General Ledger transaction batch.
Choose this option if you use optional fields and pass optional field
information from Purchase Order transaction details to the General
Ledger transaction details.
The Do Not Consolidate option provides complete information in your
general ledger transaction batch — and more transaction details than
the same setting in version 5.2.
Although this choice will result in a longer G/L Transactions report and
a larger general ledger batch, you can also consolidate transaction
details during posting in Sage ERP Accpac General Ledger.
Consolidate Transaction Details by Account. All the details within
a transaction with the same general ledger account number are
combined into one detail.
Choose this option if you do not use optional fields, but still want to
associate general ledger transactions with originating documents (for
drill down or to maintain a manual audit trail).

This option creates exactly the same G/L transactions that were
created in version 5.2 by the Do Not Consolidate choice.
Consolidate by Account and Fiscal Period. All the details with the
same general ledger account number and fiscal period are combined
into one detail.
This option is unchanged from version 5.2. (Note that it only
consolidates details from different transactions if you create
transaction batches using the G/L Batch form.)
Consolidate by Account, Fiscal Period, and Source. All the details
with the same general ledger account number, fiscal period, and
source code are combined into one detail.
This option is unchanged from version 5.2. (Note that it only
consolidates details from different transactions if you create
transaction batches using the Create Batch form.)
Partial consol. if you create batches during posting or day-end
processing
If you create batches of G/L transactions during posting or day-end
processing, the program can only consolidate the details within
transactions; it cannot consolidate the details from different transactions.
Create Batch lets you fully consolidate details
If you use the On Request Using Create Batch Icon option, you can
consolidate transaction details from all transactions for each general
ledger account if you choose Consolidate by Account and Fiscal Period
or Consolidate by Account, Fiscal Period, and Source.
See also
Choosing G/L Integration Options

Invoices for Job-Related Receipts
When the purchase order is job-related, Purchase Orders sends a jobrelated invoice to Accounts Payable. Because Purchase Orders has
already updated Project and Job Costing with receipt information,
Accounts Payable will not update Project and Job Costing with invoices
that originate with Purchase Orders.
Similarly, Purchase Orders will only send transactions to Project and Job
Costing if an invoice includes an adjustment to the receipt — such as a
change to the cost, quantity, or billing rate — because receipt entry has
already generated the job costing transactions.

Note: If you change a job-related invoice in Accounts Payable that
originated with Purchase Orders, Project and Job Costing will not be
updated with the transaction changes. You must process the changes
in Purchase Orders with a credit note or debit note, or with an Accounts
Payable transaction such as an adjustment.

Overhead and Labor Calculation
Purchase Orders performs flat rate overhead and labor calculations for
additional costs in the following way:
If the additional cost is prorated to a category that uses a flat rate per
unit, Purchase Orders will not calculate an overhead and labor
amount.
If the additional costs uses a No Proration method, and you specify a
contract, project, and category where the category uses a flat rate,
Purchase orders will disable the Calculate Overhead and Calculate
Labor choices.
If you are processing a credit note or debit note from an invoice,
Purchase Orders will not calculate overhead or labor amounts for item
details with a flat rate category.

Units of Measure for Committed and Actual
Quantities
You must receive goods using the same units of measure that are used
in the estimates in Project and Job Costing. Purchase Orders does not
convert the different units of measure when it updates PJC with
quantities from receipts or invoices.
The following example show what can happen it you receive goods using
different units of measure.
Assume that:
Your estimate includes 70 items that cost $10 each.
Shipment 1 includes 50 items, packed in 5 boxes.
Shipment 2 includes 20 items, packed individually.
Shipment 1
Material Category - Item 1001 - 5 boxes (conv. factor = 10) $500
Shipment 2
Material Category - Item 1001 - 20 items (conv. factor = 1) $200
When Project and Job Costing is updated with the quantities and costs of
these shipments, the actual quantity and cost for item 1001 will appear as
follows:
Material Category - Item 1001 - Qty = 25 items, Cost = $700

Tax Information for Additional Cost Details
You enter additional costs only with receipts, invoices, credit notes, and
debit notes. The same tax information is displayed for additional cost
details as for item details (described above).
Tax on prorated additional costs. For each additional cost detail, you
can choose a proration method that specifies how or whether to prorate
the additional cost and associated allocated tax amounts to the item
costs.
Prorating automatically. If you choose to prorate automatically, posting
or Day End Processing calculates the tax amount for each additional cost
and prorates the additional cost amount and allocated taxes to item
details, according to the proration method you choose (by quantity, cost,
or weight).
The prorated amounts are not displayed with the affected details. They
are also not included in the tax amounts you see in the Item Tax
Distribution form (because they are not part of the base on which taxes
are calculated for items), but they are shown on the posting journals for
the transactions.
Recoverable and expensed taxes. Journal entries for recoverable and
expensed taxes are created in Accounts Payable when the invoice batch
from Purchase Orders is posted.
Adding taxes to manually prorated additional cost amounts. If you
prorate additional costs manually, you must accurately calculate the tax
amount for each cost you are prorating, then allocate the full amount of
the cost and applicable allocated taxes to item details. You must enter
the exact amount to prorate to each item detail in the Manual Proration
field for the detail line on the receipt or return.
Multicurrency ledgers. If you use multicurrency accounting, you can
enter additional costs to be manually prorated only for vendors who use
the functional currency.
Checking manual proration tax amounts. If you are manually prorating
an additional cost, you can use the Additional Cost Vendor Taxes form to
check the allocated tax amount calculated by the program for the

additional cost detail.
If the tax calculations for a transaction include recoverable and expensed
taxes, you should calculate the allocated tax to prorate manually for each
detail, using the Item/Tax button on the detail entry grid (on the first tab)
or in Detail Items/Taxes form.
Use the Totals tab to check the total additional cost amount (including
taxes) to prorate manually to item details. The Totals tab lists:
The total amount to be prorated manually (in the Additional Cost To
Be Allocated field). This amount is for all vendors included in the
transaction whose costs you are prorating manually.
The amount you have prorated so far (in the Manually Prorated field).
The amount, if any, which has not been prorated or by which the
manual proration is greater or less than the total (in the Out Of
Balance field).

Return Entry Form — Detail Comments Form
Use this form to type comments which apply to the detail line.
To open the Detail Comments form
Press the Shift and F9 keys in the Comments field to open or close
the form using your keyboard.
Click the Zoom button ( ) beside the Comments field to open the form
with a mouse.
To enter comments
1.Open the Detail Comments form.
2.Type the remarks, pressing Enter to start each new line.
3.When finished, click Close to close the form.
To edit comments
1.Open the Detail Comments form.
2.Make the changes you need.
3.When finished, click Close to close the form.
To delete comments
1.Open the Detail Comments form.
2.Highlight the text to delete, then press the Delete key on your
keyboard. If a message appears asking you to confirm the deletion,
choose Yes.
3.When finished, click Close to close the form.
You can also delete comments by changing the entry in the field to No on
the Return tab, or by deselecting the Comments box on the Detail
Items/Taxes form (click the field or press the Shift and F9 keys at the
same time in it).
If you use this method, your remarks are not immediately deleted. If you
decide before posting the return that you want to use the remarks, enter
Yes (or reselect the Comments field on the Detail Items/Taxes form). The
original remarks will reappear.

Go to the Return tab.

Bill-To Location Information Form Field List
Address
Bill-To Location (display only)
Contact
Description
Fax Number
Phone Number

Cost Allocation Form Field List
Amount (additional cost detail total)
Amount (prorated for each receipt)
Billing Rate
Proration Method (display only)
Receipt Number
Retainage Percentage, Amount, and Period

Allocated Tax (display only)
The program displays the amount of allocated tax for the detail.
Allocated taxes are included in the cost of the detail. Recoverable and
expensed taxes are not included in detail costs.

Cost Allocation Form Field List
Amount (additional cost detail total)
Amount (prorated for each receipt)
Billing Rate
Distribute Proration (appears if manually prorating cost)
Proration Method (display only)
Receipt Number
Retainage Percentage, Amount, and Period

Additional Cost Vendor Address Information Field
List
(display only)
Vendor Number (display only)
Vendor Name
Address
Contact
Fax Number
Phone

E-mail
Type the e-mail address for the location, or edit the displayed address if
necessary.

Requisition Entry — Detail Items Field List
Comments/Instructions
Completed
Drop Ship
Expected Arrival Date
Item Description
Item Number
Line Number
Location
Name (Vendor)
Optional Fields
Order Number
Quantity Ordered
Unit of Measure
Vendor (Number)
Vendor Item Number (optional)

Bill-To Location form Field List
Address
Bill-To Location (display only)
Contact
Description
Fax Number
Phone Number

